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Overview of Macro Space Planning 

Overview of Macro Space Planning 
The Macro Space Planning Application (which includes the Planner and Merchandiser 
modules) is described in the diagram below. 
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Macro Space Planning 
Macro Space Planning consists of two applications sharing a common database: Macro 
Space Management and In-Store Space Collaboration. Macro Space Management is 
intended for use at headquarters and has functionality not replicated in In-Store Space 
Collaboration. In-Store Space Collaboration is designed to be portable and can be used 
(via the Internet) at stores within a retail organization. 

Macro Space Management 
Macro Space Management consists of two sorts of modules: store planning modules and 
support modules. 
1. Store Planning Modules 
Store Planning can be carried out in Planner (AutoCAD environment) or Merchandiser 
(Virtual Reality environment). Store Manager, used to administer the store hierarchy, can 
be accessed from either Planner or Merchandiser. 
2. Support Modules 
The support modules are used for three main purposes: to configure Macro Space 
Management, to configure the varying libraries of information and to operate batch 
processes.   
� Configuring Macro Space Management is carried out using the Administration 

module for global changes and the Configuration module for local, user specific 
changes.  

� Libraries of information maintained include the fixture and gondola libraries 
(Fixture Studio), product library (Product Studio) and the planogram library 
(planogram design within the Merchandiser module). 

� Batch tools include Data importer (for bulk import of data) and Report Designer 
(configuring planogram reports for bulk output) 

In-Store Space Collaboration 
In-Store Space Collaboration uses a common database with Macro Space Management. 
ISSC is more portable than MSM and is often deployed to stores to allow store managers 
to be come involved in the store planning process. It can also be used to ensure 
compliance with store plans.  
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Overview of Store Planning Business Process 
The store planning business process will vary from retail organization, but can be 
conceptually described as follows: 

 

Strategic Planning  
Retail organizations have a strategic planning process that evaluates the choices for the 
broad types of merchandise the retail chain will sell. 

Category Management and Assortment Planning 
Category Management and Assortment Planning tools are then used to find the precise 
mix of merchandise required within a specific store. 

Product Targets 
The information on the required quantities of merchandise is imported as Product 
Targets. 

Store Plan 
Merchandise is then placed within the store/floor plan until the Product Targets have 
been matched. This can be done in the Planner and Merchandiser modules (or in In-Store 
Space Collaboration). 

Performance Measurement 
Once the floor plan has been created, its performance is measured using Key 
Performance Indicators or Reports. This information can then be used to optimize the 
current floor plan or it can be fed back into the strategic planning process. 
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Logging In 

How Passwords and Privileges are Configured 
Passwords and Privileges are configured in Macro Space Management's Administration 
module. 

Note: Access to the Admin Module is normally restricted to 
a limited number of users. This is because the Admin 
Module can be used to set a wide variety of parameters 
affecting how Macro Space Management operates.   

Access rights to the Macro Space Management modules are set using the Functional 
Security option. 

 
Users are assigned to User Groups in the User Groups Tab. Which modules a User Group 
can access is specified in the Group Relationships tab. A user’s privileges thus depend on 
what user groups they are assigned to. 

 
In the above example, User 1 is only a member of the Equipment Planner user group. 
Accordingly, their access is restricted to the Fixture Studio and Planner modules. User 2 
is a member of the Equipment Planner and Merchandiser Planner user groups. They 
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have wider access and can use the Fixture Studio, Planner, Product Studio and 
Merchandiser modules. 

Logging in to Macro Space Management Modules 
When a user first attempts to access a Macro Space Management module, the Log In 
dialog box will appear. 

 
This requires the user to enter a User Name and Password. If these are correct, the user 
will be able to access the desired module. After the initial log in, information will be held 
in Security Server. Users will therefore be able to access all other Macro Space 
Management modules they have permissions for without the need to log in again.  
If the user attempts to log into a module for which they do not have permissions for, a 
warning will appear and the log in attempt will be terminated. 

 

Note: The permissions for which modules can be accessed 
are configured in the Administration module. 

Password Changes 
Macro Space Management can be configured to require password changes at specified 
intervals. If one of these intervals has been exceeded, the user will be asked to change 
their password the next time they log in. This can be done by means of the Change 
Password >>> option on the Log In dialog box. This will reveal another part of the 
dialog box where the changed password can be entered and confirmed. 

 

Security Server 
Security Server is a Macro Space Management application that runs in the background 
and is normally not visible to users. When running, it can be seen in Windows Task 
Manager.  
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How Security Server operates is shown in the following flowchart. 

 
3. The user opens a Macro Space Management module from a shortcut or the Windows 

start menu. 
4. Security server starts but remains in the background. 
5. The Log In dialog box appears. 
6. The user types their user name and password into the Log In dialog box. 
7. Security Server validates the user name and password against the information held 

in the database. If they are correct and the user has sufficient privileges, the Macro 
Space Management module opens. 

8. Security Server holds information on what other privileges the user has in Macro 
Space Management. 

9. If the user attempts to access other modules, Security Server will check the 
information it holds and allow or deny access as required. This means that a user 
only has to log into Macro Space Management once per session.  

10. When the user exits the last Macro Space Management module, Security Server also 
closes. 

Security Server and Application Errors 
On occasion a Macro Space Management module might encounter a significant error and 
automatically close. Because the closure was not user initiated, Security Server does not 
close but remains open in the background. If the module that unexpectedly closed is 
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reopened, Security Server will contain information incompatible with the restart and 
further application errors will result.  
In the event of a Macro Space Management module failing unexpectedly, carry out the 
following actions: 
1. Save the information in any other Macro Space Management modules that are open 

and close those modules. 
2. Open Windows Task Manager, highlight Security Server and click End Task. 
3. When Security Server has closed, the required Macro Space Management modules 

can be restarted. 
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Introduction to Store Manager 

Overview of Store Manager Module 
Oracle’s Macro Space Management software combines the traditional merchandising 
approach with store planning, construction, operation and inventory management. It is 
designed to maximize profitability and returns by enabling the optimum layout and mix 
of products to be efficiently planned right across an organization’s range of retail outlets.  
Macro Space Management contains large amounts of information. This can be as specific 
as the current contents of a shelf in a single store or as general as the floor plans to be 
implemented business wide in 6 months time. This mass of information has to be 
organized and administered. Within Macro Space Management this is achieved by the 
Store Manager module.  
Store Manager operates in a similar way to Windows Explorer. It has been designed to be 
easy to use and allows information to be grouped in a way that reflects the structure of 
the organizations.  

 
The menu and tool bars can be seen to the top left of the window.  
A frame showing the hierarchical tree of Clusters, Stores, Floors and Revisions can be 
seen to the left of the window.  
The files associated with a particular Revision can be seen in the frame to the upper right. 
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A preview of the drawing to be selected can be seen towards the lower right. 
Using Store Manager you can: 
� Assign your retail outlets to logical groupings, allowing comparisons and 

analysis of sales to be made between individual stores or groups of stores. 
� Assign or change floor plans for stores, allowing the effects of differing store 

layouts or merchandising mixes to be evaluated. 
� Carry out routine administration on the files used within Macro Space 

Management. 
� Get reports on the data used within Macro Space Management. 
� Interface with external programs allowing import and export of data to and from 

those programs. 

Note: Macro Space Management's sister program, In-Store 
Space Collaboration, can be used to access and edit drawings 
held in the central Macro Space Management database. 

Accessing Store Manager 
Store Manager can be accessed from either the Planner or Merchandiser modules. 
In Planner, Store Manager is accessed by clicking on the Open File option in the standard 
toolbar. Alternatively, the Open File option can be selected from the File menu. 

  
In Merchandiser, Store Manager is also accessed by clicking on the Open File option in 
the standard toolbar. Alternatively, the Open File option can be selected from the File 
menu. 

   

Overview of setting up Store Manager 

General  
Before Macro Space Management can be used, it is necessary to set up a Hierarchical Tree 
within Store Manager. This structure enables the stores to be arranged in logical 
groupings by means of Clusters and Sub-clusters. 
The performance of individual Stores can be compared against selected Prototype Stores, 
while the performance of one cluster of stores can be compared against another cluster. 
The structure of this hierarchical tree should be carefully considered as it will affect the 
quality of information that can be produced using Macro Space Management, and hence 
determine the effectiveness of Macro Space Management as a tool for improving the 
profitability of a business. 
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Planning the Structure 
Typical information needed to plan how individual stores should be assigned within the 
structure includes: 
� Store Size 
� Store Turnover 
� Store Location 
� Store Demographics 

Criteria can then be developed as to cluster types, and hence whether individual stores 
should be assigned to single or multiple clusters.  
For example, a store could be associated with three separate and distinctive clusters. One 
cluster would enable the store to be compared against those in other regions, one against 
stores of similar turnover, and the third against stores of similar size.  
Consideration should also be given to which stores can be designated as Prototypes for 
comparison purposes. Correctly assigned prototype stores will also allow swift and 
effective comparison of individual store performance against an exemplar. 
A correctly planned structure can significantly improve the performance of a retail 
organization – a poorly planned structure could prevent the full power of Macro Space 
Management being used. 

Data Import 
Macro Space Management has a Data Import module.  
This enables data to be taken from external databases and imported into the Macro Space 
Management central database.  
Activating this module brings up the MSM Data Importer dialogue box. 

 
This allows the classes of data to be imported to be selected.  
Oracle’s consultants can configure the exact nature of the data import so that specified 
data is selected from the designated databases and imported into the required fields 
within Macro Space Management’s central database.  

The Store Manager Menu Bar 
The Store Manager Menu bar contains several options: 

 
File activates a pull down menu with options primarily concerned with operations on 
files. 
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Some of these may be grayed out depending on what Store Manager function is being 
used.  
This menu can be used to add, edit and delete files and to associate files and architectural 
plans. 
Edit activates a pull down menu with options to cut, copy and paste files. 

 
Some of these may be grayed out depending on what Store Manager function is being 
used.  
View activates a pull down menu with various options controlling the way Store 
Manager appears.  

 
These can be used to change the way Store Manger displays information. 
The Tools option is only available to administrators and is toggled on and off by means 
of <Ctrl + A>. 
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It contains a series of options used to check in files, check directory integrity, import files 
and create hierarchies. 

The Store Manager Toolbar 

 
 The Store Manager Toolbar contains a series of options for administering the objects and 
files in Macro Space Management. Depending on which operation is being carried out, 
one or more options may be grayed out (unavailable). 
 

 
 
Close Store Manager 

 
 
Open a Drawing 

 
 
Add an Item 

 
 
Edit an Item 

 
 
Delete an Item 

 
 
Create reports 

 
 
Associate File 

 
 
Associate 
Architectural Plan 

 
 
Search 

 
 
Cut 
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Copy 

 
 
Paste 

 
 
Properties 

 
 
Large icons for files 

 
 
Small Icons for files 

 
 
List of files 

 
 
Details of files 

Basic Concepts 

Hierarchical structures 
A Hierarchical structure is one where objects are organized in the form of a tree. The 
more fundamental data is close to the trunk, while the more dependent data is further 
out on the branches. The most fundamental part of the hierarchical structure is the root.  

 
Hierarchical structures are used to allow objects to be set out in a logical relationship to 
each other.  
The Stores cluster contains the Prototypical sub-cluster. This sub-cluster contains the 
Large Prototype store. The Large Prototype store has a 'Level 1' floor, and that floor 
contains the Prototype revision. 
The Store cluster is closest to the trunk, while the New Dover Layout revision is the most 
dependent data. 
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Parent-child relationships 
Some objects within Store Manager are linked together in such a manner that changes to 
one object may result in changes to other objects linked to it. Such objects are described as 
being in a parent-child relationship. The object that has dependent objects associated 
with it is known as the parent, while the objects that are associated with the parent object 
are known as the children. 
In a hierarchical structure, children of one parent can be parents of their own children in 
turn. 
When the status of a parent object is changed; it can often result in changes to the status 
of child objects. Similarly, the status of parent objects can sometimes only be changed 
when the status of the appropriate child object is correct. 
When a parent object is deleted, it affects all the associated child objects. Conversely, a 
child object can often be deleted without affecting the parent. 

 
In the above example the Ground Floor is a child of the Bridgetown store, but is a parent 
of the Summer Plans Revision. 

Status 
Status defines the current standing of an object within the business life cycle.  
For example, Stores generally have three statuses. 
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At the beginning of the process, the Store has a Proposed status as it is only at the design 
stage. When the store has been built, its status will change to Open. Finally, if the store 
has reached the end of its useful life, it will be assigned Closed status. 
The status of an object thus changes as Macro Space Management users move through 
the business cycle. 

    Publish Dates and Effective Dates 
Publish and Effective dates are associated with the status of the drawing of a floor plan 
in some implementations of standard Macro Space Management and the automated 
Enterprise version of Macro Space Management.  
The Publish date is the date at which the drawing is issued to the stores. Drawings are 
typically published a number of days in advance of the time the changes are required. 
The Effective date is the date at which the published drawing becomes current. 
Publish and Effective dates can be turned on by making changes to the 
AVTTB_SYSTEM_VARIABLE table in the database.  

Note: It is STRONGLY recommended that users discuss this 
with Oracle’s Technical Support team before making the 
changes. 

Once enabled, Publish and Effective dates can be used to automatically change the status 
of revisions and drawings by making use of the UpdateStaus.exe file in the Macro Space 
Management/Tools sub-directory.  

Note: UpdateStatus.exe can be set to run on a daily or 
weekly basis by the Windows task manager, allowing some 
degree of automation of common tasks. However, for full 
automation of common tasks, it is recommended that Macro 
Space Management users use the Enterprise version of 
Macro Space Management.  

RFBin 
The RFBin is Macro Space Management’s equivalent of the Recycle Bin. Files marked for 
deletion are sent to the RFBin, but will not be permanently deleted until the Purge option 
is used in the Tools menu.  
Its location is specified in the Directories tab of the Configuration module. 
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This location can generally only be changed by users with rights to the Admin module. 

XREF's 
XREF is a method Planner uses to link drawings. When you attach a drawing as an 
XREF, you link that referenced drawing to the current drawing. Any changes to the 
referenced drawing are then displayed in the current drawing when it is opened. 
This is used within Macro Space Management where an architectural drawing can be 
attached as an XREF to multiple drawings at the same time. This allows a single 
architectural drawing to be used as a framework on which multiple arrangements of 
zones, fixtures, aisles and merchandise may be planned.  

Note: Using XREF’s reduces the quantity of data stored, as 
each architectural plan is only used once for each floor, not 
copied under multiple file names. 

Store Root 

  
The Store Root is the origin of the hierarchical tree. All other data emanates from the 
root.  
Normally, stores are grouped in clusters and sub-clusters. However, it is possible to add 
stores directly at the root level without them being associated with a cluster or sub-
cluster.  

Clusters 
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A Cluster is a logical grouping of stores that meet specified criteria. Examples of possible 
groupings for Clusters include stores that are: 
� In the same country. 
� In the same region. 
� Of the same size. 
� Of the same turnover. 
� Of the same internal layout. 

Clusters of a specific type can be further divided into sub-clusters.  

Sub-clusters 

 
A Sub-cluster is a sub-division of a Cluster. Sub-clusters are used to allow a finer level of 
detail when analyzing the performance of groups of stores.  
For example the cluster of stores labeled England might be further sub-divided into sub-
clusters called north, central and south.  
If necessary, this process could be continued further, with the north sub-cluster being 
further divided into, for example, city and suburban sub-sub-clusters.   

Stores 

 
A Store is the unique description of a specific retail outlet. Stores are made up of one or 
more floors. 
Stores are normally associated with one or more clusters; although they can, (less 
usually), be directly associated with the Store Root.     

Prototype store 

 
In some implementations of Macro Space Management a Prototype Store is a store that is 
used as a basis for comparison for other stores within the Store Manager hierarchy.  
Prototype Stores can be theoretical, in that they can be designed by marketing staff as an 
exemplar of what a store should be. They can also be practical examples selected from 
operational stores.  
There can be many Prototype Stores, but each operating store can only have a single 
Prototype Store assigned to it at one time.  
Prototype status can be assigned to a store by editing its properties.     

Floor 

 
A Floor is a distinct physical level within a store.  
A Floor can contain one or more revisions, (arrangements of fixtures and fittings), 
associated with it.     
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Revision 

 
Revision is the name given to a version of the arrangement of fixtures and fittings on a 
floor. Floors can have many revisions. For example a floor could have Spring, Summer, 
Autumn and Winter revisions, each representing a planning arrangement to be used at 
the appropriate time.  
Revisions are often color coded to show their status. 
Floors can also have different revisions showing different marketing mixes, fixture 
arrangements, etc.  
Only one Revision can be active at any one time.     

Files 
A File is a general description for a category of records. Floor plans are files, as are 
Architectural Plans.  

The Store Manager Hierarchy 

A note on parent-child relationships 
When deleting clusters, sub-clusters, stores, floors or revisions, it should be noted that all 
associated child files will be deleted along with the parent file. 
These files are not permanently deleted and can be recovered by use of the purge option 
in the Admin functions in the Store Manager module, (accessed by <Ctrl + A>). 
Changing the status of a revision may also affect the status of an associated child file. 

Adding, Editing and Deleting Clusters 
To Add a Cluster to the Store Root, go to the hierarchy tree in Store Manager. Click on 
the Store Root, (Stores), icon to highlight it. If it was not previously live it will change 
from a white to a colored Icon. 
With the mouse pointer over the Store Root icon, right click to bring up the drop down 
menu of options.  

 
To add a Cluster to an existing Cluster, click on it to highlight it. Right click to bring up 
the list of options. (Note that this is a slightly different drop down menu from that which 
appears at the Store Root). 
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Select the Add Cluster option. A small dialogue box will come up.  

 
(Alternatively, when the Store Root icon is live; click on the add-an-item icon in the 
toolbar. This will bring up the small dialogue box). 
Enter the Cluster Name and Cluster Code. Select the Cluster Type from the drop down list 
available. 

 
Selecting the correct Cluster Type is important as this information will be used for 
reporting purposes. If clusters are allocated to the wrong type, errors will occur in 
reporting.  
When all the available information has been entered, click OK to insert the cluster. 

Note: The list of drop down options is customizable. Please 
consult Oracle’s Technical Support team for information. 

Editing Clusters 
Some of the characteristics of the cluster can be edited by left clicking on the cluster to 
select it, then right clicking and selecting the Edit option. 
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The Cluster ID is allocated on creation and cannot be changed. It is accordingly grayed 
out. 
The Cluster Name, Code and Type can all be edited. 
The cluster can be deleted by left clicking on the cluster to select it, then right clicking 
and selecting the "delete" option. 

Deleting Clusters 
The cluster and all its associated child files are removed from the hierarchical tree and 
moved to the RFBin. At this stage the files have not been permanently deleted and can be 
restored via the Administrator menu, (accessed via <Ctrl + A>). 
Deleting a cluster results in all copies of the stores associated with it being removed, but 
copies of the stores associated with other clusters will not be affected.  

Adding, Editing and Deleting Sub-Clusters 
To Add a sub-cluster, go to the hierarchy tree in Store Manager. Click on the icon of the 
required Cluster to highlight it. Right click to bring up the available options. 
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Select the Add Cluster option. A small dialogue box will come up.  

 
(Alternatively, when the Cluster icon is live; click on the add-an-item icon in the toolbar. 
This will bring up the small dialogue box). 
Enter the Cluster Name and Cluster Code. Select the Cluster Type from the drop down list 
available. 

 
Selecting the correct Cluster Type is important as this information will be used for 
reporting purposes. If clusters are allocated to the wrong type, errors will occur in 
reporting.  
When all the available information has been entered, click OK to insert the cluster. 

Note: The list of Cluster types in the drop down options is 
customizable. Please consult Oracle's Technical Support 
team for information. 

Modifying and Deleting Sub Clusters 
Modifying and deleting sub-clusters is carried out exactly the same as for Clusters.    
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Adding, Editing and Deleting Stores 
To Add a Store, go to the hierarchy tree in Store Manager. Click on the icon of the 
required Cluster to highlight it.  
With the mouse pointer over the cluster or sub-cluster icon, right click to bring up the list 
of options. Select the Add Store option.  

 
The Add Store dialogue box will come up. 

 
(Alternatively, when the cluster or sub-cluster icon is live; click on the Add-an-Item icon 
in the toolbar. This will bring up the dialogue box). 
Starting with the General tab, enter the required data including the Store Code and Store 
Name.  
Select the store Status. This can be: 
� Prototype. 
� Proposed. 
� Open. 
� Closed. 

If the store is not a prototype, select the Prototype Store from the drop down list at the 
bottom of the dialogue box. 
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If the store is designated as a Prototype, then selecting a prototype store from the drop 
down list is not possible. 
Click on the Units tab and select the required units. 

Note: The units set in the Units tab are for information 
purposes only, and will not have any direct effect in current 
implementations of Macro Space Management. 

Click on the Address tab and enter the required information. 
When all the required data has been entered, click on the OK button to complete 
insertion of the store. 

Editing Stores 
Most of the characteristics of the store can be edited by left clicking on the store to select 
it, then right clicking and selecting the Edit option.  

 
This will bring up a dialogue box. 

 
The store ID is allocated on creation and cannot be changed. It is accordingly grayed out. 
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All other information can be edited. 

Note: The units set in the Units tab are for information 
purposes only, and will not have any direct effect in current 
implementations of Macro Space Management. 

Deleting Stores 
To delete a store from all the clusters it is associated with, left click on the store to select 
it, then right click and select the Delete option.  
The store and all its associated child files are removed from the hierarchical tree and 
moved to the RFBin.  
At this stage the files have not been permanently deleted and can be restored via the 
Administrator menu, (accessed via <control> A). 
To remove a store from a specific cluster, left click on the store to select it. With the left 
mouse key held down, drag the store icon to another cluster that the store is associated 
with. Release the mouse key to "drop" the store. The store will be removed from the 
original cluster.    

Stores and Clusters 

Moving Stores between Clusters 
To move a store from one cluster to another, left click on the store to select it. With the 
left mouse key held down, drag the store icon to the required cluster. Release the mouse 
key to drop the store.  
Stores can also be moved by left clicking on them to select them, then using the Cut and 
Paste options accessible with the right mouse key.  
Multiple stores can be selected by using the mouse key in conjunction with the <Shift> or 
<Control> keys 

Putting stores into Multiple Clusters 
A cluster, (or sub-cluster), is used to group together stores sharing a common 
characteristic such as size or geographical location.  
Stores can logically belong to more than one category when they meet more than one 
criteria. Accordingly, stores can be assigned to more than one cluster. 
To be put into multiple clusters, stores must first be added to an existing cluster. The 
required stores can then be selected by left clicking with the mouse. They can be added to 
the second cluster, (or sub-cluster), by use of the Copy and Paste options accessible with 
the right mouse key.  
This process can be continued until the required store(s) have been put into all the 
appropriate clusters or sub-clusters. 

Adding, Editing and Deleting Floors 
To Add a Floor, go to the hierarchy tree in Store Manager. Click on the icon of the 
required store to highlight it.  
With the mouse pointer over the store icon, right click to bring up the list of options.  
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Select the Add Floor option. A small dialogue box will come up. 
Alternatively, when the store icon is live; click on the Add-an-Item icon in the toolbar. 
This will bring up the same small dialogue box. 

 
Select the Floor Type. Example possibilities include: 
� Basement. 
� Level 1. 
� Level 5. 

Note: The list of floor types can be configured by Oracle. 
Contact Oracle Technical Support for more information. 

If additional information is required, edit the Description of the floor. (The default is the 
Floor type). 
If necessary edit the Directory. (This is the name that will be given to the associated 
directory).  
Select the Status of the floor. Available options are: 
� Proposed. 
� Existing. 
� Closed. 
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Only one floor at each level can have Existing status at a time. If a floor at the level being 
added already has Existing status, a message stating "A floor already exists of this type" 
will appear.  
To give the new floor Existing status, the status of the floor with current Existing status 
will have to be changed.  
Next, set the Allocated Area % Tolerance to any figure up to 100%. This figure is used to 
check the allocated area of the floor meets a specified level of efficiency. For example, 
setting the percentage to 95 % will result in a warning if the planning of fixtures and 
fittings results in less than 95% of the floor area being allocated. 
The Elevation option allows the merging of floors for planning purposes. 
The Edit Levels option allows fixtures to be located at higher than floor level. An 
example would be display cabinets placed high on the wall. 
Click on OK to add the Floor. 

Modifying Floors 
Most of the characteristics of the floor can be edited by left clicking on the store to select 
it, then right clicking and selecting the Edit option.  

 
This will bring up a dialogue box. 

 
The store ID is allocated on creation and cannot be changed. It is accordingly grayed out.  
All other information can be edited.  

Note: Changing the status of the floor is discussed in the 
section on business flows. 
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Deleting Floors 
To delete a floor from the store it is associated with, left click on the floor to select it, then 
right click and select the Delete option.  
The floor and all its associated child files are removed from the hierarchical tree and 
moved to the RFBin.  
At this stage the files have not been permanently deleted and can be restored via the 
Administrator menu, (accessed via <control> A).       

Adding, Editing and Deleting Revisions 
Revisions are alternative layouts for floors. Changing from one Revision to another 
allows the layout of a floor to be changed, (for example), from the Spring to the Summer 
arrangement.  
To Add a Revision, go to the hierarchy tree in Store Manager. Click on the icon of the 
required floor to highlight it.  
With the mouse pointer over the store floor, right click to bring up the list of options.  

 
Select the Add Revision option. A small dialogue box will come up. 
Alternatively, when the floor icon is live; lick on the Add-an-Item icon in the toolbar. This 
will bring up the same small dialogue box. 

 
Decide on and enter the Revision Number. If you inadvertently select an existing revision 
number, the revision number will default to the next available number. 
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Input the Revision Description and Revision Directory Name. 
Select the status of the revision. Typical available options are: 
� Proposal. 
� Authorized. 
� Current. 

At this stage it will only be possible to set the revision status to "Proposal". 
Set the season to one of the available options. 
� Spring. 
� Summer. 
� Autumn. 
� Winter. 
� All. 

The Birth date will automatically set to the days’ date.  
The Death date will automatically set to 31st December 2999. 
Neither the Birth nor Death date need changing at this stage. 
There is a check box at the bottom of the dialogue box. Selecting this will automatically 
add a proposal drawing. 
Click on OK to add the Revision. 

Editing Revisions 
Most of the characteristics of a Revision can be edited by left clicking on the Revision to 
select it, then right clicking and selecting the Edit option.  

 
This will bring up a dialogue box. 
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The revision ID is allocated on creation and cannot be changed. It is accordingly grayed 
out. 
All other information can be edited.  
Note: Changing the status of the revision is discussed in the section on business flows. 

Deleting Revisions 
To delete a revision, left click on the revision to select it, then right click and select the 
Delete option.  
The revision and all its associated child files are removed from the hierarchical tree and 
moved to the RFBin.  
At this stage the files have not been permanently deleted and can be restored via the 
Administrator menu, (accessed via <control> A).      

Associating Architectural Plans 
Architectural Plans can only be associated with Floors. 
An example of a file of this type would be a Planner drawing; (file extension .DWG). 
To associate an Architectural Plan with a Floor, go to the hierarchy tree in Store Manager. 
Click on the icon of the required floor to highlight it. With the mouse pointer over the 
floor, right click to bring up the list of options.  



The Store Manager Hierarchy 

Store Manager 31 

 
 Alternatively, the Associate Architectural Plan icon on the toolbar can be used.  

 
On selection of the Associate Architecture option the Architectural File Association 
dialogue box will come up. 

 
Two options exist; to copy or link a file. Select which option is appropriate by clicking on 
the required radio button. 

Note: Macro Space Management will automatically update 
files that are linked if they are changed or modified by an 
external program. Copied files updated by Macro Space 
Management may not have their original versions changed. 

Click on the Browse button and select the required file.  
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Select the file and click Open to confirm. This will return you to the Architectural Plan 
dialogue box. Click OK on this dialogue box to confirm the Architectural Plan is to be 
associated.     

Associating files 
For a revision to be fully active, it needs files to be associated with it. This can be done via 
the file menu. 

 
 
Another way of associating a file with a revision is to go to the hierarchy tree in Store 
Manager. Click on the icon of the required revision to highlight it. With the mouse 
pointer over the revision, right click to bring up the list of options.  
(Alternatively, the associate file icon on the toolbar can be used).  
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Select the Associate File option. A small dialogue box will come up. 

  
Two options exist; to copy or link a file. Select which option is appropriate by clicking on 
the required radio button. 
Click on the Browse button and select the required file. Click OK to confirm.  

Note: Macro Space Management will automatically update 
files that are linked if they are changed or modified by an 
external program. Copied files updated by Macro Space 
Management may not have their original versions changed. 

Status 

Overview of status 
The status of an object will be continually changing as it moves through the business 
cycle. For example stores start as Proposed. After approval they become Open. When the 
store reaches the end of its life it will become Closed. 
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Understanding the changing status of objects is fundamental to the operation of Macro 
Space Management. 
All objects except clusters and sub-clusters have a status.  
Stores and floors have independent status: their status can be changed without affecting 
the status of any objects below them in the hierarchical tree. 
Changing the status of a revision may affect the status of its associated child files. 
Changing the status of a revision may also affect the status of any other revisions for that 
floor. 
Some status changes are reversible. For example a store can be changed from open to 
closed status for a major refurbishment. On completion of the refurbishment, the stores’ 
status can then be changed back to open. 
Some status changes are irreversible. For example, once a floors’ status has been changed 
from current to historical it cannot be changed back. 
Whether a status is reversible or irreversible is determined when Macro Space 
Management is first implemented.  

Status of Clusters 
Clusters and sub-clusters are administrative devices for arranging stores in logical 
groupings. As such they do not have a status. 

Changing the status of Stores 
Stores can have the following status: 
� Proposed. 
� Open. 
� Closed. 

They can also be set to Prototype status. 
Status of a Store is changed through the Edit Store dialogue box. This is accessed by right 
clicking on the Store icon in the hierarchical tree and selecting the Edit option.  
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The status of the Store can be changed by means of the drop down list.  
A stores’ status can be changed without affecting status of the floors, revisions or files 
below it in the hierarchy.  
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Changing the status of Floors 
Floors can have the following status: 
� Proposed. 
� Existing. 
� Closed. 

Status of a Floor is changed through the Edit Floor dialogue box. This is accessed by right 
clicking on the Floor icon in the hierarchical tree and selecting the Edit option.  

 

 
A floors’ status can be changed between Proposed to Existing without affecting status of 
the revisions or files below it in the hierarchy.  
Changing the status to Closed turns any Current file to Historical status.  
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Changing the Status of Revisions 
Revisions within Macro Space Management can have the following generic statuses: 
� Proposal 
� Authorized 
� Current 
� Historical 

 

Note: Revisions cannot be directly changed to Historical 
status - they are automatically changed by Macro Space 
Management when another Revision becomes Current. 

Status of a Revision is changed through the Edit Revision dialogue box. This is accessed 
by right clicking on the Revision icon in the hierarchical tree and selecting the Edit 
option.  
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 Only one Revision can have the status of Authorized for a specific Store. 

  Only one Revision can have the status of Current for a specific Store. 
Changing the status of a Revision can affect the status of its associated child files. 

Changing from Changing to Result 

Proposal Authorized Children not affected by status change.  
If another revision has currently has 
authorized status, this revision will 
automatically have its status changed back to 
proposal.  
The change back to proposal will require 
confirmation by a prompt. 

Authorized Current A revision can only be changed to current if it 
has only one related drawing, or if only one 
drawing has been given authorized status. 
If another revision within the same floor has 
a status of current, that revision will have its 
status changed to historical.  
The change to historical will require 
confirmation by a prompt. 
"Current" children of the revision which is 
having its status changed to historical will 
also have their status changed to historical. 
Other children of that revision could also 
have their status changed.  

Current Historical This change is automatic, all pertinent 
children being changed automatically. 
This change is irreversible. 

The status of a Revision can be seen from the color of its associated folder. 
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� Proposed revisions have a buff, (yellow), colored folder. 
� Authorized revisions have a green folder. 
� Active revisions have a pink folder.  
� Historical revisions have a purple folder. 

Changing the status of Files 
Files can exist at the store, floor or revision level in Macro Space Management. 
Within Macro Space Management, files at Revision level can have a generic status of: 
� Proposed 
� Authorized 
� Current 
� Historical 

Note: Files cannot be directly changed to Historical status - 
they are automatically changed by Macro Space 
Management when another Revision becomes Current. 

If Macro Space Management is being used in parallel with In-Store Space Collaboration, 
then other generic statuses are possible: 
� Survey 
� Submitted 

Status of a Revision is changed through the Edit Revision dialogue box. This is accessed 
by right clicking on the Revision icon in the hierarchical tree and selecting the Edit 
option.  
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The status of a file can only be reversed if the status has been marked as reversible in the 
database. 
If the file is the child of a revision currently changing its status to current, the file will 
automatically have its status changed.  
If the file is the child of a revision automatically having its status changed from current to 
historical, the file will automatically have its status changed. 
Only one drawing within a revision can have a status of authorized. If you are 
attempting to change a second file to authorized status, the initial file with authorized 
status will be automatically changed back to proposed first.  
The automated change to of a revision to historical will require confirmation by a 
prompt. 

Macro Space Management Files and In-Store Space Collaboration 
Two types of drawings are often present in Macro Space Management and derived from 
the use of In-Store Space Collaboration: 
� Survey drawings 
� Submitted drawings 

Survey Drawings are created in Macro Space Management to represent store layouts that 
are currently in place, but where there the information is to be updated. They consist of a 
building outline and dummy fixtures, fitting and gondolas.  
A surveyor then walks the store and updates the drawing using In-Store Space 
Collaboration so that it reflects the actual arrangement in place.  
Fixtures, Fittings, Gondolas, Products and Merchandise can be updated on a Survey 
Drawing using In-Store Space Collaboration.  
Survey drawings start at Survey status. If they are saved using the In-Store Space 
Collaboration Save option, their status remains at Survey status.  
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Submitted drawings are drawing that have been fully updated using In-Store Space 
Collaboration and are being saved back to the central Macro Space Management 
database with a modified status.   
When they are saved using the Save Submit option within In-Store Space Collaboration, 
their status is automatically changed to Submitted.  

Note: Other statuses can be selected using the 
IN_STORE_SUBMITSTATUS system variable.  

Their status cannot be further changed by In-Store Space Collaboration. 

Accessing the Administrator functions 
The Tools menu can be toggled on and off by using <Control + A>. The menu gives 
access to a number of standard administrative tasks. 

 

Advanced Administration 

Accessing the Administrator functions 
The Tools menu can be toggled on and off by using <Control + A>. The menu gives 
access to a number of standard administrative tasks. 

 

Customizing Administration Options 
Some of the operations of the Admin module can be customized via the Options option 
on the View pull down menu. 
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.  
This brings up the Options dialogue box.  

 
Show Files Marked for Deletion leaves the Object Names present in the hierarchical 
tree, but puts a cross by them.  

 
Show Store Codes displays the store codes. 
Show Grid puts the files displayed in the List view into a grid. 
Show Large Icons changes the icon size.  
Show Tooltips for Tree View displays the revision code when the mouse pointer is held 
over the revision.  
Show Tooltips for List View displays the full path when the mouse pointer is held over 
a file.  
Show Document Preview put a preview of the document at the bottom of the Store 
Manager Window 
Date Format brings up a drop down list that enables the form the date is displayed in to 
be customized.  
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File Identification Numbers 
Each drawing within Macro Space Management has a File Identification Number. This 
is often useful in identifying information within the database. 
This can be found by opening the Properties dialogue box associated with that drawing. 
The File ID can be seen on the lower right. 

 

Significance of Dates 
There are a series of dates associated with individual files. These can be seen both in the 
Store Manager file display and in the properties tab for each file. 
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Created is the date at which the file was created. 
Accessed is the date at which the file was last viewed (without making any changes to 
the file). 
Modified is the last date at which changes to the file were saved.  
Last Modified by is the user name of the last individual to modify the file. 
Last Published is the last date at which the file was published.  
Archived indicates if the file has been moved to the Archive database.  
Publish is the date the file is set to be published on. (If the file has been published this 
date will be grayed out). 
Effective is the date at which the file will become current at. (If the file is Current or 
Historical this date will be grayed out). 
Died is the date at which the file has lost or will lose current status.  
(This date will be in the future if the file has Current status, and in the past if it has 
Historical Status). 

List Checked Out files 
When a file is being amended or updated, it is not available for other operations within 
Macro Space Management. Such a file is designated as Checked Out. The List Checked 
Out Files functions allow the administrator to identify such files. 

 
Selecting All Checked Out Files lists every file checked out from Store Manager. 
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Selecting My Checked Out Files lists the files checked out by that particular log in 
identity. (This can also be accessed by <Ctrl + O>). 
After the option has been selected, the user has the option to check files back in. 

   

The Directory Structure 
The directory structure for Store Manager is relatively simple.  
All files emanate from the Store Root.  
This Store Root is accessible from the Oracle configuration object. It can be more simply 
accessed by the View > Options button on the toolbar. 
Each level within the hierarchy can store files against itself, (with the exception of File 
type objects). 
The general format of the directory structure is thus Store Root/Cluster/Sub-
cluster/Store/Floor/Revision/File. 
Note that clusters and sub-clusters will not have a Windows folder associated with them. 

 
This can be seen in the above example where the Store Root contains a Cluster called 
Stores. This contains a Sub-cluster called Prototypes.  
The Prototype cluster contains a Store called Large Prototype, which contains a Level 1 
Floor. This Floor has a Revision called Prototype. 

Searching the Store Hierarchy 
The search facility can be activated by clicking the search icon on the toolbar.  

 
This brings up a dialogue box with a dialogue box with a series of options. Select the 
required options and click on OK. 
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The search function in Store Manager performs an in-string search and does not support 
wild-cards. It will thus only return exact matches. 
The search starts from any selected node, and can be set to search up or down from that 
node.    

Purging Files 
Using the Purge File option allows the PERMANENT removal of varying types of files 
from Store Manager. Purged files cannot be recovered, so care should be taken to ensure 
that the files to be purged are no longer required. 

 

Purging Items Marked for Deletion 
This option allows various operations to be carried out on files deleted from the Store 
Manager file structure. The available functions can be accessed by right clicking the 
mouse.  

 
Select All selects all the files chosen for deletion. 
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De-select All un-checks all files marked for deletion.  
Individual files can be selected by left clicking on them with the mouse, while groups of 
files can be selected by left clicking with the mouse in conjunction with the <Shift> or 
<Control> keys. 
Destroy Files removes all files that have been selected for deletion. 
Undelete Files restores deleted files to their original place within the Store Manager file 
structure. 

Purging .BAK files 
When Planner modifies a file it saves the modified file with the file extension .DWG. The 
old file is saved with the file extension .BAK. Because Planner files are large, these .BAK 
files can occupy a considerable amount of server or hard disc space. Purging the files 
frees up this space.  

Purging Log Files 
Store Manager writes a series of log files when any errors occur. These files accumulate 
over time. The "purge log files" allows the option of deleting these files; either between a 
date range, or on the user’s computer. 

 

Importing directories 
The Import Directory option allows files to be imported into the Store Manager file 
structure and corresponding entries to be made in the Store Manager file structure.  
The files to be imported must have a data structure compatible with Store Manager – the 
files should be in the store/floor/revision/file hierarchy.  
A parent cluster should be selected within the Store Manager hierarchy, (or created if 
required). This parent cluster will be the target for the files to be imported.  
The Import Directory option should then be selected from the Administrator menu. This 
will bring up a dialogue box called Directory Structure Import. This has three options 
called Preview, Options and Results. 
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Conformation of the cluster which the data is to be imported into will be found at the top 
of this box. 
Clicking on the browse button will bring up a further dialogue box, allowing selection of 
the required group of files. When the files have been selected, a list will appear in the 
preview pane of the Directory Structure Import box. This list can be seen either in 
summary or detailed form. 

 
The Options tab in the Directory Structure Import box allows unwanted file extensions 
from the files to be imported to be specified. This allows the import of BAK, (back-up 
version of Planner drawing), LOG, (log files), and MDB, (Access database) to be 
prevented. 
After the files have been imported the results can be seen in the Results tab of the 
Directory Structure Import. Any problems will be flagged for attention.  

Store/Cluster view 
Selecting the Store/Cluster view option brings up a window allowing an alternative way 
of viewing the information held within the hierarchical data structure within Store 
Manager. Stores are listed in the sequence determined by their unique identification 
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code. The cluster to which the store has been allocated is displayed immediately below 
the store. 

 

Integrity Check 
The Integrity Check compares the store directory structure shown in the current display 
window with that registered in the database. Any errors found are displayed and should 
be brought to the attention of the Systems Administrator for rectification. 

  
The ID column contains a list of the File ID’s used by Macro Space Management as 
references for the files. If a File ID is missing, this means a problem with the directory 
structure.  
The Type is the type of object. It can be a Store, Floor or Revision. Clusters and sub-
clusters will not appear as they are folders for holding files, not files themselves.  
The Description is the name given to the object.  
The Path is the path in the directory structure to the designated object.    
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Log Files 
Log files are files recording events and problems during operation of Macro Space 
Management. This enables problems to be investigated at a later date.  
They can be found at the location specified in the Configuration Module. 

 

    
Double clicking on a specific file will bring up a log of that aspect of Macro Space 
Management’s operations.
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3 
Object Browser 

Overview of the Object Browser 

About the Object Browser 
The Object Browser is a separate and closable window. It offers Macro Space 
Management users a single point of access to the Zone, Fixture, Product, and Planogram 
libraries and the Key Performance Indicators (KPI’s).    
It is found in both the Planner and Merchandiser environments and is used to control the 
various activities within those environments.  

 

 Planner 
Environment 

Merchandiser 
Environment 

Zones Yes Yes 

Fixturing Yes Yes 

Merchandising Yes Yes 

KPI's No Yes 
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Turning off and accessing the Object Browser 
The Object Browser can be turned off by clicking on the ‘x’ in the upper right corner.  

 
The Object Browser can be opened by selecting the Show Object Browser option on the 
View drop down menu. 
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Overview of the Object Browser 
The Object Browser has a series of parts. These are described below.  

 
 Tabs allow the Object Browser to be switched from one function to another. 
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At present the Object Browser can be used to added, edit, and delete Zones, Fixtures, and 
Merchandise.  
Each tab has the same general components.  
A Toolbar at the top allows various functions to be accessed. These typically allow 
adding, editing, and deleting of the required objects, together with searching, filtering 
and refreshing options.  
The Fixturing and Merchandising Tabs have Switch Buttons.  
In Fixturing the user can click on one or other button to select Fixturing or Gondola 
operations.  
In Merchandising the user can use the buttons to switch between planograms and 
products.  
Each tab has a series of Information Windows. These vary from tab to tab but can 
include: 
� Hierarchical trees: These give information on what objects can be added, edited, 

or deleted in the drawing. In the Zones Tab for example, the hierarchical tree 
allows the user to select different types of zones. 

� The Properties window: This gives details of the selected object. 
� The Summary window: This gives totals of types of objects placed in the 

drawing.  
� The Preview window: This shows a low resolution image of the selected object.  

In the fixturing tab for example, this would be an image of the selected fixture. 
The Information windows can be opened or closed by clicking on the Splitter Bars.     

A Note on the Refresh Option 
All the toolbars in the various Object Browser tabs contain a Refresh option. 

 
If clicked, it will update the hierarchies in that particular tab with the latest information 
from the central Macro Space Management database. 
One the hierarchies have been refreshed, the latest information from the database can be 
incorporated in the drawing.  
For example, once the refresh button has been used in the Fixturing tab, the hierarchies 
will contain the most recent fixture and gondola information for insertion into the 
drawing.  
This allows a user to update these definitions in Fixture Studio then make them 
immediately available within Merchandiser.  

Note: In this instance, if the drawing is already open then 
fixtures already placed in the drawing will not use any 
changes loaded in the refresh operation until the drawing is 
closed and re-opened.  

However, all new fixtures and gondolas added to the open drawing will use the new 
data. 
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Changing the Object Browsers Position 

Opening and Closing the Object Browser 
The Object Browser is open by default the first time a user logs in to Macro Space 
Management. There are two ways to close the Object Browser. 
� Press the button at the top right of the Object Browser 
� Right click the double bar on the Object Browser and click the Close option 

There are two ways to open the Object Browser. 
� Use the View – Show Object Browser menu option 
� Use <Ctrl> +<Shift> +<D> keyboard shortcut  

Moving the Object Browser 

Overview 
 The Object browser behaves slightly differently in the Planner and Merchandiser 
environments. 
 In the Planner environment it can be docked on any side of the screen. It can also be 
floated. In the merchandiser environment it can be docked on any side of the screen, but 
not floated. 

Planner 
By default the Object Browser is docked on the left-hand side of the screen the first time a 
user logs in to The Planner Module. The Object Browser can be moved to dock on any of 
the four sides of the screen. To move the Object Browser, click and hold the double bar 
on the Object Browser and drag to it to a new position. 
The Object Browser can also be un-docked or float on the screen. This can be done in two 
ways. 
�  Right click the double bar on the Object Browser and deselect the Allow Docking 

option 
�  Click and hold the double bar on the Object Browser and drag it to the middle of 

the screen 

 
When the Object browser is floating it can be minimized to save space while still leaving 
it visible on the screen. 
The Object Browser can be re-docked by right clicking the title bar on the left and 
selecting Allow Docking. Then drag the Object Browser to the side of the screen where 
you want to dock it.  
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Merchandiser 
By default the Object Browser is docked on the left-hand side of the screen the first time a 
user logs in to the Planner module. The Object Browser can be moved to dock on any of 
the four sides of the screen. To do this, right click on the double bar at the top and select 
the required location. 

 

Adjusting the Object Browser 
The width of the Object Browser can be adjusted by moving the mouse cursor to the 
right-hand edge and dragging the mouse to the desired width. Also the windows 
displayed on the Object Browser can be minimized by clicking on the title buttons at the 
top of each window. 

Anchoring the Object Browser 

(Planner Module Only) 
The Object Browser can also be anchored on the left or right side of the AutoCAD 
window. By anchoring the Object Browser it remains on screen, but in a minimized state, 
which allows you to bring it back up when needed. This also helps to increase the 
amount of visible drawing area. This can be done from the right click menu. 
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Saving Settings for the Object Browser 
Settings for the Object Browser are saved by Macro Space Management so if closed, it 
will re-open in the same state as it was closed by an individual user.  
Individual settings are saved to the profile currently selected in the Profiles Tab of the 
Configuration Module. 

 
Providing this profile remains selected, the Object Browser will open at the same width 
and height and in the same Tab as when it was closed.  
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The hierarchy displayed will be that showing when the Object Browser was closed and 
the information windows will be the same size and open/closed required. 

Note: If the user has not used that machine or profile before, 
then default settings will be used.  

Similarly, if the user logs onto another machine, then the settings used will be the same 
as when the user last used that machine. 

Zones Tab 

Overview of Zones Tab 
Macro Space Management uses Zones to assign space to different departments and non-
sales areas.  The zone types available to your business are customized within the 
Administration Module.  Zones can also be used to help user’s select fixtures or 
merchandise. 
The Zones tab is divided into four sections: 
� The Toolbar – provides controls to add, modify, and delete zones from a store 

plan. 
� The Zones Window – shows a hierarchy of available zones. 
� The Properties Window – when a Zone is selected from the hierarchy, its 

properties are visible in this window. 
�  The Summary Window – shows details of the zones based on the open store 

plan. 

Note: Zones are ‘read only’ in the Merchandiser 
environment. Accordingly, the majority of the functionality 
that is present when the Object Browser is used in the 
Planner module is absent.  

Zones Tab Toolbar 
Zones are ‘read only’ in the Merchandiser environment. Accordingly, the majority of the 
functionality that is present when the Object Browser is used in the Planner module is 
absent.  

Planner 

 

Icon Action 

 

Add Zone 

 
Add Hole 

 
Delete all Zones of that 
type 
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Icon Action 

 
Delete selected Zone or 
Hole 

 
Highlight Zone in Store 
Plan 

 

Highlight Selected zone in 
Tree 

 
Detect Clashes 

 
Options 

 
Refresh 

 
Hatch 

 
Remove Hatch 

Merchandiser 

 

Icon Action 

 
Options 

 
Refresh 

The Hierarchy, Properties and Summary Windows 

The Hierarchy Window 
The hierarchy window displays the zone hierarchy. This hierarchy is defined in the 
Admin module and shows all the zones that can be added to a store plan. 

 
The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 
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The Properties Window 
The Properties window displays information for the zone that has been selected in the 
zone hierarchy. The content of this window is customizable. 

 

The Summary Window 
The Summary window displays information on the zones placed in the open store plan. 
The content of this window is customizable by an Oracle Retail consultant. If set up to do 
so, this window can also show the zones drawn in the prototype store plan and their 
areas. This allows the user to see what zones should be added to the new store plan and 
the target areas. 

 

Fixturing Tab 

Overview of Fixturing Tab 
The Fixturing tab allows users to add fixtures, fittings, gondolas and other equipment to 
the store plan.  
Fixtures and fittings can also be placed one at a time if required.  Fixtures, fittings, and 
other equipment that are placed one at a time are known as blocks. 
Gondolas are a collection of fixtures and fittings that have been designed to be placed in 
a specific layout. Gondolas can place the correct number of fixtures and fittings for a 
given size by using a simple control.  
 The Fixturing tab is divided in to 5 parts as follows: 
�  The toolbar – provides controls that allow users to add, edit, and delete Fixtures 

and gondolas 
� The Fixtures window – shows a hierarchy of available blocks and gondolas 
� The Properties window – after selecting a block from the hierarchy, this window 

shows the details for the selected block.  The content of this window is 
customizable by an Oracle Retail consultant 

� The Summary window – shows details of equipment placed based on the active 
store plan. The content of this window is customizable by an Oracle Retail 
consultant 

�  The Preview window – shows a sample picture of the block selected in the block 
hierarchy 
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Note: In Merchandiser, fixtures can only be added by 
dragging and dropping from the hierarchy. The Add icon is 
not active. 

Fixturing Tab Toolbar 
The Fixturing Tab Toolbar in the Object Browser enables the user to control all aspects of 
adding, editing and deleting fixtures and gondolas within the Planner and Merchandiser 
environments. 
Clicking on the Switch Buttons will determine whether the Fixturing or Gondola options 
are active. 
Fixturing Toolbar 

 

Icon Action 

 
Add Fixture 

 
Edit Fixture in Fixture 
Studio 

 
Delete Fixture 

 
Highlight Fixture in 
drawing 

 

Highlight selected item in 
tree 

 
Find 

 
Options 

 
Refresh 

 

Show Attributes 

 

Promotional Fixtures 

 

Note: When Fixtures are added, the Add Fixture dialogue 
box (present in the Planner Environment) does not appear in 
Merchandiser. 
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Gondola Toolbar 

 

Icon Action 

 
Add Gondola 

 

Edit Gondola in Fixture Studio 

 Delete gondola option not 
available 

 Highlight Gondola  in drawing 
option not available 

 Highlight selected item in tree 
option not available 

 Find Option not available 

 Options not available 

 
Refresh 

 

Show Attributes 

 

Promotional Fixtures 

Note: The graphics for fixtures are created in the Planner 
environment.  

When editing fixtures, care must be taken that the information held in the central Macro 
Space Management database continues to reflect the actual details of the graphic. If 
information in the central database does not match the graphic, then there could be 
problems with alignment in the VR environment, adjacency calculations, etc.  
In case of doubt contact Oracle’s Technical Support team.  

The Hierarchy, Properties, Summary and Preview Windows 

The Hierarchy Window 
The Hierarchy window displays both the block and the gondola hierarchies.  To toggle 
between the hierarchies use the Blocks or Gondolas buttons respectively. The hierarchies 
are defined in the Fixture Studio environment and show all the fixtures and gondolas 
that can be added to a store plan. 
The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 
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An item in the hierarchy can be highlighted by clicking on the name of the block or 
gondola. 

 

The Properties Window 
The Properties window displays information for the block that has been selected in the 
blocks hierarchy.  The content of this window is customizable. 

 

The Summary Window 
The Summary window displays information on the blocks placed in the open store plan. 
The content of this window is customizable by an Oracle Retail consultant.  

 

The Preview Window 
The Preview window shows a sample picture of the block selected in the block hierarchy. 

 
The preview is not updated when the Gondola hierarchy is displayed. 
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Placing Fixtures and Gondolas 

Placing Fixtures 
To add a block to the store plan, highlight the required block in the hierarchy. You can 
then either press the Add Fixture button on the tool bar, or drag and drop the fixture to 
the store plan drawing. When a block is added the Insert fixture dialog opens. 

 
These controls allow blocks to be positioned accurately in the store plan. Pressing the left 
mouse button places the block in an initial position. Pressing the right mouse button or 
the <Esc> key finishes placing the block. 

Placing Fixtures - Merchandiser Module 
To add a block to the store plan, highlight the required block in the hierarchy then drag 
and drop the fixture to the store plan drawing. 
(The Insert Fixture dialogue box will not appear in Merchandiser). 

Placing Gondolas 
To add a gondola to the store plan, highlight the required gondola in the hierarchy.  
Press the Add Gondola button on the toolbar or drag and drop the gondola to the store 
plan drawing. 
The user is prompted to select a start point for the gondola. Pressing the left mouse 
button opens the Gondola Run dialog box. 

 
The Gondola Run dialog box allows the user to select the dimensions of the blocks to use 
in the gondola.  It also allows the number of bays or length of the gondola to be set.  Once 
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the desired options have been set, pressing the OK button closes the dialog and places all 
the blocks required for the gondola run in to the store plan. 

Merchandising Tab 

Overview of the Merchandising Tab 
The Merchandising tab allows users to add product placeholders (products), and 
planogram placeholders (planograms) to the store plan. A product is any category, sub-
category, or SKU that is included in the product hierarchy, i.e. any level in the hierarchy. 
Planograms are also organized in to a hierarchy of planogram groups. However, you can 
only place planograms in to the store plan. Planogram groups cannot be placed. 
Placeholders are markers that can be placed on to fixtures to indicate the product 
category, sub-category or planogram that will be used. 
The Merchandising tab is divided in to 5 parts. 
� The toolbar – provides controls that allow products and planograms to be added, 

edited, and deleted 
� The Merchandise window – shows a hierarchy of available products and 

planograms 
� The Properties window – shows details for the product that has been selected in 

the product hierarchy. Similarly it will show details of a planogram that has been 
selected in the planogram hierarchy. The content of this window is customizable 
by an Oracle Retail consultant. 

� The Summary window – shows details of products and planograms placed based 
on the active store plan. The content of this window is customizable by an Oracle 
Retail consultant 

� The Preview window – shows a sample picture of product display styles selected 
in the product hierarchy 

Note: Product display styles are only available in 
Merchandiser. In Merchandiser, products and planograms 
can only be added by dragging and dropping from the 
hierarchy. The Add icon is not active 

Merchandising Tab Toolbar 
The Merchandising Tab Toolbar in the Object Browser enables the user to control all 
aspects of adding, editing and deleting products and planograms within the Planner and 
Merchandiser environments. 
Clicking on the Switch Buttons will determine whether the Product or Planogram options 
are active. 

Products Toolbar 
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Icon Action 

 Add Product 

 Edit Definition 

 Delete Product 

 Reverse Product Placement 
Direction 

 Highlight in Store 

 Highlight in Tree 

 Find 

 Options 

 Refresh 

Planogram Toolbar 

 

Icon Action 

 Add Planogram 

 Edit Definition 

 Delete Planogram 

 Reverse Planogram 
Placement Direction 

 Highlight in Store 

 Highlight in Tree 

 Find 

 Properties 

 Refresh 

The Hierarchy, Properties, Summary and Preview Windows 

The Hierarchy Window 
The hierarchy window displays both the product and the planogram hierarchies. To 
toggle between the hierarchies use the Products or Planograms buttons respectively.  
The Product hierarchy is defined in the Product Studio module and shows all the 
products that can be added to a store plan. The Planogram hierarchy can be configured in 
Merchandiser and shows all the planograms that can be added to a store plan. 
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The hierarchy can be expanded using the plus control next to each item on the hierarchy. 
It can also collapsed by using the minus control next to each item. 

 
An item in the hierarchy can be highlighted by clicking on the name of the product or 
planogram. 

The Properties Window 
The Properties window displays information for the merchandise that has been selected 
in the products or planograms hierarchy. The content of this window is customizable by 
an Oracle Retail consultant. 

 
The Summary Window 
The Summary window displays information on the merchandise placed in the open store 
plan. The content of this window is customizable by an Oracle Retail consultant. The 
window can show the merchandise allocated per zone in the prototype store plan. This 
allows the user to see what merchandise should be added to the new store plan. 

 

The Preview Window 
The Preview Window will be blank for both Products and Planograms. 
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KPI Tab 

Overview of KPI Tab 
The KPI’s tab of the Object Browser allows users to see performance of a store plan at a 
glance. The available KPI’s are customizable and more can be added either by an Oracle 
Retail consultant or a trained Macro Space Management super user. 
The KPI tab is divided in to 4 parts. 
� The toolbar – provides controls that allow KPI’s to be run and modified 
� The Indicators window – shows a hierarchy of available KPI’s 
�  The Layers window – shows a list of KPI’s that have been run against the store 

plan 
� The Legend window – shows the color bands associated with a KPI that has been 

run 
When the tab is first opened the Layers and Legend windows are blank. These windows 
are populated when a KPI is run. 

KPI Tab Toolbar 
The KPI Tab Toolbars in the Object Browser are used to Add and Edit KPI’s. They are 
also used to Edit and Delete the list of KPI’s selected for display in the ViewPorts 

Upper Toolbar 

 

Icon Action 

 
Edit Indicator 

 
Edit Themes 

 
Add KPI 

 
Synchronize Views 

 
The Synchronize Views Icon allows the user to choose whether the ViewPorts are 
synchronized or not.  
One application of this is when ViewPorts are synchronized and three different KPI’s are 
opened in different windows. The ViewPorts will then show identical perspectives on the 
Virtual Reality environment with the information from different KPI’s overlaid.  

Lower Toolbar 
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Icon Action 

 
View Data 

 
Edit KPI in list of those 
displaying 

 
Delete KPI from list of 
those displaying 

 
Refresh All 

 
These commands are user to alter the list of those KPI’s current displayed in the 
ViewPorts. 

Running a KPI 
In order to run a KPI the user must highlight the KPI that is to be run from the hierarchy 
of Indicators that are shown on the Object Browser. 
Pressing the Add KPI button opens the Key Performance Indicator dialog for the 
highlighted KPI. 

 
The Details tab shows the name of the selected KPI in the Name field. The user can edit 
this if they wish. This will only change the name that is shown in the Layers section of 
the KPI tab on the Object Browser and not the name of the KPI definition saved in the 
database. 
The Group By field is automatically populated with the KPI Type that was saved in the 
KPI definition.  
Pressing the OK button will close the dialog and apply the KPI to the store plan drawing. 
The Layers frame will show the KPI that has just been run and the legend will be 
updated with the Color Theme for the KPI. 
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Turning Off KPI's 

 
KPI’s can be turned off in the store plan view by un-ticking the tick box next to the KPI 
name in the Layers pane on the Object Browser. 
When no KPI’s are ticked the store plan view returns to the normal view mode. 

Deleting KPI's 
The Delete KPI button removes the highlighted KPI from the list in the Layers pane. If 
this is the KPI being displayed in the store plan view, then the results will be cleared and 
the view returns to normal, i.e. with no KPI applied. 

Note: The Delete KPI only stops the results from being 
displayed.  The KPI definition is still saved in the database. 
 If the KPI needs to be run again, this can be done by 
selecting it within the KPI hierarchy again and clicking the 
Add KPI button. 
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4 
Object Grid 

Overview of Object Grid 

Overview of the Object Grid 
The Object Grid provides an alternative to selecting lower level objects in the Object 
Browser, including the following: 
� Zones 
� Fixtures 
� Products 
� Planograms 

It is an Object Browser window that is used in conjunction with the hierarchies visible in 
the Object Browser and is available in both the Planner and Merchandiser environments.  

 
Information selected from a hierarchy in the Object Browser will appear in the form of a 
list in the Object Grid.  
The higher the level selected in a hierarchy in the Object Browser, the more items that 
will appear in the list on the Object Grid. For example selecting 'Food' in the 
Merchandising tab would result in all food products (or planograms) appearing in the 
Object Grid. Selecting 'Fruit' would restrict the information displayed to just fruit items.  
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Note: The number of items displayed is set to a default 
maximum of 250 items. This is to prevent the Object Grid 
having to filter and sort thousands of items each time these 
operations are carried out.  

This default value can be changed - consult Oracle Technical Support for further 
information.  
The user can then soft and filter the data to find the objects they want.  
Once the required object has been found it can be added to the drawing by dragging the 
item from the grid. In the Planner environment it can also be added by clicking the add 
button. (The Add button is disabled in Planogram Studio). 
When an object is added from the grid that row in the grid will including values and 
colors. 
The object grid contains three tabs: 
� Data which will display the actual object data 
� Sort which will allow the user to sort the data by multiple columns 
� Filter which will allow the user to filter the data by multiple columns 

The type of information that is displayed in the grid (as well as the sort and filter panels) 
is determined by the active panel in the object browser (i.e. zones, fixturing, products or 
planograms).  
The data will be automatically filtered by clicking on a node in the object browser tree; 
for instance, clicking on a product sub-category will then show all SKUs that are related 
that sub-category. This automatic filtering will affect the filters on the filter tab, which the 
user can then modify.  
This automatic filtering may only work for the following levels (dependant on the 
custom SQL): 
� Product Department (BA) 
� Product Category (RA) 
� Product Sub-Category (PA) 
� Planogram Group Parent 
� Fixture Group Parent 
� Zone Group Parent 

It will also be possible to trigger a change in the list of displayed products, if a different 
zone is selected. In this way, the application can restrict which products are placed in 
which zone.  

Showing and Hiding the Object Grid 
The Object Grid Display can be turned On or Off using the Object Grid option on the 
View pull down menu in both the Planner and Merchandiser environments. 
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Display can also be toggled On or Off by use of the F9 key.    

Object Grid Functionality 
The Object Grid provides an alternative to selecting Fixtures and Planograms in the 
Object Browser. 
It is an Object Browser window that is used in conjunction with the hierarchies visible in 
the Object Browser.  
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Information selected from a hierarchy in the Object Browser will appear in the form of a 
list in the Object Grid.  The higher the level selected in a hierarchy in the Object Browser, 
the more items that will appear in the list on the Object Grid.   
For example selecting the 'Food' group in the Merchandising tab would result in all food 
planograms appearing in the Object Grid. Selecting the 'Fruit' group would restrict the 
information displayed to just fruit items appearing in the Object Grid.  

Note: The number of items displayed is set to a default 
maximum of 250 items. 

The user can then sort and filter the data to find the objects they want.  
Once the required object has been found it can be added to the drawing by ‘dragging and 
dropping’ the item (when using the Merchandiser module) from the grid or by clicking 
the add button (when using Planner module).  
When an object is added from the grid that row in the grid will including values and 
colors. 
The object grid contains three tabs: 
� Data Tab which will display the actual object data 
�  Sort Tab which will allow the user to sort the data by multiple columns 
�  Filter Tab which will allow the user to filter the data by multiple columns 

The type of information that is displayed in the grid (as well as the sort and filter panels) 
is determined by the active panel in the object browser (i.e. zones, fixturing, products or 
planograms).  
The data will be automatically filtered by clicking on a node in the object browser tree; 
for instance, clicking on a product sub-category will then show all SKUs that are related 
that sub-category. This automatic filtering will affect the filters on the filter tab, which the 
user can then modify.  
It is also be possible to trigger a change in the list of displayed products, if a different 
zone is selected. In this way, the application can restrict which products are placed in 
which zone. 

Changing the Object Grid's Position 

Opening and Closing the Object Grid 
There are two ways to open the Object Grid. 
� Use the View – Show Object Grid menu option. 
� Use <Ctrl> +<Shift> +<D> keyboard shortcut. 

There are two ways to close the Object Grid. 
� Press the  button at the top right of the Object Grid. 
�  Right click the double bar on the Object Grid and click the Close option. 

Moving the Object Grid 

Overview 
The Object browser behaves slightly differently in the Planner and Merchandiser 
environments. 
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 In the Planner environment it can be docked on any side of the screen. It can also be 
floated. In the Merchandiser environment it can be docked on any side of the screen, but 
not floated. 

Planner 
By default, the Object Grid is docked on the bottom of the screen the first time a user logs 
in to Macro Space Management. The Object Grid can be moved to dock on any of the four 
sides of the screen. To move the Object Grid click and hold the double bar on the Object 
Grid and drag to it to a new position. 
The Object Grid can also be un-docked or float on the screen. This can be done in two 
ways. 
� Right click the double bar on the Object Grid and un-tick the Allow Docking 

option. 
� Click and hold the double bar on the Object Grid and drag it to the middle of the 

screen. 

 
When the Object Grid is floating, it can be minimized to save space while still leaving it 
visible on the screen. 
The Object Grid can be re-docked by right clicking the title bar on the left and selecting 
Allow Docking. Then drag the Object Grid to the side of the screen where you want to 
dock it. 

 
Merchandiser 
By default the Object Browser is docked on the left-hand side of the screen the first time a 
user logs in to the Planner module. The Object Browser can be moved to dock on any of 
the four sides of the screen. To do this, right click on the double bar and select the 
required location. 
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Anchoring the Object Grid 

(Planner Module only) 
The Object Grid can also be anchored on the left or right side of the AutoCAD window. 
By anchoring the Object Grid it remains on screen, but in a minimized state, which 
allows you to bring it back up when needed. This also helps to increase the amount of 
visible drawing area. 

 
To anchor the Object Grid press the minus button on the top left. To restore the Object 
Grid to normal press the Auto-hide button on the title bar of the Object Grid.    

Adjusting the Object Grid 
The width of the Object Grid can be adjusted by moving the mouse cursor to the right-
hand edge and dragging the mouse to the desired width. Also the windows displayed on 
the Object Grid can be minimized by click on the title buttons at the top of each 
window.    

Saving Settings for the Object Grid 
Settings for the Object Grid are saved by Macro Space Management so if closed, it will 
re-open in the same state as it was closed by an individual user.  
Individual settings are saved to the profile currently selected in the Profiles Tab of the 
Configuration Module. 
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Providing this profile remains selected, the Object Grid will open at the same width and 
height and in the same Tab as when it was closed.  
When the Object Grid reopens it will open at the Data tab, no matter which tab was 
selected when the Object Grid was closed. (For example, if closed in the Sort Tab, it will 
reopen in the Data Tab). 
The columns that are respectively visible and hidden within the Object Grid Data panel 
when the module is closed should reopen in the same state when Object Grid is 
reopened. The width of the re-opened columns should be the same as when the Object 
Grid was closed. 

Note: If the user has not used that machine or profile before, 
then default settings will be used.  

Similarly, if the user logs onto another machine, then the settings used will be the same 
as when the user last used that machine. 
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Using the Object Grid 

Using the Object Grid 
The Object Grid has a series of controls at the top. These enable the user to determine 
how it functions.  

 
� The Total Records displayed are located at the bottom of the screen. 
�  The Refresh Button can be toggled on and off. It determines whether data in the 

Object Grid will be updated if a different point is selected in the current 
hierarchy in the object Browser. 

�  The Add Button allows the user to add the currently selected object to the 
drawing.  

�  The Data Tab allows the user to see the list of currently selected data. 
�  The Sort Tab allows the user to set the selected sort sequences into ascending or 

descending. 
�  The Filter Tab allows the user to filter the currently selected data. 
�  The Use Sort checkbox enables the user to toggle sorting On and Off. 
�  The Use Filter checkbox allows the user to toggle filtering On and Off. 
�  The Search Icon allows the user to search for specific text strings.  

Note: If there are more records than the maximum specified 
in the software, a warning message will appear at the 
bottom of the Object Grid as follows. 
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Selecting Data to Load into the Object Grid 
Data is selected from the currently selected hierarchy in the Object Browser.  
For example, if the products hierarchy is selected in the merchandising tab, then the 
selected list of products will be loaded into the object grid. 

 
To select a list of products Ensure the Refresh Button on the Object Grid (1) is selected.  

        

Select an appropriate node from the hierarchy in the Object Browser (2). 
The appropriate list of information will appear in the Object Grid (3).  
If there are more that the permitted number of entries a warning will appear at the base 
of the Object Grid.  

Selecting Objects 

Note: Before populating the Object grid, ensure the Refresh 
button is selected (depressed). 

Fixtures 
To populate the Object Grid with Fixtures, go to the Fixtures Tab on the on the Object 
Browser and highlight a Fixture Group. The Object Grid will populate with all fixtures 
that have been associated with that group. 
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Gondolas 
Gondolas cannot be selected using the Object Grid. 

Products 
As most merchandising will be done using planograms, the Object Grid will populate 
with planograms even if a product is selected (down to sub-class level). 
This works by identifying all planograms that contain that product.  
That list of planograms will then be displayed in the Object Grid. 

Planograms 
To populate the Object Grid with planograms, select a planogram group in the Object 
Browser. All planograms associated with that group will then be displayed in the Object 
Grid.   

Hiding and Changing Order of Columns 
Columns can be hidden by positioning the mouse cursor over the column you wish to 
hide, then right clicking to bring up a pop-up menu. 

 
The same pop-up men can be used to show all columns and to copy data from the cell 
last clicked on by the mouse. 
The column order can be changed by positioning the mouse cursor over the requited 
column heading, holding down the left mouse key and dragging it to its new position. 
Releasing the mouse key will leave it in its new position.      
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Searching for Data 
To search for data, select the Data Tab. 

 
Type a text string into the Find Text Box. The Search String can include wild cards. 
The drop down list in the Find Edit Box will display the last 10 search criteria, allowing 
the user to revert back to previous searches. The user will also be able to use <Ctrl + X>, 
 <Ctrl + C> and <Ctrl + V> to cut, copy and paste date between the Windows clipboard 
and the Find Edit Box. 
Click on the Find Icon - the first matched item will appear highlighted in the list of 
objects. Successive clicks on the Search Icon will bring up further matches. 
When the list of matches has been exhausted (or if there are no matches) then a warning 
dialog will appear. 

    

Sorting Data using Column Headers 
Data can be sorted into ascending or descending order by clicking on the column 
headers. 
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The first click will sort in ascending order. A second click will reverse the sort sequence.  
If data is sorted in this way, the Use Sort check box will be automatically cleared.  
The column alignment depends on the data type. 

Data Type Alignment 

Boolean Center 

Date Center 

Numeric Right 

Text Left 

Sorting Data 
Data can be sorted in the Sort Tab. 
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For Sorting to be enabled, the Use Sort checkbox must be enabled.  (If the user sorts the 
data in the data tab by clicking on a column header, this will automatically clear the Use 
Sort checkbox.)  
Select the required Field from the drop down list.  
The sequence fields can be Ordered in is set by the drop down list. 

  
Settings can be removed by clicking on the Clear button.    

Filtering Data 
Data can be filtered by clicking on the Filter Tab. 

 
For Filtering to be enabled the Use Filter checkbox must be selected. 
The Field to be filtered can be selected from a drop down list. The available fields will 
include those from any columns that have been hidden.  
The Operator to be used for filtering is also selected from a drop down list. Operators 
include =, <>, <, <=, >, >=, IN, NOT IN, LIKE, NOT LIKE. 
A value can be typed into the Value text box. The effect this has will depend on the filter 
operator selected. 
The Combination drop down list can be set to AND or OR. 

 
AND means all the conditions specified have to be satisfied for a filtered object to be 
selected. OR means that if either of the conditions specified met are specified, a filtered 
object will be selected.    
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Working with Columns 
There are two actions that can be carried out with columns in the Object Grid; 
showing/hiding column and changing the column order. 
Columns can be hidden by positioning the mouse cursor over the column you wish to 
hide, then right clicking to bring up a pop-up menu. 

 
The same pop-up men can be used to show all columns and to copy data from the cell 
last clicked on by the mouse. 
The column order can be changed by positioning the mouse cursor over the requited 
column heading, holding down the left mouse key and dragging it to its new position. 
Releasing the mouse key will leave it in its new position.     

Adding an Object to the Drawing 

Planner Environment 
Objects can be added from the Object grid into the drawing in two ways; by 'dragging 
and dropping' or by clicking on the Add button in the Data Tab. 
The Add button will only be enabled if an object is selected by clicking on it.  

 
Only a single object can be added to the drawing at one time. 
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Merchandiser 
Objects can only be added by 'dragging and dropping' as the Add button is disabled in 
this environment. 
Only a single object can be added to the drawing at one time. 

Technicalities 

Colored Rows 
The data is selected from the database by custom SQL.  
If the custom SQL includes a column named RGB, then the row will be colored using the 
value in the column.  
This will allow certain rows to be highlighted, which could be used indicate high 
performing products or planograms, or simply indicate which products have already 
been placed. 
Contact Oracle Technical Support for more information. 

Cut, Edit and Paste 
To cut data, highlight it and use <Ctrl + X>. 
To copy data, highlight it and use <Ctrl + C>. 
To paste previously selected data, position the cursor where you want the text to appear 
and use <Ctrl + V>.      

Examples of Combinations 
The effect of multiple filters depends on whether AND or OR is selected. 
Class = Tinned Goods AND Description = Beans will find all tinned goods with a 
description of 'beans'. 
Class = Tinned Goods OR Description = Beans will find all tinned goods. It will also find 
any item with a description of 'beans'. (This could include dried beans in plastic 
packaging). 
Use of AND will normally give a more specific result than OR.    

Operators 
Operators are used to select or filter data.  
Which operators can be used depend on the type of data to be filtered. 

Comparison Means Boolean Numeric Text Date 

= Equal to x x x x 

<> Not equal 
to 

x x x x 

< Less than  x x x 

<= Less than 
or equal to 

 x x x 

> Greater 
than 

 x x x 
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Comparison Means Boolean Numeric Text Date 

>= Greater 
than or 
equal to 

 x x x 

IN   x x x 

NOT IN   x x x 

LIKE    x  

NOT LIKE    x  

 
In the case where the LIKE operator is used, it will assume wild cards (*Value*) unless 
the user defines them explicitly. 
In the case where the IN operator is used, the user will separate the values using a space 
or the Operating System locale setting for the list separator.  
The Operating System locale setting can be found by going to the Windows control panel 
and selecting the Regional and Language Option.  

 
Clicking on the Customize button in the Regional and Language Options dialogue box 
brings up the Customize Regional Options dialogue box.  
This shows the current setting for the List Separator.    
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Wild cards 
A wild card character can be used to substitute for any other character or characters in a 
search string. 
The asterisk (*) substitutes as a wild card for any number of characters. 
The question mark (?) substitutes as a wild card for any single character. 
The hash mark (#) substitutes for any single number. 

Examples: 
� Beans 50g will find an exact match. 
� Beans* will find Beans 50g, Beans 100g, Beans - Special, Beans - barbecue, etc. 
� Be??? will find Beans and Beers. 
� Beans ##? will find Beans 50g, Beans 75g, etc. 
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5 
Planner Module 

Overview of Planner Module 
The Planner Module is based on AutoCAD. It can be used to plan the layout of 
departments (zones), equipment and merchandise within stores with considerable 
accuracy. It can also be used to generate reports on performance to enable the user to 
continually improve the efficiency and profitability of that store. 

 
It has the following components: 
Menu Bar - allows users to access various AutoCAD and Planner module commands. 
Toolbars - allows users to access various AutoCAD and Planner toolbars. 
Object Browser - allows users to add edit and delete zones, equipment and merchandise. 
Also allows users to see visual performance reports (hot-spotting/Key Performance 
Indicators). 
Object Grid - alternative method for users to place fixtures, products and planograms. 
Command Line - allowing text based input for many AutoCAD and Planner commands 
Status Bar - allows many AutoCAD commands to be toggled on or off. 
Floor Plan - the currently active representation of a floor within a specific store. 
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Planner Menu Overview 

The File Menu 
The File Menu allows users access to a number of general options. 

Note: This section of the help file refers to the File menu 
associated with the 2011 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Open Macro Space 
Management 

Opens Store Manager 

Close Macro Space 
Management 

Closes the current drawing 

Save Macro Space 
Management 

Saves the current drawing 

transmit AutoCAD See AutoCAD Help File for further information. 

Export AutoCAD See AutoCAD Help File for further information. 

Publish AutoCAD See AutoCAD Help File for further information. 

Plot AutoCAD See AutoCAD Help File for further information. 

Options AutoCAD See AutoCAD Help File for further information. 

Configuration Macro Space 
Management  

Opens the Configuration Module 



Planner Menu Overview 

Planner Module 91 

Functionality Source Comment 

Synchronize  Macro Space 
Management 

Opens the Synchronization Module  

Refresh 
Browser 

Macro Space 
Management 

Refreshed the Object Browser with the latest 
information from the database 

Drawing 
Utilities 

AutoCAD Calls varying AutoCAD utilities - see AutoCAD Help 
File for further information. 

Send AutoCAD See AutoCAD Help File for further information. 

Drawing 
Properties 

AutoCAD See AutoCAD Help File for further information. 

Exit Macro Space 
Management 

Exits the Module 

The Edit Menu 
The Edit Menu mainly gives access to AutoCAD Functionality. 

Note: This section of the help file refers to the Edit menu 
associated with the 2011 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Undo Macro Space 
Management 

Allows the last command(s) to be undone. (The 
exact text will vary depending on what the last 
executed command was).  

Redo Macro Space 
Management 

Allows the last command(s) to be undone. (The 
exact text will vary depending on what the last 
executed command was).  

Cut AutoCAD See AutoCAD Help File for further information. 
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Functionality Source Comment 

Copy AutoCAD See AutoCAD Help File for further information. 

Copy with Base 
Point 

AutoCAD See AutoCAD Help File for further information. 

Copy Link AutoCAD See AutoCAD Help File for further information. 

Paste AutoCAD See AutoCAD Help File for further information. 

Paste as Block AutoCAD See AutoCAD Help File for further information. 

Paste as 
Hyperlink 

AutoCAD See AutoCAD Help File for further information. 

Paste to Original 
Coordinates 

AutoCAD See AutoCAD Help File for further information. 

Paste Special AutoCAD See AutoCAD Help File for further information. 

Clear AutoCAD See AutoCAD Help File for further information. 

Select All AutoCAD See AutoCAD Help File for further information. 

OLE Links AutoCAD See AutoCAD Help File for further information. 

Find AutoCAD See AutoCAD Help File for further information. 

The View Menu 
The View Menu provides the following options: 

Note: This section of the help file refers to the View menu 
associated with the 2011 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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Functionality Source Comment 

Redraw AutoCAD See AutoCAD Help File for further information. 

Regen AutoCAD See AutoCAD Help File for further information. 

Regen All AutoCAD See AutoCAD Help File for further information. 

Display 2D Macro Space 
Management 

Displays the drawing in Macro Space Management 
2D Mode. (The blocks must have been configured 
accordingly). 

Display 3D Macro Space 
Management 

Displays the drawing in Macro Space Management 
3D Mode. (The blocks must have been configured 
accordingly). 

Zoom AutoCAD See AutoCAD Help File for further information. 

Pan AutoCAD See AutoCAD Help File for further information. 

Orbit AutoCAD See AutoCAD Help File for further information. 

Walk and Fly AutoCAD See AutoCAD Help File for further information. 

Aerial view AutoCAD See AutoCAD Help File for further information. 

Rotate View AutoCAD See AutoCAD Help File for further information. 

Viewports AutoCAD See AutoCAD Help File for further information. 

3D views AutoCAD See AutoCAD Help File for further information. 

Visual Styles AutoCAD See AutoCAD Help File for further information. 

Toolbars AutoCAD See AutoCAD Help File for further information. 

Color Products Macro Space 
Management 

Allows products be to colored according to 
their general type. 
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Functionality Source Comment 

Reports Macro Space 
Management 

Allows simple reports to be produced on 
objects within the current drawing.  

Drawing 
Comparison 

Macro Space 
Management 

Allows one drawing to be compared with 
another.  

Show (Hide) 
Object Browser 

Macro Space 
Management 

Will show or hide the Object Browser. 

Show (Hide) 
Object Grid 

Macro Space 
Management 

Will show or hide the Object Grid. 

The Insert Menu 
The Insert Menu provides ways to attach further information to the store plan. 

Note: This section of the help file refers to the Insert menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

– Functionality – Source – Comment 

Block AutoCAD See AutoCAD Help File for 
further information. 

External References AutoCAD See AutoCAD Help File for 
further information. 

DWF Underlay AutoCAD See AutoCAD Help File for 
further information. 

Add Architectural 
Plan 

Macro Space 
Management 

X-Refs an architectural plan to 
the currently active drawing 

Add Title Block AutoCAD See AutoCAD Help File for 
further information. 

Update Title Block AutoCAD See AutoCAD Help File for 
further information. 

Bay Numbering Macro Space 
Management 

Add numbering to the fixtures 
in the store plan 
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The Format Menu 
The Format Menu provides allows the user to control the layers, dimensions and units 
associated with the drawing. 

Note: This section of the help file refers to the Format menu 
associated with the 2011 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

Layer Aliases Macro Space 
Management 
& AutoCAD 

Calls a mixture of Macro Space Management and 
AutoCAD functionality. 

Layer AutoCAD See AutoCAD Help File for further information. 

Layer States 
Manager 

AutoCAD See AutoCAD Help File for further information. 

Layer Tools AutoCAD See AutoCAD Help File for further information. 

Dimension 
Style 

AutoCAD See AutoCAD Help File for further information. 

Units AutoCAD See AutoCAD Help File for further information. 

Drawing Set 
Up 

Macro Space 
Management 

Allow the user to select the scales for Paper space. 

The Modify Menu 
The Modify Menu provides functionality for modifying objects in the store plan. 

Note: This section of the help file refers to the Modify menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 
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Functionality Source Comment 

Properties AutoCAD See AutoCAD Help File for further information. 

Match 
Properties 

AutoCAD See AutoCAD Help File for further information. 

Change to 
ByLayer 

AutoCAD See AutoCAD Help File for further information. 

Object AutoCAD See AutoCAD Help File for further information. 

Clip AutoCAD See AutoCAD Help File for further information. 

Erase AutoCAD See AutoCAD Help File for further information. 

Copy AutoCAD See AutoCAD Help File for further information. 

Array AutoCAD See AutoCAD Help File for further information. 

Move AutoCAD See AutoCAD Help File for further information. 

Rotate AutoCAD See AutoCAD Help File for further information. 

Blocks Macro Space 
Management & 
AutoCAD 

Calls a mixture of Macro Space Management and 
AutoCAD functionality. 

Attributes Macro Space 
Management 

Allow the user to select the scales for Paper space. 

Text Macro Space 
Management & 
AutoCAD 

Calls a mixture of Macro Space Management 
and AutoCAD functionality. 

The Calculations Menu 
The Calculations Menu enables users to initiate varying calculations that write data into 
the central Macro Space Planning database. 
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None of the functionality accessed from this menu is AutoCAD functionality.    

The Express Menu 
The Express Menu provides quick access to commonly used AutoCAD functionality. 

Note: This section of the help file refers to the Express menu 
associated with the 2008 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

    

The Window Menu 
The Window Menu allows users to arrange multiple drawings, if open, and to select an 
active drawing from a set of open drawings.  

Note: This section of the help file refers to the Window 
menu associated with the 2011 version of AutoCAD. Users 
using earlier versions of AutoCAD may find a slightly 
different menu. 
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All functionality in this menu is AutoCAD functionality. 

The Help Menu 
The Help Menu contains a number of options that access Help and Assistance. 

Note: This section of the help file refers to the Help menu 
associated with the 2011 version of AutoCAD. Users using 
earlier versions of AutoCAD may find a slightly different 
menu. 

 

Functionality Source Comment 

AutoCAD Help AutoCAD See AutoCAD Help File for further 
information. 

New Features 
Workshop 

AutoCAD Not yet available 

Planner Help Macro Space 
Management 

Calls Macro Space Management's 
Help File for this module. 

Additional 
Resources 

AutoCAD See AutoCAD Help File for further 
information. 

Customer 
Involvement 
Program 

AutoCAD See AutoCAD Help File for further 
information. 

About  AutoCAD Gives the AutoCAD version. 

About Planner Macro Space 
Management 

Gives the Planner version 
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Floor Plan Tools - Find and Open 

Overview of Find and Open 
Find and Open provides and alternative to opening floor plans via Store Manager. It will 
return a list of all floor plans that a user has permissions for and allow them to select 
which to open. 

 
The basic method of operation is as follows: 

 
1. Admin Module 
Within the Admin Module: 

a. The Stores users have permissions to open floor plans from are assigned in the 
Data Security dialog box - Stores Tab. 

b. The file statuses users have permissions to open floor plans from are assigned in 
the Data Security dialog box - Statuses Tab. 
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c. The fields that display in the Filtering Tab of the Print floor Plans dialog box are 
configured in the Custom SQL dialog box.  

These settings determine what will appear in the Find and Open Floor Plans dialog box 
when it is accessed in the Planner module. 

Note: In order to access the Admin Module, users must have 
permission to do so. 

2. Planner Module 
The Print Floor Plans dialog box may be accessed from the File Menu > Find and Open 
option. Users with permissions to access the Planner module automatically have 
permission to use the functionality. 
Using Find and Floor Plan 
The functionality is used as follows: 

a. The Find and Open Plans dialog box is selected from the file menu. 
b. The appropriate floor plans are selected in the Filtering tab of the Print Floor 

Plans dialog box. 
c. Settings determining the visual appearance of the printed drawing are specified 

in the Rendering tab.  
d. On clicking the Open button, the selected floor plans will be opened. At the same 

time as they are opened, the required changes to the visual appearance (specified 
in the Rendering tab) will be made. 

e. After the selected floor plans have been opened, the Find and Open Plans dialog 
box will remain open until the Cancel button has been clicked. 

Accessing the Find and Open Functionality 
The Find and Open functionality is accessed from the File Menu > Plot > Search and 
Print option. Users with permissions to access the Planner module will automatically 
have permission to use the functionality.  
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Selecting Find and Open will bring up the Find and Open Floor Plans dialog box. This 
will open at the filtering tab and will display all floor plans that the user has been 
assigned access rights to in the Data Security option in the Admin Module.  

 

Note: the fields that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Admin module.   

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to open. It will populate with 
all floor plans that the user has permission to access. 



Floor Plan Tools - Find and Open 

102 Store Planning User Guide 

 
Find 

The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
a. Select All will select (but not check) all rows of data 
b. Clear All will deselect (but not uncheck) all rows of data 
c. Check Selected will check all rows of selected data 
d. Uncheck Selected will uncheck all rows of selected data 
e. Check All will check all rows of data 
f. Uncheck All will uncheck all rows of data 
g. Paste allows users to paste a carriage returned list of floor plan identifiers from 

the Windows clipboard. all rows in the dialog box that match the pasted 
information will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box.   

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  
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Boolean logic also includes the use of And or Or. 
1. And means that both conditions must be met. A and B means the data returned must 

contain both A and B. 
2. Or means either condition can be met. A or B means the data returned can contain 

either A or B. It does not need to contain both.   

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the checkbox is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 
These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
1. 2D Wire Frame 
2. 3D Wire Frame 
3. Hidden Detail 
4. Shaded 
5. Shaded with Edges 
6. Conceptual 
7. Realistic 

 
The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 
1. Add Titleblock 
If the Add Titleblock option is selected, users may select a title block from a drop down 
list. The list of available title blocks is configured using the Title Block option on the 
Planning menu in the Admin module. 

 
2. Use Existing Layout 
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If the Use Existing Layout option is selected, users can enter a name matching the name 
of a paper space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down list is not 
case sensitive and the following wild cards may be used:  

Wild 
Card  

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

 
The names of the paper space tabs can be seen at the foot of the floor plan in the Planner 
module. In the example below they are named Overall store, food and drink, Electrical 
and Clothing. 

 
 

Floor Plan Tools - Floor Plan Printing 

Overview of Floor Plan Printing 
Floor Plan Printing allows the user to list all floor pans that they have access rights to. 
They then have the ability to select plans to be printed and, before they are printed, 
specify how the appearance and data associated with the floor plans can be updated. 
after printing, all changes will be undone so that the floor plan is in the condition it was 
in before printing. 

Note: Users wishing to Publish the floor plan (output it in 
electronic or hard copy form with permanent changes) 
should use the Immediate Floor Plan Publishing option from 
the File menu. 
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The basic method of operation is as follows: 

 
1. Admin Module 
Within the Admin Module: 

a. The Stores users have permissions to print floor plans from are assigned in the 
Stores tab of the Data Security dialog box. 

b. The file statuses users have permissions to print floor plans from are assigned in 
the Statuses tab of the Data Security dialog box. 

Note: the floor plans that a user can see are dependent on 
the combination of store and file status permissions. 
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c. The fields that display in the Filtering Tab of the Print floor Plans dialog box are 
configured in the Custom SQL dialog box.  

These settings determine what will appear in the Print floor Plans dialog box when it is 
accessed in the Planner and Merchandiser modules. 

Note: In order to access the Admin Module, users must have 
permission to do so. 

2. Planner Module 
The Print Floor Plans dialog box may be accessed from the File Menu > Plot option. Users 
with permissions to access the Planner module automatically have permission to use the 
functionality. 

Using Floor Plan Printing 
The functionality is used as follows: 
1. The Print Floor Plans dialog box is selected from the file menu. 
2. The appropriate floor plans are selected in the Filtering tab of the Print Floor Plans 

dialog box. 
3. Settings determining the visual appearance of the printed drawing are specified in 

the Rendering tab.  
4. Settings determining how data associated with the floor plan is updated are specified 

in the Pre-Processing tab. 
5. The sequence the selected floor plans are to be printed in is specified in the Collation 

Tab. 
6. On clicking the Print button, the first floor plan will be opened (if not already open) 

in the sequence specified in the Collation Tab. 
7. Changes will be made to the floor plan as specified in the Rendering and Pre-

processing tabs. 
8. The floor plan will be printed on the default printer associated with the user's 

computer. 
9. The changes made for printing purposes will be undone and the floor plan checked 

back in.    

Accessing the Print Floor Plan Functionality 
The Print Floor Plan functionality is accessed from the File Menu > Plot > Search and 
Print option. Users with permissions to access the Planner module will automatically 
have permission to use the functionality.  
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Selecting Search and Print will bring up the Print Floor Plans dialog box. This will open 
at the filtering tab and will display all floor plans that the user has been assigned access 
rights to in the Data Security option in the Admin Module. All currently open floor plans 
will be checked. 
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Note: the columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Admin module.   

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to print. It will populate with 
all floor plans which have Publish Dates on or before the current date. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
1. Select All will select (but not check) all rows of data 
2. Clear All will deselect (but not uncheck) all rows of data 
3. Check Selected will check all rows of selected data 
4. Uncheck Selected will uncheck all rows of selected data 
5. Check All will check all rows of data 
6. Uncheck All will uncheck all rows of data 
7. Paste allows users to paste a carriage returned list of floor plan identifiers from the 

Windows clipboard. All rows in the dialog box that match the pasted information 
will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box.   

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  
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Boolean logic also includes the use of And or Or. 
1. And means that both conditions must be met. A and B means the data returned must 

contain both A and B. 
2. Or means either condition can be met. A or B means the data returned can contain 

either A or B. It does not need to contain both.   

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the checkbox is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 
These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 
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Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
1. 2D Wire Frame 
2. 3D Wire Frame 
3. Hidden Detail 
4. Shaded 
5. Shaded with Edges 
6. Conceptual 
7. Realistic 

 
The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 
1. Add Titleblock 
If the Add Titleblock option is selected, users may select a title block from a drop down 
list. The list of available title blocks is configured using the Title Block option on the 
Planning menu in the Admin module. 

 
2. Use Existing Layout 



Floor Plan Tools - Floor Plan Printing 

Planner Module 117 

If the Use Existing Layout option is selected, users can enter a name matching the name 
of a paper space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down list is not 
case sensitive and the following wild cards may be used:  

Wild 
Card  

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

 
The names of the paper space tabs can be seen at the foot of the floor plan in the Planner 
module. In the example below they are named Overall store, food and drink, Electrical 
and Clothing. 

Set Viewing Direction 
The viewing direction can be set if a Layout tab has been selected in the set Layout 
section. Users can then select the View direction from the drop down list. The options 
are: 

a. Plan 
b. NE Isometric 
c. SW Isometric 
d. SE Isometric 
e. NW Isometric 
f. N Elevation 
g. E Elevation 
h. S Elevation 
i. W Elevation 

These correspond to the options in the 3D view option from the View menu, or in the 
View toolbar. 
If the user elects to Use Custom View, the user will be able to type in the name of a 
custom view. This custom view name may use standard wildcards to allow for 
inconsistencies in the actual name. It will not be case sensitive.  
The example below shows a floor plan in SW Isometric view. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the floor plans will be printed in. 
This makes it easier to sort and distribute them after printing. 
At least one collation option must be selected, or the tab will show as having an error.  
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The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
1. Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
2. District is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 
3. Store Number is the Store Code in the Store dialog box in Store Manager. 
4. Store Name is the Store Name in the Store dialog box in Store Manager. 

 
5. Department is the department the planogram is associated with. This option requires 

a link between the Zone Definitions and the Product hierarchy. This is done by 
associating a PRD_ID (Product ID from the AVTTB_PRODUCT_DEF table) with a 
Zone Definition in the AVTTB_ZONE_DEFINITION table.  
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6. Aisle is the aisle the planogram is associated with. For this option to operate, aisles 

must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 

 
7. Bay Number is the bay number associated with the fixtures the planogram is placed 

on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 

 
8. Bay Group is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 
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9. Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 
10. Planogram Code is the code for the planogram. This is set in the Client Code field of 

the Planogram Design dialog box in Merchandiser. 
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The Pre-Processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 

 

Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 
� Changes have been made in the floor plan using AutoCAD tools and these 

changes have not been written to the database. 
� Changes have been manually made to floor plans in the Merchandiser module, 

or in In-Store Space Collaboration. 
� Changes have been made to floor plans in the database by batch processes. 
� Changes have been made to the floor plan outside Macro Space Planning - for 

example in raw AutoCAD. 
The following options are available: 
1. None - no synchronization operations will be carried out. 
2. Auto-Synchronize - the application will automatically detect which form of 

synchronization is required: 
a. If the information in the database exceeds the date the floor plan was last 

modified and saved in Planner (or modified in raw AutoCAD), the information 
will be synchronized "match the database". 
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b. If the date of the information in the floor plan (or the date it was modified in raw 
AutoCAD) exceeds the date the information was written to the database, the 
information will be synchronized "match the drawing". 

c. If (i) the date the floor plan was last modified in raw AutoCAD exceeds the date 
the floor plan was last modified in Planner and (ii) the date the floor plan was 
last modified in Planner is less than the date the floor plan was last modified in 
Merchandiser, In-Store Space Collaboration or by a batch process, 
synchronization will be by 'cross-matching'. 
i. Information in the floor plan for zones, fixtures and other blocks and aisles 

will be written to the database. 
ii. Information in the database for shelves and merchandise will be written into 

the floor plan.  
3. Synchronize to Match Database - information in the database will be written into 

the floor plan. 
4. Synchronize to Match Drawing - information from the floor plan will be written to 

the database. 
5. Cross Match - information on zones, fixtures and other blocks and aisles will be 

written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 
1. Include Fixtures - fixtures and fittings will be synchronized. 
2. Include Shelves - shelf objects will be synchronized. 
3. Include Products - products and planograms will be synchronized 
4. Include Other Blocks -  
5. Include Zones - Zones will be synchronized. 
6. Include Views - view positions in Planner or Merchandiser will be synchronized. 

(This will not affect In-Store Space Collaboration). 
7. Include Aisles - Aisles will be synchronized. 
The following points should be noted: 
� If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 

option is selected, the modified shelf positions will be written back to the 
database. This could potentially affect any planograms using those shelves. 

� Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

� Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 
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1. Redefine Blocks from Disc - this results in the DWG files in the drawing being 
updated with the latest versions of those DWG files defined in Fixture Studio. 

2. Explode Composite Blocks - this will explode all blocks defined as composites in 
Fixture Studio. These blocks will be placed on Layer 0 and will require having Color, 
Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

3. Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture Studio.  

4. Reset Color, Line type and Line-Weight to BYLAYER - this option will look at the 
color, line type and line weight of each instance of a block in the drawing. It they 
differ from the defaults for that layer, they will be set back to those defaults. 

5. Reset Layer - if blocks have been moved to a layer different to that specified in the 
Insertion Tab of the Block Details dialog box in Fixture Studio, the block will be 
restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the Admin 
Module. 
1. Annotate Fixtures - all fixtures that have had the 'Include in Fixture Annotation' 

checkbox ticked in the Category Tab of the Block Details dialog box in Fixture Studio 
will have their annotation updated. 

2. Annotate Products - all products, planograms and planogram profiles will have their 
annotation updated. 

3. Annotate Zones - all zones will have their annotation updated. 
4. Update Title Block - all text boxes in the title block that reference information in the 

database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 
1. Calculate Areas - this updates the area calculations; and hence the floor area 

assigned to each fixture. 
2. Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence the 

relationship of one fixture to another. 
3. Calculate Product Adjacencies - this updates the product adjacencies; and hence the 

relationship of one product to another. 
4. Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 

products share an aisle. 
5. Calculate Space Measures - this updates space measures: the volume occupied by 

each product in a planogram. 
6. Calculate Face Planes - this updates face planes: the frontal area occupied by each 

product in a planogram. 
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Errors and Results 
If any settings in the Print Floor Plans dialog box will lead to errors during printing, an 
error symbol will be displayed on the tab containing the data with the problem. The Print 
button will also be grayed out and unavailable. 

 
Users must correct the problems before the Print button will activate.  
The results from Floor Plan printing are stored in two tables within the database. These 
results can be viewed via reports generated from BI Publisher (or similar software).    

Changes to Floor Plan During and After Printing 
Options in the Print Floor Plans dialog box allow the use to specify the changes required 
to the floor plan before it is printed.  
The Rendering Tab allows the user to specify the visual appearance of the floor plan. 
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This may result in changes to the layers within the floor plan, the visual appearance of 
the blocks within the floor plan, the tab and title block used for printing and the direction 
the floor plan is viewed from.  
The Pre-processing tab allows users to specify a number of options affecting the data in 
the floor plan (DWG file) and in the database. this includes synchronization options, 
changes to blocks (Restructure Drawing option) and annotation and the calculations used 
for reporting purposes. 
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This may result in the floor plan being synchronized relative to the database, changes 
made to the block and annotation within the floor plan ad changes made to the data used 
for reporting purposes within the database. 

Making and Undoing Changes 
The specified changes will be made to the selected floor plans before it they are printed. 
This allows users to review a hard copy version of the floor plan in a specified condition. 
After printing, the changes will be reversed and the floor plan returned to the state it was 
before printing. The status of the floor plan will also be left unchanged. 

 Floor Plan Tools - Floor Plan Processing 

Overview of Floor Plan Processing 
Floor Plan Processing is used to prepare floor plans for further use after manual or other 
batch operations have been carried out. The options available are: 
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The basic method of operation is as follows: 
1. Admin Module 

a. Permissions to use the floor plan pre-processing functionality are assigned in the 
Functional security dialog box in the Admin module. 

b. The stores that users have permissions to process floor plans for are set in the 
Stores tab of the Data Security dialog box in the Admin Module. 

c. The file statuses that users have permission to process are set in the Files tab of 
the Data Security dialog box in the Admin module. 

Note: the floor plans that a user has permission to process 
are dependent on the combination of store and file status 
permissions. 

d. The fields that users can see in the Floor Plan Processing dialog box are specified 
in the Custom SQL dialog box in the Admin Module. 

2. Batch Processes 
Floor Plan Pre-Processing can be run as a batch process. In order to do this, a user must 
first have been assigned permission in the Functional Security dialog box in the Admin 
Module. The Batch Process will then execute using command line switches to define 
parameters. 
3. Planner Module 
In order to use Immediate Floor Plan Pre-Processing a user must first have been assigned 
permission in the Functional Security dialog box in the Admin Module. When the Floor 
Plan Processing dialog box first opens, the user must manually chose the required 
settings. 
The options available in Floor Plan Processing are: 

Synchronization 
Synchronization is used to ensure that the floor plan (DWG file) used in the Planner 
module and the information held in the database is identical. Differences could build up 
between the two. Differences can occur if for instance, changes are made to the floor plan 
outside the Macro Space Planning, or changes are made to the database by processes 
such as planogram substitution. Using synchronize resolves these differences. 
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Rendering 
Rendering is used to ensure the visual appearance of the published or printed drawing 
conforms to a specified format. This includes configuring the layers used in the floor 
plan, the visual appearance of the blocks used, refreshing the data displayed in the title 
block and selecting the layout tab in AutoCAD paper space.  

Restructuring Drawing 
The restructure options are used to ensure that the blocks in the floor plan conform to the 
latest versions defined in the Fixture Studio module. For example, the functionality can 
be used to ensure that the version of the DWG file used to represent the block is the latest 
version, that its color, line type and line weight are set to the correct values for the layer 
is designated to be on and that its elevation in the drawing (z coordinate) is identical to 
the value specified in Fixture Studio. 

Annotation 
The annotation option is used to refresh zone, fixture and product annotation. They are 
also used to ensure the information displayed in the Title Block is up to date. For 
example, if the Planogram Substitution functionality has been used to change some of the 
planograms in the floor plan, it would be necessary to re-annotate the floor plan to reflect 
the changed merchandise. 

Calculations 
The calculation option is used to ensure that information used for reporting purposes is 
up to date. For example, if the Planogram Substitution functionality has been used to 
change some of the planograms in the floor plan, Product Adjacency, Aisle Adjacency, 
Face Plane and Space Measurement calculations would probably have to be re-run to 
ensure the information generated for any reports associated with that floor plan was up 
to date.  
Examples of the use of Floor Plan Automated Processing are given below:   
1. Ensure Floor Plan data is up to date before generating reports 
If manual changes have been made in floor plans, it is by no means guaranteed that the 
person editing the floor plan has remembered to update the calculations before saving 
and closing the drawing. Running the calculations via Floor Plan Automated Processing 
is a prudent step to ensure reporting accuracy. 
2. Planogram substitutions have been run as a batch process 

The need then is to prepare the floor plans for when they are next manually opened, or 
for when they are published. The processing tasks would include: 

a. Synchronize (batch the database) to bring the substituted planograms into the 
Planner floor plans (DWG files). 

b. Annotation to update the annotation associated with the changed planograms. 
c. Calculations (Product Adjacency, Aisle Adjacency, Face Plane and Space 

Measurement) to ensure than any subsequent reports are accurate. 
3. Floor Plans are to be published and reports are to be generated 

If floor plans are to be published and reports are to be generated, business work flows 
may make it sensible to run Floor Plan Automated Processing as a predecessor to 
generating the reports and floor plans. In this case Floor Plan Publishing would be 
configured without any options selected on the pre-processing tab. 
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Permissions to Run Process Floor Plans 
Before a user can run the Process Floor Plans functionality, they must first have been 
assigned the appropriate permissions in the Admin module. This is done using the 
Functional Security dialog box accessed from the Security menu. 

Note: For users to access the Admin Module, they must first 
have the appropriate permissions. 

 
Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Automated Processing functionality. 

Note: Floor Plan Automated Processing (the right to run 
calculations on floor plans) is a separate user group to Floor 
Plan Publishing. Floor Plan Publishing users can run 
calculations on floor plans as part of the publishing process. 
To run Floor Plan Automated Publishing 'stand alone' as a 
preparatory action for outputting reports, etc, requires the 
user to have separate permission for that functionality. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box.  
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This will bring up the Permissions dialog box. 

 
4. If the User Group belongs to a Command Group higher in the Command Group 

hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

5. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
of Deny permissions.     

Accessing the Process Floor Plan Functionality 
The Process Floor Plan functionality is accessed from the File Menu > Drawing Utilities > 
Automated Processing option. 
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Selecting Automated Processing will bring up the Process Floor Plans dialog box. This 
will open at the filtering tab and will display all floor plans that are at or have exceeded 
their Publish Date. 
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Note: the columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Admin module.   

The Filtering Tab 
The Filtering tab enables the user to select the Floor Plans to Process. It will populate 
with all floor plans which have Publish Dates on or before the current date. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 
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If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'New' will be treated as '*New*' and will find New York, New Delhi, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
a. Select All will select (but not check) all rows of data 
b. Clear All will deselect (but not uncheck) all rows of data 
c. Check Selected will check all rows of selected data 
d. Uncheck Selected will uncheck all rows of selected data 
e. Check All will check all rows of data 
f. Uncheck All will uncheck all rows of data 
g. Paste allows users to paste a carriage returned list of floor plan identifiers from 

the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for processing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  
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Boolean logic also includes the use of And or Or. 
1. And means that both conditions must be met. A and B means the data returned must 

contain both A and B. 
2. Or means either condition can be met. A or B means the data returned can contain 

either A or B. It does not need to contain both.   

Results of Floor Plan Processing 
The results from Floor Plan Processing are stored in two tables within the database. 
These results can be viewed via reports generated from BI Publisher (or similar 
software).    

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan is up to 
date. 

 

Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 
� Changes have been made in the floor plan using AutoCAD tools and these 

changes have not been written to the database. 
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� Changes have been manually made to floor plans in the Merchandiser module, 
or in In-Store Space Collaboration. 

� Changes have been made to floor plans in the database by batch processes. 
� Changes have been made to the floor plan outside Macro Space Planning - for 

example in raw AutoCAD. 
The following options are available: 
1. None - no synchronization operations will be carried out. 
2. Auto-Synchronize - the application will automatically detect which form of 

synchronization is required: 
a. If the information in the database exceeds the date the floor plan was last 

modified and saved in Planner (or modified in raw AutoCAD), the information 
will be synchronized "match the database". 

b. If the date of the information in the floor plan (or the date it was modified in raw 
AutoCAD) exceeds the date the information was written to the database, the 
information will be synchronized "match the drawing". 

c. If (i) the date the floor plan was last modified in raw AutoCAD exceeds the date 
the floor plan was last modified in Planner and (ii) the date the floor plan was 
last modified in Planner is less than the date the floor plan was last modified in 
Merchandiser, In-Store Space Collaboration or by a batch process, 
synchronization will be by 'cross-matching'. 
i. Information in the floor plan for zones, fixtures and other blocks and aisles 

will be written to the database. 
ii. Information in the database for shelves and merchandise will be written into 

the floor plan.  
3. Synchronize to Match Database - information in the database will be written into 

the floor plan. 
4. Synchronize to Match Drawing - information from the floor plan will be written to 

the database. 
5. Cross Match - information on zones, fixtures and other blocks and aisles will be 

written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 
1. Include Fixtures - fixtures and fittings will be synchronized. 
2. Include Shelves - shelf objects will be synchronized. 
3. Include Products - products and planograms will be synchronized 
4. Include Other Blocks - this synchronizes all blocks assigned as type 'other' in Fixture 

Studio. 
5. Include Zones - Zones will be synchronized. 
6. Include Views - view positions in Planner or Merchandiser will be synchronized. 

(This will not affect In-Store Space Collaboration). 
7. Include Aisles - Aisles will be synchronized. 
The following points should be noted: 
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� If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 
option is selected, the modified shelf positions will be written back to the 
database. This could potentially affect any planograms using those shelves. 

� Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

� Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 
1. Redefine Blocks from Disc - this results in the DWG files in the drawing being 

updated with the latest versions of those DWG files defined in Fixture Studio. 
2. Explode Composite Blocks - this will explode all blocks defined as composites in 

Fixture Studio. These blocks will be placed on Layer 0 and will require having Color, 
Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

3. Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture Studio.  

4. Reset Color, Line type and Line-Weight to BYLAYER - this option will look at the 
color, line type and line weight of each instance of a block in the drawing. If they 
differ from the defaults for that layer, they will be set back to those defaults. 

5. Reset Layer - if blocks have been moved to a layer different to that specified in the 
Insertion Tab of the Block Details dialog box in Fixture Studio, the block will be 
restored to the default layer. 

Annotation 
The annotation option allows users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the Admin 
Module. 
1. Annotate Fixtures - all fixtures that have the 'Include in Fixture Annotation' 

checkbox ticked in the Category Tab of the Block Details dialog box in Fixture Studio 
will have their annotation updated. 

2. Annotate Products - all products, planograms and planogram profiles will have their 
annotation updated. 

3. Annotate Zones - all zones will have their annotation updated. 
4. Update Title Block - all text boxes in the title block that reference information in the 

database will have that information updated. 

Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 



Floor Plan Tools - Floor Plan Processing 

140 Store Planning User Guide 

1. Calculate Areas - this updates the area calculations; and hence the floor area 
assigned to each fixture. 

2. Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence the 
relationship of one fixture to another. 

3. Calculate Product Adjacencies - this updates the product adjacencies; and hence the 
relationship of one product to another. 

4. Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 
products share an aisle. 

5. Calculate Space Measures - this updates space measures: the volume occupied by 
each product in a planogram. 

6. Calculate Face Planes - this updates face planes: the frontal area occupied by each 
product in a planogram. 

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the checkbox is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 
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These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu. 

 

Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
1. 2D Wire Frame 
2. 3D Wire Frame 
3. Hidden Detail 
4. Shaded 
5. Shaded with Edges 
6. Conceptual 
7. Realistic 

 
The images above show the different visual appearances available. They can be set by 
means of the Visual Styles toolbar or Visual Styles Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 
1. Add Titleblock 
If the Add Titleblock option is selected, users may select a title block from a drop down 
list. The list of available title blocks is configured using the Title Block option on the 
Planning menu in the Admin module. 
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2. Use Existing Layout 
If the Use Existing Layout option is selected, users can enter a name matching the name 
of a paper space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down list is not 
case sensitive and the following wild cards may be used:  

Wild 
Card  

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

 
The names of the paper space tabs can be seen at the foot of the floor plan in the Planner 
module. In the example below they are named Overall store, food and drink, Electrical 
and Clothing. 

 

 Floor Plan Tools - Floor Plan Publishing 

Overview of Floor Plan Publishing 

Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators.  

The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing this floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 
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Note: publishing floor plans should not be confused with 
reporting on that floor plan. Reporting is used for the 
collation of information required for ordering the equipment 
and merchandise required to implement the floor plan. 
Reports will be used in conjunction with the purchasing 
system and supply chain planning in order to ensure the 
required equipment and merchandise arrive at the required 
locations in a timely manner. 

The Floor Plan Publishing functionality is used to disseminate floor plans to specified 
printers or Windows folders to facilitate implementing those floor plans.  

Note: a retail organization will still need a method of 
distributing the floor plans from the printer or Windows 
folder to the end user. 

The basic method of operation is as follows: 
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1. Admin Module 
The Admin module is used to configure access to the different parts of the functionality. 
It is also used to assign permissions to print or publish specific floor plans and 
planograms. Finally, it is used to configure how the batch processes for publishing floor 
plans will work. There are three options that affect publishing and printing of floor plans. 

a. The Functional Security option (Security menu) allows Administrators to control 
who can run Floor Plan as a batch process. It also controls who can access 
Immediate Floor Plan Publishing in the Planner Module.  

b. The Data Security option (Security menu) allows Administrators to control what 
stores and file statuses a user can use to print or publish from within the Planner 
module - this in turn control what floor plans they see.  

c. The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Floor Plan Publish dialog box in the Planner 
module. 

d. Configuring Outputs for Batch Process: the outputs for the batch process are 
configured in the administration module using the Floor Plan Publishing 
Configuration dialog box. 

2. Running as a Batch Processes 
Floor Plan Publishing can be run as a batch process - this is typically run overnight so 
that these processor hungry tasks can be executed without affecting the manual users of 
the system. The settings determining how Floor Plan Publishing operates when called by 
the batch process are set in the Floor Plan Publishing Configuration dialog box. 
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Floor Plan Pre-Processing (running a series of calculations to make sure that information 
used for reporting, etc., is accurate) can either be done as a separate preceding batch 
process, or it can be done according to settings in the Pre-Processing Tab of the Floor 
Plan Publishing Configuration dialog box. 
The rights for both Floor Plan Pre-Processing and Floor Plan Publishing are set in 
Functional Security in the Admin Module.  
3. Planner Module 
Within the Planner module, the Immediate Publishing of Floor Plans functionality can 
only be accessed by users that have been granted permissions in the Admin module. 
4. Other Functionality 
There are three other items of functionality that affect floor plan publishing. 

a. Configuration Module - the Directories tab allows users to specify where the 
root folder holding published floor plans is located. Sub-folders holding specific 
published floor plans will be created as children of this root folder. 

b. Tables in the Macro Space Planning database hold the results of floor plan pre-
processing and floor plan publishing operations. 

c. BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the tables in the database - for example the names and 
results of floor plans that have been processed.   

Permissions to Run Immediate Floor Plan Publishing 
Before a user can run Immediate Floor Plan Publishing, they must first have been 
assigned the appropriate permissions in the Admin module. This is done using the 
Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 

 
Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
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Equipment Planning Manager and Merchandise Planning Manager User Groups have 
been assigned permission to use the Floor Plan Publishing functionality. 

Note: Floor Plan Automated Publishing (the right to run 
calculations on floor plans) is a separate user group. Users 
with permissions for Floor Plan Publishing can set 
calculation options in the Pre-processing tab of the Floor 
Plan Publishing Configuration dialog box. These will 
execute during the publishing of floor plans. They will not 
execute unless the user is a member of a User Group with 
permissions for the Floor Plan Automated Publishing User 
Group. 

The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box.  

 
This will bring up the Permissions dialog box. 

 
1. If the User Group belongs to a Command Group higher in the Command Group 

hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 
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2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
or Deny permissions.   

Dates Floor Plans will be Published 
The purpose of publishing a floor plan is to disseminate information on the type, 
quantity and layout of equipment and merchandise to those tasked with implementing 
the change. Publishing a floor plan can be done in hard copy or electronic format. The 
date at which this is executed depends on the Publish Date set in the File Properties 
dialog box in Store Manager. 

Note: the Publish Date operates on the date only and takes 
no account of the time of day. Publish Dates are stored in 
Date/Time format in the database, but the functionality only 
references the Date. 

 
Another factor affecting the date at which at which floor plans will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Floor Plan Publishing 
Configuration dialog box in the Admin Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 pm (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 
For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a floor plan that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if it were running at 01.00 hrs 
in the morning of 3rd June. All floor plans with a Publish Date of 3rd June would then be 
published. 
Criteria for Publishing Floor Plans 
There are two criteria for publishing floor plans: 
1. Floor Plan Publish Date is equal to or earlier than the current date 
If the Publish Date set in the File Properties dialog box in Store Manager is equal to or 
earlier than the current date (taking into account the Lead Time Tolerance (Hours) 
setting), the floor plan will be published. 
2. Floor Plan has been Updated since it was Published 
In some implementations of Macro Space Planning it is possible that the floor plan may 
have been modified after it was last published. The condition for this is that the 
Modified by Planner date is greater than the Last Published Date. 
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Locations Floor Plans will be Published To 
The locations Floor Plans will published to and the file names used are specified in the 
Output tab of the Floor Plan Publishing Configuration dialog box in the Admin module. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 

 
This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when floor plans are published. 
The starting point for the location floor plans will published to in electronic form can be 
seen in the details for the Floor Plan Publish system directory specified in the Directories 
Tab of the Configuration module.  
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The Filtering Tab 
The Filtering Tab is used to select the floor to publish. 
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Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 

 



Floor Plan Tools - Floor Plan Publishing 

152 Store Planning User Guide 

If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
a. Select All will select (but not check) all rows of data 
b. Clear All will deselect (but not uncheck) all rows of data 
c. Check Selected will check all rows of selected data 
d. Uncheck Selected will uncheck all rows of selected data 
e. Check All will check all rows of data 
f. Uncheck All will uncheck all rows of data 
g. Paste allows users to paste a carriage returned list of floor plan identifiers from 

the Windows clipboard. all rows in the dialog box that match the pasted 
information will be checked. 

Selecting Floor Plans to Process 
Floor plans may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  
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Boolean logic also includes the use of And or Or. 
1. And means that both conditions must be met. A and B means the data returned must 

contain both A and B. 
2. Or means either condition can be met. A or B means the data returned can contain 

either A or B. It does not need to contain both.  

The Rendering Tab 
The Rendering Tab is used to ensure the visual appearance of the floor plan is as 
desired. 

 

Set Layer Theme 
If the checkbox is selected, users can select a layer theme from the drop down list. A 
number of layer themes can exist - each holding a specific set of settings for the 
individual layers. Selecting a specific layer theme, will automatically configure the 
individual layers to the settings designated for that layer theme. 
These layer themes are configured in the Layer Themes dialog box accessed from the 
Layer Aliased dialog box on the Format menu in the Planner module. 
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Change Visual Appearance 
If the checkbox is ticked, this allows users to change the visual appearance of the 
drawing. The options are: 
1. 2D Wire Frame 
2. 3D Wire Frame 
3. Hidden Detail 
4. Shaded 
5. Shaded with Edges 
6. Conceptual 
7. Realistic 

 
The images above show the different visual appearances available. Within the Planner 
module, they option can be set in either the Visual Styles toolbar or Visual Styles 
Manager. 

Set Layout 
If the checkbox is ticked the users can select one of two options: Add Titleblock or Use 
Existing Layout. 
1. Add Titleblock 
If the Add Titleblock option is selected, users may select a title block from a drop down 
list. The list of available title blocks is configured using the Title Block option on the 
Planning menu in the Admin module. 
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2. Use Existing Layout 
If the Use Existing Layout option is selected, users can enter a name matching the name 
of a paper space tab. This may be typed in. Alternatively it may be selected from the drop 
down list, which will contain the last ten names. Information in the drop down list is not 
case sensitive and the following wild cards may be used:  

Wild 
Card  

Comment 

* Any number of 
characters 

? Any single 
character 

# Any single 
number 

 
The names of the paper space tabs can be seen at the foot of the floor plan in the Planner 
module. In the example below they are named Overall store, food and drink, Electrical 
and Clothing. 

 

The Collation Tab 
The Collation Tab allows users to specify the sequence floor plans will be published or 
printed in. Its main use is in printing hard copy versions of the floor plans where the 
sequence they are printed in makes it easier to sort and distribute them after printing. 
At least one collation option must be selected, or the tab will show as having an error.  
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The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
1. Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
2. District is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 
3. Store Number is the Store Code in the Store dialog box in Store Manager. 
4. Store Name is the Store Name in the Store dialog box in Store Manager. 
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5. Floor Type is the type selected from the drop down list in the Floor dialog box in 

Store Manager. 
6. Floor Description is the Description in the Floor dialog box in Store Manager. 

 
7. Revision Number is the Revision Number in the Revision dialog box in Store 

Manager. 
8. Revision Name is the Revision Description in the Revision dialog box in Store 

Manager. 
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9. Publish Date is the Publish Date set in the File Properties dialog box in Store 

Manager. 
10. Effective Date is the Effective Date set in the File Properties dialog box in Store 

Manager. 

   

The Pre-processing Tab 
The Pre-processing tab is used to ensure that the information in the floor plan has been 
correctly updated. 
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Synchronize 
Synchronize is used to make sure that the information in the floor plan matches that held 
in the Macro Space Planning database. This information could differ for a number of 
reasons: 
� Changes have been made in the floor plan using AutoCAD tools and these 

changes have not been written to the database. 
� Changes have been manually made to floor plans in the Merchandiser module, 

or in In-Store Space Collaboration. 
� Changes have been made to floor plans in the database by batch processes. 
� Changes have been made to the floor plan outside Macro Space Planning - for 

example in raw AutoCAD. 
The following options are available: 
1. None - no synchronization operations will be carried out. 
2. Auto-Synchronize - the application will automatically detect which form of 

synchronization is required: 
a. If the information in the database exceeds the date the floor plan was last 

modified and saved in Planner (or modified in raw AutoCAD), the information 
will be synchronized "match the database". 

b. If the date of the information in the floor plan (or the date it was modified in raw 
AutoCAD) exceeds the date the information was written to the database, the 
information will be synchronized "match the drawing". 
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c. If (i) the date the floor plan was last modified in raw AutoCAD exceeds the date 
the floor plan was last modified in Planner and (ii) the date the floor plan was 
last modified in Planner is less than the date the floor plan was last modified in 
Merchandiser, In-Store Space Collaboration or by a batch process, 
synchronization will be by 'cross-matching'. 
i. Information in the floor plan for zones, fixtures and other blocks and aisles 

will be written to the database. 
ii. Information in the database for shelves and merchandise will be written into 

the floor plan.  
3. Synchronize to Match Database - information in the database will be written into 

the floor plan. 
4. Synchronize to Match Drawing - information from the floor plan will be written to 

the database. 
5. Cross Match - information on zones, fixtures and other blocks and aisles will be 

written to the database, while information on shelves and merchandise will be 
written into the floor plan. 

Date information can be seen in the File Properties dialog box in Store Manager. 

 

Items to Synchronize 
Once the synchronization method has been selected, specific items can be selected for the 
synchronization operation to work on. 
1. Include Fixtures - fixtures and fittings will be synchronized. 
2. Include Shelves - shelf objects will be synchronized. 
3. Include Products - products and planograms will be synchronized 
4. Include Other Blocks - this synchronizes all blocks assigned as type 'other' in Fixture 

Studio. 
5. Include Zones - Zones will be synchronized. 
6. Include Views - view positions in Planner or Merchandiser will be synchronized. 

(This will not affect In-Store Space Collaboration). 
7. Include Aisles - Aisles will be synchronized. 
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The following points should be noted: 
� If shelf positions are changed in Planner and the 'Synchronize to Match Drawing' 

option is selected, the modified shelf positions will be written back to the 
database. This could potentially affect any instances of placed planograms using 
those shelves. 

� Zones can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current zone information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

� Aisles can only be added, edited or deleted in Planner. If 'Synchronize to Match 
Database' is selected, the current aisle information in the Planner floor plan will 
be changed to match that held in the database. This might be done to reverse 
changes made and saved in the Planner module. 

Restructure Drawing 
Restructure Drawing allows users to update the drawing so that the blocks in the 
drawing match the latest information defined in Fixture Studio. 
1. Redefine Blocks from Disc - this results in the DWG files in the drawing being 

updated with the latest versions of those DWG files defined in Fixture Studio. 
2. Explode Composite Blocks - this will explode all blocks defined as composites in 

Fixture Studio. These blocks will be placed on Layer 0 and will require having Color, 
Line type and Line-Weight to set to BYLAYER. 

Note: Composite Blocks that are not flagged as composite in 
Fixture Studio will not be exploded. 

3. Reset Levels - this will reset the elevation of the block to that defined by the level 
assigned to it in the Insertion Tab of the Block Details dialog box in Fixture Studio.  

4. Reset Color, Line type and Line-Weight to BYLAYER - this option will look at the 
color, line type and line weight of each instance of a block in the drawing. If they 
differ from the defaults for that layer, they will be set back to those defaults. 

5. Reset Layer - if blocks have been moved to a layer different to that specified in the 
Insertion Tab of the Block Details dialog box in Fixture Studio, the block will be 
restored to the default layer. 

Annotation 
The annotation options allow users to update the annotation in the floor plan so it 
matches the latest annotation rules specified in the Text Styles option in the Admin 
Module. 
1. Annotate Fixtures - all fixtures that have the 'Include in Fixture Annotation' 

checkbox ticked in the Category Tab of the Block Details dialog box in Fixture Studio 
will have their annotation updated. 

2. Annotate Products - all products, planograms and planogram profiles will have their 
annotation updated. 

3. Annotate Zones - all zones will have their annotation updated. 
4. Update Title Block - all text boxes in the title block that reference information in the 

database will have that information updated. 
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Calculations 
This option is used to update the calculations associated with the floor plan. This has a 
number of benefits including ensuring that reports based on this floor plan are accurate 
and up to date. It also ensures that annotation draws correctly. 
1. Calculate Areas - this updates the area calculations; and hence the floor area 

assigned to each fixture. 
2. Calculate Fixture Adjacencies - this updates the fixture adjacencies; and hence the 

relationship of one fixture to another. 
3. Calculate Product Adjacencies - this updates the product adjacencies; and hence the 

relationship of one product to another. 
4. Calculate Aisle Adjacencies - this updates the aisle adjacencies; and hence which 

products share an aisle. 
5. Calculate Space Measures - this updates space measures: the volume occupied by 

each product in a planogram. 
6. Calculate Face Planes - this updates face planes: the frontal area occupied by each 

product in a planogram.   

The Validation Tab 
The Validation Tab enables users to set a series of validation checks that must be 
satisfied before the floor plan is published. If any of the checks fail, the floor plan will be 
not be published and details written to the AVTTB_PROCESS_FILE_LOG table. 
Information in this table can be read by means of a BI Publisher report or similar. 
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The tolerance values will use the system units, i.e. inches for imperial systems, and 
millimeters for metric systems. The values on the left are the lower tolerance; the values 
on the right are the upper tolerance. 
1. Check for equipment that is obsolete or not yet available - if selected, this 

validation option will compare the effective and expiry dates of the equipment 
against the effective date of the planogram.  

The Effective and Expiry Dates of the equipment are set in the Category tab of the Block 
Details dialog box in Fixture Studio. 

 
The Effective Date of the Planogram is set in the Details tab of the Planogram design 
dialog box in the Merchandiser module. 
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This validation check will error if the Planogram Effective Date is before the Equipment 
Effective Date or after the Equipment Expiry Date. 
The relevant part of the check will be ignored if the equipment effective or expiry date is 
undefined. 
2. Check for empty fixtures - if selected, this validation option will search for fixtures 

which do not contain any products. 
3. Check for expired planograms - if selected, this validation option will compare the 

effective and expiry dates of the planogram against the effective date of the floor-
plan. It will check: 
a. The Effective Date of the Planogram is less than or equal to the Floor Plan 

Effective Date 
b. The Floor Plan Effective Date is less than the Planogram Expiry Date 

The Floor Plan Effective Date is set in the File Properties dialog box in Store Manager. 
(Store Manager can be accessed from the Planner or Merchandiser modules). 
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Note: Active Dates can also be set in the File Properties 
dialog box in Store Manager. 

The relevant part of the check will be ignored if the planogram effective or expiry date is 
undefined. 
4. Check for store-specific planograms - if selected, this validation option will check 

the placed planograms are either store specific and associated with this store, or are 
generic planograms that are associated with all stores. 

Whether planogram are store specific or not is specified in the Stores tab of the 
Planogram Design dialog box in the Merchandiser module. 
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5. Check that planograms are placed on correct length fixtures - if checked, this option 

will check that the length of the planogram falls within the total of the fixture lengths 
that the planogram is placed on. This check will take into account the length 
tolerances. 

6. Check that planograms are placed on correct depth fixtures - if checked, this option 
will check that the depth of the planogram matches the fixture depths that the 
planogram is placed on. This check will take into account the depth tolerances. 

7. Check that planograms are placed on correct height fixtures - if checked, this option 
will check that the height of the planogram matches the fixture heights that the 
planogram is placed on. This check will take into account the heights tolerances. 

8. Check that planograms are placed on correct fixture styles - if checked, this option 
will check that the fixture style assigned to the planogram matches the fixture styles 
assigned to the fixtures it has been placed on.    

Errors and Results 
If any settings in the Publish Floor Plans dialog box will lead to errors during publishing, 
an error symbol will be displayed on the tab containing the data with the problem. The 
OK button will also be grayed out and unavailable. 
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Users must correct the problems before the Print button will activate.  
The results from Floor Plan Publishing are stored in two tables within the database. 
These results can be viewed via reports generated from BI Publisher (or similar 
software).    

Floor Plan Publishing and Status Change 
When floor plans are reviewed and accepted for subsequently being put into service, the 
status is set to Authorized and the Publish Date and Effective Dates set in the File 
Properties dialog box in Store Manager. 



Floor Plan Tools - Floor Plan Publishing 

Planner Module 169 

 
When Floor Plan Publishing is run, the status of the Floor Plan will be changed to 
Published. (Depending on settings in the Status dialog box, it may also be changed to 
Read Only). 

 
This change of status allows the progress of the floor plan through its business life cycle 
to be monitored. 
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Floor Plan Tools - Planogram Publishing 

Overview of Planogram Publishing 

Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators.  

Note: the default settings for the Planogram Publishing 
dialog box are derived from settings in the Planogram 
Publishing Configuration dialog box in the Admin module. 

The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

 
The Planogram Publishing functionality is used to disseminate planogram designs to 
specified printers or Windows folders to facilitate implementing those planogram 
designs.  
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Note: a retail organization will still need a method of 
distributing the planogram designs from the printer or 
Windows folder to the end user. 

The basic method of operation is as follows: 

 
1. Admin Module 
The Admin module is used to configure access to the different parts of the functionality. 
It is also used to assign permissions to print or publish specific floor plans and 
planograms. Finally, it is used to configure how the batch processes for publishing floor 
plans. There are three options that affect publishing and printing of floor plans. 

a. The Functional Security option (Security menu) allows Administrators to control 
who can run Planogram Publishing as a batch process. It also controls who can 
access Immediate Planogram Publishing in the Planner Module. It also allows 
Administrators to control who can access Report Designer to create report 
templates for publishing planogram designs. 
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b. The Data Security option (Security menu) allows Administrators to control what 
planograms a user can print or publish from in the Planner and Merchandiser 
modules (and in In-Store Space Collaboration).  

c. The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Planogram Publish dialog box in the Planner 
module. 

d. Configuring Outputs for Batch Process: the default settings for the batch 
process output of planogram designs are configured in the administration 
module using the Planogram Publishing Configuration dialog box. 

2. Running as a Batch Processes 
Planogram Publishing can be run as a batch process - typically run overnight so that 
processor hungry tasks can be executed without affecting the manual users of the system. 
The settings determining how this operates are set in the Planogram Publishing 
Configuration dialog box. 
The rights for Planogram Publishing are set in Functional Security in the Admin Module.  
3. Planner Module 
Within the Planner module, the Immediate Publishing of Floor Plans functionality can 
only be used by users for whom permissions have been granted in the Admin module. 
4. Merchandiser Module 
Within the Merchandiser module, the Immediate Publishing of Floor Plans 
functionality can only be used by users for whom permissions have been granted in the 
Admin module. 
5. Report Designer 
Report Designer can be used to create report templates that determine the format the 
planogram design is published in. 
6. Other Functionality 
There are three other items of functionality that affect planogram publishing. 

a. Configuration Module - the Directories tab allows users to specify where the 
root folders holding published planograms are located. Sub-folders holding 
specific planograms will be created as children of this root folder. 

b. Tables in the Macro Space Planning database hold the results of planogram 
publishing operations. 

c. BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of 
planograms that have been published.  

Permissions to Run Immediate Planogram Publishing 
Before a user can run Immediate Planogram Publishing, they must first have been 
assigned the appropriate permissions in the Admin module. This is done using the 
Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. 
The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box.  

 
This will bring up the Permissions dialog box. 
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1. If the User Group belongs to a Command Group higher in the Command Group 

hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
of Deny permissions.     

Dates Planograms will be Published 
The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

Note: the Publish Date operates purely on the date only and 
takes no account of the time of day. Publish Dates are stored 
in Date/Time format in the database, but the functionality 
only references the Date. 
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Another factor affecting the date at which at which planograms will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Planogram Publishing 
Configuration dialog box in the Admin Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 pm (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the planogram might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 
For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a planogram that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if it were running at 01.00 hrs 
in the morning of 3rd June. All planograms with a Publish Date of 3rd June would then 
be published. 
Criteria for Publishing Planograms 
There are two criteria for publishing planograms: 
1. Publish Date has been exceeded 
If the Publish Date set in the Planogram Design dialog box in Merchandiser exceeds the 
current date (taking into account the Lead Time Tolerance (Hours) setting), the 
planogram will be published. 
2. Planogram has been Updated since it was Published 
It is possible that the planogram may have been modified after it was last published - for 
example of a later revision has been created. The condition for this is that the Last 
Modified date is greater than the Last Published Date. These can be seen on the 
Properties tab of the Planogram Design dialog box in the Merchandiser module. 
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Note: Planograms may also be republished if the Republish 
planogram if files are missing option has been checked in 
the Planogram Publishing Configuration dialog box.   

Locations Planogram Designs will be Published To 
The locations Planogram designs will published to and the file names used are specified 
in the Output tab of the Planogram Publishing Configuration dialog box in the Admin 
module. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when planogram designs are published. 
The starting point for the location planograms will published to in electronic form can be 
seen in the details for the Planogram Publish system directory specified in the Directories 
Tab of the Configuration module.  
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The Filtering Tab 
The Filtering Tab is used to select the planograms to publish. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next planogram matching the text being 
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searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 

 
If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
a. Select All will select (but not check) all rows of data 
b. Clear All will deselect (but not uncheck) all rows of data 
c. Check Selected will check all rows of selected data 
d. Uncheck Selected will uncheck all rows of selected data 
e. Check All will check all rows of data 
f. Uncheck All will uncheck all rows of data 
g. Paste allows users to paste a carriage returned list of planogram identifiers from 

the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 



Floor Plan Tools - Planogram Publishing 

Planner Module 181 

Selecting Planograms to Process 
Planograms may be selected for printing by ticking the appropriate check box.   

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 

 
They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
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3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  
Boolean logic also includes the use of And or Or. 
1. And means that both conditions must be met. A and B means the data returned must 

contain both A and B. 
2. Or means either condition can be met. A or B means the data returned can contain 

either A or B. It does not need to contain both. 

The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 
At least one collation option must be selected, or the tab will show as having an error.  

 
The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
1. Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
2. District is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
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3. Store Number is the Store Code in the Store dialog box in Store Manager. 
4. Store Name is the Store Name in the Store dialog box in Store Manager. 

 
5. Department is the department (zone) in the floor plan the planogram is associated 

with.  
6. Aisle is the aisle the planogram is associated with. For this option to operate, aisles 

must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 
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7. Bay Number is the bay number associated with the fixtures the planogram is placed 
on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 

 
8. Bay Group is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 

 
9. Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 
10. Planogram Code is the code for the planogram. This is set in the Client Code field of 

the Planogram Design dialog box in Merchandiser. 
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The Validation Tab 
The Validation tab enables users to set a series of validation checks that must be satisfied 
before the planogram design is published. If any of the checks fail, the details will be 
written to the AVTTB_PUBLISH_POG_LOG table. Information in this table can be read 
by means of a BI Publisher report or similar. 
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1. Check for empty shelves - this option will check the parent fixture and associated 

shelf objects. It will raise an error report if: 
a. The fixture and associated shelf objects can be populated with product display 

styles, but no product display style has been placed. 
b. The fixture and associated shelf objects can be populated with display styles, but 

no display styles have been placed. 
2. Check for products that have expired or are not yet effective - this option will check 

all products in the planogram against the effective date of the planogram. It will raise 
an error report if: 
a. The Product Effective Date is after the Planogram Effective Date - i.e. the product 

is not yet available to place in the planogram. 
b. The Product Expiry Date is before the Planogram Effective Date - i.e. the product 

will expire while the planogram is still in service. 
The check will be ignored if the product effective or expiry date is undefined. 
The Planogram Effective Date is set in the Details tab of the Planogram Design dialog box 
in Merchandiser. 
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The Product Effective and Expiry dates are set in the Details tab of the SKU dialog box in 
Product Studio. 
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3. Check for equipment that is obsolete or not yet available - this option will check all 

equipment in the planogram against the effective date of the planogram. It will raise 
an error report if: 
a. The Equipment Effective Date is after the Planogram Effective Date - i.e. the 

equipment is not yet available for the planogram. 
b. The Equipment Expiry Date is before the Planogram Effective Date - i.e. the 

equipment will be taken out of service while the planogram is still in use. 
The check will be ignored if the equipment effective or expiry date is undefined. 
The Equipment Effective and Expiry dates are set in the Category tab of the Block Details 
dialog box in Fixture Studio. 
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4. Validation Scope - this controls when to apply the validation checks. There are three 

options - selectable by the radio button. 
a. Apply to all planograms. 
b. Apply to non-imported (manually created) planograms. 
c. Apply to imported planograms. 

The application will automatically distinguish between imported and manually created 
planograms by means of the information held in the Macro Space Planning database. 
This can be used to reduce the time required for validating planograms - for example if 
the planogram designs have already been validated in the third party software used to 
design them, there may be no need to validate them again when this functionality is used 
to publish planograms.   

The Templates Tab 
The Templates Tab is used so specify the type of report that will be used to output 
details of the planogram design. 
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The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 
1. Use Associated Planogram document - this option publishes the planogram design 

information using a pre-generated report using one of the following file formats: 
BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be imported when a 
planogram is imported using Oracle Data Integrator (ODI). The Associated 
Document (if available) is specified in the Associated Document text box in the 
Details tab of the Planogram Design dialog box in the Merchandiser module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

a. Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

b. Use the default Report Designer template. 
2. Use Template - this option allows the user to define the way the template from the 

Report Designer module is selected. There are two options: 
a. Use Planograms preferred template, if defined - this option is specified in the 

Preferred Template drop down list in the Details tab of the Planogram Design 
dialog box in the Merchandiser module. 

b. Use Selected Template from List Below - this option can be set by checking 
items in the list of available templates. One or more templates may be selected. If 
multiple templates are selected, the name of the template will be added to the file 
name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram 
Report).pdf  

If necessary the list of templates can be searched by entering a text string into the 
dropdown list, then clicking the Find button. (Actual or implied wild cards can be used). 
Each click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 

Note: the last 10 text strings can be selected using the drop 
down list in the text box.   
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Errors and Results 
If any settings in the Planogram Publishing dialog box will lead to errors during 
publishing, an error symbol will be displayed on the tab containing the data with the 
problem. The OK button will also be grayed out and unavailable. 

 
Users must correct the problems before the Ok button will activate.  
The results from Planogram Publishing are stored in two tables within the database. 
These results can be viewed via reports generated from BI Publisher (or similar 
software).  

Floor Plan Tools - Planogram Printing 

Overview of Planogram Printing 
Planogram Printing allows users to select planograms in the currently active floor plan 
and print out information on the ones they have permissions to print.  

Note: Users wishing to Publish the planogram design plan 
(output it in electronic or hard copy form with permanent 
changes) should use the Immediate Planogram Publishing 
option from the File menu. 

Note: the default settings for this dialog box are derived 
from settings in the Planogram Publishing Configuration 
dialog box in the Admin module. 
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The basic method of operation is as follows: 

 
1. Admin Module 
Within the Admin Module: 

a. The planogram users have permissions to print are assigned in the Data Security 
dialog box - Planograms Tab. 

b. The fields that display in the Filtering Tab of the Print Planograms dialog box are 
configured in the Custom SQL dialog box. 
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c. Planograms can be printed using report templates specified in the Report 
Designer module. Permission to access this module is specified in the Functional 
Security dialog box. 

These settings determine what will appear in the Print Planograms dialog box (and the 
reports that will be available) when it is accessed in the Planner and Merchandiser 
modules. 

Note: In order to access the Admin Module, users must have 
permission to do so. 

2. Planner Module 
The Print Planograms dialog box may be accessed from the File Menu - a floor plan 
containing planograms must previously have been opened. Users with permissions to 
access the Planner module automatically have permission to use the functionality. 
3. Merchandiser Module 
The Print Planograms dialog box may be accessed from the File > Print Menu - a floor 
plan containing planograms must previously have been opened. Users with permissions 
to access the Merchandiser module automatically have permission to use the 
functionality. 
4. Report Designer 
The Report Designer module is used to design report templates that can be specified for 
use in the Print Planograms dialog box. Permissions to access this module are assigned in 
the Functional Security dialog box in the Admin module. 

Using Planogram Printing 
The functionality is used as follows: 

a. A floor plan containing planograms is opened in the Planner or Merchandiser 
module. 

b. The Print Planogram option is selected from the File menu in the Planner or 
Merchandiser module. 

c. The appropriate planograms are selected in the Filtering tab of the Print 
Planograms dialog box. 

d. The report to use is specified in the Templates tab.  
e. The sequence the selected floor plans are to be printed in is specified in the 

Collation Tab. 
f. On clicking the Print button, the selected planogram reports will be printed on 

the default printer associated with the user's computer. 

Accessing the Print Planogram Functionality 

Note: before accessing the Print Planogram functionality, 
users should open a floor plan containing planograms. 

The Print Planogram functionality is accessed from the File Menu > Plot option. Users 
with permissions to access the Planner module will automatically have permission to use 
the functionality.  
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Opening State of Functionality 
When the Print Planogram dialog box opens it will be populated with all planograms in 
the currently active floor plan. By default, they will be checked for selection. 

 

Note: the columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Admin module.   
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The Filtering Tab 
The Filtering tab enables the user to select the Planograms to print. It will populate with 
all planograms in the currently active floor plan. 

Note: If there are multiple instances of a planogram in a 
floor plan, only a single entry will appear in the list of 
planograms. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 
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Wild 
Card 

Description 

# Any number in this 
position 

 
If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*wine*' and will find I Bay Red Wine, 1 Bay White 
Wine, etc. 

Pick 
Pick takes the user to the currently active floor plan. They can then use AutoCAD 
selection methods to select specific planograms. When the AutoCAD selection is 
completed with a right mouse click, the user will be returned to the Print Planogram 
dialog box and the dialog box will populate with the selected planograms. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
g. Select All will select (but not check) all rows of data 
a. Clear All will deselect (but not uncheck) all rows of data 
b. Check Selected will check all rows of selected data 
c. Uncheck Selected will uncheck all rows of selected data 
d. Check All will check all rows of data 
e. Uncheck All will uncheck all rows of data 
f. Paste allows users to paste a carriage returned list of floor plan identifiers from 

the Windows clipboard. All rows in the dialog box that match the pasted 
information will be checked. 

Selecting Planograms to Print 
Planograms may be selected for printing by ticking the appropriate check box. 
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Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 

 
They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  
Boolean logic also includes the use of And or Or. 
1. And means that both conditions must be met. A and B means the data returned must 

contain both A and B. 
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2. Or means either condition can be met. A or B means the data returned can contain 
either A or B. It does not need to contain both. 

The Templates Tab 
The Templates Tab allows users to specify the template format to be used when printing 
planogram designs. 

 
The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 
1. Use Associated Planogram document - this option publishes the planogram design 

information using a pre-generated report using one of the following file formats: 
BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be imported when a 
planogram is imported using Oracle Data Integrator (ODI). The Associated 
Document (if available) is specified in the Associated Document text box in the 
Details tab of the Planogram Design dialog box in the Merchandiser module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

a. Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

b. Use the default Report Designer template. 
2. Use Template - this option allows the user to define the way the template from the 

Report Designer module is selected. There are two options: 
a. Use Planograms preferred template, if defined - this option is specified in the 

Preferred Template drop down list in the Details tab of the Planogram Design 
dialog box in the Merchandiser module. 

b. Use Selected Template from List Below - this option can be set by checking 
items in the list of available templates. One or more templates may be selected. If 
multiple templates are selected, the name of the template will be added to the file 
name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram 
Report).pdf  

If necessary the list of templates can be searched by entering a text string into the 
dropdown list, then clicking the Find button. (Actual or implied wild cards can be used). 
Each click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 

Note: the last 10 text searches can be selected using the drop 
down list in the text box. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 
At least one collation option must be selected, or the tab will show as having an error.  

 
The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
1. Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
2. District is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 
3. Store Number is the Store Code in the Store dialog box in Store Manager. 
4. Store Name is the Store Name in the Store dialog box in Store Manager. 
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5. Department is the department (zone) in the floor plan the planogram is associated 

with.  
6. Aisle is the aisle the planogram is associated with. For this option to operate, aisles 

must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 

 
7. Bay Number is the bay number associated with the fixtures the planogram is placed 

on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 

 
8. Bay Group is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 
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9. Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 
10. Planogram Code is the code for the planogram. This is set in the Client Code field of 

the Planogram Design dialog box in Merchandiser. 
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Errors and Results 
If any settings in the Print Planograms dialog box will lead to errors during printing, an 
error symbol will be displayed on the tab containing the data with the problem. The Print 
button will also be grayed out and unavailable. 

 
Users must correct the problems before the Print button will activate.  
The results from Floor Plan printing are stored in two tables within the database. These 
results can be viewed via reports generated from BI Publisher (or similar software).  

Synchronization 

Overview of Synchronization 

Storing Data in Planner 
Data is stored in two ways within the Planner environment.  
Data stored in an AutoCAD drawing is retained in the .DWG file that contains all the 
pertinent information. Macro Space Management also stores information in its central 
database.  
Macro Space Management is integrated with AutoCAD. However, some AutoCAD tools 
can modify AutoCAD drawings in ways that are not registered by Macro Space 
Management's central database. For example, if AutoCAD tools are used to move or 
delete fixtures or gondolas from the drawings, this does not alter the information held in 
the Macro Space Management database.  
Potential differences between the AutoCAD drawing and the information held in Macro 
Space Management must be resolved. This is done using the Synchronization option. 
After data has been synchronized, the information held in the AutoCAD drawing is 
identical to that held in the Macro Space Management central database.  
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Storing Data in Merchandiser 
Merchandiser only operates on data held within Macro Space Management's central 
database.  
If a drawing is worked on the Merchandiser environment, any changes will not be 
reflected in the drawing when it is next opened in the Planner environment.  
 Accordingly, when a drawing is opened in the Planner environment after being worked 
on in the Merchandiser environment, it must be 'synchronized to database' in order to 
bring the drawing up to date with the changes made in Merchandiser. 

Adjacency Calculations 
Adjacency calculations are used to establish the relationships of fixtures and merchandise 
to each other. 
Before running adjacency calculations, it is good practice to run Synchronization. This 
ensures that the information in the drawing matches that in the database and hence any 
adjacency calculations will be correct. 

Saving and Synchronization 
Each time a Macro Space Management command is used, the information is written 
directly to the database at the same time as a change is made in the drawing. (These 
commands are also held in temporary memory so that 'undo' commands can be used).  
Each time an AutoCAD command is used; changes are made to the drawing, but are not 
written to the central Macro Space Management database. This can lead to differences 
between drawing and database. 
When working in Planner, it is therefore good practice to synchronize the drawing 
immediately before saving and exiting. 

Relationship between Synchronization and Adjacency 
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Accessing the Synchronization Module 
Accessing the Synchronization Module can be carried out from the File pull down 
menu in Planner. 
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This will bring up the Synchronization dialogue box. 

 
This dialogue box allows the type of synchronization to be selected by means of the 
Action frame in the upper right corner of the dialogue box.  
The types of items to synchronize can be selected by means of the Items to Synchronize 
frame in the center right of the dialogue box. 
The current status of the synchronization can be seen in the main frame of the dialogue 
box. This details the information held in the drawing only and in the database only. It 
also displays totals of identical and different items 
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Selecting Items to be Synchronized 
The items that can be synchronized are detailed in a small check box frame in the Items 
to Synchronize dialogue box. 

 
One or more options can be selected by ticking the appropriate check box. 
Fixtures ensures all fixtures, fittings and gondolas are synchronized.  
Shelves ensure all shelves are synchronized. This may be necessary when planograms 
have been used to populate features with product and the planogram contains 
information on what is on the varying shelves within the fixture. It may also be necessary 
if shelves have been added to fixtures in the Merchandiser environment. 
Products ensure all products placed as products or using planograms are synchronized. 
Other Blocks enables additional drawing features such as blocks representing lights or 
power-points to be synchronized. 
Zones enable Zone locations to be synchronized. 
Views enables views (temporary tables in the database) to be synchronized.  
Aisles enable the physical position of Aisles to be synchronized.      
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Setting Synchronization Options 
The varying options for synchronization are selected using radio buttons.  

 
Only one action may be selected.  

Note: All changes made to drawings using Macro Space 
Management tools are stored in the central database at the 
same time as the action is carried out. All changes made to 
the drawing using AutoCAD tools are only stored in the 
drawing. Synchronization means drawing and database 
contain identical information. 

Match the Drawing updates the central database with all AutoCAD changes to the 
drawing made since the last synchronization. 
No changes will be made to the drawing, and all new information in the drawing will be 
stored in the database.  
Match the Database restores the drawing to the last version held in the central database.  
All AutoCAD changes made to the drawing since the last time the drawing was 
synchronized with the database will be removed. 
Merge updates the database based on data held in both the drawing and the database.  
If objects exist in both the drawing and database, but there are slight differences between 
them (for example in position) which data will be used depends on whether merge 
priority is given to the drawing or to the database. 
Only Keep Identical updates the drawing with only those objects common to both the 
drawing and the database.  
All objects in the drawing that are not identical with objects held in the central database 
will be removed from the drawing. Similarly, all objects in the central database that are 
not identical with objects on the drawing will be removed from the database.    
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 Identifying Items in Specified Categories 
The Synchronization Module dialogue box contains tabulated lists of objects in specified 
categories. For example there are 606 Fixtures that are Identical in both Drawing and 
Database and there are 24 shelves in the Database only. 

 
If the mouse pointer is poised over a category of information with items in it, a black 
question mark will appear.  

 
This indicates left clicking on the category will bring up a dialogue box.  

 
The dialogue box contains a list of all objects.  
Item specifies the type of object. These are normally blocks, but can also be Views or 
other types of Macro Space Management options.  
Name is the user input file name of the block.  
Difference specifies whether the objects are in the drawing only, database only or are 
identical. 
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Handle is the AutoCAD handle. This handle is the unique alphanumeric tag for an object 
in that specific drawing. 
Clicking on OK returns the user to the main Synchronization dialogue box.    

Effect of Synchronization Options 
The effect of using the various synchronization options is demonstrated in the diagram 
below. 
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� In the Merge example, note that merging is with priority to the drawing. Product 
block C is selected in preference to product block D 

� In Keep Only Identical, only Fixtures 2 and 3, together with Product B are 
identical, so only these blocks are retained 
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Zones in Planner – Business Flows 

 
Based on the floor layout specified by an architectural drawing; a Zone defines a section 
of floor that is used for a specific and clearly defined purpose. The Zone might define an 
area used for sales, it might define an area used for storing stock, or it might define areas 
used for non-sales purposes such as offices, corridors or toilets.  
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From a technical standpoint, a Zone is a Macro Space Management Block that allows 
additional information to be put into an AutoCAD architectural drawing. This 
subsequently allows more structured Macro Space Management reports to be produced 
on the associated layout of fixtures, fittings and Planograms within that drawing. 
A Zone is defined by an AutoCAD Polyline enclosing a specific section of floor. Further 
Polylines within the Zone can be used to define pillars or other obstructions.  
The designation of pillars and other obstacles allows them to be taken into account when 
calculating sales areas. This results in a more accurate calculation of the area of usable 
floor, enabling sales performance analysis to take into account the effect of obstructions.  
The Zone is used to assign a specified part of the total floor area to a specific function. 
Such functions include allocating to specific types of retail goods, (for example electrical 
goods), or designating the area as a non-sales area; for example a manager’s office or a 
corridor.  
Zones thus allow the total floor area in the store to be split into sales and non-sales areas 
and then further sub-divided as to purpose.  
This sub-division of the store allows Planograms and fixtures to be filtered by Zone, 
allowing the store planner to rapidly establish which goods and which fixtures are in a 
specific part of the store.  
Zones can also be designated as being excluded from certain types of reports. This allows 
fixtures and Planograms that have been placed in a storage area to be excluded from any 
calculations or reports on the performance of that part of the store.  
Many of the characteristics of Macro Space Management Zones can be configured within 
the Administration Module. 

Zones in Planner - Object Browser 

The Zones Toolbar 
The Zones Toolbar is found on the Object Browser.  

 
It contains a series of icons allowing various operations to be carried out on Zones. 

 

Add Zone Boundary 

 

Add Hole 

 

Delete all of Zone 
Description 

 

Delete Specific Zone 

 
Highlight Zone in 
Drawing 

 

Highlight Zone in 
Tree 
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Find 

 

Detect clashes 

 

Configuration 
Options 

 

Refresh 

 

Add Hatching 

 

Remove Hatching 

 

The Zones Hierarchy Window 
The Zones Hierarchy Window is found immediately below the toolbar.  

 
It contains a Hierarchical Tree giving a list of all the available Zone types.  

Note: Zone types and descriptions can be added, edited or 
deleted using the Administration Module. 

The Properties Window 
The Properties Window gives details of the Zone Definition that has been selected in the 
hierarchy.  
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The Summary Window 
The Summary Window contains details of Zones within the currently active drawing. 

 
The information typically includes Zone Name, Zone Description, and Gross and Net 
Areas. 
(Information displayed can be customized by Oracle – contact Technical Support if 
necessary). 
Zone Names and Zone Descriptions can be sorted by clicking on the column headings. If 
a zone has been selected in the drawing, it will be highlighted in the summary of zone 
properties. 

Zones in Planner - Adding, Editing and Deleting Zones and Holes 

Overview of Adding Zones 
Adding zones is a simple process, initiated from the Object Browser.  

 
After the Zones tab has been selected on the Object Browser, the required Zone 
Description is selected from the Zones Hierarchy Window. The Add Zone option is then 
selected. Finally, the required Zone shape is then drawn and the process completed by 
using the 'close' command.  

Selecting the Zone Description 
The Zone Description is selected from the Zones Hierarchical Tree window. 
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The tree can be expanded or contacted by clicking on the + or – signs. Alternatively right 
clicking with the mouse will bring up a small menu of options.  

 
This can be used to expand or collapse the hierarchical tree.  
The required Zone can then be selected by left clicking on it to highlight it.  
Details of the Zone will appear in the Properties window. 

 
This will enable the Zone Description to be confirmed as correct.       

Initiating Drawing the Zone 
When the Zone Description has been selected, the process of drawing the Zone is 
initiated by selecting the Add Zone Boundary Option. This can be done on one of two 
ways. 
Firstly, the Add Zone Boundary icon can be clicked in the tool bar to initiate drawing the 
Zone.  
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Alternatively, right clicking in the Zone Descriptions window will bring up a small 
menu.  

 
Selecting Add Zone Definition will initiate drawing the zone.    

Drawing the Zone 
After the Add Zone Boundary option has been selected, the user will find the cursor 
active and ready to start specifying the Zone Boundaries. 

 

Note: The way the Zone is drawn will depend on whether 
OSNAP (Object Snap) has been selected or not. If selected, 
Lines can only be drawn to specified points. If OSNAP is off, 
then lines may be drawn to any location on the drawing. 
OSNAP AutoCAD Command  

Note: Entering 'Close' in the command line completes the 
Zone drawing process by turning the currently drawn line 
into a Polyline enclosing the Zone. 

Drawing a Simple Rectangle 
To draw a simple rectangle position the cursor at the required start point and left click to 
fix it. Draw the cursor to the diagonally opposite corner of the required rectangle and left 
click to fix it. Press <Escape>. A rectangle of the required dimension will immediately be 
drawn.  

Drawing Zones with OSNAP On 
When OSNAP is on a series of symbols will appear as the cursor moves about. These 
show the available points that can be selected. Click on successive points to draw the 
outline of the Zone.   

Note: With OSNAP on, the Polylines can only be drawn to a 
limited number of specified points. To draw to a wider 
selection of points, turn OSNAP off. 

Drawing Zones with OSNAP Off 
With OSNAP off, Polylines can be drawn to any point of the drawing. Draw the required 
points, left clicking to fix each in turn. 
Entering 'Close' in the command line completes the Zone drawing process by turning the 
currently drawn line into a Polyline enclosing the Zone. 
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Overview of Editing Zones with AutoCAD Tools 
Zone shapes and dimensions can be changed using AutoCAD tools. A range of these is 
available by clicking on the zone boundary to highlight it, then right clicking. This will 
bring up a menu with a number of edit options.  

 
Zones can have vertexes added and deleted, segments bent and straightened and 
segments added. See the AutoCAD help File for further information. 

Editing Zones with AutoCAD 
Editing a Zone in AutoCAD can be done simply by using the AutoCAD grip points. 
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Click on the required Zone to get the grip points to show. 

 
Click on the required grip point and move it to the desired new location. 

 
Left click to set the new location for the grip point and <Escape> to complete the 
AutoCAD editing process. 

 
The Zone should now be fixed in its new shape.     

Deleting Zones and Holes using Macro Space Management 
There are two options to delete a zone: 
1. Delete all zones of that description 
2. Delete a specific zone or hole  

Delete all Zones of that Description 
To Delete all examples of a specific Zone Description, first select the required zone in the 
hierarchical tree. Click on the Delete Zone icon in the toolbar to delete the Zone.  
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Note: If there are multiple Zones of this type in the drawing, 
all Zones of this type will be deleted.  

Note: If you need to identify the Zone type to be deleted, use 
the highlight Zone in Tree option. Highlight Zone in Tree  

Delete a Specific Zone or Hole 
To delete a specific zone or hole, click on the Delete Boundary/Hole option on the 
toolbar. 
 

 
 
Clicking on a zone or Hole in the drawing will then delete that zone or hole.    

Deleting Zones using AutoCAD 

Note: It is possible to delete Zones using the AutoCAD Erase 
tool. However, it is recommended users delete Zones using 
the Macro Space Management Delete Zone option as this is a 
simpler and more effective way of achieving deletion. 

To erase a Zone using AutoCAD tools select the zone so that the markers show.  

 
Right click to bring up the menu and click on the Erase icon.  

 
This will remove the Zone from the drawing. 
The Zone will not be removed from the Macro Space Management database until the 
Synchronize tool has been used. This can be found on the File pull down menu. 
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Note: If Synchronization is not run after deleting Zones with 
AutoCAD tools, unpredictable effects can occur in the 
drawing. 

Zones in Planner - Cutting or Editing Holes 

Overview of Cutting Holes 
Cutting holes in Zones is a simple process, initiated from the Object Browser.  

 
After the Zones tab has been selected on the Object Browser, the required Zone is 
highlighted in the Zones Hierarchy. 
After clicking the Cut Holes icon, the shape of the hole can be drawn. 
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Entering 'Close' in the command line completes the hole drawing process by turning the 
currently drawn line into a Polyline enclosing the hole.    

Selecting the Zone in which to Cut a Hole 

Note: Holes can only be cut in the Zone currently 
highlighted in the Zone Hierarchy  

If the name of the zone is known, the appropriate Zone Description can be selected from 
the Zones Hierarchical Tree window. 

 
Alternatively, the Highlight zone in Tree command can be used to select the appropriate 
Zone Description in the Zones Hierarchy. 

 

Note: If the Zone Definition is not correctly selected before a 
hole is cut, the error message depicted will result.  

 

Initiating Drawing the Hole 
When the Zone Description has been selected, the process of drawing the Hole is 
initiated by selecting the Add Hole Option. This can be done by clicking on the tool bar 
to initiate drawing the Hole.  
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Defining the Hole 
After the Cut Hole option has been selected, the user will find the cursor active and 
ready to start specifying the Hole Boundaries. 

 

Note: The way the hole is drawn will depend on whether 
OSNAP (Object Snap) has been selected or not. If selected, 
Lines can only be drawn to specified points. If OSNAP is off, 
then lines may be drawn to any location on the drawing. 
OSNAP AutoCAD Command  

 

Note: Entering 'Close' in the command line completes the 
hole drawing process by turning the currently drawn line 
into a Polyline enclosing the hole. 

Drawing a Simple Rectangle 
To draw a simple rectangle position the cursor at the required start point and left click to 
fix it. Draw the cursor to the diagonally opposite corner of the required rectangle and left 
click to fix it. Press <Escape>. A rectangle of the required dimension will immediately be 
drawn.  

Drawing Holes with OSNAP On 
When OSNAP is on a series of symbols will appear as the cursor moves about. These 
show the available points that can be selected. Click on successive points to draw the 
outline of the hole.   

Note: With OSNAP on, the Polylines can only be drawn to a 
limited number of specified points. To draw to a wider 
selection of points, turn OSNAP off. 

Drawing Holes with OSNAP Off 
With OSNAP off, Polylines can be drawn to any point of the drawing. Draw the required 
points, left clicking to fix each in turn. 
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Entering 'Close' in the command line completes the hole drawing process by turning the 
currently drawn line into a Polyline enclosing the hole.    

Overview of Editing Holes 
Hole shapes and dimensions can be changed using AutoCAD tools. A range of these is 
available by selecting the required hole, then right clicking. This will bring up a menu 
with a number of edit options.  

 
 
Holes can have vertexes added and deleted, segments bent and straightened and 
segments added. See the AutoCAD help File for further information.    

Editing Holes 
One way of Editing Holes is by using the AutoCAD grip points. 
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Click on the required Hole to get the grip points to show. 

 
Click on the required grip point and move it to the desired new location. 

 
Left click to set the new location for the grip point and <Escape> to complete the 
AutoCAD editing process. 

 
The Hole should now be fixed in its new shape. 

Zones in Planner - Other Options 

Highlight Zone in Drawing 
The Highlight Zone in Drawing icon allows the location of a zone to be identified in the 
drawing. 

 
This operation can be toggled on and off by clicking on the icon. When toggled on the 
icon will appear slightly depressed.  
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When active, left clicking on any Zone in the hierarchical tree will then cause that zone to 
display in the drawing.  

Note: Only Zones currently in the drawing can be displayed. 
Selecting a zone which has not been placed will have no 
effect. The precise way the zone highlights will be 
determined by the setting in the Zones tab of the 
Configuration module. 

Highlight Zone in Tree 
The Highlight Zone in Tree option allows users to click on a zone boundary in the 
drawing, and have that zone highlighted in the Zone Hierarchy in the Object Browser. 

 

Find In Tree 
Find in Tree allows users to search for Zone Names in the Zone Hierarchy. 

 
Clicking the icon will bring up the Find Zone dialogue box. 
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To use the dialogue box: 
1. Type a text string into the text box 
2. Click on the search Icon 
3. Any zones with a name matching the search string will be listed 
4. To select a zone in the hierarchy, highlight it and click the OK button 

Detect Clashes 
The Detect Clashes option can be invoked from the Zones toolbar.  

 
If this option is selected, then any Zones of the same type with overlapping boundaries 
will be highlighted.  
Zones of the same type that share a common boundary will not be highlighted.  

Note: Zones of different type are drawn on different 
AutoCAD layers. Zones on different layers that overlap will 
not be shown as clashing.    

Configuration Options 
The Zones Tab in the Configuration Module can be called by clicking on the 
Configuration icon on the Zones toolbar  
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This brings up the Zones Tab. 

 
This dialog box contains a series of check boxes controlling the way Zones display. 

Options Frame 
� Auto Close means that if a point in the zone (or hole) being drawn is within the 

specified Proximity of the first point drawn; the zone will automatically close 
(complete drawing). 

� Hatch Zones determines whether the Zones drawn are color coded or not when 
the zone is first drawn. (Hatching can be added later using the hatch commands).  

� Hatch over Text determines whether the hatch pattern leave a gap for the zone 
text or not. 

� Detect Clashes is used to determine whether Zones on the same layer, (i.e. the 
same type), overlap each other.  

� Prompt for Name allows users to locally rename the zone when first drawn. 
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Highlight Options Frame 
 
This determines how the zone highlights in the drawing if the 'highlight in drawing' 
option is selected in the Object Browser. 
� Thicken Boundary results in the thickness of the Polyline used to draw the Zone 

being increased.  
� Flash will cause the Zone boundaries to flash. 
� Zoom means when the Zone is selected, it will zoom, (expand) either to the limits 

of the drawing, or by the scaling factor set in the Max Zoom Scale parameter.     

Refresh 
The Refresh Option causes the hierarchical tree in the Zones window to be updated with 
any Zone Definitions that have been added or edited since the Planner module was 
opened for the current session. (This is useful if work is being carried out in parallel in 
the Administration module  

   

Adding and Removing Hatching 
Hatching can be added to or removed from zones using the appropriate option.  

 
In the example below the top zone is hatched, the bottom one is not. 
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Zones in Planner - Zone Administration 

Options in the Administration Module 
Options in the Administration Module allow several aspects of Zones to be configured.  

Note: The Administration Module is only available to users 
with Administrators Privileges.  

If you do not have these privileges, you will not be able to access the Administration 
Module. 
� Zone Types can be configured using the Zone Types option. 
� Zone Definitions can be configured using the Zone Definition option. 
� Zone Hatch Styles can be configured using the Hatch Styles option. 
� Zone Annotation can be configured in using the Text Styles option. 

The Zone Types Option 
The Zone Types Option in the Administration Module allows Zone Types to be Added, 
Edited, and Deleted.  
Zone Types are broad definitions of zones that allow zones to be grouped into general 
subclasses. 

 
Options can be selected from the Edit menu. 
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Alternatively, they can be selected from the toolbar.  

 
Exit 

 
Add Zone 
Type 

 
Edit Zone 
Type 

 
Delete Zone 
Type 

 
Refresh 
View 

 

The Zone Definition Option 
The Zone Definitions Option in the Administration Module allows Zone Definitions to 
be Added, Edited, and Deleted.  
Zone definitions are specific definitions of zones (that are grouped together as Zone 
types). 
In the example below, there are DIY, Electrical, fashion, Grocery, and Home 
departments. 

 
Options can be selected from the Edit menu. 
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Alternatively, they can be selected from the toolbar.  

 
Exit 

 
Add Zone 
Definition 

 
Edit Zone 
Definition 

 
Delete Zone 
Definition 

 
Refresh View 

 
View Zone Types 

 
View Hatch Types 

  

The Zone Hatch Styles Option 
The Hatch Styles Option in the Administration Module allows Zone Hatch Styles to be 
Added, Edited, and Deleted.  
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Changing Zone Annotation 
The Text Styles Option in the Administration Module allows Zone Annotation to be 
configured to the user’s requirements. 
(Other forms of annotation can also be configured using this option). 

Note: Zone Annotation only applies to the AutoCAD 
environment – it is not visible in the Merchandiser 
environment. 

 
Selecting the Zone option will allow annotation to be configured. 
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About System Variables 
Some of the variables affecting how Macro Space Management operates can be 
customized.  
Within Macro Space Management these can be changed via the Administration Module.  

 

 

Note: Changing System Variables can have a significant 
effect on how Macro Space Management operates. It is 
STRONGLY recommended that any changes are made only 
after consulting the Oracle technical support team. 
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There are currently no System Variables within this table affecting the operation of 
Zones. 

Fixturing in Planner - Overview 

The Planner Module and the Business Life Cycle 
The Planner module is part of the Business Life Cycle. 
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Store Manager Activities start the business cycle 
Here stores, floors and revisions are added, edited or deleted. Revisions contain store 
plans. These are often x-refed to architectural plans so that fixtures and gondolas can be 
placed relative to the walls of the store. 
(Store Manager can be accessed from both Planner and Merchandiser). 
Store Planning involves the placement of zones, fixtures and merchandise 
Zones can only be placed in Planner (although they can be seen in Merchandiser). 
Fixtures and merchandise can be placed in both Planner and Merchandiser. (It is 
normally more convenient to carry out Fixturing Operations in Planner and 
Merchandising operations in Merchandiser). 
Using the Fixtures module, the user can: 
� Place single or multiple fixtures, fittings and gondolas. 
� Move or rotate fixtures, fittings and gondolas. 
� Erase fixtures, fittings and gondolas. 
� Number bays in fixtures and gondolas. 
� Calculate effective sales areas. 
� Collate information on fixtures and fittings.  

After the floor plan has been designed, each fixture can subsequently be populated by a 
predetermined quantity and arrangement of sales products using the Planogram 
Selection and Add Product modules. After the floor has been merchandised, Macro Space 
Management can be used to analyze and report on the effectiveness of the layout. 
Result Management involves checking the completed store layout by means of Reports 
and Key Performance Indicators before releasing the layout to stores for implementation 
or starting on the next phase of planning.  

About Fixture Studio 
Fixture Studio is a stand alone module where Fixtures and Gondolas can be added, 
edited and deleted. These fixtures and gondolas can then be used on the Planner (and 
Merchandiser) environments 

Fixture Studio can be opened (or activated if already open) from the Object Browser in 
the Planner module by clicking on the Edit icon on the Fixturing toolbar. (There is an Edit 
Fixture icon when working with fixtures and an Edit Gondola icon when working with 
gondolas). 

 
Fixture studio allows the properties of fixtures and gondolas to be specified. It also 
allows the hierarchical tree in which they are organized to be modified.  
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About Merchandiser 
The Merchandiser Module is a virtual reality environment that can be used in 
conjunction with the Computer Aided Design (CAD) environment of the Planner 
module.   

 
The merchandiser module has several functions:  
Firstly, it can be used to design planograms.  
Secondly, it can be used to design a floor layout; fixtures, fittings and gondolas being 
placed and viewed in the 3D virtual reality (VR) environment. It is not as precise as the 
Planner environment, but gives a more visual representation of the store plan. 
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Finally, the fixtures and gondolas can be populated with shelves, products and 
planograms, again in the 3D virtual reality (VR) environment. 

Note: Shelves can only be placed in the Merchandiser 
environment, although they can be seen in the Planner 
environment after Synchronization. 

Note: Products can only be placed at display style level in 
Merchandiser. Such products are not visible in Planner. 

About Synchronization and Adjacencies 
When fixtures, fittings and gondolas are placed on the drawing using MSM tools, they 
are also sent as data to the Macro Space Management central database.  
If fixtures in the drawing are modified with AutoCAD tools, this will change the 
drawing, but not the central database. 
The process of making sure the AutoCAD drawing and the Macro Space Management 
Central database hold the same information is known as synchronization. 
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After the drawing has been synchronized with the central database, the Adjacency 
calculations can be run.  
Fixture Adjacency calculations establish the physical relationship of one fixture to 
another.  
These relationships are used for both bay numbering and as the basis for subsequent 
Product Adjacency calculations.  
Product Adjacency calculations establish the relationship of one type of product to 
another. They cannot be run until the Fixture Adjacencies have been calculated. 

About System Variables 
Some of the System Variables affecting how Macro Space Management operates can be 
changed by the user. 
Within Macro Space Management these can be changed via the Admin Module. 

 

Note: Changing these System Variables can have a 
significant effect on how Macro Space Management 
operates. It is STRONGLY recommended that any changes 
are made only after consulting the Oracle technical support 
team. There is currently one System Variable affecting the 
operation of Fixturing. 

 The ADDITIONAL_FIXTURE_HEIGHT System Variable determines the allowance 
made for the height of products above the top shelf.  
For example, if a fixture is 2,000 mm high, and the ADDITIONAL_FIXTURE_HEIGHT 
System Variable is set to 300 mm, then the total possible maximum height of fixture and 
products is 2,300 mm. 

Accessing the configuration options 
The Configuration Options can be accessed by clicking on the Properties icon on the 
Fixturing toolbar.  

 
This will bring up the Fixturing Tab from the Configuration Module. 
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Fixturing in Planner – Object Browser  

Overview of Fixturing on the Object Browser 
Clicking on the Fixturing Tab on the Object Browser brings up a series of options for 
adding, editing and deleting Fixtures and Gondolas.  
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The Toolbar gives access to a series of options concerning fixtures. 
The Buttons allow the user to toggle between Fixtures (Blocks) and Gondolas. 
The Hierarchy Window allows users to select fixtures (or gondolas) from the list 
available. 
The Properties Window shows the properties assigned to the selected fixture. 
The Summary Window shows the number of instances of the selected fixture placed in 
the drawing. 
The Preview Window shows a preview of the selected Fixture.    

The Fixturing Toolbar 
The Fixturing Toolbar is found on the Object Browser. It is selected by clicking on Blocks 
in the Fixturing window. 
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It contains a series of icons allowing various operations to be carried out on Fixtures. 
Some may be grayed out if they are not available for that operation.  

 
Add Fixture 

 
Edit Fixture 

 
Delete Fixture 

 
Highlight selected item 
in view  

 
Highlight selected item 
in tree 

 
Search 

 
Configuration Options 

 
Refresh 

 
Attributes 

 
Promotional Fixtures 
On or Off 

 

The Fixtures Hierarchy Window 
The Fixtures Hierarchies Window shows a hierarchical tree of all the available fixtures 
or gondolas.  

 
The tree can be expanded or contracted by clicking on the + or – icons.  
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The Fixturing window can be minimized by clicking on the splitter bar. 

 
The Blocks or Gondolas buttons immediately above the window determines whether the 
hierarchical tree shows fixtures or gondolas. 
The hierarchical tree can be configured in Fixture Studio using the Add Group, Edit 
Group and Delete Group icons on the toolbar.    

The Properties Window 
The Properties Window will show the properties for the currently selected fixture. 

 
The Properties window can be minimized by clicking on the splitter bar. 

   

The Summary Window 
The Summary Window will show a user defined list of fixtures placed in the drawing. 

 
Clicking on a column heading will re-order that column. Clicking again will reverse the 
sort order.  
The Summary window can be minimized by clicking on the splitter bar. 

 

The Preview Window 
The Preview Window shows a low resolution image of the fixture selected in the 
hierarchical tree.  
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The window can be resized in the horizontal plane by dragging the edge of the Object 
Browser with the mouse. It can be resized in the vertical plane by dragging the bottom of 
the window with the mouse.  
The Preview window can be minimized by clicking on the splitter bar. 

 
The image can be rotated by positioning the mouse pointer in the screen and holding 
down the left mouse key. The position of the mouse cursor will determine the direction 
of rotation, while the distance of the mouse cursor from the object will determine the 
speed of rotation.  
The image can be moved up and down using the central wheel on the mouse.  
The image can be resized by holding down the <Ctrl> key, then left clicking the mouse 
and dragging the object. 

Highlighting Selected item in Tree 
Highlight Selected Item in Tree is invoked by clicking the icon in the Fixturing toolbar.  

 
This button can be toggled On and Off by clicking on it. When toggled on, the button will 
appear depressed.  
When the Highlight Selected Item in Tree option is selected, clicking on any fixture in the 
drawing will result in that fixture type being highlighted in the hierarchical tree.  

Highlighting Selected Item in View 
Highlight Selected Item in View is invoked by clicking the icon in the Fixturing toolbar 
of the Object Browser.  

 
This button can be toggled On and Off by clicking on it. When toggled on, the button will 
appear depressed.  
When the Highlight Selected Item in View option is selected, clicking on any fixture in 
the hierarchical tree of fixtures will result in that type of fixture in the visible portion of 
the drawing being highlighted.  

Using the Find Function 
The Find function is invoked by clicking on the Find icon in the fixturing toolbar.  
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This will bring up the Find Block dialogue box. 

 
This is used by typing the required search string into the Find box and clicking the Find 
icon to the right of it.  

 
This will bring up a list of any blocks matching the search string.  
Left clicking on any result will return the user to the Fixtures Window, where the 
selected block will be highlighted in the hierarchy tree.  

Fixturing Options 
The Fixturing Options can be accessed by clicking on the Properties icon on the Fixturing 
toolbar.  

 
This will bring up the Fixturing Tab from the Configuration Module. 
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(See section on the Configuration Module for more information). 

Fixture Attributes 
Fixture Attributes can be assigned by selecting a fixture or fixtures and clicking on the 
Fixture Attribute icon in the toolbar. 

 
This will bring up the Fixture attributes dialogue box.  
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This allows the user to add or edit information for that fixture.  
These notes serve as prompts for the user. 
If multiple fixtures are selected, only fields with common data will display information. 
(These Attributes are configurable in Fixture Studio - see the Fixture Studio help file for 
more information).     

Refreshing 
The Refresh Icon refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. 

 
Clicking on the Refresh button in the Gondolas tab will load the latest gondola 
information from the database into the Gondola hierarchy.  
At the same time, it will load the latest fixture information from the database into the 
Fixture Hierarchy. 
(This refreshing will operate irrespective of whether the Object Browser is used either in 
the Planner or Merchandiser environments).  
Dragging and dropping a gondola from the appropriate hierarchy after the refresh 
button has been pressed will add that gondola to the drawing using the latest definition 
from Fixture Studio.  
Similarly, using the Add button will also add a gondola to the drawing using the latest 
definition from Fixture Studio. 
If a drawing is already open then gondolas already placed in the drawing will not use 
any changes loaded during the refresh operation until the drawing is closed and 
reopened. However, new gondolas added to the open drawing will use the new data.     

Promotional Fixtures 
Promotional Fixtures can be assigned by selecting a fixture or fixtures and clicking on 
the Fixture Attribute icon in the toolbar. 

 
Promotional Fixtures are normally used for reporting purposes.  
They are assigned by selecting a fixture then selecting the appropriate option from the 
pull down menu. 
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Fixtures designated as Promotional can be identified by using the highlight option. 
Alternatively, they can be identified by running a report on the drawing or by using a 
KPI. 

Fixturing in Planner – Other Operations 

Overview of Restructuring the Drawing 
Restructuring the drawing can be initiated from the Retail Toolbar. 

 
This will bring up the Restructure Drawing dialogue box. 

 
This enables users to select blocks in a drawing then carry out one or more operations on 
those blocks. This results in the blocks being reset to match the latest definitions 
associated with that block. 
Options include: 

Option Effect 

Redefine Blocks 
from Disc 

Update the drawing with the latest version of the block (.dwg 
file) that is held on disc. 

Explode 
Composite Blocks 

Explodes any composite blocks into their individual parts. 
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Option Effect 

Reset Level Changes the level the block is placed to the level currently 
defined in Fixture Studio. 

Reset Color, Line 
Type and Line 
Weight to 
BYLAYER 

Resets the block properties to BYLAYER - i.e. it resets the block 
color, line type and line weight to the defaults for that layer. 

Reset Layer Changes the layer the block is currently placed on to the one 
currently defined in Fixture studio. 

List Unknown 
blocks 

Lists any blocks in the drawing that are not registered in the 
central database. 

Selecting Blocks for Restructuring 
Selecting Blocks for Restructuring is done by using the varying selection options and 
building up a list of blocks for the Restructuring operations to be carried out on.   

 
Each selection is added to the current list (Add to Selection radio button) or removed 
from the current list (Remove from Selection radio button). A list containing several 
types of blocks can thus be built up - the total number of blocks currently selected being 
shown in the dialogue box. 
Clicking on the Select button temporarily hides the Restructure Drawing dialogue box 
and takes the user to the drawing. The required blocks can be individually selected by 
left clicking on each individual block. When all the blocks have been selected, the 
selection process is completed by right clicking in the drawing. 
Clicking on the Select by Block button temporarily hides the Restructure Drawing 
dialogue box and takes the user to the drawing. The required type of blocks can be 
selected by left clicking on an example. All other blocks of that type on the drawing will 
then be selected. Multiple types of blocks can be selected before the selection process is 
completed by right clicking in the drawing. 
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Clicking on Select All Blocks will select all blocks in the drawing. 
The OK button will remain grayed out until one or more options are ticked in the 
Options frame.    

Restructuring Options 
Once the blocks have been selected, varying restructuring options can be chosen.  

 

Redefine blocks from Disk 
It is possible to edit the block definition of a specific block within the drawing. The block 
properties will not then match the generic block details held in the .dwg file stored 
within Macro Space Management. 
Redefine Blocks from Disk compares each block definition selected in the drawing and, if 
different from the .dwg file stored in Macro Space Management, changes the block 
definition in the drawing to match that stored in the software. 

Note: Block names will be ignored if they are not registered 
in the database. 

Explode Composite Blocks 
This option will take any selected blocks and determine if they are composite (made up 
of two or more previously combined blocks).  
If any blocks are composite, they will be separated into their component blocks and any 
connection points associated with the composite blocks removed. (If individual blocks 
within the composite have connection points assigned, these will not be affected).  

Note: Composite blocks cannot be reassembled after this 
operation, except by means of an 'undo' command. 

Reset Level 
This option results in any selected blocks being reassigned to the level they are assigned 
to in the block Definition in Fixture Studio.  
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If the level is set to 'undefined', no changes will be made in the level for the block. 

Note: Both shelves and products should be on undefined 
levels and should not be affected by this command. 

Reset Color, Line Type and Line Weight to BYLAYER 
If the colors, line types and line weights of any selected block are different from the 
default properties of the layer on which they have been placed, the properties of the 
selected blocks will be set to those defaults.  

Reset Layer 
If the selected block is on a different layer to that defined for that block in Fixture Studio, 
the block will be moved to that layer in the drawing.  

List Unknown Blocks 
It is possible for blocks to exist in the drawing, but not be registered in Fixture Studio. 
These sorts of blocks are shown in the Processing Blocks dialogue box that appears when 
the drawing is being restructured. 

 

The Retail Layers Toolbar 
The Retail Layers Toolbar enables users to quickly control which layers pertinent to 
Retailing are visible.  

 
 

Buttons Description 

 
 
Turns on all zones, zone text and aisles / 
boundary layers 

 
 
Turns off all zones, zone text and aisles / 
boundary layers 

 
 
Turns on all fixtures (but not fittings)  
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Buttons Description 

 
 
Turns off all fixtures (but not fittings)  

 
 
Turns on all fittings (but not fixtures)  

 
 
Turns off all fittings (but not fixtures)  

 
 
Turns on all products, shelves and 
associated annotation 

 
 
Turns off all products, shelves and 
associated annotation 

 
 
Turns on all general notes, markups and 
general dimension lines 

 
 
Turns off all general notes, markups and 
general dimension lines 

 
Toggles fixtures to 2D layer (if set up for 
this) 

 
Toggles fixtures to 3D layer (if set up for 
this) 
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Display 2D and 3D 
The Display 2D and Display 3D options are available from the View pull down menu.  

 
They are also available from the Retail Layers toolbar. 

 
This command works on fixtures that have had their drawing (dwg) file configured to 
have the base on the 2D layer and the remainder of the drawing on the 3D layer.  
If Display 2D is selected, only the base of the fixture will be displayed, giving an outline 
plan view.  
If display 3D is selected, all of the fixture will be displayed, giving a three dimensional 
view if the drawing is viewed from an oblique angle.  
The advantage of display 2D over the AutoCAD plan view is that it displays a simple 
outline of the fixture. If seen in plan in 3D mode, all the construction lines will be visible. 
This may make the plan view look very cluttered when the drawing is printed out.  
This can be seen in the example below where the fixture can be seen in both 3D (top) and 
2D (bottom). 
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Fixturing in Planner – the Insert Fixture Dialog Box 

Overview of Insert/Edit Feature Dialogue Box 
The Insert/Edit Fixture dialogue box appears when the Add Fixture icon is clicked on the 
Fixtures toolbar. 

 
This dialogue box contains a series of options for manipulating the fixture during 
placement. 

 
Move 
Fixture 

 
Attach 
Fixture to 
Another 

 
Move and 
Align 
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Fixture 

 
Move 
Fixture to 
be between 
others 

 
Place 
Fixture on 
Top of 
Another 

 
Offset the 
Fixture 

 
Place 
Fixture In-
Line with 
Another 

 
Change 
Justification 

 
Rotate the 
Fixture 

 
Rotate the 
UCS 

 
Create an 
Array of 
Fixtures 

 
Change the 
Size of the 
Fixture 

 
Add the 
same 
fixtures as 
the last 
added 

 
Undo the 
last change 

 

Modify the 
Options for 
this Fixture 

 
Click on each button to activate the required option.  
When fixture placement options are satisfactory; complete insertion by clicking on the 
cross in the upper right corner of the Insert/Edit Fixture dialogue box, or press 
<Escape>. 
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Note: The availability of some of these options depends on 
settings within the Fixturing tab of the Configuration 
Module. For example the arraying option will not be 
available if the Auto Reinsert option is checked. 

Move Fixture option 
 

 
Move 
Fixture 

 
This option is active when the Insert/Edit Fixture dialogue box appears. It enables the 
fixture to be inserted into the drawing at a point determined by the mouse cursor.  
Moving is completed by clicking on the x in the upper right part of the Insert/Edit 
Fixtures dialogue box, or pressing <Escape>. 

Attach Fixture to Another option 
 

 
Attach Fixture to 
Another. 

 
This button will allow one (or more) fixtures to be attached to another when both have 
compatible connection points.  
(If the connection points are not compatible, the fixtures cannot be attached). 
To use this option, place a fixture and then clock on the Attach Fixture to another icon. 
The fixture can them be moved around and will snap to any compatible connection 
points.  

Move and Align Fixture option 
 

 
Move and Align 
Fixture 

 
This allows the fixture to be moved to another position and, if necessary, aligned with an 
existing fixture. 

Move Fixture to Between Others option 
 

 
Move Fixture to 
Between Others 

 
Clicking on this icon will bring up a dialogue at the cursor asking for the start position of 
the line on which the fixture will be placed at the midpoint.  
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Left click to select the start point. The dialogue will then change to ask for the endpoint of 
the line on which the fixture will be placed at the midpoint. 

 
Left clicking will result in the Fixture being placed at the midpoint of the selected line.  

Place Fixture on Top of Another option 
 

 
Place Fixture on 
Top of Another. 

 
This button will allow one fixture to be placed on top of another when both have 
compatible connection points.  
At present this feature is not enabled in Macro Space Management. 

Offset the Fixture option 
 

 
 
Offset the Fixture 

 
Clicking on this icon will bring up the Offset dialogue box. 

 
To select the object to be offset from, click the Offset from Object button. Click on an 
object to select it. The fixture will be temporarily placed at this point. There are then two 
ways of determining the offset. 
Firstly, when the fixture is first positioned in the drawing, a dialogue box will appear 
giving the offset from the selected fixture: 
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This can be used to select the required offset. Left clicking will return the user to the 
Offset dialogue box, which will now have the X, Y, Distance and Angle co-ordinates 
showing.  
Alternatively, when the fixture has been selected, press <Escape> to return directly to the 
Offset dialogue box. The X and X coordinates of the offset can then be input. 
(Alternatively, they can be entered as a distance and an Angle).  
Clicking on Apply or OK will place the fixture at the desired offset.  

In-Line the Fixture option 
 

 

 
In Line the Fixture 

 
Clicking in this icon brings up the In-Line dialogue box. 

 
Clicking on the appropriate button selects how the fixture being inserted will be placed 
relative to the selected fixture. 
On clicking the button for the first time, the user will be invited to select a fixture. 

 
On selecting the fixture, the user will be returned to the dialogue box. Clicking on OK 
completes the process. 

Change Justification option 
 

 
 
Change Justification 

 
Clicking on the Change Justification icon brings up the Justification dialogue box. 

 
Clicking on the appropriate button changes the justification of the annotation for that 
particular type of fixture. 
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Rotate the Fixture option 
 

 
 
Rotate the Fixture 

 
Clicking on this icon brings up the Rotate Block dialogue box. 

 
Clicking on the Align with Object button allows the user to select a previously placed 
fixture. The new fixture will then be placed at the same angle as the selected fixture.  
Alternatively, the angle required for the fixture being placed can be entered directly into 
either the Relative Angle or Absolute Angle boxes. 

Rotate the UCS option 
 

 
Rotate the UCS 

 
Clicking on the Rotate the UCS icon enables the orientation of the Universal Co-ordinate 
System to be changed. 

 

A note on the WCS (World Co-ordinate System) and UCS (Universal Co-ordinate 
System). 
MSM AutoCAD has two coordinate systems: a fixed system called the World Co-
ordinate System (WCS) and a movable system called the User Co-ordinate System (UCS).  
The UCS is useful for entering coordinates, defining drawing planes, and setting views. 
Changing the UCS does not change your viewpoint. It changes only the orientation and 
tilt of the coordinate system.  
If you are working in a drawing, you can continually relocate the UCS to simplify your 
work. For example, if you have created a 3D object, you can edit each of its six sides 
easily by aligning the UCS with each side as you edit it.  
If you change the UCS relative to the WCS, you can always make the two align again by 
using the World option of the UCS command.  
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Create an Array of Fixtures option 
 

 
Create an Array of 
Fixtures 

 
Clicking on the Create an Array icon will bring up the Array dialogue box.  

 
The usual method is to select the numbers of row and columns for the array by means of 
the number radio buttons.  
Alternatively, clicking on the Measure button enables the user to define a rectangle. Left 
clicking returns the user to the dialogue box where the number of rows and columns will 
be defined.  
Clicking on OK or Apply completes the process. 

Change the Size of the Fixture option 
 

 
Change the Size of 
the Fixture 

 
This button will allow the fixture to be changed in size during insertion.  
This option will only work for fixtures that are stretchable - it will not work for non-
stretchable ones. 

Insert the Same Fixture as Last Added 
 

 
Insert a Copy of the 
Current Block 

 
This option allows the user to insert another instance of the last block to be inserted by 
simply clicking on the icon.  
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Undo the Last Change option 
 

 
Undo the Last 
Change 

 
The Undo the Last Change option undoes the effect of the last action. 

Modify the Options for this Fixture 
 

 

Modify the Options for 
this Fixture 

 
Selecting this option brings up the Fixturing Tab from the configuration Module.  

 
This allows users to configure some options as to how fixtures behave. (See 
Configuration Module help file for more information). 
 

Fixturing in Planner – Editing and Deleting Fixtures 

Overview of Editing Fixtures using AutoCAD Tools 
Fixtures can be edited using AutoCAD tools. These can be accessed from the Modify > 
General drop down menu options.  
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This allows objects to be Erased, Moved or Rotated. 

Note: Fixtures can also be moved by the Fixture 
Manipulation tools provided by Macro Space Management.  

Overview of Editing Fixtures using Fixture Studio 
Fixture Studio allows the properties of a fixture of fitting to be edited.  
It is accessed from the Object Browser by clicking on the Edit Fixture icon on the 
Fixturing tool bar.  

 
While in Fixture Studio a wide range of properties for the selected fixture or fitting can be 
customized. These include: 
� Insertion points 
� Size 
� Connection points 
� Parts 
� Shelving 
� Merchandisable areas  

Changes made to a fixture or fitting while in Fixture Studio will affect all blocks of that 
type.  

The Fixture Studio window 
The Fixture Studio window contains two main parts.  
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On the left is a hierarchical tree of all the available gondolas, while on the right is a 
window allowing the block details of the currently selected gondola to be customized.  

Moving Fixtures 
Moving Fixtures can be done by selecting the Move option from the Modify pull down 
Menu. 

 
This will bring up a small prompt asking the user to select the Fixtures to be moved.  
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Any objects selected will change from solid to dotted lines.  

 
Right clicking completes the selection process. 
The use will then be asked to specify a base point. 

 
Following specification of a base point, the user will be prompted to specify a second 
point. 

 
In both cases the points can be specified either by left clicking, or by typing in the X and 
Y coordinates.  
The two points specified define a vector. This indicates how far and in what direction the 
selected fixtures are to be moved. 

Note: Using MSM AutoCAD tools changes the drawing, 
without the changes being recorded in the central Macro 
Space Management database. Run Synchronize then 
Adjacencies to ensure the central database contains the 
effects of all AutoCAD changes.  

Rotating Fixtures 
To Rotate a Fixture select the Rotate option from the Modify pull down menu. 
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This will bring up a small prompt asking the user to select the Fixtures to be rotated.  

 
Any objects selected will change from solid to dotted lines.  

 
Right clicking completes the selection process. 
The use will then be asked to specify a base point. The point can be specified either by 
left clicking, or by typing in the X and Y coordinates.  

 
Following this the user will be invited to specify a rotation angle. 

 
The rotation angle can be specified by typing it in. Alternatively, the mouse cursor can be 
used to draw a line at the required angle.  
Left clicking will cause the specified objects to be rotated.  
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Note: Using AutoCAD tools changes the drawing, without 
the changes being recorded in the central Macro Space 
Management database. Run Synchronize then Adjacencies to 
ensure the central database contains the effects of all 
AutoCAD changes.  

Erasing Fixtures 
To Erase a Fixture select the Erase option from the Modify pull down menu. 

 
This will bring up a small prompt asking the user to select the Fixtures to be erased.  

 
Any objects selected will change from solid to dotted lines.  

 
Right clicking completes the selection process – which will cause the selected objects to 
be removed from the drawing.  

Note: Using AutoCAD tools changes the drawing, without 
the changes being recorded in the central Macro Space 
Management database. Run Synchronize then Adjacencies to 
ensure the central database contains the effects of all MSM 
AutoCAD changes.  

Undoing changes 
Moved, Rotated or Erased fixtures can generally be restored to their original position by 
making use of the Undo command on the AutoCAD Toolbar  
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Note: Using MSM AutoCAD tools changes the drawing, 
without the changes being recorded in the central Macro 
Space Management database. Run Synchronize then 
Adjacencies to ensure the central database contains the 
effects of all AutoCAD changes.  

Deleting Fixtures 
It is recommended that Fixtures are deleted using Macro Space Management tools. This 
can be achieved by means of the Delete Fixture option on the Fixturing toolbar. 

 
Delete 
Fixture 

To delete fixture(s) click on the fixtures required. Alternatively, use the AutoCAD 
selection tools. 

 
The outline of the fixture(s) will turn to dotted and the insertion point will show. 
At the same time the Delete icon will change from grayed out to active, while the Add 
Fixture and Edit Fixture icons will grey out. 

 
Clicking on the Delete icon will remove all selected fixtures (and gondolas). 

Fixturing in Planner - Fixture Swap and Manipulation 

Overview of Fixture Manipulation 
The Planner module is integrated with AutoCAD. Experienced AutoCAD users can make 
use of the majority of AutoCAD functionality to lay out floor plans in the Planner 
module. However, AutoCAD is a complex program and some users carrying out store 
planning tasks may not be familiar with AutoCAD functionality. Accordingly, Planner 
has been provided with some Fixture Manipulation tools. These enable users to perform 
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a variety of operations including moving, rotating and aligning fixtures. One way of 
accessing these is from the Fixturing toolbar. 

 

Fixture Manipulation and Child Objects 
One of the advantages of using the Fixture Manipulation tools is that they control child 
objects. The Planner floor plan is divided into layers, each containing a particular type of 
object - such as fixtures or zone annotation. The display or selection of objects is often 
controlled by turning off or locking layers. If purely AutoCAD tools are used, objects on 
the turned off or locked layers are not included in the selection. This can result in some 
objects being moved, while their child objects are left in their original location. 
Another problem that can occur when using AutoCAD selection tools is that it is possible 
to select objects that it is not intended to move. For example the selection set could 
include blocks representing pillars or columns in a store. Fixture Manipulation filters the 
selected objects so that only fixtures and merchandise are moved, together with their 
associated annotation and bay numbers. 
The available Fixture Manipulation options are: 

Group On or Group Off for Fixtures 
Gondolas are items of equipment placed in a precise relationship to each other. When 
manipulating gondolas it is some times useful to manipulate then as a whole and it is 
sometimes useful to manipulate individual parts of a gondolas. If Fixture Grouping is 
On, selecting one part of a gondola will select all parts of that gondola. If Fixture 
Grouping is Off, individual parts of a gondola can be selected without selecting the 
whole.  

Move Fixtures 
Move fixtures enables the user to move the selected items of equipment (together with 
any merchandise and annotation) any direction in the X and Y axes. The elevation of the 
equipment remains unchanged. 

Slide Fixtures 
Slide fixtures enables the user to move the selected items of equipment (together with 
any merchandise and annotation) at 90 degree increments to the present orientation and 
position of the fixture. This enables the user to move the selected fixtures left, right, 
forward or back. The elevation of the equipment remains unchanged. 

Offset Fixtures 
Align fixtures enables the user to take a selected set of equipment (and its merchandise 
and annotation) and align it relative to another object in the floor plan. It is also spaced a 
selected distance (offset) from that object. This might be used to take a gondola and place 
it a specific distance from a wall. 

Match Rotation 
Match Rotation enables the user to take a selected set of equipment (and its merchandise 
and annotation) and align it relative to another object in the floor plan. 
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Cut 
Cut removes the selected equipment (and its merchandise and annotation) from the floor 
plan and pastes them to the clipboard. If a planogram has been 'exploded' (shows full 
detail of shelves and merchandise), this detail will also be pasted to the clipboard. 

Copy 
Copy takes details of the selected equipment (and its merchandise and annotation) from 
the floor plan and pastes the information into the clipboard. If a planogram has been 
'exploded' (shows full detail of shelves and merchandise), this detail will also be pasted 
to the clipboard. 

Paste 
Paste takes the information from the clipboard and inserts it into the floor plan. If a 
planogram has been 'exploded' (shows full detail of shelves and merchandise), this detail 
will also be pasted to the floor plan. 

Delete 
Delete removes the selected equipment (and its merchandise and annotation) from the 
floor plan. 

Rotate 
Rotate takes the selected equipment (and its merchandise and annotation) and allows it 
to be rotated by any angle about the geometric center of the selected objects. 

Rotate 90 Degrees Clockwise 
Rotate 90 Degrees Clockwise takes the selected equipment (and its merchandise and 
annotation) and gives it a clockwise 90 degree rotation about the geometric center of the 
selected objects. 

Rotate 90 Degrees Anti-clockwise 
Rotate 90 Degrees Anti-clockwise takes the selected equipment (and its merchandise and 
annotation) and gives it an anti-clockwise 90 degree rotation about the geometric center 
of the selected objects. 

Rotate 180 Degrees  
Rotate 180 Degrees takes the selected equipment (and its merchandise and annotation) 
and gives it a 180 degree rotation about the geometric center of the selected objects. 

Mirror 
Mirror produced a mirror image of a selected set of equipment, merchandise and 
annotation. The selected objects are 'reflected' about a specified axis. 

Array 
Array takes a selected set of equipment, merchandise and annotation and generates 
additional rows and columns of that set of objects. 

Overview of Fixture Swap 
The Fixture Swap functionality allows users to automatically swap selected fixtures in 
the active floor plan for replacements of a different type. Fixture Swap can be called from 
the Command Line (AVT_FIXTURESWAP) or from the Fixturing toolbar. 
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The process works as follows: 

 
1. The Fixtures it is desired to swap in the floor plan are selected. 
2. The Fixture swap dialog box is selected and will populate with the selected fixtures. 
3. A fixture is selected to be swapped out. 
4. The fixture to be swapped in (replacement fixture) is selected. 
5. The two fixtures (in and out) are defined as a swap pair. 
6. The user continues to define swap pairs as required. 
7. When all swap pairs have been defined, the fixtures are swapped. 

Note: it is possible to reverse the first two steps - i.e. open 
the dialog box first, then select the required fixtures. 

Examples of Fixture Swaps 
One example of Fixture Swap is shown below, where it has been decided to replace two 
racking fixtures with slatwalls - allowing planograms involving hung products to be 
placed in the future. 

 
Fixture swap also changes the size of planogram placeholders if they are on the fixtures 
being swapped. In the example below, the original planograms are shown on the rear 
gondola run. Two fixtures have been resized - and the planogram placeholders have 
changed size accordingly. This can be seen in the front gondola run.  
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Accessing Fixture Swap and Manipulation Options 

Fixture Swap 
Fixture Swap can be initiated in the following ways: 
1. From the command line by typing AVT_FIXTURESWAP and pressing Return. 
2. From the Fixturing Toolbar 

 
Fixture Manipulation 

Fixture Manipulation can be accessed in the following ways: 
1. From the command line by typing in individual commands and pressing Return. 

Option Command 

Group On/Off None 

Move Fixtures AVT_MOVE 

Slide Fixtures AVT_SLIDE 

Offset Fixtures AVT_OFFSET 

Match Rotation AVT_MATCH_ROTATION 

Cut Fixtures AVT_CUT 

Copy Fixtures AVT_COPY 

Paste Fixtures AVT_PASTE 

Rotate Fixtures AVT_ROTATE 
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Option Command 

Rotate Fixtures 90 
Degrees 
Clockwise 

AVT_ROTATE_90 

Rotate Fixtures 90 
Degrees 
Anticlockwise 

AVT_ROTATE_270 

Rotate Fixtures 
180 Degrees 

AVT_ROTATE_180 

Mirror Fixtures AVT_MIRROR 

Array Fixtures AVT_ARRAY 

 
2. As a keyboard shortcut 

Option Shortcut 

Group On/Off Ctrl + Alt + G 

Move Fixtures Ctrl + Alt + M 

Slide Fixtures Ctrl + Alt + E 

Offset Fixtures Ctrl + Alt + O 

Match Rotation Ctrl + Alt + L 

Cut Fixtures Ctrl + Alt + X 

Copy Fixtures Ctrl + Alt + C 

Paste Fixtures Ctrl + Alt + V 

Delete Fixtures Ctrl + Alt + D 

Rotate Fixtures Ctrl + Alt + R 

Rotate Fixtures 90 Degrees 
Clockwise 

Ctrl + Alt + Right 
Cursor Arrow 

Rotate Fixtures 90 Degrees 
Anticlockwise 

Ctrl + Alt + Left 
Cursor Arrow 

Rotate Fixtures 180 
Degrees 

Ctrl + Alt + Down 
Cursor Arrow 

Mirror Fixtures Ctrl + Alt + I 

Array Fixtures Ctrl + Alt + A 

 
3. From the Fixturing toolbar. 
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Option Icon 

Group On/Off 
 

Move Fixtures 
 

Slide Fixtures 
 

Offset Fixtures 
 

Match Rotation 
 

Cut Fixtures 
 

Copy Fixtures 
 

Paste Fixtures 
 

Delete Fixtures 
 

Rotate Fixtures 
 

Rotate Fixtures 90 
Degrees Clockwise  

Rotate Fixtures 90 
Degrees Anticlockwise  

Rotate Fixtures 180 
Degrees  

Mirror Fixtures 
 

Array Fixtures 
 

 
4. From the right click menu accessed in the floor plan 
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Note: these commands should not be confused with the pure 
AutoCAD commands available from (for example) the 
Modify menu. 
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Turning Grouping On or Off 
Grouping affects how objects are selected for Fixture Manipulation or Fixture Swap. 
Grouping is Toggled on or Off using the icon on the Fixturing toolbar. 

 

Grouping On 
If Grouping is turned on, selecting a single item of equipment in a gondola selects all 
items of equipment in that gondola. 

Grouping Off 
If Grouping is turned off, items of equipment within a gondola must be individually 
selected; either by clicking on them, or by using Windows or Crossing selection boxes. 
In the example below, one fixture in the upper double sided gondola has been clicked 
while grouping was turned on - resulting in all fixtures and fittings in the gondola being 
selected. Grouping was then turned off, and a single fixture clicked in the bottom double 
sided gondola. Because grouping was turned off, only a single fixture was selected. 

 
Toggling Grouping On or Off has a significant effect on what is selected. 
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Technicalities of Fixture Swap and Manipulation 

Selection Sequence 
There are generally two ways a command can be executed: 
1. Select the objects first then issue the command. 
2. Issue the command then select the objects. 
The examples given in this section are all based on selecting the objects first, then issuing 
the command. Issuing the command first, then selecting the objects is an equally valid 
way of working.  
In this case the command is invoked from the Fixturing toolbar. In the example below, 
the Move command has been selected. 

 
A prompt then appears in the command line. This identifies the command that has been 
invoked and prompts the user to select the objects the command is to be applied to.  

 
Once the objects have been selected, the rest of the command is executed in a similar 
manner to when the objects were selected first and then the command invoked. 

Object Height 
The position of an object can be described relative to the origin of the floor plan by three 
coordinates: 

 
The origin of the floor plan is by convention always (0, 0, 0). 
1. The X axis is the distance along (to the left or right) of the origin. 
2. The Y axis is back of or in front of the origin. 
3. The Z axis is the height above or below the origin. 
 So, if an object is 20 feet to the left of the origin, 10 feet back from it and 3 ft above it, it 
would have Cartesian coordinates (expressed in feet) of   
(20, 10, 3).  

 Note: Cartesian coordinates are often expressed in inches or 
millimeters. If expressed in inches, the example above would 
be (240, 120,  36). 

All the Fixture Manipulation and Fixture Swap operations will affect the distance along 
from and back from the origin (X and Y coordinates). They will not affect the height (Z 
coordinate).  
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Fixture Manipulation and XData 
Fixture Manipulation relies on the block having been registered in a specific manner in 
Fixture Studio. When saving a block, there is an option to Write Block Files. 

 

Note: Users require the appropriate permissions to access 
Fixture Studio. 

This writes additional information into the block in the form of a special attribute called 
BSLINK_ATT. This attribute can be seen by selecting a fixture in Planner and using the 
Block Edit (BEDIT) command. Zooming in close to the insertion point of the block should 
reveal this attribute. 

 

Note: this attribute is hidden when the block/fixture is 
displayed in the floor plan. It can only be revealed by means 
of the BEDIT command. 

If the attribute is absent, fixture manipulation commands will not work. 
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Selection Methods 
Before carrying out Fixture Manipulation or Fixture Swap operations, users must be able 
to select objects in the floor plan. Selected objects have a dotted outline and the insertion 
point shows as a small blue square.  

 

Individual Selection 
Individual objects can be selected by left clicking a line belonging to that object. 
Additional objects can be added to the selection set by continuing to left click lines in 
other items in the drawing. When all objects have been selected, the selection is 
completed by right clicking in the floor plan with the mouse.  

Window Selection Box 
One way of selecting multiple fixtures is to use a window selection box. To do this click 
on a point in the floor plan, hold down the left mouse button and move the cursor to the 
right of the first point. A blue box will result. All objects completely enclosed by the box 
will be selected. 
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In the above example, fixtures F-11 and F-12 will be selected because they are completely 
enclosed, but fixtures like F-27 that are not completely enclosed will not be selected. 
Multiple windows selection boxes may be used to select objects. The selection is 
completed by right clicking in the floor plan with the mouse.  

Crossing Selection Box 
One way of selecting multiple fixtures is to use a window selection box. To do this click 
on a point in the floor plan, hold down the left mouse button and move the cursor to the 
left of the first point. A green box will result. All objects fully or partially enclosed by the 
box will be selected. 

 
In the above example, fixtures F-10, F11, F-12, F-13, F-25, F-26, F27, and F-28 will be 
selected because they are fully or partially enclosed. 
Multiple crossing selection boxes may be used to select objects. The selection is 
completed by right clicking in the floor plan with the mouse.  

De-Selecting Fixtures 
Any existing selection set can be de-selected by hitting the escape key. 

Synchronization 
Synchronization is used to ensure that the information in the database matches that held 
in the Planner floor plan. It is invoked from the Synchronization option on the Retail 
toolbar. 

 
This will bring up the Synchronization dialog box. 
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Note: For full information see the section on Synchronization 
in the Planner help file. 

There are two main options controlled the radio button in the upper right of the dialog 
box. These are: 
1. Match the Drawing 
2. Match the Database 
Synchronization is run by selecting one or other option and then clicking the 
Synchronize button. 
The circumstances when the options are required are described below. 

Changes made with AutoCAD tools 

 
In the above case, changes have been made using AutoCAD tools (for example the 
AutoCAD Erase command). Because the Macro Space Planning database is not affected 
by AutoCAD commands, changes exist between the floor plan and the database. A 
Synchronize (Match the Drawing) operation is required so that the floor plan and 
database contain the same information. 

Changes made with Planner tools 

 
Changes made elsewhere in Macro Space Planning 

In the above case, changes have been made using Planner tools (for example the Delete 
command on the fixturing toolbar). This command makes changes simultaneously in 
both the floor plan and database so no synchronization is required. 
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Note: changes made with the Fixture Manipulation tools in 
Planner automatically update the database as well the floor 
plan. 

 
It is also possible for tools outside of the Planner module to make changes to the 
database. These could be: 
1. Changes made to the floor plan in the Merchandiser module. 
2. Changes made to the floor plan in In-Store Space Collaboration. 
3. Changes made to the floor plan using Batch tools such as Drawing Automation. 
The changes made to the database may not be reflected in the floor plan. Differences will 
therefore exist between the database and that floor plan. A Synchronize (Match the 
Database) operation is required so that the floor plan and database contain the same 
information. 

AutoCAD's Object Snap Functionality 
AutoCAD has Object Snap functionality. This can be toggled on or off by clicking the 
button on the AutoCAD status bar. 

 
Right clicking the Object Snap icon and selecting Settings enables the settings to be 
defined. Check boxes can be ticked to specify points that the cursor can snap to when 
carrying out fixture manipulation options. 

 
When carrying out a Fixture Manipulation command (for example Move), the user will 
be prompted to pick a base point in the selected objects. 
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If Object Snap is on, the cursor will snap to any points that have been specified in the 
Settings dialog box. In the example below an Endpoint has been selected by clicking it. 

 
Once the first Object Snap point has been selected, the user will be invited to select a 
point to move to. 

 
The user can then select another Object Snap point. In the example below, the corner of 
the wall in the architectural plan has been selected.  

 
On clicking the second Object Snap point the selected objects will be moved to that point. 
In the example below, the fixtures have been moved precisely into the corner of the wall. 
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Note: for more information on using Object Snap or 3D 
Object Snap see the AutoCAD help material. 

Fixture Swap and Custom SQL 
The information in the Fixture Swap dialog box is controlled by Custom SQL in the 
database. For example, if different columns are required, this can be achieved by 
modifying the Custom SQL.  

 
This task can only be accomplished by Administrators with access rights to the Admin 
Module. 
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Fixture Manipulation – Move Fixtures 
Move Fixtures allows the user to move the selected set of equipment, merchandise and 
annotation from one point to another in the floor plan.  

 
The command is invoked from the Move option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be moved relative to the single 
sided gondolas along the wall. 

 
The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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The user can then click the Move icon on the Fixturing toolbar. The Insertion points will 
disappear, but the fixtures will still remain as dotted outlines. 

 
At the same time, the user will be prompted (via the command line) to select a base point 
for the move. 

 
If Object Snap is turned on in the Status Bar, the user can 'snap' the cursor to a convenient 
point on one of the selected fixtures. 
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The cursor will then snap to a selected point on the fixture. 

 
The fixtures can then be moved via the cursor to the point they are required in the floor 
plan. The fixtures will appear as a 'ghost' outline until finally placed. 
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On left clicking at the selected point in the drawing, the fixtures will be moved to that 
point. 
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Fixture Manipulation – Slide Fixtures 
Slide Fixtures allows the user to move the selected set of equipment, merchandise and 
annotation from one point to another in the floor plan.  
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The command is invoked from the Slide option on the Fixturing toolbar. 

 
The Slide option is a more restricted form of the Move command. Fixtures can only be 
moved at 0, 90, 180 or 270 degrees relative to the selected fixtures. If it is desired to move 
the fixtures a precise distance in the specified direction, this distance can be entered into 
the AutoCAD command line. 
In the example below, the double sided gondolas are to be 'slid' relative to the single 
sided gondolas along the wall. 

 
The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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The use can then click the Slide icon on the Fixturing toolbar. The selected fixtures can be 
'slid' along the permitted axes until they are in the correct position. The fixtures will 
appear as a 'ghost' outline until finally placed. 



Fixturing in Planner - Fixture Swap and Manipulation 

294 Store Planning User Guide 

 
On left clicking at the required point, the fixtures will be repositioned. 
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Fixture Manipulation – Offset Fixtures 
Offset Fixtures allows the user to align the selected set of equipment, merchandise and 
annotation a set distance from a line (for example a wall) in the floor plan.  
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In the above diagram, the left hand example shows the effect of selecting a wall to offset 
from and setting an offset of 0: the selected objects will align directly along the wall. The 
right hand sample shows the effect of a positive offset: the selected objects have aligned a 
specific distance from the wall. 
In the diagram below, the double gondola is to be moved parallel to and 8 feet from the 
single gondola along the wall. 

 
The command is invoked from the Offset option on the Fixturing toolbar. 

 
The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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The user can then click the Offset icon on the Fixturing toolbar. The user will then be 
prompted to set the Offset distance - the distance the gondola will be from the selected 
wall, etc. 

 
Alternatively, click two successive points in the floor plan. After clicking the first point, 
the user will be invited to click a second: 

 
This method can be used to measure an existing distance between two objects in the floor 
plan (for example a gap between two other gondolas) and use it for the offset. 
The user will then be invited to select a source edge. This is the edge of the gondola that 
will be moved relative to another object. 
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The user will then be invited to select an angle along the source edge. This is done by 
clicking another point on the face of the gondola. 

 

 
The user will then be invited to select an edge of the object to be aligned with. 
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In the example below, the user has selected the front edge of the single gondola along the 
wall. 

 
The user will then be invited to select an angle along the reference edge. 

 
This is done by clicking on another point on the front edge of the single gondola along 
the wall. 
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The user will be invited to select the side of the reference line the double gondola is to be 
offset to. 

 
This is done by clicking on the side of the single gondola we wish the double gondola to 
be offset to. 

 
As soon as this point is clicked, the selected equipment, merchandise and annotation will 
rotate until they are aligned with the selected edge. 
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If Grouping is On, how the offset fixtures line up to their datum fixtures depends on the 
fixture clicked on to select the fixtures to offset and the fixture selected to specify the 
fixtures to offset to. When the fixtures to be offset move, the insertion points of the two 
selected fixtures will align. 
In the example below, the top left fixture of the double gondola was clicked when 
selecting the objects to offset, and the top fixture was selected in the gondola to offset to 
(left hand diagram). The result is shown in the right hand diagram. 

 
In the example below, the bottom left fixture of the double gondola was clicked when 
selecting the objects to offset, and the bottom fixture was selected in the gondola to offset 
to. (Left hand diagram). The result is shown in the right hand diagram. 
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Fixture Manipulation – Match Rotation 
Match Rotation allows the user to align the selected set of equipment, merchandise and 
annotation with a line (for example a wall) in the floor plan.  

Note: If it desired to align the selected equipment, 
merchandise and annotation against a wall, etc., use the 
Offset command with an Offset of 0. 

In the example below, the single sided gondola is to be aligned with the wall behind it. 
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The command is invoked from the Match Rotation option on the Fixturing toolbar. 

 
The initial stage is to select the gondolas to be moved. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Fixture Grouping is On or 
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The use can then click the Match Rotation icon on the Fixturing toolbar. The user will 
then be invited to select a source edge. This is the edge of the gondola that will be rotated 
relative to another object. 

 
This is done by clicking a point on the required edge of the gondola.  

Note: It is not possible to select an edge by clicking an 
insertion point. You must click on an edge of a fixture. 
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The user will then be invited to select an angle along the source edge. This is done by 
clicking another point on the face of the gondola. 

 

 
The user will then be invited to select an edge of the object to be aligned with. 
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In the example below, the user has clicked on the face of the wall the gondola run is to be 
aligned to.   

 
The user will then be prompted to select the direction for the edge. 

 
This is done by clicking on another point on the face of the wall. 

 
As soon as the second point is clicked, the selected equipment, merchandise and 
annotation will rotate until they are aligned with the selected edge. 
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If Grouping is On and the required fixtures are selected by clicking on an individual 
fixture, the insertion point of that fixture will serve as the point around which the fixtures 
will rotate. In the example below, if the top fixture (colored red in this example) is 
selected, the gondola will rotate about its insertion point. If the bottom fixture (colored 
blue in this example) is selected, the gondola will rotate about that insertion point.  
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Fixture Manipulation – Cut, Copy and Paste Commands 
The Cut, Copy and Paste commands take a selected set of equipment, merchandise, 
annotation and bay numbers and move them to or from the clipboard. The Delete 
command removes the selected set of equipment, merchandise, annotation and bay 
numbers from the floor plan. The commands are invoked from the Fixturing toolbar. 

 

Cut or Copy Commands 
The Cut Command removes the selected equipment, merchandise, annotation and bay 
numbers from the floor plan and places the information into the clipboard. Any previous 
information in the clipboard is overwritten. 
The Copy Command takes a copy of the selected equipment, merchandise, annotation 
and bay numbers from the floor plan and places the information into the clipboard. Any 
previous information in the clipboard is overwritten. 
In the example below, the two double sided gondolas are to be either cut or copied from 
the floor plan and placed on the clipboard. 

 
The initial stage is to select the required fixtures. The outlines of the fixtures will turn 
dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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If the Cut command is clicked on the fixturing toolbar, the selected equipment, 
merchandise, annotation and bay numbers will be removed from the floor plan and 
placed into the clipboard. Any previous information in the clipboard is overwritten. 

 

 
If the Copy command is clicked on the fixturing toolbar, the command Line will 
prompted the use to specify a base point. 

 

 
If Object Snap is turned on in the Status Bar, the user can 'snap' the cursor to a convenient 
point on one of the selected fixtures. 
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After clicking on the selected point, a copy of the selected equipment, merchandise, 
annotation and bay numbering will be taken from the floor plan and placed into the 
clipboard. Any previous information in the clipboard is overwritten. In addition, the 
equipment, merchandise and annotation remains in the floor plan and remains selected. 

 

Paste 
Paste takes the information from the clip board and inserts it into the floor plan. The 
Paste command is invoked from the Fixturing toolbar. 

 
After clicking the Paste button, the equipment, merchandise, annotation and bay 
numbering will be taken from the clip board and placed in the floor plan relative to the 
mouse cursor. 
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Fixture Manipulation – Copying Between Floor Plans 
The Copy function also allows users to take information from one floor plan and transfer 
it to another floor plan. This is done as follows: 
1. Open or make active the floor plan it is desired to take the information from. 
2. Select the required equipment and merchandise 
3. Use the Cut or Copy commands to place a copy of the information in the clipboard. 

this information will include annotation, bay numbering, etc. 
4. Open or make active the floor plan it is desired to transfer the information into 
5. Use the paste command to add the information into the floor plan. 
6. The information will automatically be synchronized with the information in the 

database. 

Fixture Manipulation – Delete Command 
The Delete command can be used to delete fixtures, together with their associated 
shelves, merchandise, annotation and bay numbers. This is because the display or 
selection of objects is often controlled by turning off or locking layers. If purely 
AutoCAD tools are used, objects on the turned off or locked layers are not included in 
the selection. This can result in some objects being moved, while their child objects are 
left in their original location. 
The Delete function is found on the fixturing toolbar. 

 
In order to delete fixtures and their associated child objects: 
1. Select the required fixtures in the floor plan 
2. Click the Delete command on the Fixturing toolbar or on the Toolbar of the Fixturing 

Tab of the Object Browser 
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3. The fixtures and their child objects will then be deleted. 

Fixture Manipulation – Rotate Fixtures 
Rotate Fixtures takes a selected set of equipment, merchandise and annotation and 
rotates them about the center of the selected objects.  

 
The command is invoked from the Rotate option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated to through 80 degrees 
relative to the single sided gondola along the wall. 

 
The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). 
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Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected and the Rotate button has been clicked on the 
Fixture Manipulation toolbar, they can be rotated around the center of the selected 
objects by means of the mouse cursor. The new position of the fixtures will be shown as a 
'ghost' outline. If this method of rotating the fixtures is being used, the fixtures will be 
drawn in their final position after a left mouse click in the floor plan.  

 
Alternatively, a precise rotation angle can be entered into the Command line.  If this 
method of rotating the fixtures is being used, the fixtures will be drawn in their final 
position when Return is pressed. 

 
The fixtures have been rotated as required. Other options (such as the Move or Slide 
commands can then be used to further adjust their position). 
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Fixture Manipulation – Rotate Fixtures 90 Degrees Clockwise 
Rotate Fixtures 90 Degrees Clockwise takes a selected set of equipment, merchandise 
and annotation and rotates them 90 degrees clockwise about the center of the selected 
objects.  

 
The command is invoked from the Rotate 90 degrees Clockwise option on the Fixturing 
toolbar. 

 
In the example below, the double sided gondolas are to be rotated 90 degrees clockwise. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or Crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be rotated about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected, the Rotate 90 Degrees Clockwise button is clicked 
on the Fixture Manipulation toolbar. The fixtures will then be drawn in their final 
position in the floor plan.  
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Fixture Manipulation – Rotate Fixtures 90 Degrees Anticlockwise 
Rotate Fixtures 90 Degrees Anticlockwise takes a selected set of equipment, 
merchandise and annotation and rotates them 90 degrees anticlockwise about the center 
of the selected objects.  

 
The command is invoked from the Rotate 90 degrees anticlockwise option on the 
Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated 90 degrees clockwise. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be rotated about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected, the Rotate 90 Degrees Anticlockwise button is 
clicked on the Fixture Manipulation toolbar. The fixtures will then be drawn in their final 
position in the floor plan.  
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Fixture Manipulation – Rotate Fixtures 180 Degrees 
Rotate Fixtures 180 Degrees takes a selected set of equipment, merchandise and 
annotation and rotates them 180 degrees about the center of the selected objects.  

 
The command is invoked from the Rotate 180 degrees option on the Fixturing toolbar. 

 
In the example below, the double sided gondolas are to be rotated 180 degrees. 
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The initial stage is to select the gondolas to be rotated. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be rotated about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 

 
Once the fixtures have been selected, the Rotate 180 Degrees button is clicked on the 
Fixture Manipulation toolbar. The fixtures will then be drawn in their final position in 
the floor plan.  
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Fixture Manipulation – Mirror Fixtures 
Mirror Fixtures enables users to produce a mirror image of the selected fixtures. 
In the example below, the merchandiser has decided to swap the equipment and 
merchandise to opposite sides of the aisle. The left hand side of the diagram below shows 
the aisle before mirroring and the axis about which the aisle will be mirrored. The right 
hand side of the diagram shows the aisle after mirroring. 

 
In the example below, the merchandiser has decided to swap the equipment and 
merchandise about the center of the aisle. The left hand side of the diagram below shows 
the aisle before mirroring and the axis about which the aisle will be mirrored. The right 
hand side of the diagram shows the aisle after mirroring. 

 
The command is invoked from the Mirror option on the Fixturing toolbar. 
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In the example below, the equipment and merchandise in the two double gondolas is to 
be mirrored about the specified axis. 

 
The initial stage is to select the objects to be mirrored. The outlines of the fixtures will 
turn dotted and the insertion points will show as blue boxes. (If using individual fixture 
selection, the selection set must be completed by clicking the right mouse button.  If 
using Windows or Crossing selection boxes, continue selecting until all required objects 
are in the selection set). The fixtures will be mirrored about the center of the selected 
objects. 

Note: Selection behavior will also be affected by whether 
Grouping is On or Off. 
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Note: Care must be taken to select only the fixtures and 
merchandise it is intended to mirror. 

Click the Mirror command on the fixturing toolbar. The cursor will be returned to the 
floor plan and (if not already on) the AutoCAD Ortho command will be turned on. This 
restricts the permissible angle the fixtures can be mirrored through to 0, 90, 180 and 270 
degrees. Moving the cursor about will select the varying possible angles. At the same 
time a 'ghost' image will show where the fixtures are to be mirrored to. 

 
On left clicking in the floor plan, the selected objects will be mirrored. 
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Note: if it is desired to mirror at any other angle than 0, 90, 
180 and 270 degrees, it is possible to manually turn off the 
AutoCAD Ortho command during the mirroring operation. 
The blocks can then be mirrored about any specified angle. 

Fix Mirrored Blocks 
Because the blocks have been mirrored, they are a precisely inverted reflection of the 
original block. this includes the insertion points. The Mirror command automatically 
calls the Fixed Mirrored Blocks command and (provided the block is symmetrical) the 
insertion points are adjusted to the correct position. 

Non-Symmetrical Objects 
The functionality is unable to fully mirror non symmetrical objects. An example would 
be the checkouts seen in the bottom of this diagram. The Mirroring axis is shown in the 
left hand part of this diagram. When the double sided gondolas and checkouts are 
mirrored, the double sided gondolas become a mirror image of each other. However, 
because the checkout are not symmetrical, they are 'reflected' to the new position, but the 
block itself remains 'un-reflected'. 

 

Fixture Manipulation – Array Fixtures 
Array takes a selected set of equipment, merchandise and annotation and generates 
additional rows and columns of that set of objects. In the diagram below, the original red 
fixture has been used as the basis for an array of three rows and two columns of similar 
fixtures. 
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The command is invoked from the array option on the Fixturing toolbar. 

 
Arraying can be used to speed up laying out the arrangement of equipment in a store. In 
the example below, the original checkout (shown in red for clarity), has been extended 
into a row of checkouts by means of the array command. 

 
Similarly, in the example below, the original gondola (shown in red for clarity), has been 
copied twice by means of the array command. 
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To use the array command, consider the following example: 

 
Having laid out some initial checkouts and gondolas, it has been decided to put down an 
array of bins for special offers. The initial bin (shown in red for clarity) has already been 
placed. The array command can then be used to space additional bins. The steps are as 
follows: 
1. Establish the dimensions of the bin. In this example it is 36 inches square. 
2. Establish the X and Y dimensions for the array. In this case it has been decided to 

leave a 5 ft gap between adjacent bins in the X axis, and to align the bins with the 
ends of the gondolas in the Y axis. The gondola runs are 12 ft between centers. 

3. Select the bin and then click the Array command on the fixturing toolbar. This will 
cause the Array dialog box to appear. 
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4. The number of columns is set to 3 (to match the number of gondolas) and the row 
offset is set to 144 (to match the centers of the gondola runs). 

5. The number of rows is set to 2. As we want to leave 5 ft (60 inches) between the bins, 
the column offset is set to 96 (36 inches for the bin, plus 60 inches for the gap between 
them.  

6. Clicking the Preview button will show a preview of the arrayed fixtures. Pressing 
Escape will return the user to the Array dialog box. Pressing Return will place the 
arrayed fixtures in the floor plan. 
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Fixture Swap – The Fixture Swap Dialog Box 
The Fixture Swap dialog box is made up of a number of parts. 

 

Toolbar 
The toolbar allows users to mirror (copy) and delete filter settings. It also allows users to 
delete defined swaps and to copy information to the clipboard. 

Filter Options 
Each column in the Selected Fixtures and Replacement Fixture sections of the dialog box 
can be filtered to refine the list of available data. 

Fixtures to Swap 
The Selected Fixtures/Fittings section contains a list of all equipment that was selected in 
the floor plan when the Fixture Swap dialog box was activated. 

Fixtures Available to Swap 
The Replacement Fixtures/Fittings section contains a list of all equipment that could be 
used to replace the equipment in the floor plan. 

Defined Swaps 
This section of the dialog box contains a list of all the fixture swaps that have been 
defined. 
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Action Buttons 
The action buttons allow the user to execute the currently defined swaps, execute the 
currently defined swaps and exit, and cancel the currently defined swaps and exit. 

Status Bar 
The status bar gives information in the number of objects found in the drawing, and the 
number selected. 

Fixture Swap – The Fixture Swap Filters 
Filters are available to reduce the number of fixtures displayed for selection in the 
Selected Fixtures/Fittings and Replacement/Fixtures/Fittings frames of the Fixture 
Swap dialog box. They can be activated by clicking on the arrow head by each column of 
data. 

 
This will bring up a drop down menu with a number of options. 
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� Selecting Show All will remove the filters and show all rows of data. 
� Selecting Custom Filter will bring up a custom filter allowing Boolean operations 

on the data (see below). 
� Selecting Blanks will reduce the data to those rows that have blank values in that 

column. 
� Selecting Non-Blanks will reduce the data to those rows that have a value in that 

column. 
In addition, the lower part of the drop down menu contains a list of the individual items 
of data in that column. Clicking an item reduces the rows to that item of data. 

Custom Filters 
The custom filter option is invoked from the filter drop down menu. 

 
It enables users to use Boolean logic. In the above example (with numerical data 
selected), the lengths will be filtered to find all fixtures with lengths between 36 and 48 
inches. (This filtering logic also applied to Date values). 
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Condition Description 

Equals Values must be exact: for example select all rows with a value of 48 

Does Not 
Equal 

Values will exclude that value: for example select all rows that do 
not have a value of 48. 

Greater Than Selects all values above a specific value: for example Greater Than 
48 will return 49, 50, 51, etc. 

Less Than Selects all values below a specific value: for example Less Than 36 
will return 35, 34, 33, etc. 

Greater Than 
or Equal 

Selects all values equal to or above a specific value: for example 
Greater Than or Equal to 48 will return 48, 49, 50, etc. 

Less Than or 
Equal 

Selects all values equal to or below a specific value: for example Less 
Than or Equal to 36 will return 36, 37, 38, etc.  

 
If a text value is selected, a different set of Boolean logic applies 

Condition Description 

Equals Values must be exact: will return rows that are an exact match for the 
entered text. 

Does Not 
Equal 

Values will exclude that value: will return rows that do not match 
the text string 

Contains Will return rows where part of the data matches the text string. (Uses 
implied wild cards). 

Does Not 
Contain 

Will return rows where no part of the data matches the text string. 
(Uses implied wild cards). 

Begins With Will return rows where the text string is an exact match for the start 
of the data.  

Does Not 
Begin With 

Will return rows where the text string is an exact match for the end 
of the data.  

Ends With Will return rows there the text string is not an exact match for the 
start of the data.  

Does Not 
End With 

Will return rows there the text string is not an exact match for the 
end of the data.  

 
Boolean logic also includes the use of And or Or. 
� And means that both conditions must be met. A and B means the data returned 

must contain both A and B. 
� Or means either condition can be met. A or B means the data returned can 

contain either A or B. It does not need to contain both. 
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Mirroring and Clearing Filters 

 
1. Mirroring Filters 
The Selected Fixtures/Fittings and Replacement Fixtures/fittings frames contain 
identical columns. If a filter is set in (for example) the Fixture Length column in the 
Selected Fixtures/Fittings frame, clicking Mirror Filter will also set that filter in the 
Replacement Fixtures/fittings frame. (The reverse case also applies). 
2. Clearing Filters 
Clicking the Clear Filters icon will clear all the filters set in the Fixture Swap dialog box. 

Fixture Swap – Other Data Manipulation Options 
There are two other ways data can be ordered in the dialog box. 

Selecting Columns to Display 
Right clicking on the column header area in either the Selected Fixtures Fitting or the 
replacement Fixtures/fittings frames allows the users to select which columns of data are 
displayed. 

 

Note: Block Name and Block Type are mandatory columns 
and cannot be deselected. 

Sorting Columns of Data 
Columns of data can be sorted in ascending or descending order by clicking the header. 
When the data in a column has been sorted, a small triangle will appear in the header - 
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the direction of the triangle indicating whether the data is sorted ascending or 
descending. 

 
In the above example, the Width column has been sorted in ascending order.  

Note: the Width column can be compared to the Length 
column, where data has not been sorted. 

Fixture Swap – Carrying Out Fixture Swaps 
Carrying out Fixture Swaps is achieved as follows: 
1. The Fixtures are selected  

 
2. Fixture Swap is called 
This can be done from the Command Line (AVT_FIXTURESWAP) or from the Fixturing 
toolbar. 

 

Note: Selecting the Fixtures and Invoking Fixture Swap can 
be done in either order. 
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3. The Fixture Swap dialog box will open 
When the Fixture Swap dialog box opens, only the Selected Fixtures/Fittings list of data 
is populated. Filters can be used to refine the list. 

 
4. Select the Fixture or Fitting to be replaced 
The fixture or fitting to be replaced is selected in the list of Fixtures and fittings. This 
causes the list of replacement fixtures and fittings to populate. 

 
It is possible to select multiple fixtures for replacement by holding down the Control Key 
and left clicking on additional rows. 
5. Select the Replacement Fixture or Fitting 
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A replacement fixture or fitting is selected. (Filters can be used to refine the list of 
available replacements). Clicking the Add Swap Pairs button causes the Swap Pairs pane 
to populate. 
One a fixture has been added to a swap pair, the entry will be removed from the top 
(Selected Fixtures/Fittings) frame to prevent multiple swap types being defined for that 
fixture. If the swap pair is subsequently deleted, the fixture will be added back to those in 
the Selected Fixtures/Fittings frame. 

 
6. Make the Swap 
Click the Apply button to cause all the defined swaps to execute and leave the dialog box 
open to define further swaps. Click the OK button to make all the defined swaps and exit 
the dialog box.- 

Fixture Swap – Limitations of Fixture Swap 
The Fixture Swap functionality is useful for making large scale changes to equipment 
within a store plan, but there are some limitations on what it can achieve. These 
limitations are explained below. 

Size and Type 
Fixture Swap does not place any restrictions on the size of the equipment that can be 
swapped. In the example below, the back gondola run is the original gondola. The 
middle gondola run represents what would happen if 4 foot long fixtures were replaced 
by 3 ft long ones. The front gondola run shows what would happen if fixtures are 
replaced by inappropriate ones: in this instance racking has been replaced by freezer 
units.  
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Effect of Planograms 
If exploded (3D) planograms have been placed on fixtures in Merchandiser, they will not 
be visible in Planner. However, as the information is held in the database on what 
fixtures do contain exploded planograms, fixture swaps will not be carried out on those 
fixtures.  
In the example below, the back gondola run has two planograms. The fixtures containing 
these planograms have been color coded yellow in this diagram. It would not be 
immediately apparent to a user in Planner that these fixtures contain planograms because 
they will not contain product blocks - unlike if the planogram was in 2D (imploded) 
form. 

 
If the fixtures are selected for a fixture swap operation, only the fixture that does not 
have a planogram placed will be swapped, despite all fixtures being included in the 
selection. The effect of this can be seen in the front gondola run. The user will be given a 
warning in the AutoCAD command line - although the fixtures containing planograms 
are not identified. 
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Note: one solution for this limitation is to create a KPI (Key 
Performance Indicator) to color code all fixtures containing 
planograms. It is then possible to determine which 
planograms are not merchandised (and which can be 
subjected for Fixture Swap) and which are merchandised 
and cannot be swapped. 

Effect on Planograms 
If planograms are present as placeholders (2D form), they are visible in the Planner 
module. If a fixture is swapped for one of a different size, the planogram placeholder is 
scaled to suit. However, the planogram design is not changed. In the example below, the 
rear gondola run has the planogram placed on a fixture of the intended size. In the front 
planogram run, the correctly sized fixture has been swapped for one that is both higher 
and wider. 

 
The effect of this can be seen when the planogram is viewed in exploded (3D) form in the 
merchandiser module. As can be seen in the example below, both the shelving and 
merchandise fail to correctly fill the larger fixture that was swapped in. 



Gondolas in Planner – Overview 

340 Store Planning User Guide 

 
When swapping fixtures, it may be necessary to subsequently swap the existing 
planograms for ones of a more appropriate size for the replacement fixture.   

Note: planograms on inappropriately sized fixtures can be 
identified by means of KPI's and Reports. 

Gondolas in Planner – Overview  

Overview of Placing Gondolas 
Gondola placement is in two stages; gondola selection and gondola insertion.  

Gondola Selection 
Gondolas are selected from the hierarchical tree in the Fixturing Tab.  
(The Gondolas button has to be selected to show the gondola hierarchical tree). 
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Gondola Insertion 
Once the Gondola has been selected in the hierarchical tree it can be placed in the 
drawing in one of two ways: the required gondola can be dragged and dropped in the 
AutoCAD drawing, or the Add Gondola icon can be clicked on the toolbar.  
 

 
Add 
Gondola 

 
After selecting an insertion point, the Gondola Run dialogue box will come up. This will 
allow the gondola run being placed to be customized. 

 

The Gondola Insertion dialogue box 
The Gondola Run dialogue box will appear after the start point for the gondola run has 
been selected.  
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The exact form of the dialogue box that appears will depend on how the Gondola was 
specified.  

Note: Gondolas are specified in Fixture studio. 

Dimensions 
The available dimensions are specified in the Gondola Sizes dialogue box. 

 

Gondola Parts and Positions 
Gondola parts and positions are specified in the Gondola definition dialogue box. 
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Gondola Dimensions 
The Dimensions displays a list of sizes that can be selected for that particular gondola.  

 
The number of dimensions displayed is determined by those specified in the Gondola 
Definition dialogue box in Fixture Studio. The actual dimensions available are defined in 
the Gondola Size dialogue box in Fixture Studio.  
Dimensions can either be selected from the available list, or selected using the Match 
button.  
Clicking on the Match button will temporarily hide the dialogue box and take the user to 
the drawing. The user will be prompted to measure a distance on the drawing. The 
Gondola Run dialogue box will then be re-displayed with the dimension closest to that 
measured highlighted.  
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Note: Adding a gondola requires the blocks corresponding 
to the chosen combination of sizes to be present in the 
database. If a block is not present, the gondola cannot be 
drawn and an error message will result.  

 

The Options Frame 
The Options Frame displays a list of parts that are optional for that particular gondola.  

 
Ticking the appropriate check box will ensure the optional parts are included in the 
gondola when it is placed in the drawing.  

Note: Optional parts are specified in the Gondola Definition 
dialogue box in Fixture Studio. 
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The Row Frame 
The Row Frame allows the number of bays, placement angle, start position, etc, to be 
specified.  

 
Number can be any integer greater than 0. This number can be changed using the spin 
control. 

Note: The maximum number of bays permissible may be 
restricted by settings in Fixture Studio. 
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If the user clicks on the Measure button, they will be prompted to pick a second point in 
the Planner drawing. This point will be relative to the previously selected insertion point 
of the gondola.  
The distance between the two points will determine the length of the gondola run, as 
well as its direction. Based on the length of the gondola run, Macro Space Management 
will calculate the number of full bays that will fit into the measured distance. 

Note: The distance occupied by the number of full bays will 
often be less than the distance measured. To add another 
bay, tick the Extend option. 

End caps will be additional to the number of bays calculated using measure.  
The software will also return a calculated angle based on the displacement between the 
two points. (Angle is measured in degrees from East anticlockwise).  
Alternatively, an angle can be input.  
Start Position determines whether the specified number of bays is added to the left or 
right of the insertion point.  

Note: The direction bays will be added in is also dependent 
on the insertion angle. A gondola with an insertion angle of 
180 degrees will be facing in a different direction to a 
gondola an insertion angle of 0 degrees. 

The Extend option is primarily of use when placing island gondolas, (i.e. away from 
walls). The number of bays calculated is normally less in length than the measured 
distance. 
The Best Fit option is only enabled if the length dimension on the gondola definition 
contains more than one size. It is primarily of use when placing a run of gondolas against 
a wall. 
It will use the selected length of the gondola for all but one fixture. The program will 
then select an extension piece of the best practical length to fill the remaining space.  
The Extend option will only be available if the Best Fit option has been enabled.  
A drop down list enables the user to decide whether to place the extension piece at the 
start of the gondola run, in the middle, or at the end.  

Completing Insertion 
Insertion is completed by clicking on the OK button at the bottom of the Gondola Run 
dialogue box. 
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Alternatively, the insertion can be aborted by means of the Cancel button. 

Note: Adding a gondola requires the blocks corresponding 
to the chosen combination of sizes to be present in the 
database. If a block is not present, the gondola cannot be 
drawn and an error message will result.  

 

Gondolas in Planner – Object Browser 

The Gondolas Toolbar 
The Gondolas tool bar is found on the Object Browser. It is selected by clicking on 
Gondolas in the Fixturing window. 
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It contains a series of icons allowing various operations to be carried out on Fixtures. 
Some may be grayed out if they are not available for that operation.  

 
Add Gondola 

 
Edit Gondola 

 
Delete Gondola 

Not available for 
Gondolas 

Highlight selected item in view  

Not available for 
Gondolas 

Highlight selected item in tree 

Not available for 
Gondolas 

Search 

Not available for 
Gondolas 

Configuration Options 

 
Refresh 

 
Attributes 

 
Promotional Fixtures On or Off 

Highlighting Selected Item in View 
Highlight Selected Item in View is only available in the fixtures toolbar and is grayed 
out in the Gondolas toolbar.  

 

Highlighting Selected Item in Tree 
Highlight Selected Item in Tree is only available in the Fixtures toolbar and is grayed 
out in the Gondolas toolbar.  
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Using the Search Function 
Find is only available in the fixtures toolbar and is grayed out in the Gondolas toolbar.  

 

Gondola Options 
Fixture options are invoked by clicking on the Options icon in the fixturing toolbar.  

 
This will take the user to the Fixturing tab on the Configuration Module, enabling 
changes to be made to placement options, connection points, etc.  
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(See section on the Configuration Module for more information). 

Refreshing 
The Refresh option refreshes both Fixtures and Gondola information in the respective 
hierarchical trees. 

 
Clicking on the Refresh button in the Fixturing tab will load the latest fixture information 
from the database into the Fixture hierarchy. At the same time, it will load the latest 
gondola information from the database into the Gondola Hierarchy. 
(This refreshing will operate irrespective of whether the Object Browser is used either in 
the Planner or Merchandiser environment).  
Dragging and dropping a fixture from the appropriate hierarchy after the refresh button 
has been pressed will add that fixture to the drawing using the latest definition from 
Fixture Studio. Similarly, using the Add button will also add a fixture to the drawing 
using the latest definition from Fixture Studio. 
If a drawing is already open then fixtures already placed in the drawing will not use any 
changes loaded during the refresh operation until the drawing is closed and reopened. 
However, new fixtures added to the open drawing will use the new data. 

Gondola Attributes 
Attributes only apply to fixtures. 

 
 
To get information in individual fixtures within a gondola, select the required fixtures 
within the gondola and click on the attributes icon. 

Promotional Fixtures 
Promotional Fixtures can be assigned by selecting a fixture or fixtures and clicking on the 
Fixture Attribute icon in the toolbar. 
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Promotional Fixtures are normally used for reporting purposes.  
They are assigned by selecting a fixture then selecting the appropriate option from the 
pull down menu. 

 
Fixtures designated as Promotional can be identified by running a report on the drawing 
or by using a KPI. 

Gondolas in Planner – Editing and Deleting 

Overview of Editing Gondolas using MSM AutoCAD tools 
Gondolas can be edited using AutoCAD tools. These can be accessed from the Modify > 
General drop down menu options.  

 
This allows objects to be Erased, Moved or Rotated. 

Moving Gondolas 
Gondolas can be moved by selecting the Move option from the Modify pull down Menu. 
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This will bring up a small prompt asking the user to select the gondolas to be moved.  

 
Any objects selected will change from solid to dotted lines.  

 
Right clicking completes the selection process. 
The use will then be asked to specify a base point. 

 
Following specification of a base point, the user will be prompted to specify a second 
point. 

 
In both cases the points can be specified either by left clicking, or by typing in the X and 
Y coordinates.  
The two points specified define a vector. This indicates how far and in what direction the 
selected fixtures are to be moved. 

Note: Using MSM AutoCAD tools changes the drawing, 
without the changes being recorded in the central Macro 
Space Management database. Run Synchronize then 
Adjacencies to ensure the central database contains the 
effects of all MSM AutoCAD changes.  

Rotating Gondolas 
To rotate a Gondola select the Rotate option from the Modify pull down menu. 
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This will bring up a small prompt asking the user to select the Fixtures to be rotated.  

 
Any objects selected will change from solid to dotted lines.  

 
Right clicking completes the selection process. 
 
The use will then be asked to specify a base point. The point can be specified either by 
left clicking, or by typing in the X and Y coordinates.  

 
Following this the user will be invited to specify a rotation angle. 

 
 
The rotation angle can be specified by typing it in. Alternatively, the mouse cursor can be 
used to draw a line at the required angle.  
Left clicking will cause the specified objects to be rotated.  

Note: Using AutoCAD tools changes the drawing, without 
the changes being recorded in the central Macro Space 
Management database. Run Synchronize then Adjacencies to 
ensure the central database contains the effects of all 
AutoCAD changes.  
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Erasing Gondolas 
To erase a gondola select the Erase option from the Modify pull down menu. 

 
This will bring up a small prompt asking the user to select the gondolas to be erased.  

 
Any objects selected will change from solid to dotted lines.  

 
Right clicking completes the selection process – which will cause the selected objects to 
be removed from the drawing.  

Note: Using AutoCAD tools changes the drawing, without 
the changes being recorded in the central Macro Space 
Management database. Run Synchronize then Adjacencies to 
ensure the central database contains the effects of all 
AutoCAD changes.  

Undoing Changes 
Moved, Rotated or Erased gondolas can generally be restored to their original position by 
making use of the Undo command on the MSM AutoCAD Toolbar  

 

Note: Using AutoCAD tools changes the drawing, without 
the changes being recorded in the central Macro Space 
Management database. Run Synchronize then Adjacencies to 
ensure the central database contains the effects of all 
AutoCAD changes.  

Overview of Editing Gondolas using Fixture Studio 
Fixture Studio allows the properties of a gondola to be edited.  
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It is accessed from the Planner by clicking on the Edit Gondola icon on the Fixturing tool 
bar.  

 
While in Fixture Studio a wide range of properties for the selected gondola can be 
customized. These include: 
� Sizes 
� Fixture Positions 
� Whether parts are optional or not 

Changes made to a Gondola while in Fixture Studio will affect further placements of that 
type.  

The Fixture Studio Window 
The Fixture Studio window contains several parts.  

 
On the left is a hierarchical tree of all the available fixtures, while on the right is are 
windows allowing the block details of the currently selected fixture, fitting or gondola to 
be customized.  
(See the Fixture Studio help file for more information). 
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Deleting Gondolas 
Gondolas can only be deleted using AutoCAD tools as the Delete Gondola option is 
grayed out and unavailable in the Gondolas toolbar. 

 

Note: After using AutoCAD tools, the drawing must be 
synchronized so that the changes are written to the central 
Macro Space Management database. 

Bay Numbering in Planner - Overview 

Overview of Bay Numbering and Bay Groups 
Bay numbering allows each fixture within the drawing to be assigned a unique 
identification code for reporting and identification purposes.  

 
Bay numbering can either be fixture or gondola based.  
Fixture based bay numbering numbers each fixture in an incremental sequence starting 
from a designated number.  
Gondola based bay numbering numbers fixtures within a gondola with a four part 
sequential code unique to the drawing.  
Before Bay Numbering can be carried out, the Synchronization module must be run to 
ensure the information from the drawing has been fully transferred to Macro Space 
Management’s central database.  
Following this, the Adjacency option must be run so the central database has up to date 
information on which fixture is next to which fixture.  
Bay Groups are where two or more fixtures have been linked together for bay 
numbering purposes.  

 
Bay Groups can contain any number of fixtures, but care should be exercised in using 
this feature. The Bay Number will appear in the geometric center of the selected fixtures, 
causing it to appear in an unpredictable place if the fixtures selected occupy too wide an 
area. 
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Preparations – Before Bay Numbering 

Synchronization 
To synchronize the drawing, select the Synchronize option from the File menu or from 
the toolbar. This will bring up the Synchronize dialog box. 

 
In the Synchronize dialog box, select the Match the Drawing option (under the Action 
section), Fixtures, Other Blocks, and Zones check boxes (under the Items to Synchronize 
section), and then click the Synchronize button. 

Fixture Adjacency 
Fixture Adjacency is used by the Planner application to calculate the fixtures that are 
adjacent to each other. If they are within a specified distance (usually just a few mm), 
they are treated as part of a gondola; otherwise they are treated as individual fixtures. If 
fixture adjacency is not run, then fixtures may have bay numbers in an odd sequence. 
To run Fixture Adjacency, select the Calculate Fixture Adjacencies option from the 
Calculations menu or toolbar.  
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About Bay Numbering 
Before Bay Numbering can be carried out the Synchronization module must be run to 
ensure the information from the drawing has been fully transferred to Macro Space 
Management’s Central database. 
Following this, the Adjacency option must be run so the central database has up to date 
information on which fixture is next to which fixture.  
Bay numbering then allows each fixture within the drawing to be assigned a unique 
identification code for reporting and identification purposes.  

 

Accessing the Bay Numbering Options 
Bay numbering is accessed from the view pull down menu. 
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This brings up the Bay Sequence Numbering dialogue box. 

 

Example of Adding Basic Bay Numbering 
To add basic bay numbering: 
1. Select the Bay Numbering option from the Insert menu or from the toolbar.  The Bay 

Sequence Numbering dialog box appears. 
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The Bay Sequence Numbering dialog box has the following sections: 
� Select Bays section allows users to select the bays that will be numbered (or have 

the numbers removed).  Within the Select Bays frame, the Direction area specifies 
the direction bay numbering will operate in. 

� Group section controls the Notation that will be added.  
� Action section determines what form of labeling will be applied. 

2. In the Select Bays frame, ensure that the following options are selected: 
� Add radio button 
�  Use Adjacencies check box 
� Sort Bays check box 
� In the Direction area, Left to Right radio button 

3. Click the All Bays button. This will select all fixtures in the drawing. 
4.  In the Group frame, set the following options: 
� Give the selected fixtures a collective name by typing it in the Name text box.  
� Add a prefix in the Prefix text box. This will be added to all the bay numbers. 
� Select the Start number in the Start drop down list. The bay numbering will start 

from this value. 
� Select the shape of the block from the Label Block drop down list. 
� Select the color of the text from the Color dialog box. 

5.  In the Action frame, click the Add button. 
The Bay Numbers will then be added. 
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Advanced Bay Numbering 

About Advanced Bay Numbering 
There are several ways of carrying out more advanced bay numbering. This example 
uses a Fence selection method to select both the fixtures to be bay numbered and the 
sequence they are to be numbered in.  

 

The Bay Numbers on the top (S1 – S10) were numbered in the usual manner and run in 
sequence up and down the selected bays of the gondola.  
The Bay Numbers in the center (F1 – F10) were numbered using a fence and can be 
precisely controlled as to the sequence they number in.  
The Gondola on the bottom shows the path of the fence used to select the sequence the 
fixtures were numbered in. 

 Bay Numbering with a Fence 
To bay number using a fence: 
1. From the View menu, launch the Bay Sequence Numbering dialog box.  
2. In the Select Bays frame, select the Add Radio button, and ensure the Use 

Adjacencies and Sort Bays check boxes are cleared. 

Note: If the Use Adjacencies check box is not cleared, the 
fence method will not work. 
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3.  In the Group frame, set the following options 
� In the Name field, type in the required name for the group of fixtures to be 

selected. 
� In the Prefix field, type in the Prefix that will precede the bay numbers. 
� In the Start drop down list, set the Start Number for the numbering. 
� In the Label Block drop down list, select the shape of the Label Block that will be 

used for bay numbering 
� In the Color dialog box, select the color for the bay numbering text. 

 In the Select Bays frame, click the Select Bays button. The cursor will appear in the 
drawing.  
4. Type in Fence and then press ENTER. 

 

5.  A Prompt appears next to the cursor to specify the first fence point. Left click to set 
it. 
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6. Continue to draw the fence by clicking to set successive points.  

 

Note: It is important for the fence line to start and finish 
outside the fixtures to be selected. If the fence line starts 
inside a fixture, the numbering of that and the next fixture 
might become confused. 

7. When all the points in the fence have been drawn, press ENTER until the Bay 
Sequence Numbering dialog box reappears. 
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8. In the Group frame, select the Labeling radio button, and click the Add button in the 
Action frame. The selected bays will then be numbered. 

 

The above figure shows the bays numbered in the sequence specified by the fence. 

Removing Bay Numbering 
Removing bay numbering is the reverse of adding it. To remove bay numbering: 

 
1. From the Insert menu, select the Bay Numbering option. This will bring up the Bay 

Sequence Numbering dialog box. 
2. To remove the bay numbering, click the Select Bays button to have bay numbering 

removed from specific bays, or select the All Bays button to remove bay numbering 
from all bays. 

3. Click the Remove button, and Bay Numbering will be removed. 

Bay Numbering in Planner – Dialog Box 

The Select Bays Frame  
The Select Bays frame gives a series of options as to how to select fixtures for bay 
numbering. 
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The Add or Remove radio buttons determine whether fixtures are added or removed 
from the list of those selected for Bay Numbering. The number selected is shown 
immediately below. 
Clear Selection removes all fixtures from the list of those selected.  
Preview shows the fixtures selected for bay numbering – these will briefly blink on the 
drawing.  
Select Bays >> enables the user to select fixtures from the drawing by use of the mouse. 
Multiple selections can be made by using AutoCAD selection techniques. The selected 
bays will flash three times. 
By Bay Run enables the user to select gondolas for Bay numbering. The user is returned 
to the drawing to select a gondola by left clicking on it with the mouse. A small dialogue 
box will appear. 

 
If the Whole Run option is selected, every fixture in the gondola will be selected.  
If the whole run is not included, then only part of the gondola will be included; the user 
being asked to specify a stop position. This option should only be used by Macro Space 
Management users who understand the numbering sequence within gondolas.  
This option may also be used to select fixtures that have been placed individually. The 
selected bays will flash three times. 
By Group enables fixtures to be selected that have already been designated as belonging 
to a Group. The selected bays will flash three times. 
All Bays selects all fixtures on the drawing. 
Unlabeled Bays selects all fixtures that have not been allocated a bay number. 
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Sort Bays when checked causes fixtures to be numbered according to the adjacency rules. 
It will be grayed out unless the Sort Adjacencies option is checked. If Sort Bays is 
checked, the Direction radio buttons become available, allowing the user to select the 
numbering direction.  
If Sort Bays is unchecked, then fixtures can be numbered using the sequence defined by a 
user specified AutoCAD fence. 

The Group Frame 
The Group frame enables users to specify a number of options concerning Bay 
Numbering.  

 
Name enables a specified selection of fixtures to be given a collective name. This must be 
entered prior to labeling the selected fixtures.  
For example a group of fixtures designated for electrical sales might simply be named 
Electrical. Whenever this group is selected in the future, all fixtures that were designated 
as part of it will be selected. 
Prefix is added to any bay number as it is applied. For example choosing a prefix of E- 
will result in all selected fixtures being labeled E-1, E-2, E-3, etc. Prefixes are useful for 
giving visual indication that a fixture belongs to a specific group. 
Start specifies the number at which bay numbering is to commence. This is important 
where grouping has been used, as it enables overlapping ranges of bay numbers to be 
avoided. 
Label Block brings up a list of label blocks. These will enclose the actual bay numbers. 

 
For example, choosing ref-elps will enclose all bay numbers in an elliptical shape. 
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Color enables bay numbers to be assigned a color. Clicking on the button with the ellipsis 
will bring up a color pallet.  

 
The selected color will then be applied to all selected bays.  

 
This is useful for color coding bays assigned to different groups.  
The Labeling and Gondola Numbering buttons allow users to select whether Bay or 
Gondola numbering is used. (Gondola numbering uses a slightly different logic from Bay 
Numbering). 

The Action Frame 
The Action Frame completes the bay numbering process.  
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Add adds numbering to any selected fixtures. 
Remove removes any existing numbers from any selected fixtures. 
Exit enables the user to leave the bay numbering routine, having completed all required 
actions. 

Accessing the Bay Groups option 
The Bay Group options can be accessed from the Modify option on the menu bar 
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They can also be accessed from the Bay Numbering toolbar. 

 
Group Bays allows the user to select fixtures to group together a number of fixtures into 
a single bay. 
Clear Bay Group converts grouped fixtures back into fixtures that will receive individual 
bay numbers. 
Select Bay Group causes other members of a bay group to be highlighted when an 
individual fixture within the bay group is selected. 

Making Fixtures into Bay Groups 
To make Bay Groups from fixtures:  
1.  From the Modify menu under the Blocks submenu, click the Group Bays option. 

Alternatively use the Group Bays option from the Bay Numbering toolbar. 
A prompt appears next to the cursor to select the required fixtures. 

 
2. Select the objects by means of selection windows, left clicking on the required 

fixtures, or by a fence. Complete the selection by a right click. The selected Bay 
Group will be numbered as such when the fixtures are bay numbered. 

 
In the above example, there are a number of normally numbered bays, and four Grouped 
Bays. (Note how the Grouped bays have a master bay number and sub-bay numbers). 

Removing Bay Groups 
To remove fixtures in a bay group: 
3. Select the Remove Bay Group option from the Modify menu or Bay Numbering 

toolbar. 
4. A prompt appears next to the cursor to select the blocks to remove from the group. 
5.  Select a block from the bay group. All the blocks of the bay group are selected. 

 



Merchandise in Planner – Object Browser 

370 Store Planning User Guide 

6. On right clicking to complete the selection, the blocks will be removed from the 
group. 

Showing Bay Groups 
To show all the fixtures in a bay group: 
1. Select the Show Bay Group option from the Bay Numbering toolbar or the Modify 

menu. 
A prompt appears next to the cursor to select a block. 

 
Select a Block Prompt 

2. Select any block in the bay group and the other blocks will also be selected. 

 

 Merchandise in Planner – Object Browser 

Overview of Merchandising on the Object Browser 
Clicking on the Merchandising Tab on the Object Browser brings up a series of options 
for adding, editing and deleting Products and Planograms.  
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The Product Toolbar 
The Product toolbar is found on the Merchandising Tab of the Object Browser. It is active 
when the Product button is selected.  

 
It contains a series of icons allowing various operations to be carried out on Products. 

 

 

Add to Selected Fixture 

 

 

Edit Definition 

 

 

Remove from Fixture 

 

 

Move between Fixtures 
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Highlight where used in store 

 

 

Highlight Selected Item in Tree 

 

 

Find Product or Planogram 

 

 

Show Merchandising Options 

 

 

Refresh 

The Planogram Toolbar 
The Planogram toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Planogram button is selected.  

 
It contains a series of icons allowing various operations to be carried out on Planograms. 

 

 

Add to Selected Fixture 

Not 
available 
for 
Planograms 

 

Edit Definition 

 

 

Remove from Fixture 

 

 

Reverse Planogram Placement 
Direction 

 

 

Highlight where used in store 

 

 

Highlight Selected Item in 
Tree 

 

 

Find Product or Planogram 

 

 

Show Merchandising Options 

 

 

Refresh 
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The Merchandising Hierarchy Window 
The Merchandising window shows a hierarchical tree of all the available products or 
planograms.  

 
The tree can be expanded or contracted by clicking on the + or – icons.  
The Merchandising window can be minimized by clicking on the splitter bar. 

 
The Products or Planograms buttons immediately above the window determine whether 
the hierarchical tree shows products or planograms. 
The Products hierarchical tree can be configured in Product Studio using the Add 
Product, Edit and Delete options on the menu available by right clicking.  

 
The Planograms hierarchical tree can be configured in the Merchandiser module using 
the Add, Edit and Delete options on the menu available by right clicking.  
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The Properties Window 
The Properties Window will show the properties for the currently selected product or 
planogram. 

 
The Properties window can be minimized by clicking on the splitter bar. 

 

The Summary Window 
The Summary Window will show a user defined list of products or planograms placed in 
the drawing. 
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Clicking on a column heading will re-order that column. Clicking again will reverse the 
sort order.  
The Summary window can be minimized by clicking on the splitter bar. 

 

The Preview Window 
The Preview Window shows an image of the product or planogram selected in the 
hierarchical tree.  

 
The window can be resized in the horizontal plane by dragging the edge of the Object 
Browser with the mouse. It can be resized in the vertical plane by dragging the bottom of 
the window with the mouse.  
The Preview window can be minimized by clicking on the splitter bar. 

 

Highlight Where Used in Store 
The Highlight where used in Store icon enables products or planograms selected from 
the appropriate hierarchical tree to be highlighted on the drawing.  

 
This is a feature that can be toggled On or Off. To toggle the option on, click on the icon. 
This will show as depressed on the toolbar. To toggled the option off, click on the icon 
again. It will no longer be depressed.  

Note: It is recommended this option be only selected when 
required. When activated, (toggled on), it takes up 
processing capacity. Leaving this option toggled on when 
not required will slow other operations. 

To highlight a product or planogram find the required item in the hierarchical tree and 
click on it. The item will then be highlighted in the drawing – the exact method of 
highlighting depending in the options selected in the Configuration Module. 

Highlight Selected Item from Tree 
The Highlight Selected Item from Tree option enables products or planograms selected 
from the appropriate hierarchical tree to be highlighted when they are selected in the 
drawing.  
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This is a feature that can be toggled On or Off. To toggle the option on, click on the icon. 
This will show as depressed on the toolbar. To toggled the option off, click on the icon 
again. It will no longer be depressed.  

Note: It is recommended this option be only selected when 
required. When activated, (toggled on), it takes up 
processing capacity. Leaving this option toggled on when 
not required will slow other operations. 

To highlight a product or planogram find the required item in the drawing and click on 
it. The item will then be highlighted in the hierarchical tree – the exact method of 
highlighting depending in the options selected in the Configuration Module. 

Find Product or Planogram 
The Find Product or Planogram function is invoked by clicking on the Search icon in the 
Merchandising toolbar.  

 
This will bring up the Find Product (or Find Planogram) dialog box. 

 
This is used by typing the required search string into the Find box and clicking the 
Search icon to the right of it.  

 
This will bring up a list of any blocks matching the search string.  
Left clicking on any result will return the user to the Merchandising Products Window, 
where the selected Product or Planogram will be highlighted in the hierarchy tree.  
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Configuration Options 
The Merchandising Tab in the Configuration Module can be called by clicking on the 
Configuration icon on the Merchandising toolbar. The options in this Tab are more fully 
explained in the section in the Configuration Module. 

 
This will bring up the Merchandising Tab from the Configuration Module. 

 

Editing Product Definitions 
Clicking on the Edit Definitions Icon in the Products toolbar opens Product Studio.  

 
(If Product Studio is already open, it will be made the active window). The currently 
selected product will then be presented for editing. 
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Note: The Product Studio dialogue box that opens will 
depend on what level in the product hierarchy has been 
selected. 

Once changes have been made and saved, they can be used within Merchandising after 
the Refresh option has been used on the Object Browser. 

Editing Planogram Definitions 
To Edit a Planogram, highlight the required planogram in the hierarchy and right click to 
bring up the pop-up menu. 
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 (If the merchandiser module is already open, it will be made the active window). The 
currently selected Planogram will then be presented for editing. 

 
Once changes have been made and saved, they can be used within Merchandising after 
the Refresh option has been used on the Object Browser. 

The Refresh Option 
The Refresh Icon refreshes the both Planogram and Product information in the 
hierarchical tree.  

 
Using Refresh ensures that the information is brought up to date with any changes made 
in Merchandiser or Product Studio, both to the hierarchical tree and to any products or 
planograms added to, edited, or deleted from it.  

Merchandise in Planner – Adding Products or Planograms 

Overview of Adding Products or Planograms to Fixtures 
The flowchart below specifies the sequence of actions required to place Products or 
Planograms on Fixtures. 
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Actions in the Configuration Module 
� Specifying the Fixture Selection Method enables the user to choose how fixtures 

for population will be selected.  
� Specifying the Planogram Placement method enables the user to choose what 

options control how planograms place.  
� The options will be specific to the user.  

Actions in the Merchandising Module  
� Clicking on the appropriate button will toggle the user between the Product and 

Planogram hierarchical trees, allowing them to select the class of object to be 
placed.  

� The required Product or Planogram can then be found in the hierarchical tree. 
� The Fixture on which the Product or Planogram is to be placed is selected. 
� The Product or Planogram is placed.  
� If a planogram is placed, the user may receive one or more warnings if the 

selected fixtures do not match the details in the planogram definition. 
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� The user may chose to override the warnings, in which case the planogram will 
place. 

Selecting Whether to Add Products or Planograms 
Whether Products or Planograms are added will depend on whether the user has 
selected the Product or Planogram hierarchical tree.  

 
In the above example, the Planogram hierarchical tree has been selected. 

Selecting the Product or Planogram Required 
There are two ways of finding the Product or Planogram required for merchandising a 
fixture.  
1. The first is to select the required Product or Planogram directly from the hierarchical 

tree. 
2. This can be done by clicking on the + or – sign to expand or contract the hierarchical 

tree as required, then highlighting the required Product or Planogram.  

 

3. The second is to use the Find option in the merchandising toolbar.  
a. Typing the required search string into the Find Product dialogue box will bring 

up a list of any blocks matching the search string. Left clicking on any result will 
return the user to the Merchandising Window, where the selected Product or 
Planogram will be highlighted in the hierarchy tree.  
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b. When the required Product or Planogram has been found, it can be selected for 
insertion into the drawing in one of three ways: 

4. The Product or Planogram can be ‘dragged’ from the hierarchical tree and ‘dropped’ 
into the drawing.  

5. The Product or Planogram can be double clicked to activate it for insertion.  
6. The user can click on the Add Product or Add Planogram icons. 

 

Add Product to Selected 
Fixture 

 

Add Planogram to Selected 
Fixture 

Constraints on Products that can be Added 
Product Effective or Product Expired dates outside File Effective date 
When a drawing is created, Store Manager allows the user to set an effective date for 
when that file will become active. Products that have a Product Effective Date (when they 
become current) dated after the File Effective Date will not be capable of being added to 
that drawing. 
Products that have a Product Expired Date (when they become historical) dated before 
the File Effective Date will not be capable of being added to that drawing. This will 
prevent products that will not be current or will be historical at the date of 
implementation of the Store Plan being added to that drawing. 
Product that is not current for the active store plan will be grayed out in the Object 
Browser and the Object Grid. 

Note: If a file has not been given an effective date, all 
products will be available. If products are copied from one 
drawing to another, they will be placed in the drawing even 
if their product dates are not valid for this file. 

Note: This functionality does not apply to planograms, 
which have parallel mechanisms for version change and 
planogram substitution. 

Placed Products Expiring before File is Effective 
Placed products that have Product Expired Dates (dates when the product will revert to 
historical status) before the File Effective Date will be transparent and colored grey in the 
graphic for the Merchandise Report and Merchandising window. The row in the 
Merchandise Report that refers to the expired product will also be grayed. 
This will allow users to readily identify placed products that have become historical and 
need replacement. 

Selecting the Required Fixture(s)  
The exact method of selecting the required fixtures will depend on the settings within the 
Configuration Module.  
Pick Near Position selects the nearest position from a range of fixtures previously 
selected using Macro Space Management tools.  
� If there is more than one bay to be placed, then the user will be prompted to pick 

another point to indicate the direction of placement.  
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� If one of the bays adjacent to the first selected fixture is already populated, that 
direction will automatically be excluded as a possibility and the opposite 
direction selected. 

� If both fixtures adjacent to the first selected fixture are already populated, the 
user will be prompted to select another bay – the process continuing until the 
whole planogram has been placed.  

The user can cancel the product or planogram placement at any time by pressing 
<Enter>, <Escape> or right clicking.  
Standard Select uses the standard Planner selection boxes to pick the fixture(s). If this 
method is used, Planner will filter by layer, eliminating any fixtures that are not on the 
required layer. It will then determine groups of runs from fixture adjacencies and start 
placement at the leftmost fixture. 
For all selection methods, selected fixtures will change from solid to dotted outlines, and 
the insertion point will show as a small blue square. 

 

Placing the Products or Planograms 
Once the required fixtures have been selected, together with the required products or 
planograms, clicking on the add product or add planogram icon will result in the 
fixture(s) being populated. 
 

 
Add Product to Selected 
Fixture 

 
Add Planogram to 
Selected Fixture 

 
The fixture(s) will also be annotated with the number and description of the product or 
planogram placed. 

 

Reverse Planogram Population Direction 
 

 

 

Reverse Planogram Placement 
Direction 

 

 

Reverse Planogram Placement 
Direction 
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Which option is currently active will depend on whether the user has selected Products 
or Planograms in the Merchandising hierarchical tree.  
When placing the planogram, it will reverse the order of the profiles, and within each 
profile, it will reverse the positions of the products. A left justified planogram will then 
be right justified, and vice versa. 

Removing Products or Planograms from Fixtures 
Products or planograms can be removed from fixtures using the remove icons. 

 
 
Remove Product from 
Fixture 

 
 
Remove Planogram 
from Fixture 

Which option is currently active will depend on whether the user has selected Products 
or Planograms in the Merchandising hierarchical tree.  
To remove a product or planogram select the fixtures from where they are going to be 
removed. When all required fixtures have been selected, click on the appropriate remove 
icon.  
If the Always show selection dialogue is enabled in the Merchandising Tab of the 
Configuration Module, then a dialogue box will always come up to confirm the items to 
be removed. If the Always show selection dialogue is not enabled, then the dialogue box 
will only come up if more than one fixture is selected. 

 

 
The number at the top of the dialogue box is the fixture number. 



Merchandise in Planner – Adding Products or Planograms 

Planner Module 385 

� Delete Bay and Delete Whole Planogram are mutually exclusive options selected 
by a radio button.  

� Delete Bay will remove the planogram from the selected bay only. Delete Whole 
Planogram will remove the planogram from all bays that it has been placed in.  

When the correct selection has been made, click on OK to remove the product or 
planogram, cancel to leave it in place. 
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Merchandise in Planner – Other Information 

Business Flows in Merchandising 
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For Macro Space Management to operate effectively, detailed information has to be input 
on the stores to be managed.  
The starting point is the Store Manager module. This allows stores to be organized into a 
logical structure. It also allows the individual stores to be sub-divided into floors.  
Details of the floors can then be imported into Macro Space Management as Planner 
drawings. These floors can be subdivided into Zones dedicated to sales of particular 
product lines.  
The Fixtures module within Macro Space Management then allows the detailed layouts of 
the floors to be planned (multiple plans for a floor within a store being administered by 
Store Manager).  
Each fixture can subsequently be populated by a predetermined quantity and 
arrangement of sales products using the Merchandising Tab on the Object Browser.  
Within the Merchandising Tab, Macro Space Management users can: 

  Select single or multiple bays to be populated with merchandise. 

  Quickly and efficiently select the required merchandise. 

  Substitute merchandise as required. 
The user can also see information on the effectiveness of the merchandising plan by 
switching to Merchandiser and looking at the Key Performance Indicators. 
After the floor has been merchandised, Macro Space Management Reports can be used to 
analyze and report on the effectiveness of the layout. These are available from the Report 
Studio standalone module.  

Product Studio 
Product Studio can be invoked using the Edit Definition option in the toolbar in the 
Merchandising Tab of the Object Browser. It is used to configure the product 
placeholders that can be placed in the Planner Module. 

 

 

Edit 
Definition 

Product Studio allows the design and editing of product images. These images can be 
arranged in a hierarchy and subsequently used to populate a store. Options within the 
module allow attributes to be assigned to each product, giving it intelligent properties. 
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Merchandiser 
Merchandiser can be invoked from the Edit Planogram option from the pop-up menu in 
the Object Browser.  

 
Merchandiser allows the planograms, and the fixtures on which they have been placed, 
to be viewed in a Virtual Reality (VR) 3D environment. Using the provided controls, the 
Macro Space Management user can ‘fly’ round the VR store. 
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Merchandiser is also used to design and edit planograms (and to place them in a 3D 
environment).  

 
Planograms can be designed in varying levels of detail. These planograms can be 
arranged in a hierarchy and subsequently used to populate a store.  

Planogram Placement Options 
The Configuration Module also contains a series of options concerning how planograms 
place. 
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Check Rules specify what warnings are given if the selected fixtures do not match the 
data specified in the planogram definition. 
Options allow the user to specify the tolerance allowed if the dimensions of the selected 
fixtures do not match that specified in the planogram definition. 
Placement Rules specify what will happen if the planogram is longer or shorter than the 
selected fixtures. 

Accessing the Configuration Options 
The Configuration options can be accessed by clicking on the Properties icon on the 
Merchandising toolbar. (This is available when either Products or Planograms are 
selected). 

 
This will bring up the Merchandising Tab from the Configuration Module. 
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System Variables Used in the Merchandising Tab 
There are six system variables that affect the Merchandising Tab: 
1. DEFAULT_MERCH_BLOCK specifies the block to be used as the default when 

populating fixtures in 2D in the Planner environment.  
2. FINGER_GAP specifies the practical tolerance to be allowed above products for 

placing those products on shelves. For example, if the vertical distance between 
shelves is 500 mm, a small gap has to be left for the stackers fingers when they place 
boxes, etc on that shelf.  

3. MERCH_DB_DETAIL specifies whether 2D, 3D or full 3D information should be 
saved to the DB (Merchandising). The more detail that is specified, the more data 
storage capacity will be required.  

4. MERCH_DWG_DETAIL specifies whether 2D, 3D or full 3D information should be 
saved to the drawing. Specifying more detail will result in larger drawing files.  

5. MERCH_TOLERANCE_OVER specifies how much larger a planogram can be 
relative to the nominal size of a fixture and still be placed.  

6. MERCH_TOLERANCE_UNDER specifies how much larger a planogram can be 
relative to the nominal size of a fixture and still be placed.  

Note: The MERCH_DB_DETAIL system variable should be 
defined during the implementation stage and not changed 
frequently. 

Note: Some of these system variables can be changed in both 
the Administration and Configuration Modules. 
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Selection Methods for adding Products or Planograms to Fixtures 
The Selection frame in the Merchandising Tab of the Configuration Module specifies a 
series of options determining how fixtures are selected for placement of Products or 
Planograms.  

 
Fixture Selection Mode is selected from a drop down list.  

 
� Pick Position Near selects the nearest position from a range of fixtures previously 

selected using Macro Space Management tools.  
� Standard Selection uses the standard Planner selection boxes to pick the 

fixture(s). 
Vertical Category Filter enables the user to select Planograms that have previously been 
assigned to a vertical category within an aliased layer.  
Always show selection dialogue permanently turns on the selection dialogue window 
when planograms are deleted. If this option is not enabled, then the dialogue will only 
show when multiple planograms are selected – single planograms will be deleted 
without the need for confirmation. 
Select whole planogram is used when a Planogram requires multiple bays to be placed. 
Highlight selected fixtures highlights fixtures previously selected using Macro Space 
Management tools. 
Sort left-most sorts selected fixtures in a left to right order. If this option is not enabled, 
then fixtures are selected in the order they were placed on the drawing.  
Product tooltip enables the type of tooltip to be selected from a drop down list.  



Annotation in Planner 

Planner Module 393 

 

Annotation in Planner 

About Annotation 
Annotation is used to label fixtures within the drawing as to what product or planogram 
has been placed.  

 
The number is the product or planogram identification code.  
Annotation also displays the name of the product or planogram. 
Products or planograms are annotated when placed, but the annotation requires 
refreshing when they are moved or deleted.  

Refreshing Annotation 
From the Modify menu, select the Text options. Use standard Planner techniques to select 
the required objects in the drawing. Right click to stop selecting objects. All selected 
objects will be re-annotated. 
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Configuring Annotation 
Annotation can be configured from using the Text Styles option within the 
Administration Module.  

Note: The Administration Module is only available to users 
with Administrator's privileges. 

 
Please consult Oracle technical support for advice on how to configure these options. 
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6 
Merchandiser Module 

Overview of Merchandiser 

Overview of Merchandiser 
Merchandiser can be used to create, edit and review 3D Virtual Reality Stores.  
Merchandiser integrates with other modules in Macro Space Management to enable the 
user to control all aspects of operating a retail organization.  
� Fixtures and fittings can be created and edited in Fixture Studio.  
� Similarly products can be created and edited in Product Studio.  
� Planograms can be either imported or created in Merchandiser.  

Merchandiser can then be used to add, edit or delete equipment in a 3D Virtual Reality 
store. Similarly, Merchandiser can be used to add edit or delete merchandise in a 3D 
Virtual Reality store.  
The results of these activities are stored in the Macro Space Planning database. 

 

Note: The Macro Space Planning database is also used by the 
Planner (AutoCAD) module, which provides an alternative 
way to create and edit store layouts. Macro Space 
Management users may therefore work in which 
environment they find most convenient as the results of 
activities in either environment are stored in the central 
database and are available to the other environment.  
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The Merchandiser Window 
The Merchandiser Window has six main parts.  

 
The Menu Bar gives access to a series of drop down menus that control many of the 
operations in Merchandiser. 
The Toolbars give access to a further series of commands. 
The Object Browser controls fixturing and merchandising operations, together with the 
display of KPI’s. 
The Object Grid provides an alternative way to place equipment and merchandise. 
The Graphics Window displays a 3D plan of the selected store. 
The Status Bar gives information on current operations. 

Merchandiser Components 
The varying operations within Merchandiser are controlled in one of four ways: from the 
Object Browser and Object Grid, from the Menu Bar, from the toolbars, or using the 
mouse and keyboard. 
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Merchandiser – Object Browser 

Overview of Merchandising on the Object Browser 
Clicking on the Merchandising Tab on the Object Browser brings up a series of options 
for adding, editing and deleting Planograms.  
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The Toolbar gives access to varying options concerning Planograms. 
Buttons allow users to swap between product or planogram operations. 
The Hierarchy Window allows users to see the list of available planograms. (The 
hierarchy showing will depend on which button is selected). 
The Properties Window gives details of the currently selected object. 
The Summary Window gives details of how many of the selected objects have been 
placed in the drawing. 
The Preview Window gives a preview of the selected product or planogram (if 
available). 

Highlight Selected Item from Tree 
The Highlight Selected Item from Tree option enables products or planograms selected 
from the appropriate hierarchical tree to be highlighted when they are selected in the 
drawing.  
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This is a feature that can be toggled On or Off. To toggle the option on, click on the icon. 
This will show as depressed on the toolbar. To toggled the option off, click on the icon 
again. It will no longer be depressed.  

Note: It is recommended this option be only selected when 
required. When activated, (toggled on), it takes up 
processing capacity. Leaving this option toggled on when 
not required will slow other operations. 

To highlight a product or planogram find the required item in the drawing and click on 
it. The item will then be highlighted in the hierarchical tree – the exact method of 
highlighting depending in the options selected in the Configuration Module. 

Highlight Where Used in Store 
The Highlight where used in Store icon enables products or planograms selected from 
the appropriate hierarchical tree to be highlighted on the drawing.  

 
This is a feature that can be toggled On or Off. To toggle the option on, click on the icon. 
This will show as depressed on the toolbar. To toggled the option off, click on the icon 
again. It will no longer be depressed.  

Note: It is recommended this option be only selected when 
required. When activated, (toggled on), it takes up 
processing capacity. Leaving this option toggled on when 
not required will slow other operations. 

To highlight a product or planogram find the required item in the hierarchical tree and 
click on it. The item will then be highlighted in the drawing – the exact method of 
highlighting depending in the options selected in the Configuration Module. 

Editing Product Definitions 
Clicking on the Edit Definitions Icon in the Products toolbar opens Product Studio.  
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(If Product Studio is already open, it will be made the active window). The currently 
selected product will then be presented for editing. 

 

Note: The Product Studio dialogue box that opens will 
depend on what level in the product hierarchy has been 
selected. 

Once changes have been made and saved, they can be used within Merchandising after 
the Refresh option has been used on the Object Browser. 

Editing Planogram Definitions 
To Edit a Planogram, highlight the required planogram in the hierarchy and right click to 
bring up the pop-up menu. 
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 (If the merchandiser module is already open, it will be made the active window). The 
currently selected Planogram will then be presented for editing. 

 
Once changes have been made and saved, they can be used within Merchandising after 
the Refresh option has been used on the Object Browser. 

Find Product or Planogram 
The Find Product or Planogram function is invoked by clicking on the Search icon in the 
Merchandising toolbar.  
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This will bring up the Find Product (or Find Planogram) dialog box. 

 
This is used by typing the required search string into the Find box and clicking the 
Search icon to the right of it.  

 
This will bring up a list of any blocks matching the search string.  
Left clicking on any result will return the user to the Merchandising Products Window, 
where the selected Product or Planogram will be highlighted in the hierarchy tree.  

The Refresh Option 
The Refresh Icon refreshes the both Planogram and Product information in the 
hierarchical tree.  

 
Using Refresh ensures that the information is brought up to date with any changes made 
in Merchandiser or Product Studio, both to the hierarchical tree and to any products or 
planograms added to, edited, or deleted from it.  

Configuration Options 
The Merchandising Tab in the Configuration Module can be called by clicking on the 
Configuration icon on the Merchandising toolbar. The options in this Tab are more fully 
explained in the section in the Configuration Module. 
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This will bring up the Merchandising Tab from the Configuration Module. 

 

Merchandiser - Controls 

Shortcut Keys 
Shortcut keys are available. These provide alternatives to calling the required function 
from pull down menus of toolbars.  

General Shortcuts 

Shortcut Keys Also available from: Function 

<Ctrl> + O File pull down Menu or 
Standard Toolbar  

Open Drawing (Via 
Store Manager) 

<Ctrl> + P Standard Toolbar Show Print Preview 

<Ctrl> + 
<Shift> + C 

File pull down menu Show Configuration 
Module 

<Ctrl> + S File pull down menu Save Drawing 
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Shortcut Keys Also available from: Function 

<Ctrl> + Q File pull down menu Quit Application 

<Ctrl> + N File pull down menu Create New 
Planogram 

F8 View Menu Show/Hide Object 
Browser 

Delete N/A Delete all selected 
objects 

Display Shortcuts 

Shortcut Keys Also available from: Function 

<Ctrl> + F Edit pull down menu Display Find 
Dialogue 

<Ctrl> + L Directions and Product 
Text Toolbar 

Display Layers 
Dialogue 

F12 View Menu Take snapshot of 
Virtual Reality Store 

Editing Shortcuts 

Shortcut Keys Also available from: Function 

<Ctrl> + G Edit pull down menu Toggle Group On or 
Group Off 

<Ctrl> + A Edit pull down menu Select All 

<Ctrl> + E Edit pull down menu Empty selected 
fixture/shelf of 
products 

<Ctrl> + C Edit pull down menu Copy the Selected 
Products to the 
Clipboard 

<Ctrl> + X Edit pull down menu Cut the Selected 
Products and Paste 
on Clipboard 

<Ctrl> + V Edit pull down menu Paste the Selected 
Products onto the 
selected 
fixture/shelf 

<Ctrl> + Z Edit pull down menu Undo last action 

<Ctrl> + D Edit pull down menu Deselect all selected 
objects 
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Shortcut Keys Also available from: Function 

<Shift> + up or 
down cursor 
keys 

N/A Move selected shelf 
up or down on 
parent object 

Menu Options 

File Menu 
The File menu gives access to several options. The most important of these are the 
creating and editing of planogram definitions, accessing Store Manager, Printing and 
accessing the Configuration Module. 

 

Edit Menu 
The Edit down menu give access to a series of options mainly concerned with editing. 

 
The Undo and Redo options allow the user to undo or redo recent actions.  
Cut, Copy and Paste allow the user to carry out those operations on objects in the 
drawing.  
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Select all, De-select all, Empty and Delete enable the user to carry out bulk opera6tions 
on the drawing.  
Group On or Group Off determines how Families and Groups are selected. 
Size Rule allows the user to specify whether on not product size is to be taken into 
account when placing products on shelves.  

View Menu 
The View Options pull down menu allows the user to specify a number of options 
affecting the view on screen.  

 
Find enables the user to find an object in the drawing.  
Record Path, Stop Record Path, Replay Path and Delete Path allow the user to configure 
a path specified though the drawing for the purpose of making a Virtual Reality movie of 
the store layout.  
Start Animation Recording, Stop Animation Recording and Replay Last Recorded 
Animation are options concerned with Virtual Reality movies of the store layout.  
Set 4 ViewPorts or Set 1 ViewPort determines how many views of the virtual store are 
available.  
Pivot Around Selected Object enables the user to select an object in the drawing to 
rotate around. 

Products Menu 
The Product pull down menu enables Product Dimensions to be updated. It also allows 
access to Product Studio.  
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Lights Menu 
The Lights pull down menu calls up the Lights dialogue box  

 
This allows the user to specify the lighting arrangements for the store. 

 

Calculate Menu 
The Calculate pull down menu gives access to calculations required for accurate 
reporting. 

 
Calculate Aisle Adjacencies 
This enables the user to determine which merchandise shares an aisle. 
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Calculate Areas 
This gives determines how efficiently space in the store has been allocated. 
Calculate Face Planes 
Calculate Face Planes enables users to calculate the respective frontal area of products in 
planograms.  
Calculate Fixture Adjacencies 
This is used to determine which fixtures are next to which. The information is used for 
calculation and reporting purposes. 
Calculate Product Adjacencies 

This is used to determine which fixtures are next to which. The information is used for 
calculation and reporting purposes. 
Calculate Space Measurements 
Calculate Space Measurements enables users to calculate the respective volumes of 
products in planograms.  
Window Menu 
The Window menu allows users so arrange multiple store plans (if open) and to select 
which store plan they wish to be active. 

 
The Help Options menu gives access to this help file. 

 
It also allows the version of the software to be checked. 

The Align Products Toolbar 
The Align Products toolbar allows shelves or products to be aligned. 

 

 
 
Align Left 

 
 
Align Center 

 
 
Align Right 

 
 
Align Front 
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Align Middle 

 
 
Align Back 

 
 
Justify in X plane 

 
 
Justify in Y plane 

 
 
Justify in Z Plane 

  
Select shelf or 
product to justify 
(Icon toggles) 

The Animation Toolbar 
The Animation Toolbar enables the user to make define and store walk through paths 
for taking movies. It also allows users to record movies of the store layout in the Virtual 
Reality Environment.  

 

 
 
Start Recording AVI 

 
 
Stop Recording AVI 

 
 
Play Recorded AVI 

 
 
Start Recording Path 

 
 
Stop Recording Path 

 
 
Replay Path 

 
 
Delete Path 

 
 
Available Recorded 
Paths 

 
The varying Path options allow the user to set, edit or delete a path along which a 
recording will take place.  
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The Recording options allow users to make movies of the Virtual Reality store, either by 
controlling the camera directly, or by setting it to follow a predefined path.  

The Directions and Product Text Toolbar 
The Directions and Product Text Toolbar is mainly concerned with views of selected 
objects.  

 

 
 
Front view of selected object 

 
 
Back view of selected object 

 
 
Top view of selected object 

 
 
Bottom view of selected object 

 
 
Left view of selected object 

 
 
Right view of selected object 

 
 
NW isometric view of selected 
object 

 
 
NE isometric view of selected object 

 
 
SE isometric view of selected object 

 
 
SW isometric view of selected object 

 
 
Show product text 

 
 
Show product text 

 
 
Show gridlines form 

 
 
Show zones form 

 
 
Size rule (Toggle On or Off) 
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Layers 

 
 
Undo 

 
 
Redo 

 
 
Explode 

 
 
Implode 

 
After an object (or objects) have been selected it may viewed from any of six axes or four 
isometric directions.  
Other options specify whether zones, gridlines, etc., display.  

The Formatting Toolbar 
The Formatting Toolbar has a whole series of options concerning the appearance of 
annotation in the Virtual Reality store.  

 

 
 
Add Label 

 
 
Edit Selected 

 
 
Delete Selected Label 

 
 
Bold Text 

 
 
Italic Text 

 
 
Left Justify Text 

 
 
Center Justify Text 

 
 
Right Justify Text 

 
 
Top Justify Text 
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Middle Justify Text 

 
 
Bottom Justify Text 

 
 
Text Color 

 
 
Background Color 

 
 
Font Type 

 
 
Font Size 

 
List of Current Labels 

The Standard Toolbar 
The Standard toolbar enables the user to carry out a series of common actions. 

 

 
 
New Planogram 

 
 
Open Store Manager 

 
 
Save Drawing 

 
 
Print Options 

 
 
Cut 

 
 
Copy 

 
 
Paste 

 
 
AutoFill 

Options include creating a new planogram, opening Store Manager, Saving and Printing 
the drawing, etc.  
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The View Toolbar 
The View Toolbar enables the user to set varying options for viewing the Virtual Reality 
environment. 
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 2D Label Viewing Distance 

 
Options include setting the number of viewports, pivoting around selected objects, 
locking movement in various directions and setting the level and type of detail visible in 
the drawing.  

Note: There are no tooltips for the Movement Speed, Texture 
Quality, Level of Detail, Front Clipping Plane and Back 
Clipping Plane sliders. Instead, they show as prompts 
towards the right hand end of the status bar.  

Merchandiser - Using the Mouse in the Drawing 

Overview of Movement in the Drawing 
Moving in the drawing can be done in several ways. These are: 
� General movement with the mouse 
� Pivoting about a selected object 
� Viewing objects from selected directions 

In addition users can select a plan view, which lets them choose the general section of the 
Virtual Reality environment to view.  

General movement with the mouse 
� Holding down the left mouse key enables the user to move their viewpoint 

forward and back and to rotate left and right.  
� Holding down the right mouse key enables the user to move their viewpoint up 

and down and left and right.  
� Using the mouse wheel enables the user to rotate their viewpoint up and down.  

Pivoting about a selected object 
This option allows a user to circle around a selected object in the drawing.  

Viewing objects from selected directions 
This option allows the user to view an object from one of ten perspectives by selecting it, 
then clicking on the appropriate icon. 

Plan View 
The plan view is a simplified overhead view of the Virtual Reality store. The user’s 
position within the store can be changed by ‘dragging and dropping’ the camera icon 
within this view.  

Mouse Wheel 
The mouse wheel will behave differently depending on whether movement within the 
Virtual Reality environment is Normal or Pivoting about an Object. 

Normal Movement 
The Mouse wheel is used to change the pitch of the Virtual Reality View. 
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Rotating the wheel forward will increase the angle of pitch, tilting the camera view 
upwards. 
Rotating the wheel backwards will decrease the angle of pitch, tilting the camera view 
downwards. 

Pivot around object 
The Mouse wheel is used to move forward towards or back from the selected object. 

 

Pivot around selected object 
This option is toggled on and off using the View toolbar. 

 

Left Mouse Button 
Normal movement while holding down the left mouse button allows movement in the 
X, Y plane. The viewpoint may be moved either forward or back or rotated left and right.  
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The position of the mouse cursor relative to the center of the drawing determines the 
type of motion.  
The further from the center, the more rapid the motion.  

Note: General motion speed can be set using the appropriate 
slider control in the view toolbar. 

Note: Pivoting around an object will change left mouse 
button behavior. 

Right Mouse Button 
Normal movement while holding down the right mouse button allows movement in the 
Y, Z plane. The viewpoint may be moved either left or right or back or moved up and 
down.  

 
The position of the mouse cursor relative to the center of the drawing determines the 
type of motion.  
The further from the center, the more rapid the motion.  

Note: General motion speed can be set using the appropriate 
slider control in the view toolbar. 

Note: Pivoting around an object will change left mouse 
button behavior. 
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Locking Movement in Planes 
The View Toolbar contains several controls for restricting the available movement in the 
drawing. 

 

 
Lock View 
Position 

 
Lock X Axis 
Movement 

 
Lock Y Axis 
Movement 

 
Lock Z Axis 
Movement 

 
The options can be toggled on and off by clicking on them.  
� Lock View Position will freeze the drawing with no movement possible 
� Lock X Axis Movement will freeze the drawing with respect to left and right 

movement. 
� Lock Y Axis Movement will freeze the drawing with respect to forward and 

back movement. 
� Lock Z Axis Movement will freeze the drawing with respect to vertical 

movement. 

Pivoting About a Selected Object 
The Pivot About Selected Object option in the View toolbar enables the user to rotate 
about a specific point in the drawing.  
It is toggled On and Off by clicking on it.  

 
Click on an object to select it. If the Pivot About Selected Object option has been selected, 
all movement will be relative to the selected object. 
Only the left mouse button and the mouse wheel will be enabled when this option is 
selected. The right mouse button will be disabled.  

Note: If Pivot About Selected Object is enabled, the selected 
object will always remain in the center of the selected field of 
view. 

Viewing Objects from Specified Directions 
Objects can be viewed from specified directions by clicking on the appropriate icons on 
the Directions and Product Text toolbar.  

 
First select the objects to be shown by <Ctrl> and left clicking with the mouse. Next, click 
on an icon to show the specified viewpoint. 
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Depending on the icon selected, the selected objects can be shown from the front or back, 
above or below, or left and right.  
They can also be shown from one of four isometric views. 

Plan View 
The Plan View Option can be activated from the Plan View option on the View Pull 
Down Menu 

 
This brings up the Plan View window.  
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This shows a plan view of the store and the current position of the camera within the 
store.  
The camera position can be repositioned by holding down the left mouse key and 
dragging it to its new position.  

Overview of Selecting 
One or more objects in the drawing can be selected for editing or deleting. The objects 
chosen are known as a Selection set.  
� If the chosen objects are not in a Group or Family they are known as a Simple 

Selection Set.  
� If the objects selected have previously been included in a Group they are known 

as a Group Selection Set.  
� If the objects selected have previously been included in a Family they are known 

as a Family Selection Set.  
� The selection status of selected objects can be seen from their colors.  
� Simple Selection Sets are shown in red and blue.  
� Family and Group Selection Sets are shown in yellow and green (and sometimes 

cyan). 
The behavior of the selected objects will sometimes vary depending on whether they are 
in Simple, Family or Group Selection Sets.  

Selecting and De-selecting Objects 
Objects can be selected by holding down the <Ctrl> key and left clicking on them with 
the mouse.  

Standard Selection Set 
Standard Selection Sets occur when the objects are not in a Group or Family. The first 
object selected for a Standard Selection Set will be enclosed in a red frame. Subsequent 
objects selected for a set of objects will be enclosed in blue frames.  
 

 
Individual objects can be de-selected by holding down the <Ctrl> key and left clicking on 
them with the mouse for a second time. All objects in the Standard Selection Set can be 
de-selected by holding down the <Ctrl> key and clicking on the red fame for a second 
time.  

Family and Group Selection Sets 
Objects that have been put into Families or Groups will be enclosed by yellow and green 
frames.  
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If Grouping is Off it is also possible that cyan frames will be visible. 

 
If Grouping is On, then all objects in the set can be selected or de-selected by clicking on 
any member of the set. If Grouping is Off, individual objects can be de-selected by 
holding down the <Ctrl> key and left clicking on them with the mouse for a second time. 
All objects in the set can be de-selected by holding down the <Ctrl> key and clicking on 
the yellow fame for a second time.  

General De-Selection 
All currently selected objects can be de-selected by <Ctrl + D>. 

Editing Objects 
Objects can be edited by holding down <Ctrl> and right clicking on them with the 
mouse. This will bring up the Editing menu. 
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This gives access to a wide range of options. 
 

Merchandiser – Floor Plan Display Options 

Overview of Single and Four ViewPorts 
Merchandiser can be viewed using single or multiple ViewPorts.  A single ViewPort 
will just show one image of the Virtual Reality Store. 
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Changing to 4 ViewPorts will show four images of the Virtual Reality store. 

 
These 4 ViewPorts can either be treated as separate entities or they can be synchronized.  
If used as separate entities, they can be used, for example, to move merchandise from one 
set of shelves to another. 
If used while synchronized they can be used, for example to show three different KPI’s 
(Key Performance Indicators), for the same part of the store. 

Setting Up and Switching Between ViewPorts 
When the drawing opens, it will show a single view of the store plan.  
(If 4 ViewPorts were enabled when the drawing was last saved and closed, the top left 
ViewPort will be displayed when the drawing is re-opened).  
Starting/returning to the 4 ViewPorts option can be achieved using the menus or 
toolbars.  
If using the View pull down menu, clicking on Set 4 ViewPorts will change the display 
from one to four viewpoints.  
If the user is already using four viewpoints, then the pull down menu will read Set 1 
view point, enabling the user to toggle back to a single view point. 
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Alternatively, the user can click on the appropriate icon in the toolbar. These will toggle 
between Show 4 ViewPorts and Show 1 viewport.  
The Next View icon toggles between the available views. 

 
 

 
Switch to 4 
ViewPorts  

 
Switch to 1 
ViewPort 

 
Next view 
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Saving and Restoring ViewPorts 
While working in a Virtual Reality store, it is possible to save ViewPorts for later 
restoration. To do this, the user should select the Windows > Views option from the View 
pull down menu. 

 
This will bring up the Views dialogue box.  

 
This enables users either to save or restore specific ViewPorts 

Synchronizing ViewPorts 
The views in the 4 ViewPorts can be synchronized if required. This is achieved from the 
toolbar.  
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Clicking on the Synchronize icon will immediately switch all four viewpoints to that they 
mirror the viewpoint in the currently active window.  
Clicking on the Synchronize icon again will desynchronize the four viewpoints to that 
they can be manipulated independently. 

Note: If the user has toggled from Show 1 Viewport to Show 
4 ViewPorts and 3 Viewports are blank, clicking on the 
synchronize icon is a quick way of populating the blank 
ViewPorts with views.  

Overview of Object Display 
The way objects display in a store plan can be changed in three ways in Merchandiser.  
The drawing is subdivided into layers and each class of object (fixture, fitting, product, 
etc), has its own specific layer. By changing the properties of the layer, the user can 
change how the objects on that layer display.  

Locking the Layer 
Locking the layer prevents objects on that layer being moved or deleted. 

Changing the Visibility 
It is possible to turn layers on or off. If a layer is turned on objects on it are visible. If a 
layer is turned off, they are hidden.  

Changing the Transparency 
The transparency values for a layer (and the objects on that layer) can be changed 
anywhere within a range of 0% - 100%. If the transparency is set to 0%, objects are 
completely opaque. If the transparency is set to 100% objects are completely transparent. 

Overview of Locking Objects 
It is possible to lock objects so that they cannot be altered when in place in the 
Merchandiser environment.  
This is done by using the locking option in the Layers dialogue box, accessible from the 
View toolbar 
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This shows the layers and whether they are locked or not.  
 

 
Layer unlocked 

 
Layer locked. 

 
The lock for each layer can be toggled on or off by clicking on the appropriate icon.  

Note: Depending on the system variable settings, some 
layers will be automatically locked depending on which 
Object Browser tab the user is in.  

If the system variable is enabled, when in the Fixturing Tab, all layers associated with 
merchandising are locked. Similarly, when in the Merchandising Tab, all layers 
associated with fixturing are locked. 

LOCK_OBJECTS_ON TAB_CHANGE System Variable 
The LOCK_OBJECTS_ON_TAB_CHANGE system variable is accessed from General 
Menu in the Admin Module. 

 
This brings up the System Variables dialogue box. 
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LOCK_OBJECTS_ON_TAB_CHANGE can be set to 0 or 1. 
If set to 0, the layers will not be locked when changing from the Fixturing to the 
Merchandising Tabs and vice versa. 
If set to 1, the layers will be automatically locked. 

Note: Changing (and especially deleting) system variables 
can have a significant effect on the way Macro Space 
Management operates. It is recommended that Macro Space 
Management users consult their System Administrator or 
consult Oracle’s Technical Support Team.  

Locking Objects 
Locking of specific classes of objects is achieved by locking the layers that those objects 
are placed on. 
The layer for the majority of objects, such as fixtures, fittings and shelves, will be 
determined when the object is created in Fixture Studio: 



Merchandiser – Floor Plan Display Options 

428 Store Planning User Guide 

 

Note: Layers selected for classes of objects should be 
consistent. If they are not then only some of the class of 
objects will be locked when a specific layer is turned off.  

Layers for zones will be determined by the Zone Type. 
Fixtures and fittings should be placed on specifically defined and consistent layers.  
Products are placed on their own specific layer. 
Locking layers is particularly useful for any object that is on the building layer, i.e. 
pillars, which should not be modified in the Merchandiser environment.  
Locked objects can still be selected, so that properties can be determined, etc.  
When locked objects are selected, a small warning will appear at the bottom of the 
screen.  

 

Note: If objects are locked, then they cannot be deleted, 
moved, etc. If it is desired to do this, the layer must first be 
unlocked.  
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Changing the Transparency of Objects 
It is possible to change the transparency of objects so that they become more or less 
opaque when in place in the Virtual Reality environment.  
This is done by using the Transparency option in the Layers dialogue box, accessible 
from the View toolbar 

 

 
The degree of transparency for each layer can be set anywhere within a range of 0% - 
100%.  
If the transparency is set to 0%, objects are completely opaque. If the transparency is set 
to 100% objects are completely transparent  
In the example below, the transparency is set to 0% - opaque. 
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In the example below, the products and back panels have been set to 75% transparency. 

 

Changing the Visibility of Objects 
The visibility of objects can be changed so that they show or are hidden from view in 
store plans.  
This is done by using the Visibility option in the Layers dialogue box, accessible from the 
View toolbar 

 

 
This shows the layers and whether they are visible or not.  
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Layer visible 

 
Layer not visible 

 
The visibility for each layer can be toggled on or off by clicking on the appropriate icon.  
If the layer is not visible, all objects on the layer will be hidden. 

Merchandiser - Styles 

Overview of Styles 
Styles are used to define whether different types of objects fit together. They can be used 
to specify (for example) whether a shelf will fit on a fixture, or whether a product can be 
placed on a shelf.  
Using Styles in Merchandiser requires settings to be configured in the Administration, 
Fixture Studio and Product Studio Modules, as well as in Merchandiser. 

 
Each of these steps is discussed in more detail in the following topics. 
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Configuring Styles 
Styles can be configured from within the Admin Module. 

Note: The Admin Module is only accessible to those with 
Administrator's privileges.  

To access Styles, select the Styles option from the Edit pull down menu.  

 
This will bring up the Styles dialogue box, which can be used to configure styles and the 
relationships between them.  

 

Styles Tab 
This allows Styles to be added or deleted from the list of available styles. 

Style Relationships Tab 
This allows relationships to be set up between different types of styles. 
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Test Tab 
This is used to test what product styles can be placed on equipment and what equipment 
specific products can be placed on.  

Adding and Deleting Styles 
Adding or Deleting Styles is done by using the Style tab in the Styles dialogue box 
accessed from the Admin Module. 

 
 

 
Add style 

 
Delete 
style 

Adding a Style 
To add a style, click on the Add Style icon. A new line will be added in the styles table.  
The Style ID is a fixed, sequential number allocated when the style is created. 
The Name and Description will initially read Style11 and Description21, where the 
number is that of the style being created. These can be edited to the style name and 
description required.  
The Style type can be selected from a drop down list. 
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Tip: Fixture, Shelf and Product styles are in current use. 
Module style has yet to be implemented.  

Deleting a Style 
Styles can be deleted by highlighting a style and clicking on the Delete Style icon. 
If not in use, the style will be deleted.  
If in use, a warning will appear. 

 

Adding and Deleting Style Relationships 
Style Relationships can be added and deleted by using the Style Relationships tab in the 
Styles dialogue box accessed from the Admin Module. 

 
 

 
Add style 
relationship 

 
Delete style 
relationship 

Adding a Style Relationship 
To add a style relationship, first select the style types which it is desired to set up a 
relationship with.  
This can be done from the drop down lists – for example it might be required to associate 
a Shelf style with a Product style. 
Next, select the specific types of styles from the lists provided – for example it might be 
required to associate the Pallet Shelf Style with the Multipack product style.  
Finally, click on the Add Style Relationship icon to add the relationship. It will then 
appear in the list of current relationships. 
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Deleting a Style Relationship 
Styles relationships can be deleted by highlighting a style and clicking on the Delete Style 
Relationship icon. 

Note: Style relationships in use can be deleted without any 
warning being given.  

This will not affect any objects placed before the relationship was deleted, but if further 
objects are to be placed using this relationship, it must be reinstated before they are. 

Adding and Deleting Joints 
Adding and Deleting Joints is done by using the Style Relationships tab in the Styles 
dialogue box. 

 
 

 
Add joint 
relationship 

 
Delete joint 
relationship 

Adding a Joint 
To add a joint, first select the style types which it is desired to set up a relationship with.  
First select Fixture Style in the left hand drop down list. Next select Product Style in the 
central drop down list. Finally select Shelf Style in the right hand drop down list.  
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Next highlight the required styles in each of the three lists. (For example Metal as a 
Fixture Style, Hung as a Display Style and Peg as a Shelf Style. 
Finally, click on the Add Joint Relationship icon to add the relationship. It will then 
appear in the list of current relationships. 

Deleting a Joint 
Joints can be deleted by highlighting a style and clicking on the Delete Style Relationship 
icon. 

Note: Joints in use can be deleted without any warning 
being given. This will not affect any objects placed before the 
relationship was deleted, but if further objects are to be 
placed using this relationship, it must be reinstated before 
they are. 

Testing Style Relationships 
Testing Style Relationships is done by using the Test tab in the Styles dialogue box. 

 

Equipment 
To see which product styles are associated with an item of equipment, click on that item 
of equipment in the list of available equipment.  
The list of associated product styles will then display. 

Note: The list of equipment can be sorted in ascending or 
descending order by clicking on the column headers.  
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Products 
To see which equipment styles are associated with a product, click on that product in the 
list of available products.  
The list of associated equipment styles will then display. 
Products can be found by entering the product name or code and clicking on the search 
icon. 

Note: The list of products can be also sorted in ascending or 
descending order by clicking on the column headers.  

Joints 
Joints can only be tested by trail placements on equipment. 

Assigning Fixture, Shelf and Product Styles 
There are three broad classes of style (although others can be defined). 
� Fixture styles 
� Shelf styles 
� Product styles 

In additions there are: 
� Joints 

FIXTURE 

Fixture style Shelf style Product style 

Fixtures must have one or 
more fixture styles.  
The Fixture Style 
Relationships determine 
what shelves and products 
it can accept.   

If shelving is to be placed 
on the fixture then a style 
relationship must exist 
between the assigned 
fixture style and the 
required shelf style. 

For products to be placed a 
fixture, a style relationship 
must exist between the 
assigned Fixture Style and 
the required Product Style. 

 

SHELF 

Fixture style Shelf style Product style 

For shelves to be placed on 
a fixture, a style 
relationship must exist 
between the assigned Shelf 
Style and the required 
Fixture Style. 

Shelves must have one or 
more Shelf Styles. 
The Shelf Style 
Relationships determine 
what equipment the shelf 
can be placed on and what 
products it can accept.   

For products to be placed 
on the shelf, a style 
relationship must exist 
between the assigned Shelf 
Style and the required 
Product Style. 
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PRODUCT 

Fixture style Shelf style Product style 

For products to be placed a 
fixture, a style relationship 
must exist between the 
assigned Fixture Style and 
the required Product Style. 

For products to be placed 
on the shelf, a style 
relationship must exist 
between the assigned Shelf 
Style and the required 
Product Style. 

Products must have one or 
more product styles.  
The Product Style 
Relationships determine 
what equipment and 
shelves the product can be 
placed on.   

 

Note: Products can only be assigned styles at the Display 
Level. They cannot be assigned styles at SKU level and 
above.  

 

JOINT 

Allows products to be placed directly on fixtures, placing at the same time the associated 
shelf object.  

Fixture style Product style Shelf style 

For products to be placed a 
fixture, a style relationship 
(using a joint) must exist 
between the assigned 
Fixture Style and the 
required Shelf style. 

For products to be placed 
on the shelf, a style 
relationship (using a joint) 
must exist between the 
assigned Shelf Style and 
the required Product Style. 

Products must have one or 
more product styles.  
 
The Product Style 
Relationships determine 
what equipment and 
shelves the product can be 
placed on.   

When creating a joint, if a fixture-shelf style relationship similar to the type being defined 
already exists it must be deleted before the joint (a combination of fixture, product and 
shelf styles) can be created.   

Example:  
In the following Style Relationship (created in Admin) fixtures that have a Fixture Style 
of Metal assigned can accept shelves that have had either an Open Shelf, Heavy Duty 
Shelf or Lateral Rod Shelf Style assigned.  
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Conversely, if a shelf has only had a Peg Slatted Style assigned it cannot be placed on a 
Fixture that has only has a Fixture Style of Metal assigned. 

Fixture Styles 
Each fixture should be associated with one or more Fixture Styles.  
An example of a fixture style might be ‘Metal’. This style might also be associated with 
fitting and shelves and can be used to indicate that particular items of equipment can be 
fitted together. 
If product is to be placed directly on any fixture, it also requires a shelf style. 

Shelf Styles 
Each shelf must be associated with one or more Fixture Styles and also one or more Shelf 
Styles.  
The Fixture Style is used to ensure the shelf fits onto a compatible fixture.  
The Shelf Style only allows products with compatible styles to be placed.  

Product Styles 
Each product must be associated with one or more product styles. These product styles 
will determine the compatible shelves the product can be placed on.  
For example shirts could be available in both Hung and Folded Product (Display) Styles.  
If a product is dragged into a shelf at item level then it will automatically select the 
correct Product Style. For example if shirts are dragged into an open shelf, they will be 
placed as Folded Shirts. If shirts are dragged onto a peg or bar, then they will be placed 
as Hung Shirts.  
If product is dragged onto a shelf at Display Level then it can only be placed on 
equipment compatible with that style. For example Folded shirts cannot be placed onto a 
bar. 
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Adding Styles in Admin Module 
To add styles to the available list, open the Styles option in the Admin Module. Use the 
Style Tab and click on the Add Style Icon (circled).  

 
This will add another line to the information grid (circled). 

 
Edit this line until it has the desired information. 

 



Merchandiser - Styles 

442 Store Planning User Guide 

Other styles can be added as required.  
Finally, exit to save the styles.  

Warning: There is a known issue with the Styles option at 
present. Information is temporarily lost if a second style is 
added immediately after the first. To overcome this close the 
Styles dialogue box after each style is added then re-open it 
to add the next.  

Setting up Style Relationships in Admin Module 
To Add Style Relationships to the available list, open the Styles option in the Admin 
Module. Click on the Style Relationship Tab.  

 
Set the options as required.  
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Set the first of the Style Types to Shelf Style and the other to Product Style.  
Next select the Peg style from the list of the available Shelf styles and the Railed Product 
style from the list of the available product styles.  
Finally, click on the Add Style Relationship icon. This will cause the Style to be added to 
the list of available Style relationships.  
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This means we can put these Railed Product styles of product onto any shelf object 
assigned the Peg style. 

Note: If we need place products directly onto a fixture, a 
Style Relationship would be required between the Fixtures 
Style and the Product Style. 

An example of this would be putting products of Boxed Style onto fixtures of Pallet Style.  

Adding Style to Fixture in Fixture Studio Module 
To Add a Fixture Style to a fixture, open Fixture Studio. Select the required fixture and 
right click to bring up the pop-up menu. 

 
Click on Edit Block. This will bring up the block details dialogue box. Select the 
Fixture/Styles Tab.  
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To add a Fixture Style (or styles) select the required style(s) from the  list of available 
styles and move then over to the list of selected styles using the > arrow.  

 
This means this fixture will now accept any shelves or products that have Style 
Relationships with the Fixture - Batteries Fixture Style.  

Adding Styles to Shelf in Fixture Studio Module 
To Add Fixture and Shelf Styles to a shelf, open Fixture Studio. Select the required shelf 
and right click to bring up the pop-up menu. 

 
Click on Edit Block. This will bring up the block details dialogue box. Select the 
Fixture/Styles Tab.  
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To add a Fixture Style (or styles) and a Shelf Style (or styles) select the required style(s) 
from the  list of available styles and move then over to the list of selected styles using the 
> arrow.  
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This means this shelf will now accept any fixtures or products that have style 
relationships with the Shelf - Batteries Shelf Style.  
Similarly, a Fixture style can be selected to determine what fixtures the shelf can be 
placed on.   

Testing Style Relationship 
Testing Style Relationships is done by using the Test tab in the Styles dialogue box. 

 

Equipment 
To see which product styles are associated with an item of equipment, click on that item 
of equipment in the list of available equipment.  
The list of associated product styles will then display. 

Note: The list of equipment can be sorted in ascending or 
descending order by clicking on the column headers.  

Products 
Product can be found by entering the product name or code and clicking on the search 
icon. 

Note: Be as specific as possible in the search. The fewer 
items selected in the search, the faster the software will find 
the associated styles. 

To see which equipment styles are associated with a product, click on that product in the 
list of available products.  
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The list of associated equipment styles will then display in the highlighted box to the 
right. 

Note: The list of products can be also sorted in ascending or 
descending order by clicking on the column headers.  

Joints 
Joints cannot be tested in the Test Tab - they can only be verified by placing them on an 
item of equipment. 

Assigning Fixtures and Shelf Styles 
Styles can be assigned to fixtures and shelves from within Fixture Studio by highlighting 
them in the hierarchy and right clicking to bring up the pop up menu. 
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Clicking on Edit Block will bring up the Block Details dialogue box. The Styles/Ranges 
tab can then be used to specify the available styles for a particular object.  

 
Styles can then be assigned or removed using the < and > arrows.  

Note: A shelf object will require a fixture style to ensure it 
can be assigned to fixtures, and a shelf style to allow product 
to be assigned to it.  

Adding Style to Product in Product Studio 
To Add a Product Style to a product, open Product Studio. Select the required product 
and right click to bring up the pop-up menu. 

Note: Products can only be assigned styles at the Display 
Level. They cannot be assigned styles at SKU level and 
above.  
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Click on Edit. This will bring up the Product Display Style dialogue box. Select the Styles 
Tab.  

 
To add a Product Style (or styles) select the required style(s) from the list of available 
styles and move then over to the list of selected styles using the appropriate icon. 

Assigning Product Styles 

Note: Products can only be assigned styles at the Display 
Level. They cannot be assigned styles at SKU level and 
above.  
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Styles can be assigned to Products from within Product Studio by highlighting them in 
the hierarchy and right clicking to bring up the pop up menu. 

 
Clicking on Edit will bring up the Product Display Style dialogue box. The Styles tab can 
then be used to specify the available styles for a particular product.  

 
Styles can then be assigned or removed using the appropriate icons.  
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Placing Fixtures 
Primary Fixtures can be placed without reference to their assigned Styles.  
The only criteria for placing fixtures are that they have been assigned a primary object 
that places at floor level.    

Placing Shelf Objects 
Shelf Objects can only be placed if they meet two criteria.  

Connection 
Points 

The connections points assigned to the shelf must be compatible 
with the connection points assigned to the fixture it is to be placed 
on. 

Styles. The Fixture Style assigned to the shelf must be compatible with 
the Fixture Style assigned to the fixture it is to be placed on.  

Setting Preferred Styles 
Because some objects can be associated with multiple styles, specific instances of shelves 
within the drawing can be given preferred styles.  
For instance, a shelf could be associated with both a Stock shelf style as well as a 
Presentation shelf style; two display styles may then be defined for a particular product, 
a Display product style and a Boxed product style.  
The Stock shelf style would be linked with the Boxed product style, and the Presentation 
shelf style would be linked with the Display product style. This would allow both the 
Boxed and Display version of the product to be placed on the shelf.  

 
However, the user would be able to indicate the preferred style for a particular instance 
of a shelf as being Presentation, which would force the Display product to be placed for 
that particular shelf.  
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Using Preferred Styles 
Preferred styles can be specified for a specific shelf or shelves by selecting those 
required. This is done by holding down the <Ctrl> key and left clicking on the desired 
shelves. The first instance of a selected shelf will be highlighted in Red, subsequent ones 
in blue. 

 
Holding down the <Ctrl> key and right clicking will then bring up the pop-up Menu. 
Clicking on the Edit option will bring up the Edit Shelves dialogue box. 
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This can be used to set the preferences for that specific shelf or shelves.  
If different types of shelves have been included in a multiple shelf selection, only 
preference types common to the different types will be shown.  
If there are no common preference types, then the field in the preferences box will be 
blank.  

Using Styles 
The diagram below indicates how styles interrelate.  

 
The fixture has been assigned a Metal Fixture Style.  
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The Open Shelf, Peg Board and Hanging Rod shelf objects have all been assigned Metal 
Fixture styles. This means any of these three types of shelf object can be placed on the 
fixture.  
If another type of shelf object (for example a slatted back panel) had been assigned the 
Lozier fixture style, it would not have a fixture style compatible with that assigned to the 
fixture itself, and could not be assigned to that fixture. 
The Open Shelf, Peg Board and Hanging Rod shelf objects have also all been assigned 
appropriate shelf styles.  
The varying types of products have been assigned product styles. For example shirts 
have been assigned Boxed, Folded and Hung product styles. These styles determine what 
form of shelf object shift can be placed on.  
For example shirts with a Hung product style can only be placed on Hanging Rods. 
Conversely, the Open Shelf has been configured to accept both Boxed and Folded shirt 
styles.  
Ties only have Pegged product style and are restricted to the Peg Board. 

Note: Where an object has multiple styles they can set in 
order of preference using preferred styles.  

Floor Plan Tools – Planogram Publishing 

Overview of Planogram Publishing 

Note: The way that planogram publishing performs in the 
Planner and Merchandiser modules is dependent of settings 
in other modules. This section is included so that users of the 
Planogram Publishing Functionality can discuss requested 
changes with the Administrators.  

Note: the default settings for the Planogram Publishing 
dialog box are derived from settings in the Planogram 
Publishing Configuration dialog box in the Admin module. 

The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 
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The Planogram Publishing functionality is used to disseminate planogram designs to 
specified printers or Windows folders to facilitate implementing those planogram 
designs.  

Note: a retail organization will still need a method of 
distributing the planogram designs from the printer or 
Windows folder to the end user. 

The basic method of operation is as follows: 
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7. Admin Module 
The Admin module is used to configure access to the different parts of the functionality. 
It is also used to assign permissions to print or publish specific floor plans and 
planograms. Finally, it is used to configure how the batch processes for publishing floor 
plans will work. There are three options that affect publishing and printing of floor plans. 

a. The Functional Security option (Security menu) allows Administrators to control 
who can run Planogram Publishing as a batch process. It also controls who can 
access Immediate Planogram Publishing in the Planner Module. It also allows 
Administrators to control who can access Report Designer to create report 
templates for publishing planogram designs. 

b. The Data Security option (Security menu) allows Administrators to control what 
planograms a user can print or publish from in the Planner and Merchandiser 
modules (and in In-Store Space Collaboration).  

c. The Custom Query dialog box allows an Administrator to specify what fields 
will appear in the Immediate Planogram Publish dialog box in the Planner 
module. 
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8. Configuring Outputs for Batch Process 
The outputs for the batch process output of Planograms are configured in the 
administration module using the Planogram Publishing Configuration dialog box. 
9. Running as a Batch Processes 
Planogram Publishing ban be run as a batch process - typically run overnight so that this 
processor hungry tasks can be executed without affecting the manual users of the system. 
The settings determining how this operates are set in the Planogram Publishing 
Configuration dialog box. 
The rights to do this are set in Functional Security in the Admin Module.  
10. Planner Module 
Within the Planner module, the Immediate Publishing of Floor Plans functionality can 
only be used by users for whom permissions have been granted in the Admin module. 
11. Merchandiser Module 
Within the Merchandiser module, the Immediate Publishing of Floor Plans 
functionality can only be used by users for whom permissions have been granted in the 
Admin module. 
12. Report Designer 
Report Designer can be used to create report templates that determine the format the 
planogram design is published in. 
13. Other Functionality 
There are three other items of functionality that affect planogram publishing. 

a. Configuration Module - the Directories tab allows users to specify where the 
root folders holding published planograms are located. Sub-folders holding 
specific planograms will be created as children of this root folder. 

b. Tables in the Macro Space Planning database hold the results of planogram 
publishing operations. 

c. BI Publisher (or a similar application) can be used to generate reports based on 
the information held in the database - for example the names and results of 
planograms that have been published. 

Permissions to Run Immediate Planogram Publishing 
Before a user can run Immediate Planogram Publishing, they must first have been 
assigned the appropriate permissions in the Admin module. This is done using the 
Functional Security dialog box accessed from the Security menu. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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Users assigned to the Automation Command Group (such as the Administrator User 
Group) can run all Automation Functionality. User Groups assigned to the child 
Command Groups (Floor plan automated publishing, Floor plan publishing, Planogram 
publishing) have the ability to use that functionality. In the example above, the 
Merchandise Planning Manager User Group has been assigned permission to use the 
Planogram Publishing functionality. 
The User Groups precise rights depend on settings in the Permissions dialog box. This is 
accessed from the right click menu in the Functional Security dialog box.  

 
This will bring up the Permissions dialog box. 
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1. If the User Group belongs to a Command Group higher in the Command Group 

hierarchy, by default it will inherit the permissions from that higher Command 
Group. This permission can be varied at the lower level by changing the selections 
made using the check boxes. 

2. If the User Group only exists at this level in the hierarchy, the Permissions dialog box 
will initially have all check boxes blank. The Administrator must then assign Allow 
of Deny permissions.   

Dates Planograms will be Published 
The purpose of publishing a planogram is to disseminate information on the type, 
quantity and location of shelves and merchandise to those tasked with implementing the 
change. Publishing a planogram design can be done in hard copy or electronic format. 
The date at which this is executed depends on the Publish Date set in the Details tab of 
the Planogram Design dialog box in the Merchandiser module. 

Note: the Publish Date operates purely on the date only and 
takes no account of the time of day. Publish Dates are stored 
in Date/Time format in the database, but the functionality 
only references the Date. 
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Another factor affecting the date at which at which planograms will be published is the 
Lead Time Tolerance (Hours) setting on the Output tab of the Planogram Publishing 
Configuration dialog box in the Admin Module. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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Batch processes can be set to start at any time of the day. For example, the batch process 
might initiate at 8 pm (20.00 hrs) in the evening to allow the maximum number of batch 
processes to be run before users come in for work again the following morning. 
However, the Publish date for the floor plan might be set for when the following day 
begins at midnight. The Lead Time Tolerance (Hours) setting allows for this. 
For example, if batch process is run on the 2nd June at 20.00 hrs in the evening and has 
no lead time tolerance, a planogram that has a Publish Date of 3rd June would be ignored 
for publishing purposes by this run of the batch process. If however, the Lead Time 
Tolerance (Hours) setting is set to 5 hours, this will be added onto the Date and Time for 
the batch process and cause the batch process to operate as if it were running at 01.00 hrs 
in the morning of 3rd June. All planograms with a Publish Date of 3rd June would then 
be published. 

Criteria for Publishing Planograms 
There are two criteria for publishing planograms: 
1. Publish Date has been exceeded 
If the Publish Date set in the Planogram Design dialog box in Merchandiser exceeds the 
current date (taking into account the Lead Time Tolerance (Hours) setting), the floor 
plan will be published. 
2. Planogram has been Updated since it was Published 
It is possible that the floor plan may have been modified after it was last published - for 
example of a later revision has been created. The condition for this is that the Last 
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Modified date is greater than the Last Published Date. These can be seen on the 
Properties tab of the Planogram Design dialog box in the Merchandiser module. 

 

Note: Planograms may also be republished if the Republish 
planogram if files are missing option has been checked in 
the Planogram Publishing Configuration dialog box. 

Locations Planogram Designs will be Published To 
The locations Planogram designs will published to and the file names that will be used 
are specified in the Output tab of the Planogram Publishing Configuration dialog box in 
the Admin module. 

Note: this dialog box will only be accessible to users with 
access rights to the Admin Module. 
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This dialog box allows Administrators to specify the directory structure, file format and 
file name that will be used when planogram designs are published. 
The starting point for the location planograms will published to in electronic form can be 
seen in the details for the Planogram Publish system directory specified in the Directories 
Tab of the Configuration module.  
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The Filtering Tab 
The Filtering Tab is used to select the planograms to publish. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next planogram matching the text being 
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searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 

Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 

 
If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*Wine*' and will find White Wine, Red Wine, etc. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
a. Select All will select (but not check) all rows of data 
b. Clear All will deselect (but not uncheck) all rows of data 
c. Check Selected will check all rows of selected data 
d. Uncheck Selected will uncheck all rows of selected data 
e. Check All will check all rows of data 
f. Uncheck All will uncheck all rows of data 
g. Paste allows users to paste a carriage returned list of planogram identifiers from 

the Windows clipboard. all rows in the dialog box that match the pasted 
information will be checked. 
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Selecting Planograms to Process 
Planograms may be selected for printing by ticking the appropriate check box. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 

 
They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows there the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows there the text string is not an exact match for 

the end of the data.  



Floor Plan Tools – Planogram Publishing 

468 Store Planning User Guide 

3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  

The Template Tab 
The Template Tab is used so specify the type of report that will be used to output details 
of the planogram design. 

 
The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 
1. Use Associated Planogram document - this option publishes the planogram design 

information using a pre-generated report using one of the following file formats: 
BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be imported when a 
planogram is imported using Oracle Data Integrator (ODI). The Associated 
Document (if available) is specified in the Associated Document text box in the 
Details tab of the Planogram Design dialog box in the Merchandiser module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

a. Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

b. Use the default Report Designer template. 
2. Use Template - this option allows the user to define the way the template from the 

Report Designer module is selected. There are two options (selected using the radio 
button): 
a. Use Planograms preferred template, if defined - this option is specified in the 

Preferred Template drop down list in the Details tab of the Planogram Design 
dialog box in the Merchandiser module. 

b. Use Selected Template from List Below - this option can be set by checking 
items in the list of available templates. One or more templates may be selected. If 
multiple templates are selected, the name of the template will be added to the file 
name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram 
Report).pdf  

If necessary the list of templates can be searched by entering a text string into the 
dropdown list, then clicking the Find button. (Actual or implied wild cards can be used). 
Each click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 

Note: the last 10 text strings can be selected using the drop 
down list in the text box. 
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The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 
At least one collation option must be selected, or the tab will show as having an error.  

 
The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
1. Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
2. District is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 
3. Store Number is the Store Code in the Store dialog box in Store Manager. 
4. Store Name is the Store Name in the Store dialog box in Store Manager. 
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5. Department is the department (zone) in the floor plan the planogram is associated 

with.  
6. Aisle is the aisle the planogram is associated with. For this option to operate, aisles 

must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 

 
7. Bay Number is the bay number associated with the fixtures the planogram is placed 

on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 

 
8. Bay Group is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 
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9. Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 
10. Planogram Code is the code for the planogram. This is set in the Client Code field of 

the Planogram Design dialog box in Merchandiser. 
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The Validation Tab 
The Validation tab enables users to set a series of validation checks that must be satisfied 
before the planogram design is published. If any of the checks are failed, the details will 
be written to the AVTTB_PUBLISH_POG_LOG table. Information in this table can be 
read by means of a BI Publisher report or similar. 

 
1. Check for empty shelves - this option will check the parent fixture and associated 

shelf objects. It will raise an error report if: 
a. The fixture and associated shelf objects can be populated with product 

placeholders, but no product placeholder has been placed. 
b. The fixture and associated shelf objects can be populated with display styles, but 

no display styles have been placed. 
2. Check for products that have expired or are not yet effective - this option will check 

all products in the planogram against the effective date of the planogram. It will raise 
an error report if: 
a. The Product Effective Date is after the Planogram Effective Date - i.e. the product 

is not yet available to place in the planogram. 
b. The Product Expiry Date is before the Planogram Effective Date - i.e. the product 

will expire while the planogram is still in service. 
The check will be ignored if the product effective or expiry date is undefined. 
The Planogram Effective Date is set in the Details tab of the Planogram Design dialog box 
in Merchandiser. 
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The Product Effective and Expiry dates are set in the Details tab of the SKU dialog box in 
Product Studio. 
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3. Check for equipment that is obsolete or not yet available - this option will check all 

equipment in the planogram against the effective date of the planogram. It will raise 
an error report if: 
a. The Equipment Effective Date is after the Planogram Effective Date - i.e. the 

equipment is not yet available for the planogram. 
b. The Equipment Expiry Date is before the Planogram Effective Date - i.e. the 

equipment will be taken out of service while the planogram is still in use. 
The check will be ignored if the equipment effective or expiry date is undefined. 
The Equipment Effective and Expiry dates are set in the Category tab of the Block Details 
dialog box in Fixture Studio. 
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4. Validation Scope - this controls when to apply the validation checks. There are three 

options - selectable by the radio button. 
a. Apply to all planograms. 
b. Apply to non-imported (manually created) planograms. 
c. Apply to imported planograms. 

The application will automatically distinguish between imported and manually created 
planograms by means of the information held in the Macro Space Planning database.  

Errors and Results 
If any settings in the Planogram Publishing dialog box will lead to errors during 
publishing, an error symbol will be displayed on the tab containing the data with the 
problem. The OK button will also be grayed out and unavailable. 
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Users must correct the problems before the Ok button will activate.  
The results from Planogram Publishing are stored in two tables within the database. 
These results can be viewed via reports generated from BI Publisher (or similar 
software).  

Floor Plan Tools – Planogram Printing 

Overview of Planogram Printing 
Planogram Printing allows users to select planograms in the currently active floor plan 
and print out information on the ones they have permissions to print.  

Note: Users wishing to Publish the planogram design plan 
(output it in electronic or hard copy form with permanent 
changes) should use the Immediate Planogram Publishing 
option from the File menu. 

Note: the default settings for this dialog box are derived 
from settings in the Planogram Publishing Configuration 
dialog box in the Admin module. 
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The basic method of operation is as follows: 

 
1. Admin Module 
Within the Admin Module: 

a. The planogram users have permissions to print are assigned in the Data Security 
dialog box - Planograms Tab. 

b. The fields that display in the Filtering Tab of the Print Planograms dialog box are 
configured in the Custom SQL dialog box. 
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c. Planograms can be printed using report templates specified in the Report 
Designer module. Permission to access this module is specified in the Functional 
Security dialog box. 

These settings determine what will appear in the Print Planograms dialog box (and the 
reports that will be available) when it is accessed in the Planner and Merchandiser 
modules. 

Note: In order to access the Admin Module, users must have 
permission to do so. 

2. Planner Module 
The Print Planograms dialog box may be accessed from the File Menu - a floor plan 
containing planograms must previously have been opened. Users with permissions to 
access the Planner module automatically have permission to use the functionality. 
3. Merchandiser Module 
The Print Planograms dialog box may be accessed from the File > Print Menu - a floor 
plan containing planograms must previously have been opened. Users with permissions 
to access the Merchandiser module automatically have permission to use the 
functionality. 
4. Report Designer 
The Report Designer module is used to design report templates that can be specified for 
use in the Print Planograms dialog box. Permissions to access this module are assigned in 
the Functional Security dialog box in the Admin module. 
5. Using Planogram Printing 
The functionality is used as follows: 

a. A floor plan containing planograms is opened in the Planner or Merchandiser 
module. 

b. The Print Planogram option is selected from the File menu in the Planner or 
Merchandiser module. 

c. The appropriate planograms are selected in the Filtering tab of the Print 
Planograms dialog box. 

d. The report to use is specified in the Templates tab.  
e. The sequence the selected floor plans are to be printed in is specified in the 

Collation Tab. 
f. On clicking the Print button, the selected planogram reports will be printed on 

the default printer associated with the user's computer. 

Accessing the Print Planogram Functionality 

Note: before accessing the Print Planogram functionality, 
users should open a floor plan containing planograms. 

The Print Planogram functionality is accessed from the File Menu > Plot option. Users 
with permissions to access the Planner module will automatically have permission to use 
the functionality.  
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Opening State of Functionality 
When the Print Planogram dialog box opens it will be populated with all planograms in 
the currently active floor plan. By default, they will be checked for selection. 

 

Note: the columns that are displayed in the dialog box are 
configurable in the Custom SQL option available from the 
General Menu in the Admin module. 

Using Filters in the Filtering Tab 
The Filtering Tab is provided with a series of filters on each column. Setting a filter on 
one column will affect data in all other columns. 
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They are used as follows: 
1. Show All - this option shows all results. 
2. Custom Filter - this option allows users to set filters using Boolean logic. The options 

are: 
a. Equal to: will return rows that are an exact match for the entered text. 
b. Not Equal to: will return rows that do not match the text string 
c. Contains: will return rows where part of the data matches the text string. (Uses 

implied wild cards). 
d. Does not contain: will return rows where no part of the data matches the text 

string. (Uses implied wild cards). 
e. Begins with: will return rows where the text string is an exact match for the start 

of the data.  
f. Ends with: will return rows where the text string is an exact match for the end of 

the data.  
g. Does not begin with: will return rows where the text string is not an exact match 

for the start of the data.  
h. Does not end with: will return rows where the text string is not an exact match 

for the end of the data.  
3. Blanks - column will be filtered to only show rows with null values. 
4. Non-Blanks - column will be filtered to only show rows containing a value 
5. Results - column will be filtered to only show the selected result.  

The Templates Tab 
The Templates Tab allows users to specify the template format to be used when printing 
planogram designs. 
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The user can use a radio button to specify the form the report will take: an imported 
'associated planogram document' or a template that is configured in the Report Designer 
Module. 
1. Use Associated Planogram document - this option publishes the planogram design 

information using a pre-generated report using one of the following file formats: 
BMP, GIF, JPEG, JPG, PDF, PNG, TIFF or WMF. This report will be imported when a 
planogram is imported using Oracle Data Integrator (ODI). The Associated 
Document (if available) is specified in the Associated Document text box in the 
Details tab of the Planogram Design dialog box in the Merchandiser module. 
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There are two options (selected using the radio button) for when the pre-generated 
report is missing. 

a. Write an error to the AVTTB_PUBLISH_POG_LOG table. Information in this 
table can be read by means of a BI Publisher report or similar. 

b. Use the default Report Designer template. 
2. Use Template - this option allows the user to define the way the template from the 

Report Designer module is selected. There are two options (selected using the radio 
button): 
a. Use Planograms preferred template, if defined - this option is specified in the 

Preferred Template drop down list in the Details tab of the Planogram Design 
dialog box in the Merchandiser module. 

b. Use Selected Template from List Below - this option can be set by checking 
items in the list of available templates. One or more templates may be selected. If 
multiple templates are selected, the name of the template will be added to the file 
name in brackets - for example 1_Bay_Mixed_Fizzy_Drinks (Basic Planogram 
Report).pdf  

If necessary the list of templates can be searched by entering a text string into the 
dropdown list, then clicking the Find button. (Actual or implied wild cards can be used). 
Each click of the Find button will cause the search engine to move forward through the 
matching results until no results are left. 

Note: the last 10 text searches can be selected using the drop 
down list in the text box. 
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The Filtering Tab 
The Filtering tab enables the user to select the Planograms to print. It will populate with 
all planograms in the currently active floor plan. 

Note: If there are multiple instances of a planogram in a 
floor plan, only a single entry will appear in the list of 
planograms. 

The Filtering tab returns a list of all planograms in the database. If only specific zones 
have been loaded into the floor plan when it was opened, the Filtering tab will also 
contain the planograms in the zones that were not loaded.  

Note: the option to only load specific zones is controlled by 
the Express Load option in the Merchandiser tab of the 
Configuration module. 

 

Find 
The Find option can be used by typing text into the text box then clicking the Find icon. 
Each successive click will move the user to the next floor plan matching the text being 
searched for. When no more matches are available, a confirmatory dialog box will 
appear. 

 
Find operates with explicit or implied wild cards. The explicit wild cards are: 
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Wild 
Card 

Description 

* Any characters 

? Any character in this 
position 

# Any number in this 
position 

 
If explicit wild cards are not used, implicit wild cards will be assumed. For example the 
text entry 'Wine' will be treated as '*wine*' and will find I Bay Red Wine, 1 Bay White 
Wine, etc. 

Pick (Planner Only) 
Pick takes the user to the currently active floor plan. They can then use AutoCAD 
selection methods to select specific planograms. When the AutoCAD selection is 
completed with a right mouse click, the user will be returned to the Print Planogram 
dialog box and the dialog box will populate with the selected planograms. 

Right Click Menu 
The right click menu provides a quick way of modifying the selected items. 

 
1. Select All will select (but not check) all rows of data 
2. Clear All will deselect (but not uncheck) all rows of data 
3. Check Selected will check all rows of selected data 
4. Uncheck Selected will uncheck all rows of selected data 
5. Check All will check all rows of data 
6. Uncheck All will uncheck all rows of data 
7. Paste allows users to paste a carriage returned list of floor plan identifiers from the 

Windows clipboard. All rows in the dialog box that match the pasted information 
will be checked. 
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Selecting Planograms to Print 
Planograms may be selected for printing by ticking the appropriate check box. 

The Collation Tab 
The Collation Tab allows users to specify the sequence the planogram designs will be 
published or printed in. Its main use is in printing hard copy versions of the designs 
where the sequence they are printed in makes it easier to sort and distribute them after 
printing. 
At least one collation option must be selected, or the tab will show as having an error.  

 
The available options can be ordered by highlighting them, then using the up or down 
arrows. The options are made active by using the check boxes. 
1. Region is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 
2. District is a specific type of cluster set in the Cluster type drop down list in the 

Cluster dialog box in Store Manager. 

 
3. Store Number is the Store Code in the Store dialog box in Store Manager. 
4. Store Name is the Store Name in the Store dialog box in Store Manager. 
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5. Department is the department (zone) in the floor plan the planogram is associated 

with.  
6. Aisle is the aisle the planogram is associated with. For this option to operate, aisles 

must first be drawn in the floor plan in the Planner module. In the example below, 
Aisle F-1 has been drawn between two runs of fixtures. 

 
7. Bay Number is the bay number associated with the fixtures the planogram is placed 

on. For this option to operate, the fixtures in the floor plan must previously have 
been bay numbered. 

 
8. Bay Group is the Name assigned to a number of fixtures sharing a common 

characteristic. It is assigned in the Name field of the Bay Numbering dialog box in 
the Planner module. 
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9. Planogram Name is the name of the planogram. This is set in the Name field of the 

Planogram Design dialog box in Merchandiser. 
10. Planogram Code is the code for the planogram. This is set in the Client Code field of 

the Planogram Design dialog box in Merchandiser. 
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Errors and Results 
If any settings in the Print Planograms dialog box will lead to errors during printing, an 
error symbol will be displayed on the tab containing the data with the problem. The Print 
button will also be grayed out and unavailable. 

 
Users must correct the problems before the Print button will activate.  
The results from Floor Plan printing are stored in two tables within the database. These 
results can be viewed via reports generated from BI Publisher (or similar software).  

Merchandiser - Zones 

Overview of Zones 

Important Note: Zones can only be added, edited and 
deleted in the Planner environment. Zones can be viewed 
but not altered in Merchandiser. Based on the floor layout 
specified by an architectural drawing; a Zone defines a 
section of floor that is used for a specific and clearly defined 
purpose. The Zone might define an area used for sales, it 
might define an area used for storing stock, or it might 
define areas used for non-sales purposes such as offices, 
corridors or toilets.  

From a technical standpoint, a Zone is a Macro Space Management block that allows 
additional information to be put into a Store Plan. This subsequently allows more 
structured Macro Space Management reports to be produced on the associated layout of 
fixtures, fittings and Planograms within that drawing. 
A Zone is defined by a Planner Polyline enclosing a specific section of floor. Further 
Polylines within the Zone can be used to define pillars or other obstructions.  
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The designation of pillars and other obstacles allows them to be taken into account when 
calculating sales areas. This results in a more accurate calculation of the area of usable 
floor, enabling sales performance analysis to take into account the effect of obstructions.  
The Zone is used to assign a specified part of the total floor area to a specific function. 
Such functions include allocating to specific types of retail goods, (for example electrical 
goods), or designating the area as a non-sales area; for example a manager’s office or a 
corridor.  
Zones thus allow the total floor area in the store to be split into sales and non-sales areas 
and then further sub-divided as to purpose.  
This sub-division of the store allows Planograms and fixtures to be filtered by Zone, 
allowing the store planner to rapidly establish which goods and which fixtures are in a 
specific part of the store.  
Zones can also be designated as being excluded from certain types of reports. This allows 
fixtures and Planograms that have been placed in a storage area to be excluded from any 
calculations or reports on the performance of that part of the store.  
Many of the characteristics of Macro Space Management Zones can be configured within 
the Admin Module. 

The Zones Toolbar 
The Zones Toolbar is found on the Object Browser. 

 
It contains two icons allowing operations to be carried relative to Zones. 

 
Configuration 
Options  

 
Refresh 

 
Configuration Options invokes the Zones tab in the configuration module. 
Refresh refreshes the Zones Hierarchy to reflect any changes made in the Admin Module 
since Merchandiser was opened for the current session.   
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The Zones Hierarchy Window 
The Zones Hierarchy Window is found immediately below the toolbar. 

 
It contains a Hierarchical Tree giving a list of all the available Zone types.  
A zone selected in the drawing will be highlighted in the hierarchical tree.  

Note: Zone types and descriptions can be added, edited or 
deleted using the Admin module.  

The Properties Window 
The Properties Window gives information on the selected Zone Definition. 

 
The Zone Type and Area Properties are read only and cannot be edited.  

The Summary Window 
The Summary Window contains details of Zones within the drawing. 

 
The information typically includes Zone Name, Zone Description, and Gross and Net 
Areas. 
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(Information displayed can be customized by Oracle – contact Technical Support if 
necessary). 
Zone Names and Zone Descriptions can be sorted by clicking on the column headings.  

Overview of Express Loading 
Express Loading is used to load only some of the zones available in the drawing.  
This allows Macro Space Management users to load just the sections of the store plan that 
are of interest to them.  
This reduces the amount of detail in the drawing that the user has to view. 
It will also slightly speed up movement in the Virtual Reality environment as less data is 
being manipulated when the user's viewpoint moves. 
Drawings that are express loaded with only some of the available Zones will still be 
checked out to the user, preventing anyone from working on the Zones that have not 
been loaded. 

Activating Express Loading 
Express Loading is enabled in the Configuration Module.   
The Merchandiser Tab contains an Express Load checkbox.   

 
If the checkbox is ticked, Express Loading will be enabled.  

The Express Loading dialogue box 
The Express Load dialogue box allows the user to select which Zones, Fixtures, Shelves 
and Products will be loaded.  
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The four radio buttons at the top of the dialogue box control what is loaded in the 
selected zones.  
Load entire drawing results in every zone in the drawing being loaded. This will include 
any fixtures not included within a zone. 
Select all Fixtures will select the fixtures in every zone in the drawing. 
Select all Fixtures and Shelves will select the fixtures and shelves in every zone in the 
drawing. 
Select all Fixtures, Shelves and Products will select the fixtures, shelves and products in 
every zone in the drawing. 

Note: Using the Select all Fixtures, Select all Fixtures and 
Shelves and Select all Fixtures, Shelves and Products options 
will not select from Fixtures, Shelves or Products that are not 
in a zone.  

Alternatively, the requirements for Individual Zones can be set by checking or un-
checking the respective boxes for Fixtures, shelves and Products for those zones. 
Objects that are not at floor level (for example banners) are still associated with the zone 
they are within and will be displayed accordingly - i.e. the level of an object does not 
affect whether it is associated with a zone.  
The Include Groups and Families outside of the Zone checkbox (if selected) will result in 
all fixtures (and their associated shelves and products) belonging to a group or family 
that extend outside the selected zones being displayed. 
If this option is not checked, then only fixtures (and their associated shelves and 
products) that cross the boundary of the selected zones will be displayed. 
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Objects crossing Zone Boundaries 
If only some of the available zones are enabled, some fixtures and fittings from the non-
enabled zones may overlap the boundaries of the selected zones.  
The user will be able to see these overlapping fixtures and fittings, together with their 
associated shelves and products.  
These overlapping fixtures, fittings, shelves and products will not be locked, and the user 
will not be prevented from editing, moving or otherwise modifying these objects.  

Merchandiser – Equipment and Fixture Studio 

About Fixture Studio 
Fixture Studio is another Macro Space Management module.  

 
Activities in Fixture Studio have a significant influence on Merchandiser. 
� The hierarchies of Fixtures and Gondolas that display in the Object Browser in 

Merchandiser are configured in Fixture studio. 
� Fixture properties are configured in Fixture Studio. 
� Gondolas are defined in Fixture Studio. 

Gondola and Fixture Hierarchies 
Gondolas and Fixtures for use in Merchandiser are selected from a hierarchy in the 
Object Browser. 
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There is one hierarchy for fixtures and another for gondolas. Users can switch between 
the two by clicking on the Blocks or Gondolas button while in the Fixturing Tab. 
They are made up of groups and fixtures (or gondolas). Groups are the equivalent of 
windows folders and serve to hold fixtures (or gondolas) of a specific type.  
The fixture and gondola hierarchies cannot be altered in Merchandiser, only in Fixture 
Studio.  
In Fixture Studio groups can be added, edited and deleted, as can fixture and gondola 
definitions. This allows the hierarchy to be customized to suit the user.    

Fixture Properties 
Fixture Properties are defined in the Block Details definition box in Fixture Studio. 
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It contains a series of tabs that allow intelligent properties to be assigned to the graphic 
that appears in the drawing.  

Category Tab Basic parameters for the fixture including data on materials, 
manufacturer, how products fit onto the equipment, etc. 

Insertion Tab How the fixture is inserted into the drawing including the 
height above floor level and what direction the front of the 
fixture faces.  

Size Tab The dimensions of the fixture, including additional floor area 
assigned to allow for extra equipment to be placed on the 
fixture.  

Connections Tab Specifies which equipment can be connected to what other 
equipment.  

Parts Tab Specifies what a list of parts for the equipment; for example 
bolts and castors required. 

Fixture Tab  

UDA Tab Allows User Defined Attributes (text based information) to 
be assigned to the fixture. These UDA's can then be viewed 
in Merchandiser.  

Styles/Ranges Tab  
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Merchandisable 
Areas Tab 

Defines the volume that merchandise is allowed to occupy.   

Shelf Tab Sets the default angle for any shelving to be attached to the 
equipment 

Preview Tab For use within Fixture Studio - it allows users to visually 
check connection points, merchandisable areas, etc.  

Gondola Definitions 
Gondolas are defined using the Gondola Definitions dialogue box in Fixture Studio.  

 
They allow gondolas to be defined from the available fixture blocks. Options include: 

Gondola Parts The list of parts that go to make up a gondola, including which 
are optional. 

Gondola 
Dimensions 

The permissible dimensions for the gondola. 

Specifying Insertion Points 
Insertion points can be specified within Fixture Studio. First select the block to be 
modified then select the Edit Block command.  
This will open the block Details dialogue box. The Insertion Tab allows the Insertion 
Position and Child Insertion Position to be specified.  
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Note: The Insertion Position is this dialogue box is a Macro 
Space Management insertion position. The original insertion 
position is an AutoCAD or 3D Studio graphics insertion 
position and the Macro Space Management Insertion 
Position is specified to match.  

If the Macro Space Management Insertion Position is changed, the AutoCAD or 3D 
Studio insertion position must also be modified by changing the graphic or vice versa.  
Failure to do this will result in differences between the AutoCAD/3D Studio insertion 
position and the Macro Space Management Insertion Position. This may result in 
misalignment when objects are placed in Macro Space Management. It will also result in 
errors when calculating adjacencies, etc. 

Child Insertion Points 
Child Insertion Points are used to provide a datum for product being inserted onto a 
fixture or shelf object.  
They are different from Insertion Points.  
Insertion points are used to specify the location of an object (fixture, shelf object, etc) 
within a Virtual Reality store.  
Child Insertion Points are used by Retail Focus to align product being placed on that 
fixture, shelf object, etc. 
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In the above diagram the shelf has an insertion point (red). This has been used to align 
the shelf relative to the back panel it has been placed on.  
Any moving or editing operations for the shelf will be carried out relative to this 
insertion point.  
The shelf also has a child insertion point (green). This will be used to align any product 
placed on the shelf.  
Any moving or editing operations for products placed will be carried out relative to this 
insertion point.  

Setting Child Insertion Points 
Child Insertion Points are set in Fixture Studio. 

 
The Child Insertion Position can be set to any one of nine positions in a specific X – Y 
plane, and to any of three positions in the Z axis. This gives 27 options for the child 
insertion position.  

Important: Wherever possible, child insertion positions 
should be standardized for particular classes of object. This 
will prevent misalignment problems.  

Overview of Equipment Types 
Equipment is categorized under three types: 
Fixtures: Equipment that can be placed on the floor and can be populated with shelves 
and/or products. 
Fittings: Equipment that can be placed on the floor, but can’t be populated. 
Shelves: Equipment that is placed on a fixture and can optionally hold product. 
In addition, there is a fourth class of objects:  
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Other: Any other item that is not equipment, e.g. an architectural column. 

Attachment Options 
The equipment used in building a store layout falls into three categories: Primary, 
Secondary and Tertiary. 
Primary Equipment indicates the most fundamental form of equipment. All Primary 
Equipment is capable of being placed directly on the floor. 
Examples of Primary Equipment include Metal Uprights, Back Panels, Pallets and 
Fittings, (such as legs). 
Some Primary Equipment is capable of accepting subsidiary equipment, (Secondary 
Equipment).  
Secondary Equipment indicates items of equipment that attach directly to Primary 
Equipment. Secondary equipment cannot be placed directly on the floor.  
Examples of Secondary Equipment include shelves, peg boards and slatted back panels 
Some Secondary Equipment is capable of accepting further subsidiary equipment, 
(Tertiary Equipment).  
Tertiary Equipment indicates equipment that is attached to Secondary Equipment.  
Examples of Tertiary Equipment include pegs, rods and dividers.  
Equipment can therefore be arranged in a hierarchy. 

 
All Secondary Equipment must have an item of Primary Equipment as a parent. 
Similarly, every item of Tertiary Equipment must have an item of Secondary Equipment 
as its respective parent.  
Depending on the design, some items of Primary, Secondary and Tertiary Equipment can 
accept merchandise. Others cannot.  

Equipment Placement Options 
The following table indicates how Macro Space Management fixtures and fittings can be 
inserted into the drawing and connected to each other.  

–  Shelf Style 
Name 

Can be 
placed 
on floor 

Attaches 
to Fixture 

Attaches 
to Shelf 

Accepts 
Equipment 

 

Back Panel 

  
X 

   
X 
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–  Shelf Style 
Name 

Can be 
placed 
on floor 

Attaches 
to Fixture 

Attaches 
to Shelf 

Accepts 
Equipment 

 
Basket Shelf 

 
Basket 

   
X 

 
X 

 

Booster Shelf 

    
X 

 

Crossbars, 
Lateral Rod 

 
Crossbar 

  
X 

  
X 

 
Divider 

 
Divider 

   
X 

 

Fittings, i.e. 
legs 

   
X 

  

 
Gravity Feed 

   
X 

  

 
Grille/Riser 

 
Grille 

   
X 

 

 

Hanging Bar 

 
Bar 

  
X 

  
X 

 
Metal Upright 

  
X 

   
X 

Obstruction, 
i.e. cross brace 

 
Obstruction 

  
X 

  

 

Pallet 

 
Pallet 

 
X 

   

 
Pegboards 

Pegboard  X  X 

 

Pegs 

Peg    
X 

 

 
Products 

    
X 

 

 
Rods 

 
Rod 

   
X 

 

 

Shelves 

 
Open Shelf 

  
X 

  
X 

Slatted Back 
Panels 

Slatted Back 
Panel 

  
X 

  
X 
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–  Shelf Style 
Name 

Can be 
placed 
on floor 

Attaches 
to Fixture 

Attaches 
to Shelf 

Accepts 
Equipment 

 
Space Holder 

 
Space 

  
X 

 
X 

 

 
Can be placed on floor indicates equipment that can be placed directly on the floor. All 
other equipment must be attached to and supported by these types of equipment. 
All equipment that places directly on the floor is Primary Equipment. 
Attaches to Fixture indicates items of equipment that can be directly attached to a 
fixture.  
All equipment that cannot be placed directly on the floor and requires attaching to a 
fixture is Secondary Equipment. 
Attaches to shelf indicates equipment that can only be placed on a shelf -  
All equipment that needs to be placed on a shelf is Tertiary Equipment. 
Accepts equipment indicates that this item can have subsidiary items of equipment 
attached to it. For example, fixtures can accept shelves, shelves accept dividers and grilles 
and pegboards accept pegs.  

Equipment Merchandising Options 
Macro Space Management equipment can be merchandised as follows.  
(Fittings cannot hold products – only fixtures and shelves can hold merchandise). 
 

–  Shelf Style Name Can Populate with 
Placeholder 

Can Populate 
with SKU 

 
Back Panel 

  
X 

 

 
Basket Shelf 

Basket  
X 

 
X 

 

Booster Shelf 

  
X 

 
X 

 
Crossbars, Lateral 
Rod 

 
Crossbar 

  

 
Divider 

 
Divider 

  

 
Fittings, i.e. legs 

   

 
Gravity Feed 

  
X 

 
X 
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–  Shelf Style Name Can Populate with 
Placeholder 

Can Populate 
with SKU 

 

Grille/Riser 

 
Grille 

  

 
Hanging Bar 

 
Bar 

  

 

Metal Upright 

  
X 

 
X 

 
Obstruction, i.e. cross 
brace 

 
Obstruction 

 
X 

 
X 

 
Pallet 

 
Pallet 

  

 
Pegboards 

 
Pegboard 

  

 

Pegs 

 
Peg 

 
X 

 
X 

 
Products 

   

 

Rods 

 
Rod 

 
X 

 
X 

 
Shelves 

 
Open Shelf 

 
X 

 
X 

 
Slatted Back Panels 

Slatted Back 
Panel 

  

 
Space Holder 

 
Space 

  

 
Both fixtures and shelves (Open Shelves, Hanging Bars, etc) can be populated with 
products.  
Other fixtures, such as back panels, cannot be populated with products directly but can 
hold shelves – which in turn can hold product.  
Can Populate with Placeholder indicates that a placeholder can be placed on the fixture. 
Placeholders allow the user to indicate the fixture can be used for a general class of 
merchandise (for example men’s clothing) than a more specific SKU (for example blue 
men’s shirts). 
Can Populate with SKU indicates that individual items of merchandise (SKU’s or Stock 
Units) can be placed on the fixture. 
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Working and Stacking Axes 
Working and Stacking axes define how product is placed onto fixtures and shelf objects.  
Fixtures and shelf objects that do not have at least one working and one stacking axis 
defined cannot accept product.  

Working Axis 
When products are placed onto a shelf object they have to be aligned with each other 
during placement.  
The working axes of an item of shelf equipment are the axis’s which product that is being 
sequentially placed is aligned along.  
� The X working axis is from left to right. 
� The Y working axis is from front to back.  
� The Z working axis is used for vertical placement.  

The working axis set should be appropriate for the type of fixture or shelf object.  
For example a shelf will normally have only an X working axis as product is normally 
placed along the length of a shelf. 
A freezer cabinet might have an X and a Y working axis as product is placed both along 
the length of the cabinet and from back to front 

 
The working axis set should be appropriate for the type of fixture or shelf object.  

Stacking Axis 
The stacking axis (or axis’s) is the direction(s) that products may be stacked on a fixture 
or shelf object.  
� The X stacking axis is from left to right. 
� The Y stacking axis is from front to back.  
� The Z stacking axis is used for vertical stacking.  
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The stacking axis set should be appropriate for the type of fixture or shelf object.  

Examples of the Working and Stacking Axis’s of Fixtures and Shelf Objects 
An open shelf will have objects placed along the length of the shelf (X working axis). 
It can have objects stacked next to each other (X axis) behind each other (Y axis) and on 
top of each other (Z axis). Accordingly an open shelf should have all three stacking axes 
checked.  

SHELF X Y Z 

Working ;   

Stacking ; ; ; 

 
A peg on the other hand can only have products placed along its length (Y working axis). 
A peg can only have products slid along its length – they are constrained so they can 
only move in that direction. Accordingly, a peg should only have its Y stacking axis 
enabled. 

PEG X Y Z 

Working  ;  

Stacking  ;  

 
 Working and Stacking Axes are set in Fixture Studio.  

 
The rotation of products is theoretically allowed in any axis. In practice this is 
constrained by the Working/Stacking axes of the shelf objects.  

Merchandiser – Aspects of Equipment 

Overview of Macro Space Management Equipment 
A Store in the Merchandiser environment is populated by equipment. This can include 
fixtures, fittings, shelves and many other items of store furniture. 
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The way these items behave is affected by the properties they have been assigned, how 
they are grouped together for collective manipulation and by what the System variables 
are set to.  

Object Properties 
Each of these items of equipment has been initially created as a graphic (using for 
example AutoCAD). The graphic contains basic properties such as dimensions and an 
insertion point.  
The graphic has then been imported into Macro Space Management and turned into a 
Macro Space Management Block. During this process, the Macro Space Management 
Block is assigned additional properties that allow it to act in an ‘intelligent’ manner when 
in the Macro Space Management CAD and Virtual Reality Environments.  
Knowledge of how these ‘Intelligent Properties’ affect the behavior of equipment within 
Macro Space Management is important in understanding the behavior of the software. 
Some of these properties are: 
 

Insertion 
Points 

Determine the locations at which equipment 
and merchandise is placed in Merchandiser 

Child Insertion 
Points 

Determine the justification which products 
are placed on fixtures and shelf objects 

Connection 
options 

Determines how one item of equipment 
connects to another.  

Placement 
Options 

Determines the alignment, etc, when product 
is placed onto open shelves, pegs and other 
shelf objects 

Styles Determines which items of equipment are 
compatible with another. Also determines 
which shelf objects products can be placed 
on. 

Alignments Determines how groups of products on shelf 
objects can be aligned (justified) relative to 
that shelf object. 

Product 
Orientations 

Individual product items can be placed in 
specified orientations, for example with the 
front, side or top of the packaging facing 
forward on the shelf object. 

Grouping of Objects 
Multiple objects (collections of either equipment or products) can be selected for 
collective operation. This is done by: 
� Selection sets: used for a single collective operation. 
� Groups: sets of objects in horizontal alignment that can repeatedly manipulated 
� Families: sets of objects in vertical alignment that can repeatedly manipulated 
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System Variables 
In addition there are a number of System Variables that affect Macro Space Management. 
These may be set to different values – each of which will cause a modification to the 
behavior of the Macro Space Management environment.  

Overview of Equipment Types and Connection Points 
The equipment used in building a store layout falls into three categories: Primary, 
Secondary and Tertiary. 
Primary Equipment indicates the most fundamental form of equipment. All Primary 
Equipment is capable of being placed directly on the floor. Some Primary Equipment is 
capable of accepting subsidiary equipment, (Secondary Equipment). Only Primary 
Equipment has an Insertion Point that is directly placed in the floor plan of a store.  
Secondary Equipment indicates items of equipment that attach directly to Primary 
Equipment. Secondary equipment cannot be placed directly on the floor. Some 
Secondary Equipment is capable of accepting further subsidiary equipment, (Tertiary 
Equipment). Secondary Equipment has an insertion point relative to the insertion point 
of its parent Primary fixture.  
Tertiary Equipment indicates equipment that is attached to Secondary Equipment. 
Equipment can therefore be arranged in a hierarchy, as in the example below. 

 
Within the Merchandiser environment, store furniture can be assembled in standard or 
custom configurations by joining together items of equipment.  
For example, a back panel could be placed directly on the floor. This back panel could 
then have runs of shelving attached, and the shelves in turn have dividers placed on 
them.  
Macro Space Management’s internal rules determine exactly how items of equipment can 
connect together. Within the Merchandiser environment, connection points give visual 
indications as to how individual items of equipment can be assembled.  
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Overview of Location and Coordinate Systems 
The central Macro Space Management database holds information on the location (and 
dimensions) of all objects placed on the floor of the Virtual Reality store. These will 
normally be a limited number of fixtures and fittings such as legs, pallets, etc.  
Each object will be inserted at a specific Insertion Location with coordinates expressed in 
terms of X, Y and Z coordinates.  
Each object to be inserted has two Insertion Points; a Graphical Insertion Point and a 
Macro Space Management Insertion Point. The graphical insertion point is created when 
the graphic is drawn (in for example AutoCAD). When the graphic is imported into 
Macro Space Management, the coordinates of the graphical insertion point are manually 
entered into the object details held by Macro Space Management. This manually entered 
data must match the original graphical insertion point, or misalignments will occur in the 
Virtual Reality environment.  
All other objects, (equipment of merchandise) are connected to the fixtures and fittings 
that have been placed on the floor. These objects are known as children of their parent 
objects. 
Children have their own insertion locations specified relative to the insertion location of 
their parent objects. They also have their own individual graphical and Macro Space 
Management insertion points. Again, these must match to prevent misalignments. 

Overview of Connection and Placement Options 
Objects in Macro Space Management can be split into several broad categories.  
Two of these categories are Equipment and Products. They connect together in slightly 
different ways. 

Equipment 
Equipment connects together using Connections. These may be either points (which 
simply snap two items of equipment together), lines (which allow equipment to be 
connected at intervals defined along a line), or planes (which allow equipment to be 
connected at intervals defined in a 2 dimensional grid). 

Products  
Products connect together using Placement Options. These may be either Continuous 
Placement (where products can be placed anywhere within a specified boundary, for 
example an open shelf), or Point Placement (where products can be placed in clearly 
specified places, for example on an array of pegs). 

Overview of Styles 
Styles are used to specify which items of equipment are compatible with another, and 
which types of product can be placed on which shelf. 
Equipment has Fixture Styles. Only equipment with compatible styles can be connected 
together.  
Shelves have both Fixture Styles and Shelf Styles. The Fixture style must be compatible 
with the equipment it is being placed on. The shelf style must be compatible with the 
product that can be placed on it.  
Product has a Product Style. The Product Style must be compatible with the shelf on 
which it is being placed or placement will not be allowed. 
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Overview of Alignments 
When objects are placed on shelf objects, they may not be in the best possible alignment 
to display them, or there may be gaps between products leading to inefficient use of shelf 
space.  
Macro Space Management has a series of alignment options so that selected products on 
pre-determined shelves can be aligned (justified) to customer specified requirements 
such as the left of the shelf, the back of the shelf, etc.  

Overview of Product Orientations 
Products are normally placed with the front of the packaging facing the front of the shelf 
object.  
However, placing products in this orientation may not fill the shelf to its maximum 
capacity.  
Macro Space Management thus allows products to be placed in other orientations, for 
example on their side, so that the number of products placed on a particular shelf object 
can be maximized.  
Product placed in orientations other than the main one is known as caps.  

Product Orientations 
Product is normally placed on the shelves with the front of the packaging facing the 
customer. However, this orientation can be changed; either during placement or when a 
product is edited.  

 
The nine possible orientations are as follows: 

 
(The red dot indicates the insertion point). 
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Front is the default orientation. The other orientations are achieved by the following 
rotations from the default.  

Orientation Rotation in X Axis Rotation in Y Axis Rotation in Z Axis 

Front None None None 

Front Side None 270o None 

Back None None 180o 

Left None None 90o 

Right None None 270o 

Left side None 270o 90o 

Top 90o None None 

Top side  90o 270o None 

Bottom 270o None None 

Effect of Rotations 
Then the object is rotated to change its orientation, it occupies the same relative position 
on its parent object. This is done by means of child insertion points.  
In the example of the box on a shelf, the child insertion point (the datum for the boxes’ 
position) is shown in blue. It is set at the front left of the shelf.  

 
When the box is rotated, it is still aligned relative to the child insertion point, although 
the boxes’ insertion point (shown in red) has moved  
A similar effect can be seen in the example of a box being rotated relative to its parent 
peg. 

 
The child insertion point (shown in blue) is at the front of the peg. When the box is 
rotated it remains in the same relative position to the child insertion point although its 
own insertion point has changed position.  
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Merchandiser – Connection Points 

Overview of Connection Points 
Connections points are used to join items of equipment together. They can either be 
used singly, or aligned in lines, planes or boxes. 
Connection Points are used to attach items of equipment together.  
Connection Lines are used where items like crossbars have set positions along their 
length that can accommodate Tertiary Equipment such rods.  
The position of the arrow indicates the position of the connection point. 
The increments between set positions along a connection line are defined in Fixture 
Studio.  
The position of the connection arrow defines the leftmost position of the first point on the 
connection line. 
Connection Planes are used where Secondary Equipment such as peg boards or slotted 
back panels have a 2 dimensional array of possible connection points for Tertiary 
Equipment such as pegs.  
The increments between set positions in a connection plane are defined in Fixture Studio.  
The position of the connection arrow defines the bottom left position of the first point on 
the connection plane. 

 
In the above diagram, blue arrows (1) represent Connection Points; red arrows (2, 3, 4) 
represent Connection Lines and the green arrow (5) represents a Connection Plane. The 
arrow direction indicates the X axis and the arrow lies in the X, Y plane. 
Slatted back panels use a connection plane with the X spacing set to 0 so that rods can be 
slip to any position along the slot. The Y spacing is set to the distance between slots. 

 
It is also possible to use more than one connection line, as for example with racking.  
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The fixture could be defined as two uprights (front and back), plus the cross-bracing. 
This would allow beams (blue) to be added to either the front or the back.  
Macro Space Management will use the nearest connection arrow to the drop/pick point 
when deciding which to use. 
Connection points are used to define the exact point on the dropped object (shelf or peg 
or rod) that attaches to the notch position. The connection line/plane filters must match 
the connection point filters. If no connection point is defined for the dropped object, it 
will use the insertion point of the shelf/peg. 

The Connections Tab in Fixture Studio 
The Connections Tab in the Block Details dialogue box in Fixture Studio lets the user 
specify the connection options for Macro Space Management blocks.  

 
A small Toolbar at the top lets users Add, Copy and Delete connections, while the 
Wizard on the toolbar allows the user to add three basic connections. 
The Connections List below the toolbar lists all current connections for the Macro Space 
Management Block. 
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The defined connection points are the defaults for that fixture type and will be applied 
for every instance placed in the drawing.  

Note: See the Fixture Studio Help File for more information. 

The Connections Tab and the Configuration Module 
Settings in the Configuration Module can affect how connection points appear and 
behave. Settings are local and can be customized for the user. 
Access the Configuration Module by selecting the Configure Option in the file pull down 
menu.  

 
Within the Configuration module, select the Fixturing Tab. The Connection Points frame 
can then be used to change their appearance.  

 
Pointer Size and Line Size affect the appearance of the connection points as displayed.  
Colors for Neutral, Male and Female connection points can also be set. 
A series of check boxes allow users to configure some aspects of how connection points 
operate: 
� Gender Filter determines whether connection genders are taken into account 

when deciding if connections are compatible.  
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� Size Filter determines whether connection sizes are taken into account when 
deciding if connections are compatible.  

� Shape filter options determine whether connection shapes are taken into account 
when deciding if connections are compatible.  

These settings are local and will not affect other users of Macro Space Management.  

Connection Details 
Each connection needs the following information to be specified for it in Fixture Studio.  
� Name 
� Type 
� Layer 
� Gender 
� Shape 
� Size 
� Whether it is the Default 
� Position, Array and Angle settings 

For one item of equipment to connect to another the following must be true. 

–  Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders 

This requirement can be 
disabled in the 
Configuration Module 

Shape The connection points must have the 
same shape 

This requirement can be 
disabled in the 
Configuration Module 

Size The connection points must have 
compatible sizes 

This requirement can be 
disabled in the 
Configuration Module 

 
If any of these criteria are not true, then a connection cannot be made. 
In addition, if the details of the connections are not correctly specified relative to each 
other, equipment may connect together in unintended alignments.  

Setting Connection Point Parameters 
The Connection Point parameters are set using the Block Details dialogue box in Fixture 
Studio.  
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Brief details will be discussed in the following sections - see the Fixture studio help file 
for more detailed information. 

The Connections Toolbar 
The Connections Toolbar is found to the upper left of the Connections Tab in the Block 
Details dialogue box in Fixture Studio. 
It allows users to Add, Copy and Delete Connections. It also allows the user to invoke the 
Connections Wizard. 

 

 
Add a Connection 

 
Copy a Connection 

 
Delete a 
Connection 
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Connection Point 
Wizard 

Add a Connection 
Clicking on the Add a Connection icon causes a line to be added to the Connections List 
ready for further details of the connection to be added. 

 

Copy a Connection 
Clicking on the Copy a Connection icon causes a line to be copied again to the 
Connections List mirroring details of the connection to be added. 

 
Before clicking the Copy icon, select the connection to be copied. Clicking on the icon will 
bring up the connection naming dialogue box. 

 
Edit the name to one suitable for the new connection. In the example To be copied has 
been edited to Copied. 
On clicking OK, a duplicate connection will be added, save for the changed name. 

 

Delete a Connection 
To delete a connection, highlight the connection to be deleted and click on the Delete 
icon.  
The User will be asked to confirm deletion. 
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Connection Wizard 
The Connection Wizard is discussed in its own section here  

The Connections Wizard 
The Connections Wizard can be invoked from the Wizard icon in the toolbar in the 
Connections Tab in the Block Details dialogue box in Fixture Studio. 

 
This will bring up the Connections Wizard dialogue box. 

 
� Checking the Add connection on Left checkbox will add a Connection on the left. 
� Checking the Add connection on Right checkbox will add a Connection on the 

right. 
� Checking the Add connection at Back checkbox will add a Connection at the 

back. 
The left connection is male and the right female so that fixtures can only attach when 
they are facing the same way. The left connection is additionally set to be the default. 
The Back connection has no gender, so it will attach to any other connection.  
Checking the Clear Existing Blocks checkbox will remove any existing connections. 
On clicking OK on the Wizard, the selected default connections will be added. 
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Other Connection Point Parameters 
Other connection point parameters can be set in the Connections Tab in the Block 
Details dialogue box in Fixture Studio. 

 
These include Type, Position, Array Spacing, Gender, Shape, Size, Horizontal Angle and 
Vertical Angle.  
(See the Fixture Studio Help File for more information). 

Overview of Using Connection Points 
Connection points can be used to attach one piece of equipment to another.  
For the equipment to connect, the connection points must be compatible.  
Some factors affecting compatibility are set in the Configuration Module. 
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Other fixture specific factors are set in the Configuration Tab of the Block Details 
dialogue box in Fixture Studio. 

 
The combination of both sets of parameters will determine whether two connection 
points are compatible with each other. 
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Turning Connection Display On and Off 
The Connection Display can be turned on and off for individual fixtures or a selection 
set of fixtures within the Merchandiser Module. 
Select one or more fixtures, then move the mouse pointer inside a fixture and use <Ctrl> 
plus right click to bring up the pop-up menu.  

 
Clicking on the Connection points option in the pop-up menu allows connection display 
to be turned on and off.  
Hide parent will turn off connection point display the parent fixture when (for example) 
a child object such as a shelf is selected.  

Connection Point Appearance 
When visible, Connection Points are shown as triangles.  

 
The color and size of the connection points can be specified in the Configuration Module.  
Their angle, gender, etc, for a specific fixture can be specified in Fixture Studio.  
Connection Points can appear in lines and arrays, as well as discrete points. The example 
below shows a Connection Line. 
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Checklist for Compatibility 
For one item of equipment to connect to another the following must be true. 

–  Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders 

This requirement can be 
disabled in the 
Configuration Module 

Shape The connection points must have the 
same shape 

This requirement can be 
disabled in the 
Configuration Module 

Size The connection points must have 
compatible sizes 

This requirement can be 
disabled in the 
Configuration Module 

Gender 
The gender of a connection determines whether that connection is compatible with 
another. There are three genders; male, female and neutral. They connect as follows: 

–  Can connect with 

Male Female Neutral 

Female  Male Neutral 

Neutral Any other connection 

Shape 
The shape of a point connection can be specified from a list provided by Oracle. They 
connect as follows: 

–  Can connect with 

None Any other connection shape 

Rectangle Rectangle None 
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Circle Circle None 

Oval Oval None 

Triangle Triangle None 

Hexagonal None None 

 
The shape of a connection point is a theoretical concept used to make it easier to 
remember what connects to what - i.e. fixtures with 'Oval' connection points can only 
connect to other fixtures with 'Oval' connection points.  
(When displayed in Merchandiser, all connection points will appear visually as 
triangles). 

Size 
A maximum and minimum size for the connection can be set in Fixture studio 
A pair of connection points must have compatible sizes to connect together.  
If the Match check box is ticked, then the connections must have identical maximum and 
minimum sizes. If they are not identical, the connections will not mate. 
If the Match check box is not ticked, then the connections must have overlapping size 
ranges. If they are not overlapping, the connections will not mate. 

–  Connection 1 Connection 2 –  

Size Range 0 - 50 25 - 75 Compatible 

Size Range 0- 25 50 - 75 Incompatible 

 

Connecting two objects in Edit Mode 

Swap to Edit Mode 
To connect two objects in edit mode, first ensure that edit mode has been selected by 
toggling from Walk Mode to edit mode on the status bar.  

 

Turn Connection Points On 
Next, ensure that the connection points have been toggled on by selecting a least two 
fixtures and use <Ctrl> plus right click to bring up the pop-up menu.  
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Turn connection points on and they will appear as triangles in the drawing.  
Click First Connection Point and Follow Prompts 
Click on the first connection point (circled in red in the image below). 

 
A prompt will then appear in the status bar asking the user to select the  

 
Select a connection point on the other fixture (circled in red in the image below). 

 



Merchandiser – Adding Products 

524 Store Planning User Guide 

As soon as the second connection point is clicked, the first object will be connected to the 
second one. 

 
Note how the two connection points now meet: 

 

Merchandiser – Adding Products  

Overview of Adding Products 
When Products are added, they are added as a Product Group; that is to say as a set of 
linked individual products that can be manipulated as a single entity.  
Products are added by dragging them from the window in the Merchandising tab on the 
Object Browser onto the fixture or shelf that they are intended to populate.  
They can only be placed if the dimensions of the receiving fixture and fitting are of 
sufficient size and if the styles of the fixture or shelf are compatible with the product 
being placed on it.  
If the product can be placed then the Add Products Dialogue box will appear.  

 
This enables the Quantity, Alignment, Detail, Orientation and Properties to be specified.  
Product quantities and alignments can either be placed manually or calculated 
automatically. The latter option is particularly useful when using caps.  
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The above example has back and end caps. These could be placed manually, but this 
would be time consuming. They can be placed in a single operation when the quantity is 
calculated automatically.   

The Quantity Tab - Overview 
The Quantity Tab allows the user to specify the number of instances a product can be 
placed.  

 
Two radio buttons allow the user to specify whether quantities are set by the user (1) or 
calculated by the program (2). 
For information on setting quantities by the user see here. 
For information on using the program to calculate quantities see here. 

The Quantity Tab - Setting by User 
The Quantity Tab allows the user to specify the number of instances a product can be 
placed.  
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Two radio buttons allow the user to specify whether quantities are set manually by the 
user (1) or set automatically by the program (2). 

Set Manually by the User 
Spin controls (3) allow the user to set the required quantities for facings, depths and stack 
height. 

Facings The number of times the product can be placed along the shelf (the X 
direction). 

Depth The number of times the product can be placed relative to the depth of 
the shelf (the Y direction). 

Stack The number off times product can be stacked on top of each other (the 
Z direction).  

 
These quantities are constrained by the dimensions of the shelf or fixture. The minimum 
possible value in each direction is one, while the maximum number is determined by the 
dimensions of the product.  

Set Automatically by the Program 
Four buttons automatically set the facings, stack and depth values to the maximums 
possible for that option relative to the dimensions of the shelf. 
The One button (4) sets facings, depth and stack values for a single instance of the 
product.  
The Depth button (5) sets facings, depth and stack values for a single row of product to 
the full depth and height available. 
The X,Y fill button (6) sets facings, depth and stack values for a single layer of product to 
the full length and depth of the shelf. 
The Fill button (7) sets facings, depth and stack values to get the maximum number of 
products on the shelf without using caps. 
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Note: Automatic setting by the program does not place caps, 
but only places the product in the primary orientation. If the 
user wants to place products with side, rear or top caps, it is 
recommended they select the Calculate option by clicking on 
the appropriate radio button - (2) in the annotated diagram 
above.  

Grouped (8) determines whether products are placed as product groups, or as a stack of 
ungrouped items.  

Note: It is recommended that products are placed as 
grouped items as they can then be manipulated as a single 
object. If they are placed as a stack of ungrouped items, then 
each item in the stack has to be manipulated individually. 

The Alignment Tab 
The Alignment Tab allows alignment to be adjusted in horizontally, i.e. in the X, Y plane.  

 
In the example below, the products on the left hand shelf have been placed with a Left 
Front justification, and the products on the right hand shelf have been placed with a Back 
Right justification.  

 

The Alignment Tab and Child Insertion Positions 
It is important to be aware of the different effects that the Child Insertion Position and 
the selection made in the Alignment Tab have.  
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Child Insertion Position 
The child insertion position for a fixture determines the insertion point of the products 
that will be placed on the fixture. This is because products are not directly assigned an 
insertion point, but adopt those specified for the fixture they are being placed on. 

 
If the fixture has an insertion point of Bottom Front Left any products will be placed with 
this point on the product used as a datum.  
Similarly, products with insertion points of Top Back Center or Bottom back left will be 
placed using different datum points for those products.  
If a shelf object (for example a open shelf) was intended to take boxed products, it might 
have its Child Insertion Position set to Bottom Back Left as the boxed products will sit on 
top of the shelf.  
If a shelf object (for example a hanging rod) was intended to take products hanging from 
it, it might have its Child Insertion Position set to Top Back Center so the products 
appear to hang from the rod when placed on it.  

Note: Child Insertion Positions are set in Fixture Studio. 

Alignment Tab 
The settings made in the alignment tab determine the position of the product when 
placed on the object.  

 
For example if Back Left is selected, product will be placed at the back left of the shelf.  
Similarly, if front middle is selected for a rod, product will be placed starting at the front 
of the rod.    
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Summary 
The Child Insertion Position determines how the product is placed relative to the object it 
is being placed on; above it, below it, centered on it, etc.  
The Alignment Option determines which part of the object (for example a shelf) a 
product is placed starting from. For example if Front Right is selected, the first box of a 
product will be placed at the front right of the shelf.  

The Detail Tab 
The Detail Tab gives information on dimensions and quantities. 

 
Size is the size of one instance of the Product. 
Gap is the gap between instances of the product. The gap is preset when the product is 
designed in Product Studio and may be necessary where merchandise like glass or 
crockery is concerned.  
Min stack is the minimum quantity that can be placed.  
Max Stack is the calculated maximum quantity that can be placed.  
Shelf Capacity is the dimension of the shelf on which the products are being placed.  

The Orientation Tab 
The Orientation Tab allows the orientation of the product to be changed when it is 
placed on the shelf. 

 
The maximum amount placeable for each orientation will be shown, while non available 
orientations will be grayed out.  
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By default the product is placed with the front of the packaging showing. It can be placed 
in a whole series of other orientations with the top, bottom, left or right sides of the 
packaging showing.  

 
In the above example the product group on the left has been placed with the Front 
orientation. A second example of the same product group has then been placed to its 
right in the Top Side orientation. 

Note: Changing orientation will also change the quantity on 
the Quantities Tab to the maximum possible in that 
orientation. This is to allow the user to see if changing the 
orientation will increase the quantities that can be placed on 
the shelf.  

The Properties Tab 
The Properties tab displays a customizable list of properties associated with the products 
being placed. 
The values for this customizable list can be input into Macro Space Management directly 
or imported from an external program.  
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The information is advisory only and will not cause a warning to be issued if the product 
being placed falls outside of the set criteria. 

Overview of Calculation Option Method 
This section of help details how the calculate option can be used to simplify maximizing 
the number of products placed on a shelf.  
There are two options for adding products in Merchandiser; by manually adding then 
and by automatically adding them by using the calculate option. 
To maximize the number of products on a shelf it is sometimes necessary to use end caps, 
as in the example below. 

 
It is possible to achieve this manually by placing the main body of product, then placing 
the rear end cap and then the size end cap. This may require some time to achieve. 
It is also possible to achieve this in a single operation using the Calculate option. This can 
result in considerable savings in time when populating shelves. 

Summary of Method 
Within Merchandiser: 
� Check the Size Rule is ON. 
�  If necessary make shelves a Group. 
�  Select the product to be placed from the product hierarchy. 
�  Drag the product onto the required shelf. 
� Select the calculate option and use the spin controls to set the number of 

products required. 
�  Set the tolerance and orientation in the Calculation screen. 
�  Set priority for the working axes, specify if dimension is to be filled/ maximum 

number of products and specify if caps are allowed. 
�  If solution is satisfactory, click on OK to confirm. 

Check the Size Rule is ON 
When placing product it is recommended the Size Rule is turned on, either from the edit 
menu or the icon on the toolbar. 
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This will restrict the number of products added to those permitted by the confines of the 
shelf. 
If this option is not enabled, it is possible that product will overlap shelves to the left, 
right or above. 

If necessary make shelves a Group 
With the Size rule on, product will be confined to a single shelf, unless two or more 
shelves have been made into a Group.  
Shelf Groups are groups of shelves that are at the same height, at the same angle and 
form a continuous run.  
Grouped shelves allow the user to treat adjacent shelves as one long shelf. This enables 
the user to place products that span more than one shelf. 

Note: Grouping can be applied to any type of shelf objects, 
such as open shelves, rods, bars, pegs, dividers etc. 

To make a Shelf Group, left click on the required shelves, right click to bring up the pop-
up menu and select Groups > Join. 
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Ungrouped shelves can be distinguished by their red and blue outlines.  
Grouped shelves have yellow and green outlines. 

Select the product to be placed from the product hierarchy 
The product required should be selected from the hierarchy in the object browser by 
clicking on it to highlight it. 
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Drag the product onto the required shelf. 
Hold down the left mouse key and drag the selected product onto the desired shelf. 

 
A + sign by the cursor indicates that the shelf has been selected.  

Note: If styles are in use the Shelf Style and the Display 
(Product) style must be compatible or the product cannot be 
placed. 

As soon as the mouse key is released, the Add Products dialogue box will appear.  

Select the calculate option and use the spin controls to set the number of products 
required 

The Add Products dialogue box allows the user to control the quantity and orientation of 
the product being placed.  

 
The calculate option is selected by clicking on the appropriate radio button (1).  
The Spin Control (2) can then be used to set the required quantity of product to be 
placed.  
The Calculate button (3) can then be used to open the calculation screen.  

Note: If it is desired to get the absolute maximum of 
products onto the shelf, the required quantity should be set 
significantly above what is required. This will ensure Macro 
Space Management calculates the maximum number of 
products that will fit on the shelf. 
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Set the tolerance and orientation in the Calculation screen 
After the calculate button is clicked, the calculation screen will appear. 

 
The Required Quantity (1) is that set in the preceding Add Products dialogue box. If 
necessary this can be edited to a different value while in the screen. 
The Quantity Tolerance (2) allows the user to set the permissible variation in quantity.  
If set to 0, Macro Space Management will try and calculate an exact solution. If set to >0 
Macro Space Management will accept the first calculated solution that comes inside the 
permissible range.  
For example, if set to 60 ± 5, the first calculated solution that falls in the range 55 – 65 will 
be accepted.  
The Main Orientation (3) of the product can be set from the drop down list. 

 
This determines which part of the products’ packaging faces the front of the shelf. 
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Set priority for the working axes, specify if dimension is to be filled/ maximum number of 
products and specify if caps are allowed 

 
The Priority (1) for the working axes can be set by clicking on the appropriate axis to 
highlight it (2) then using the + and – buttons (3) to change the order of priority.  
Macro Space Management will calculate the quantities in the order the axes have been 
selected. For example, if the X axis has been chosen, the software will stack the maximum 
number of products along that axis then take the dimensions of those placed products in 
account when calculating how many products can be placed along the second priority 
axis.  
If the Fill check box (4) is selected, then Macro Space Management will place the 
maximum number of products in that direction.  
If the Fill checkbox is not selected, then a Fixed Quantity (5) can be entered in the 
appropriate box. If a Fixed Quantity is entered, this will also disable the Allow Caps (6) 
option as the fixed quantity only applies to products placed in the Main Orientation.    
If a quantity greater than the maximum number that will fit is entered then the number 
will default to the largest value possible.   
End Caps (6) can be allowed or prevented by selecting or un-selecting the check box as 
appropriate.  

If solution is satisfactory, click on OK to confirm 
The calculate screen will continually update to show the effect of any changes. 
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The results will show in the Proposed Solution frame (1). 
A warning (2) will appear if the number of products that can be placed is below that in 
the Required Number (3) setting.  
If the details are correct, click on the OK button (4) to place the products. 

Overview of adding Products using Pegs 
To add products using pegs in Merchandiser, a series of preparatory parameters must 
be set in the Admin Module, Fixture Studio and Product Studio.  This then enables 
products to be added to pegs in Merchandiser.  
A pegboard might contain an array of 10 x 20 pegs, 200 pegs in all. Merchandising these 
pegs is a potentially time consuming operation as this might involve 5 sizes of battery (N, 
AAA, AA, C & D) from three or four manufacturers (Duracell, Exide, Eveready, 
Energiser). 
It is therefore normal to produce a planogram involving a specific combination of battery 
sizes and manufacturers. Once available, this planogram can then be placed multiple 
times in multiple stores. 
An example would be a battery planogram designed for an end cap on a gondola run.    

Flowchart for adding Products using Pegs 
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Setting up Styles in the Admin Module 

Note: For more detailed information see the Admin Module 
Help File. 

Styles serve as filters to determine what can be attached to what.  
� The parent fixture will have a fixture and a shelf style. 
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� The peg will have a shelf style. 
� The product will have a product style. 

For the peg to go onto the parent fixture there must be a style relationship between the 
Fixture and Shelf Styles. 
For the product to go onto the peg there must be a style relationship between the Shelf 
and the Product Styles.   

Overview of Settings Required in Fixture Studio 
For products to be placed on pegs, some fundamental settings need to be correct on the 
equipment onto which the products will be placed.  

Connection Points 
The pegs and their parent fixtures must have compatible connection points. This enables 
them to fit together.  

Styles 
The pegs and their parent fixtures must have appropriate styles assigned, and a style 
relationship must exist between them. 

Merchandisable Areas 
The merchandisable area for the peg must be compatible with the product being placed.  

Connection Points for Pegs and Parent Fixtures 
 

Note: For more detailed information see the Fixture Studio 
Help File. 

Connection points are used to fit together one item of equipment to another in accurate 
alignment.   
For one item of equipment to connect to another the following must be true. 
 

–  Requirement Optional or Mandatory 

Gender The connection points must have 
compatible genders 

This requirement can be 
disabled in the 
Configuration Module 

Shape The connection points must have the 
same shape 

This requirement can be 
disabled in the 
Configuration Module 

Size The connection points must have 
compatible sizes 

This requirement can be 
disabled in the 
Configuration Module 

 
If any of these criteria are not true, then a connection cannot be made. 
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Gender 

Permissible Values Comment 

Male, Female, Neutral. Male connects with female.  
Neutral connects with itself and both male and 
female. 

 
Male can connect with female, and it would be conventional to give the connections on 
the parent fixture female gender, with the peg having male gender.   

Shape 

Permissible Values Comment 

None, Rectangle, Circle, 
Oval, Triangle, Hexagonal. 

Specific shapes will only connect with themselves 
and None. 

 
Both peg and parent fixture should be assigned the same shape, or 'None'. This will allow 
them to connect.  

Size 

– Permissible Values – Comment 

Minimum size 0, maximum 
size 1000. 

Two items of equipment must have overlapping 
connection sizes to connect.  

 
It is recommended that both the parent fixture and peg are given identical connection 
sizes. 

Note: The above comments only deal with the connection 
between parent fixture and peg. Other connections may exist 
(for example between pegboard and supporting legs). These 
would have different genders, shapes and sizes to the 
connections specified above.  

Assigning Styles for Pegs and Parent Fixtures 

Note: For more detailed information see the Admin Module, 
Fixture Studio and Product Studio Help Files. 

Styles serve as filters to determine what can be attached to what.  
� The parent fixture will have a fixture and a shelf style. 
� The peg will have a shelf style. 
� The product will have a product style. 

For the peg to go onto the parent fixture there must be a style relationship between the 
Fixture and Shelf Styles. 
For the product to go onto the peg there must be a style relationship between the Shelf 
and the Product Styles.   
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Configuring Merchandisable Areas for Pegs 

Note: For more detailed information see the Fixture Studio 
Help File. 

The merchandisable area for the peg is the area that merchandise can take up on the peg. 
It is configured in the Merchandisable Areas tab of the Block Definitions dialogue box for 
the peg.  
It is generally set to be unbounded in the X direction using the appropriate check boxes. 

Overview of Setting up Peg Positions 
Peg Positions are set up using the Peg Holes Tab in Product Studio 

 
Peg Hole positions can be added or deleted using the Add or Delete Peg Hole Icons on 
the Toolbar  

 

Add Peg Hole 
Position 

 

Delete Peg Hole 
Position 
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Setting Up Peg Hole Positions 
To set up a Peg Hole Position requires the following stages. 

 

 
Click on the Add Peg Hole Icon to add a Peg Hole to the List. 
The X, Y coordinates of the peg hole can then be set by clicking on the radio buttons. 
More Info 
The selected X, Y coordinates can be seen in the list. These determine where on the top of 
the product the peg hole will be located.   
The Style Filter allows the user to select a Peg Style that the product can be placed on. If 
the product is to go onto two or more styles of peg, then multiple peg holes must be 
defined. 
The Offsets can then be adjusted to allow for hole positions, etc. More Info 

Selecting the Basic Offset using Radio Buttons 
The nine radio buttons allow the user to set an offset in the X, Y plane relative to the top 
back left position of the product.  
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In this case the selected radio button corresponds to the blue circle on the product.  
Offsets will be calculated relative to the size of the object.  

 
In the above example the Width (X) and Depth (Y) offsets are calculated based on the 
area of the object, which is 100 x 100 mm. All offsets are calculated from the top, back, left 
corner of the package. 

Changing Offsets to allow for Hole Positions 
Sometimes a small offset will be required in the Z axis to allow for the position of the 
hole relative to the top of the product.  
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 The actual position should be the top of the hole, as indicated by the red dot in the 
diagram. This will then correspond with a connection line on the peg, which will be 
defined on the top of the peg. 

   

Multiple Peg Holes 
Multiple peg hole positions can be defined for a product.  
The first position will be defined as the primary, which is the one used when positioning 
the product on a pegboard. The other hole positions will determine where the extra pegs 
are placed.  
To define a product with multiple peg holes, simply define two or peg holes that have 
the same style.   

Multiple Peg Types 
It is possible to define different types of peg for different parent fixtures. This is done by 
specifying at least two peg holes for the product, and specifying different Styles for each 
from the Style Filter list.  
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The actual peg that is used will be then be determined by the pegboard onto which the 
item is placed, as dictated by the style relationship rule. This ensures that the product is 
only placed onto certain types of peg. 

Merchandiser – Placing Product on top of Product 

Overview of Product on Top of Product 
Macro Space Management allows products to be placed on top of other products. This is 
done by determining the height of the top face of the existing product and adjusting the 
elevation of the new product accordingly.  
This will only be enabled if the parent shelf/fixture of the product, on which it is being 
placed, allows stacking in the Z axis (working or stacking Z axis is enabled). 

Placing Product on Top of Product 
To place on product on top of another drag the required product from the options in the 
merchandising tab over to the product on top of which you wish to place it.  
Ensure the mouse cursor is just inside the object to be placed on top of, and release the 
mouse key. The desired products will them be placed on top. 

Note: If the mouse cursor is just above the object to be 
placed on top of when the key is released, then the object 
being placed will be inserted to one side, rather than on top. 

 
The depth and number of facings of the object being placed on top cannot exceed those 
determined by the length and depth of the object of which it has been placed on top. 

Caps 
Caps are when the same product is placed over another product, using a different 
orientation, in order to fill space. 
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These can be achieved by placing a separate instance of the product on top of another 
product and changing its orientation/rotation.  
In the first example above, two arrayed products would be placed, the first with 2 front 
facings, the second (on top) with 2 facings with top orientation. 
The second example above could be achieved with three sets of arrayed products: the 
first would be 1 facing with front orientation, then 2 facings with a left orientation and 
finally a 2 facings with top orientation. 

Note: Orientations can be changed during insertion by 
choosing the orientation from the Orientations Tab of the 
Add Products dialogue 

box.   

Nesting 
Nesting is where the same products are arrayed, but the each additional instance 
partially fits within another, as in the example below. 

 
 
Currently only bottom nesting (as in the example of the cups) is available. 

Nesting Different Products 
On some occasions, users wish to place different products on top of other products, 
where nesting would apply, but the nesting value could not be determined in advance by 
a value in the database.  
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First the products have to be placed on top of each other.  
The nesting distance can then be manually adjusted by selecting the objects to be nested 
and right clicking to bring up the pop-up menu. 

 
Clicking on Edit Article Nesting will bring up the Edit Product Nesting dialogue. 

 
The distance can be adjusted by means of the spin control. 
The units will automatically default to imperial or metric units depending on what was 
defined for the store in Store Manager. 

Merchandiser – Alignment 

Overview of Alignment 
Alignment defines the relative positions of product (and sometimes equipment) to each 
other. 
In previous implementations of Macro Space Management alignment was automatically 
determined by the parent onto which the products were placed.  
In the current implementation of Macro Space Management, alignment is no longer 
automatic and the user can customize position using the various options available.  
Products can be aligned with each other, or with their parent fixture or shelf, depending 
on what is selected.  
The alignment will work with equipment, as well as products. 
There are 9 options for alignment. 
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Aligning along length of shelf 

 Align to Left 

 Align to Center 

 Align to Right 

Aligning across depth of shelf 

 Align to Front 

 Align to Middle 

 Align to Back 

Distributing across volume of shelf 

 Distribute 
Left/Right 

 Distribute 
Front/Back 

 Distribute 
Top/Bottom  

 
Buttons for aligning along or across the shelf will only be enabled if at least one object is 
selected and the drawing is not read-only. 
Buttons for distributing across the shelf will be enabled if at least 3 objects are selected 
and the drawing is not read-only. 

Clash Detection 
Clash Detection should be turned on when aligning or products can overwrite each 
other.  
� If Clash Detection is turned on, products will move until they are in contact.  
� If Clash Detection is turned off, products can be moved so they occupy the same 

physical space.  
Clash detection is toggled On or Off by clicking on the clash Detection Icon in the Views 
toolbar 

 

Sequential Operations 
Each alignment operation only works on one plane at a time; i.e. it only works in the X, 
Y or Z plane for that particular operation.  
It is thus possible to use sequential alignment operations to achieve the desired effect. For 
example it is possible to use the Align to Left operation (X axis) followed by the Align to 
Back operation (Y axis).  
This will result in all selected products being aligned to the left and rear of the selected 
shelf. 
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Align to Left 

 Align to Left 
If one or more shelves/fixtures are selected before clicking the Align to Left button, then 
all child products will be aligned to the left. Alignment towards the front or back of the 
shelf will not be affected.  
Products will first be sorted in order of position along the length of the shelf. The first 
product will then be placed at the left hand end of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
products will be placed in a similar manner until all have been placed in a left justified 
alignment.  
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then they will be aligned so that left-hand side of each 
product matches the right-hand side of the preceding product in the selection set. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those products 
will be aligned with the shelf, rather than all the products on the shelf.  
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Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the shelf. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Align to Center 

 Align to Center 
If one or more shelves/fixtures are selected before clicking the Align to Center button, 
then all child products will be aligned to the center. Alignment towards the front or back 
of the shelf will not be affected.  
When all products have been aligned to center, there will be an equal unoccupied space 
to either side. 
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then they will be aligned so that centre-hand side of each 
product matches the centre-hand side of the first product in the selection set. 
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Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those products 
will be aligned with the shelf, rather than all the products on the shelf.  

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the shelf. 
 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Align to Right 

 Align to Right 
If one or more shelves/fixtures are selected before clicking the Align to Right button, 
then all child products will be aligned to the right. Alignment towards the front or back 
of the shelf will not be affected.  
Products will first be sorted in order of position along the length of the shelf. The first 
product will then be placed at the right hand end of the shelf. The next product will be 
placed adjoining the first such that it is adjacent, but does not overlap. Successive 
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products will be placed in a similar manner until all have been placed in a right justified 
alignment.  
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then they will be aligned so that right-hand side of each 
product matches the right-hand side of the first product in the selection set. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those products 
will be aligned with the shelf, rather than all the products on the shelf.  

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the shelf. 
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Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Align to Front 

 Align to Front 
If one or more shelves/fixtures are selected before clicking the Align to Front button, 
then all child products will be aligned to the front. Alignment towards the left or right of 
the shelf will not be affected.  
Products will first be sorted in order of position along the depth of the shelf. The first 
product will then be placed at the front edge of the shelf. The next product will be placed 
adjoining the first such that it is adjacent, but does not overlap. Successive products will 
be placed in a similar manner until all have been placed in a front justified alignment.  
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then each selected product will be aligned so that front edge 
of each matches the front edge of the shelf. 
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Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those selected 
products will be aligned with the front of the shelf, rather than all the products on the 
shelf.  

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the front of the shelf. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Align to Back 

 Align to Back 
If one or more shelves/fixtures are selected before clicking the Align to Back button, then 
all child products will be aligned to the back. Alignment towards the left or right of the 
shelf will not be affected.  
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Products will first be sorted in order of position along the depth of the shelf. The first 
product will then be placed at the back edge of the shelf. The next product will be placed 
adjoining the first such that it is adjacent, but does not overlap. Successive products will 
be placed in a similar manner until all have been placed in a back justified alignment.  
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then each selected product will be aligned so that back of 
each matches the back of the shelf. 

 

Shelf/Fixture and Products Selected 
If the shelf/fixture, plus some of its child products are selected, then only those selected 
products will be aligned with the back of the shelf, rather than all the products on the 
shelf.  

 

Shelf/Fixture Selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the back of the shelf. 



Merchandiser – Alignment 

556 Store Planning User Guide 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Align to Middle 

 Align to Middle 
If one or more shelves/fixtures are selected before clicking the Align to Middle button, 
then all child products will be aligned to the middle. Alignment towards the left or right 
of the shelf will not be affected.  
When all products have been aligned to the middle, there will be an equal unoccupied 
space to the front and rear. 
The manner of the alignment will depend on whether only products are selected, 
whether the shelf and some of its products are selected, or whether the shelf/fixture 
alone is selected. 

Products Selected 
If only products are selected, then each selected product will be aligned so that middle of 
each matches the middle of the shelf. 
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Shelf/Fixture and Products selected 
If the shelf/fixture, plus some of its child products are selected, then only those selected 
products will be aligned with the middle of the shelf, rather than all the products on the 
shelf.  

 

Shelf/Fixture selected 
If the shelf is selected (and no products) and the alignment button is pressed, then it will 
assume all child objects are selected and align them to the middle of the shelf. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Distribute Left/Right 

 Distribute Left/Right 
Distribution ensures that the spaces (or overlaps) between objects are equal.  
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Products 
If only products are selected, then Distribute Left/Right will establish the total distance 
between the left edge of the leftmost product and the right edge of the rightmost product. 
It will then establish the combined length of all the products within that distance.  
After comparing the total distance and the combined length, Distribute Left/Right will 
then move all selected products so that the gaps (or overlaps) between the selected 
products are equal.  
If products are selected, the left hand and right hand products in the selection will not 
move, but all intermediate products may have their positions adjusted.  

Parent Fixture/Shelf 
If the parent fixture/shelf is also selected, then it will assume that all child products are 
selected; this will distribute products between the left hand edge and right hand edge of 
the merchandisable areas.  
This means that unlike a Products selection, the left hand and right hand products in the 
selection will move to the respective left hand and right hand extents of the shelf 
respectively. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Distribute Front/Back 

 Distribute Front/Back 
Distribution ensures that the spaces (or overlaps) between objects are equal.  
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Products 
If only products are selected, then Distribute Front/Back will establish the total distance 
between the front edge of the foremost product and the back edge of the rearmost 
product. It will then establish the combined depth of all the products within that 
distance.  
After comparing the total distance and the combined depth, Distribute Front/Back will 
then move all selected products so that the gaps (or overlaps) between the selected 
products are equal.  
If products are selected, the front and back products in the selection will not move, but 
all intermediate products may have their positions adjusted.  

Parent Fixture/Shelf 
If the parent fixture/shelf is also selected, then it will assume that all child products are 
selected; this will distribute products between the front edge and rear edge of the 
merchandisable areas.  
This means that unlike a Products selection, the front and rear products in the selection 
will move to the respective front and rear extents of the shelf respectively. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Distribute Top/Bottom 

 Distribute Front/Back 
Distribution ensures that the spaces (or overlaps) between objects are equal.  
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Products 
If only products are selected, then Distribute Top/Bottom will establish the total distance 
between the top edge of the lowermost product and the maximum height available. It 
will then establish the combined heights of all the products within that distance.  
After comparing the total distance and the combined heights, Distribute Top/Bottom 
will then move all selected products so that the gaps (or overlaps) between the selected 
products are equal.  
If products are selected, the top and bottom products in the selection will not move, but 
all intermediate products may have their positions adjusted.  

Parent Fixture/Shelf 
If the parent fixture/shelf is also selected, then it will assume that all child products are 
selected; this will distribute products between the front edge and rear edge of the 
merchandisable areas.  
This means that unlike a Products selection, the top and bottom products in the selection 
will move to the respective top and bottom extents of the shelf respectively. 

 

Note: It is recommended that Clash Detection be turned on. 
This will avoid one product being placed on top of another if 
only some of the products on a shelf are selected for 
alignment.  

Aligning to Non-Rectangular Objects 
Macro Space Management allows alignment to non rectangular objects such as semi-
circular fixtures or corner shelves.  
The shape of the non-rectangular shelf is defined in Fixture Studio - all products placed 
on the shelf will be confined to the bounds of the non-rectangular area.  
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Shelves 
Alignment on non-rectangular objects should be carried out using the Shelf alignment 
options and with clash detection on. 

 

Products 
Non-rectangular products will be treated as boxes for alignment purposes. 

Aligning to Snap Grid 
It is possible to align objects to a regular grid. This can be toggled On or Off by clicking 
on the Snap option on the Status bar. 

 
It is also possible to toggle it On or Off using the Edit menu. 
 
 

 
The grid itself can be set to be displayed using the Grid Lines Option in the View pull 
down menu. 
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This brings up the Grid Lines dialogue box which can be used to set the parameters of 
the grid. 

 
The grid will then appear in the Virtual Reality Environment. 
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To turn a grid off, go to the layers dialogue box and turn off the grid lines layer.  

 

Planogram Design – the Planogram Hierarchy 

Overview of the Planogram Hierarchy 
The Planogram Hierarchy is found towards the top of the Object Browser. 

 
It is active when the planogram button is selected in the merchandising toolbar.  
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The hierarchy can be modified in one of two ways: groups and planograms. 

Groups 
Groups hold collections of planograms. They can be set up in a hierarchical structure - for 
example Summer Promotion is a child of Promotional Items.  

Planograms 
Planograms can be assigned to groups. Each Group holds a collection of planograms of 
similar purpose.   

Adding a Group 
To add a group, highlight the node in the hierarchy the group is to be a child of. 

 
In this case the Tinned Goods Group has been selected.  
Use <Ctrl> and Right click to bring up the pop-up menu. 
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Select Add Group to bring up the Group dialogue box. 

 
The Name and description can be typed in, and the pertinent icon selected from a drop 
down list. On clicking on OK, the group will be added to the hierarchy. 

Editing a Group 
To edit the details of the Planogram Group, highlight the required group in the hierarchy 
and use <Ctrl> plus right click to bring up the pop-up menu. 
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Select the Edit Group option. This will bring up the Edit Group dialogue box. Modify it 
as required. 

 
In this instance 'Example Planogram Group' has been changed to Modified Planogram 
Group'.  
Click on OK and the details will be modified in the hierarchy.  

Deleting a Group 
To delete a Planogram Group, highlight it in the hierarchy, then bring up the right click 
menu. 
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Click on Delete Group and the group will be deleted. If the Planogram group has 
planograms associated with it, these will be deleted as well. Before this can occur, a 
confirmatory dialog box will appear.   

 

Adding Planograms 
Planograms are added by selecting a parent group and highlighting it.  
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In this case we wish to add a Planogram to the 3D Samples Group.  
Once the group is highlighted, there are two ways to add a planogram; from the menu 
bar and from the pop-up menu.  
� Planograms can be added from the File pull down menu: 

 
Clicking on New Planogram will cause a blank Planogram dialogue box to appear, ready 
for the details of the planogram to be entered. 
� Planograms can also be added by using <Ctrl> plus right click to bring up the 

pop-up menu. 
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The add planogram option will then cause a blank Planogram dialogue box to appear, 
ready for the details of the planogram to be entered. 

 
On saving of the Planogram dialogue, the new planogram will appear in the hierarchy. 
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Editing Planograms 
Planograms are edited by selecting a planogram and highlighting it.  

 
Planograms can be opened for editing in one of two ways: from the menu bar and from 
the pop-up menu.  
� Planograms can be opened for editing from the File pull down menu: 
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� Planograms can also be edited by using <Ctrl> plus right click to bring up the 

pop-up menu. 

 
In both cases the Planogram dialogue box will open to allow the properties of the 
planogram to be edited. 
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Deleting Planograms 

Note: Planograms that have been deleted from the hierarchy 
have not yet been removed from the database. To remove 
them from the database, the purge option in the Admin 
Module must be used. 

To delete a planogram from the hierarchy first highlight it, then bring up the right click 
menu.  
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Clicking on the Delete Planogram option will bring up a confirmation dialogue.  

 
Clicking on Yes will cause the planogram to be deleted from the hierarchy (but not yet 
from the database). 
In order to permanently delete the planogram from the database it must be removed 
using the Purge option in the Administration Module.  

Purge Planograms Option 
Purge options are available using the Purge option on the Tools pull down menu in the 
Admin Module. 

 

Note: The Admin module is only available to users with 
Administrator's privileges.  

The planograms will not be permanently deleted from the database until the Planograms 
option is checked on the Purge dialogue and the OK button clicked.  
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Results will be reported in the Purge Results dialogue box. 

 

  Planogram Design – Other Aspects 

Setting Access Permissions for Planogram Design 
The ability for users to modify the planogram hierarchy and individual planograms is set 
in the Administration module. These permissions can be used to: 
1. Allow users to add, edit or delete Planogram groups in the Planogram Hierarchy 
2. Allow users to add, edit or delete individual planograms 

Overview of Planogram Creation 
There are two basic ways of creating planograms.  
1. By designing a planogram in the planogram design dialog box. 
2. By selecting merchandised fixtures in the store and using them to create a 

planogram.  
The first method is used for creating a planogram from scratch, including selecting the 
fixtures, shelves and products from those available. 
The second method is used to turn an existing arrangement of fixtures, shelves and 
products in a floor plan into a planogram.  
Both methods use a similar logic, and which one is used at a specific time will depend on 
the circumstances.  
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Special Forms of Planograms 
There are two forms of planograms that can be used to supplement fully detailed, 
finished planogram designs. 

Equipment Planograms 
If a store plan is being developed, but planograming is still at an early stage, it is possible 
to create equipment planograms. These can be used to lay out the shelves, etc, in the floor 
plan so that a bill of materials can be generated.  

Planogram Design – Object Browser 

Overview of Merchandising on the Object Browser 
Clicking on the Merchandising Tab on the Object Browser brings up a series of options 
for adding, editing and deleting Planograms.  
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The Toolbar gives access to varying options concerning Planograms. 
Buttons allow users to swap between product or planogram operations. 
The Hierarchy Window allows users to see the list of available planograms. (The 
hierarchy showing will depend on which button is selected). 
The Properties Window gives details of the currently selected object. 
The Summary Window gives details of how many of the selected objects have been 
placed in the drawing. 
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The Preview Window gives a preview of the selected product or planogram (if 
available). 

The Planogram Toolbar 
The Planogram toolbar is found on the Merchandising Tab of the Object Browser. It is 
active when the Planogram button is selected.  

 
It contains a series of icons allowing various operations to be carried out on Planograms.  

 
 
Add to Selected Fixture  

 
(Not enabled in 
Merchandiser) 

 
 
Edit Planogram Definition 

 

 
 
Remove from Fixture 

 
(Not enabled in 
Merchandiser) 

 
 
Reverse Planogram 

 
(Not enabled in 
Merchandiser) 

 
 
Highlight where used in 
store 

 

 
 
Highlight Selected Item in 
Tree 

 

 
 
Find Product or Planogram 

 

 
 
Show Merchandising 
Options 

 

 
 
Refresh 

 

 
Some of these options are only available in the Planner environment - alternative 
methods being available in the Merchandiser module. 

The Merchandising Hierarchy Window 
The Merchandising window shows a hierarchical tree of all the available products or 
planograms.  
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The tree can be expanded or contracted by clicking on the + or – icons.  
The Merchandising window can be minimized by clicking on the splitter bar. 

 
The Products or Planograms buttons immediately below the splitter bar determine 
whether the hierarchical tree shows products or planograms. 
The Products hierarchical tree can be configured in Product Studio using the Add 
Product, Edit and Delete options on the menu available by right clicking.  

 
The Planograms hierarchical tree can be configured in Merchandiser using the Add, Edit 
and Delete options on the menu available by right clicking.  
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The Group or Planogram options will be available or grayed out depending on whether a 
group or a planogram has been highlighted in the hierarchy. 

The Properties Window 
The Properties Window will show the properties for the currently selected product or 
planogram. 

 
The Properties window can be minimized by clicking on the splitter bar. 

 

The Summary Window 
The Summary Window will show a user defined list of products or planograms placed 
in the drawing. 
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Clicking on a column heading will re-order that column. Clicking again will reverse the 
sort order.  
The Summary window can be minimized by clicking on the splitter bar. 

 
The information that appears in the summary window is customizable and is selected by 
means of a SQL statement.    

The Preview Window 
The Preview Window will be blank if a planogram is selected.  

 
The Preview window can be minimized by clicking on the splitter bar. 

 

Planogram Design – Planogram Creation in Store 

Overview of Planogram Creation in the Store 
Planogram Creation within the Store requires the following stages: 
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Select Fixtures 
This determines which fixtures (and associated products) will become the planogram. 
Right click and Select Make Planogram 
This starts the planogram definition process. 

Specify Planogram Details 
This allows the user to specify the Planogram Details, Store Dependency, Season 
Dependency, Fixture Styles, and User Defined Attributes, (UDA's). 
It also allows the user to modify the fixtures and products originally selected for the 
planogram design. 

Select Node in Planogram Hierarchy 
This determines where the planogram will be saved in the hierarchy one it has been 
defined. 

Save Planogram 
This saves the defined planogram to the specified point in the planogram hierarchy in the 
Object Browser. 

Select Fixtures 
One or more fixtures (together with their associated merchandise) can be selected by 
holding down <Ctrl> and right clicking on the required fixtures. The fixtures will then be 
enclosed by a selection box.  

 
 
In this example, the first selected fixture is enclosed by a red selection box, and the 
second in a blue selection box. Other selection box colors may occur depending on 
whether multiple fixtures have been selected, or whether the fixtures belong to a group 
or family.    
All selected fixtures will be included in the planogram. 

Right click and select Make Planogram 
Once the fixture(s) have been selected, position the mouse pointer over them and right 
click to bring up the pop-up menu.  
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Note: The Make Planogram option will only be available if 
fixtures are selected. If product or shelves are selected, it will 
not be available.  

 
Selecting the Make Planogram Option will bring up a new Planogram dialogue box.  
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This requires completion and saving.  

Specify Planogram Details 
The Planogram dialogue box allows users to specify full details for the planogram. 

 
The Details Tab allows the planogram name, effective date, etc, to be specified.  
The Stores Tab allows users to select which stores the planogram is intended for. 
The Seasons Tab allows users to select which time periods the planogram is intended 
for. 
The Fixture Styles Tab allows users to specify which types of fixtures the planogram can 
be placed on. 
The Design Tab allows the planogram design to be modified relative to the fixtures and 
merchandise selected in the store. 
The Financial Tab allows financial performance data to be assigned to the planogram. 
The UDA Tab allows User Designed Attributes to be set for the Planogram.   

Select Node in Hierarchy 
Selecting the node in the hierarchy determines where the planogram will be saved once 
it has been created. 
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Here, the Carbonated Drinks Planogram Group has been highlighted, and the planogram 
will be saved under this node. 

Save Planogram 
Clicking on the OK button will save details of the planogram to the Macro Space 
Planning database. 

 



Planogram Design Options 

Merchandiser Module 585 

Note: The Save As button is used to save a different version 
of an existing planogram. It is not normally used when 
creating a planogram from new.  

 

Note: it is also possible to place the shelves, etc, directly in 
the floor plan without using equipment planograms. 

Placeholder Planograms 
Planograms can be saved with product placeholders in place of display styles. 

 
The usual purpose of this sort of planogram is to allow store planning to start before 
planogram design. The placeholder planogram is saved as Revision 1. When the design is 
finalized, it is saved as Revision 2. 
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If Planogram Substitution is carried out in a floor plan containing Revision 1 
(placeholder), that planogram will automatically updated to Revision 2 (full detail).  

Planogram Design – New Planogram Design 

Overview of New Planogram Design 
Planogram Creation from new requires the following stages: 

 

Select New Planogram from File pull down menu 
This starts the planogram definition process. 

Specify Planogram Details 
This allows the user to specify the Planogram Details, Store Dependency, Season 
Dependency, Fixture Styles, and User Defined Attributes, (UDA's). 
It also allows the user to modify the fixtures and products originally selected for the 
planogram design. 

Select Node in Planogram Hierarchy 
This determines where the planogram will be saved in the hierarchy one it has been 
defined. 

Save Planogram 
This saves the defined planogram to the specified point in the planogram hierarchy in the 
Object Browser. 
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Select New Planogram from File pull down menu 
The New Planogram Option is selected from the File Pull down menu. (Alternatively, 
the Add Planogram option can be selected from the right click menu). 

 
This will bring up a blank Planogram definition dialogue to allow the details of the 
planogram to be specified.  

 



Planogram Design – New Planogram Design 

588 Store Planning User Guide 

Specify Planogram Details 
The Planogram dialogue box allows users to specify full details for the planogram. 

 
The Details Tab allows the planogram name, effective date, etc, to be specified.  
The Stores Tab allows users to select which stores the planogram is intended for. 
The Seasons Tab allows users to select which time periods the planogram is intended 
for. 
The Fixture Styles Tab allows users to specify which types of fixtures the planogram can 
be placed on. 
The Design Tab allows the planogram design to be created from the available fixtures 
and merchandise. 
The Financial Tab allows financial performance data to be assigned to the planogram. 
The UDA Tab allows User Designed Attributes to be set for the Planogram.   
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Select Node in Hierarchy 
Selecting the node in the hierarchy determines where the planogram will be saved once it 
has been created. 

 
In this example, only a simple hierarchy has been created, but considerably more 
complex hierarchies can exist in large retail organizations.  
Here, the Clothing Planogram group has been highlighted, and the planogram will be 
saved under this node. 
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Save Planogram 
Clicking on the Save button will save details of the planogram to the central Macro Space 
Management database. 

 

Note: The Save As button is used to save a different version 
of an existing planogram. It is not normally used when 
creating a planogram from new.  
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Planogram Design  - Planogram Design dialog Box 

Overview of Planogram Design Options 
The Planogram dialogue box allows users to specify full details for the planogram. 

 
The Details Tab allows the planogram name, effective date, etc, to be specified.  
The Stores Tab allows users to select which stores the planogram is intended for.  
The Seasons Tab allows users to select which time periods the planogram is intended 
for. 
The Fixture Styles Tab allows users to specify which types of fixtures the planogram can 
be placed on.  
The Design Tab allows the planogram design to be modified relative to the fixtures and 
merchandise selected in the store.  
The Financial Tab contains performance data for the planogram. 
The UDA Tab allows User Designed Attributes to be set for the Planogram.  
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Overview of the Details Tab 
The Details Tab is used for to set up the description of the planogram, together with 
other parameters concerning its operation.  

 

Name, Description and Revision 
The Name, Description and Revision allow users to enter information pertinent to the 
planogram. 

 
Name is the filename by which the planogram will be referenced in the database. 
Description is a longer and more informative version of the name.  
Revision is the number of the initial revision of the planogram. The revision will be auto-
incremented each time a new version of the planogram is saved.  
Size Description is used to describe the nominal dimensions of the planogram. 
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Planogram Status and Dates 
The date  

 

Status 
Status is set from the Status drop down list in the Details tab. 

 
Status can be set to one of three options: 
� Proposed - the planogram is still in the process of being deigned and approved. 

Planograms at Proposed status can be placed in floor plans - for example to allow 
floor plans to be developed before planogram designs are complete.  

Note: it may be necessary to develop a report or KPI that 
shows planograms of Proposed status so they can be 
reviewed before a floor plan is authorized to go into service. 

� Current - the planogram is in service and available for placement 
� Superseded - the planogram is obsolete and has been taken out of service. 
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Note: additional statuses may be added using the Status 
option available from the General menu in the Admin 
module. 

Publish Date 
This date is a flag that can be used to indicate the data at which equipment and 
merchandiser required to implement the planogram can be ordered. 

Effective Date 
This is the date planograms come into service.  
If the MERCH_TREE_EFFECTIVE_DATE system variable is turned on (Admin module) 
the effective date of the planogram will be compared to the Active Date of the current 
floor plan (set at the top of the Object Browser). If the Planogram Effective Date is after 
the Active Date for the floor plan, the planogram will not be available for placement. This 
prevents planograms that will only be available after a specific date being placed  
Expiry Date 

The Expiry date is the date at which the planogram will be taken out of service. When a 
planogram is created, the date will be set to a default of 31st Dec 2999. 

Planogram Information 

Planogram information 
This section contains information on the planogram  
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Note: Name, Description, Size Description, Revision, Status, 
Publish Date, Effective Date, Expiry Date are discussed 
elsewhere in this section. 

Family Code indicates the Family the planogram belongs to. There might be a 1 bay 
planogram for printer cartridges for small stores and a 2 bay planogram with larger 
quantities of the same cartridges for a larger store. The Family Code can be used in 
reports of KPI's to check that only one instance of a printer cartridge planogram has been 
placed in a store. 
Assortment Code gives further information on the purpose of the planogram. Codes are 
often client specific - for example HSL might indicate that the planogram was designed 
for stores with a Hispanic demographic, for stores of small size and does not have a large 
movement of products associated with it.  
Temperature Range is the temperature that the products in the planogram will be 
displayed at. It is set using the drop down list. The selected temperature range must 
match the temperature range on the fixtures the planogram will be placed on in the floor 
plan. Temperature ranges are configured using the Ranges option in the Merchandising 
menu in the Admin module. 
Weight Range indicates the total weight of the products in the planogram. This 
functionality is not yet in use. 
Stock Type is not in use in this version of the software. 
AutoFill Rule indicates the AutoFill rule that has been selected if the AutoFill 
functionality has been configured in the Merchandiser module.  
Can be Split is a flag indicating whether the planogram must be placed on adjacent 
fixtures, or whether the selected fixtures can be separated from each other.  
Client Code is a code assigned by the client to identify the planogram. The code will 
vary from retailer to retailer. 
Buddy Family Code indicates the Family code of a planogram that should be associated 
with this planogram. For example, if the family code of a planogram is that of printer 
cartridges, the Buddy Family code might be that of printer paper. The Buddy Family 
Code can be used in reports or KPI's to check that the right pairing of planograms has 
been placed. 
Units are the units of measure for the planogram dimensions. The list of available units 
can be configured using the Units option accessed from the General menu in the Admin 
Module. 
Time Units are the units of measure for the set and dismantle times. The list of available 
units can be configured using the Units option accessed from the General menu in the 
Admin Module. 
Manpower Set Time is the time it will take to add any shelving and place the products. 
The units are set in the Time units drop down list. 
Manpower Dismantle Time is the time it will take to clear all shelving and products in 
preparation for placing the next planogram. 
Category Role is the reason the retailer believes customers purchase products from that 
planogram.  
Inventory Model indicates the Inventory Model used to provide the data for the 
planogram design. 
Rank is an arbitrary number that can be assigned to indicate order  
Traffic Flow indicates whether the planogram is designed to be viewed by people 
walking left to right or right to left. 
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Requires Power is a flag 

Overview of the Properties Tab 
The Properties tab (which is read only) gives information on the planogram. 

 
Source is the source of the design of the planogram. MSM indicates that the planogram 
was created using Macro Space Management. Alternatively, this could be the name of the 
third party source of the planogram design. this information is read from the 
AVTTB_POG_SOURCE table in the database. 
Import Identifier is assigned to identify the specific import that brought in the 
information. 
Imported Name identifies the source of the import. this could be the name assigned to 
the planogram in the third party software, a cluster holding a series of planograms or a 
flat file holding a number of planograms. 
Last Imported is the date of the last import. (Information may be imported a number of 
time to update - for example - financial data. 
Parent Product is the name of the node in the hierarchy that is the common link between 
all of the products in the planogram. It can either be calculated by Macro Space 
Management or assigned during import.  
Created is the date the planogram was first created or imported 
Created By is the identifier of the user if the planogram was manually created. If the 
planogram was imported, this will be indicated instead.   
Last Modified is the date the planogram was last saved or information was last 
imported. 
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Last Modified By is the identifier of the user if the planogram was manually updated. If 
the information was imported, this will be indicated instead.   
Last Published is the date the planogram design was last printed in electronic or hard 
copy form. 
Size is the calculated size of the planogram. 
Number of Bays is the number of profiles (bays) in the planogram. 
Total Number of Facings is the number of facings in the planogram. 

Overview of the Stores Tab 
The Stores Tab is used to select the Stores the planogram is valid for. 

 
This information is for reporting purposes only and does not put any constraints on 
planogram placement. 

Configuring the List of Stores 
The list of stores can be configured by means of the Store Manager module. This is 
invoked by clicking the Store Manager Icon in the toolbar. 
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Store Manager allows the hierarchy of clusters and stores to be added to, edited and 
deleted from. 

 

Adding or Removing Stores 
To Add or Remove Stores check the Store Dependent box. 

 
This will enable the Stores toolbar. 

 
Add Store 
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Remove Store 

 
Remove all Stores 

 
Individual Stores can be added or removed by using the Add Season or Remove Season 
icons. 
Remove all Stores will remove all selected stores from the right of the display.  

Overview of the Seasons Tab 
The Seasons Tab allows users to specify which seasons (if any) the planogram is valid 
for. 

 
This information is for reporting purposes only and does not put any constraints on 
planogram placement. 

Configuring the List of Seasons 
The list of seasons is configured in the Admin Module. Select the Seasons option from the 
Merchandising Menu. 
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This will bring up the Seasons dialogue box. 

 
This allows seasons to be added, edited or deleted. 

Adding or Removing Seasons 
To Add or Remove seasons check the Season Dependent box. 



Planogram Design  - Planogram Design dialog Box 

602 Store Planning User Guide 

 
This will enable the season toolbar 

 
Add Season 

 
Remove Season 

 
Remove all Seasons 

 
All available seasons can be added to the planogram by selecting all seasons on the left of 
the display, then clicking on the Add Season icon. 
Individual seasons can be added or removed by using the Add Season or Remove Season 
icons. 
Remove all seasons will remove all selected Seasons from the right of the display.  

Overview of the Fixture Styles Tab 
The Fixture Styles tab allows users to specify which fixture styles the planogram can be 
placed on.  
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Planograms can only be placed on fixtures that have been assigned those styles.  
In the example above, the planogram can only be placed on fixtures that have been 
assigned the Standard Fixture style.   
Selecting styles can be done by means of the toolbar.  

 
Add Style 

 
Remove Style 

 
Remove all Styles 
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Adding or Removing Styles 
Styles can be added or removed by means of the toolbar. 

 
To add or remove a style, simple highlight it and click on the relevant icon. 

 
Add Style 

 
Remove Style 

 
Remove all Styles 

 
Remove all Styles will remove all selected Styles from the right of the display.  
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Configuring the List of Styles 
The list of available styles is configured in the Admin Module. 

Note: Users will require the appropriate privileges to use the 
Admin Module 

Select Styles from the Admin Module Merchandising Menu. 

 
This will bring up the Styles dialogue box. This allows Styles to be defined, Style 
Relationships to be set and those style relationships to be tested. 
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Overview of the Design Tab 
The Design Tab is used to design the planogram. 

 

Selecting the Fixtures and Shelf Objects for the Planogram 
When working in the Design tab, only fixtures and shelf objects can be added. It is not 
possible to using gondolas. 
The fixtures required for the planogram can be selected from the hierarchy on the Object 
Browser and 'dragged and dropped' into the planogram design.  
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As fixtures are 'dragged and dropped' into the design window, they will align facing the 
user and ordered from left to right.  
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Similarly, shelf objects can be added by selecting the required parent fixtures and adding 
as necessary.  
Selection details work in a similar manner to in a floor plan, as do Walk Mode and Edit 
Mode. 

Selecting the Products for the Planogram 
Products can then be placed using those available from the hierarchy in the Object 
Browser. 

 
If objects are selected at SKU level or above, they will be placed as placeholders - 
indicating that type of merchandise is on that fixture or shelf, but giving no indication of 
position, size or quantity. If objects are selected at display style level, position, size and 
quantity are specified. 
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The screen shot above shows products being added to a planogram at display style level.  

2D and 3D Views 
There are two forms the planogram can be viewed in: 2D and 3D. The option in use is 
selected from the toolbar in the Design tab of the Planogram Design dialog box. 

 

2D 
The 2D option shows a flat 'Read Only' image of the planogram. It is a preview of the 
image that can be set to appear on the front of planograms when they are imploded into 
2D form in Merchandiser floor plans. 
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3D 
The 3D option shows a fully editable view of the planogram. It shows the planogram as it 
would appear when placed in a floor plan in the merchandiser module. It also allows 
equipment and merchandise to be added, edited and deleted. 

 

User Defined Attributes 
As well as the User Defined Attributes assignable to the planogram in general on the 
UDA tab, it is also possible to assign UDA information to individual profiles (bays), as to 
specific shelves and products. 

UDA's associated with Planogram Profiles (bays) in the planogram design 
UDA's associated with a specific profile (bay) in a planogram can be seen by highlighting 
that bay in the Design tab. 
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 Clicking the Object Properties icon on the toolbar will bring up the Profile User Defined 
Attributes dialog box. 

 
This will bring up the Profile User Defined Attributes dialog box. 

 

Note: the number after the parent fixture for the profile (23 
in the above example) is the PRD_ID from the 
AVTTB_PROFILE table. It is a unique identifier for the 
profile/bay the UDA refers to.  
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UDA's associated with specific items of equipment in the planogram design 
UDA's associated with a specific item of equipment in a planogram can be seen by 
highlighting that item of equipment in the Planogram Design window in the 
Merchandiser module and clicking the Object Properties icon on the toolbar. 

 
This will bring up the Equipment User Defined Attributes dialog box. 

 

Note: the number after the item of equipment (62 in the 
above example) is the FXL_ID from the AVTTB_POG_FIXEL 
table. It is a unique identifier for the item of equipment the 
UDA refers to.  

UDA's associated with specific products in the planogram design 
UDA's associated with a specific product in a planogram can be seen by highlighting that 
item of merchandise in the Planogram Design window in the Merchandiser module and 
clicking the Object Properties icon on the toolbar. 

 
This will bring up the Product User Defined Attributes dialog box. 
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Note: the number after the item of merchandise (67 in the 
above example) is the PPR_ID from the 
AVTTB_POG_PRODUCT table. It is a unique identifier for 
the item of merchandise the UDA refers to.  

Overview of the Financial Tab 
The Financial Tab contains information of the performance of the planogram. this 
information can either be manually entered or imported as part of a planogram import. 
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Financial Tab - Basic Details 

 

Currency 
The currency for the financial data is set from a drop down list. The data in this list is 
specified in the Units dialog box, accessed from the General Menu in the administration 
module. 

Calculate other fields after editing 
If checked, this forces all data associated with specific fields to be recalculated when data 
is changed elsewhere. 

Use Planogram Size for Dimensions 
This substitutes the planogram size held in the database for the imported planogram size 

Linear 
This field holds the base linear measurement of the planogram 

Square 
This field holds the footprint of the planogram: the base linear multiplied by the depth 

Cubic 
This field holds the volume of the planogram: the base linear multiplied by the depth 
multiplied by the height. 

Linear Units 
This field holds the unit of measure for the length. 

Square Units 
This field holds the unit of measure for the area. 

Cubic Units 
This field holds the unit of measure for the volume. 

Demand Transference 
This is the probability that if a specific product is out of stock in a store, a customer will 
buy an alternative product. This probability could be very high - for example for baked 
beans. It could be very low for specific products - for example recently released computer 
software games. 



Planogram Design  - Planogram Design dialog Box 

616 Store Planning User Guide 

Target Capacity 
This is the minimum percentage of the merchandisable capacity of the parent fixtures 
that should be filled with product. 

Target Service Level 
This is the level of stock that will result in the specified percentage of merchandise being 
present in the stores across the retail chain. High Target Service Levels result in stock 
being increasingly available for customers, but also increase inventory costs. 

Historical Service Level 
This is the service level resulting from the historical levels of stock.  

Target Number of Facings 
This is the designed number of product facings in the planogram 

Return on Inventory Investment 
This is the Gross Margin Return on Investment.  

Note: the calculation method may vary from retail 
organization to retail organization. 

Financial Tab - Actual Data 
The actual data is based on EPOS data collected by the retailer and imported into Macro 
Space Planning as updates to the planogram specific data during planogram imports. 
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Note: The currency units for the financial data are set using 
the Currency drop down list in the upper part of this dialog 
box. 

Sales 
This is the sales for this planogram. The time period is client dependent and may be daily 
average, weekly total, monthly total, etc.  

Sales/Linear 
This is the sales figure divided by the Linear figure for the planogram. 

Sales/Square 
This is the sales figure divided by the Square (footprint) value for the planogram. 

Sales/Cubic 
This is the sales figure divided by the Cubic (volume) value for the planogram. 

Profit 
This is the profit for this planogram. The time period is client dependent and may be 
daily average, weekly total, monthly total, etc.  

Profit/Linear 
This is the profit figure divided by the Linear figure for the planogram. 

Profit/Square 
This is the profit figure divided by the Square (footprint) value for the planogram. 

Profit/Cubic 
This is the profit figure divided by the Cubic (volume) value for the planogram. 

Gross Margin 
This is the gross margin for this planogram. Gross Margin is calculated by the formula 
Gross Margin = (Profit/Sales) x 100% 
The time period is client dependent and may be daily average, weekly total, monthly 
total, etc.  

Gross Margin/Linear 
This is the gross margin divided by the Linear figure for the planogram. 

Gross Margin/Square 
This is the gross margin divided by the Square (footprint) value for the planogram. 

Gross Margin/Cubic 
This is the gross margin divided by the Cubic (volume) value for the planogram. 

Movement 
Movement is the number of times the planogram will be replenished in a specific time 
period.  
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Movement/Linear 
This is the movement divided by the Linear figure for the planogram. 

Movement/Square 
This is the movement divided by the Square (footprint) value for the planogram. 

Movement/Cubic 
This is the movement divided by the Cubic (volume) value for the planogram. 

Financial Tab - Forecast Data 
This tab contains forecast data for the performance of the planogram. It can be 
superseded by actual data as the planogram comes into service. 

 

Note: the currency units for the financial data are set using 
the Currency drop down list in the upper part of this dialog 
box. 

Forecast Sales 
This is the forecast sales for this planogram. The time period is client dependent and may 
be daily average, weekly total, monthly total, etc.  

Forecast Sales/Linear 
This is the forecast sales figure divided by the Linear figure for the planogram. 
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Forecast Sales/Square 
This is the forecast sales figure divided by the Square (footprint) value for the planogram. 

Forecast Sales/Cubic 
This is the forecast sales figure divided by the Cubic (volume) value for the planogram. 

Forecast Profit 
This is the forecast profit for this planogram. The time period is client dependent and 
may be daily average, weekly total, monthly total, etc.  

Forecast Profit/Linear 
This is the forecast profit figure divided by the Linear figure for the planogram. 

Forecast Profit/Square 
This is the forecast profit figure divided by the Square (footprint) value for the 
planogram. 

Forecast Profit/Cubic 
This is the forecast profit figure divided by the Cubic (volume) value for the planogram. 

Forecast Gross Margin 
This is the forecast gross margin for this planogram. Gross Margin is calculated by the 
formula Gross Margin = (Profit/Sales) x 100% 
The time period is client dependent and may be daily average, weekly total, monthly 
total, etc.  

Forecast Gross Margin/Linear 
This is the forecast gross margin divided by the Linear figure for the planogram. 

Forecast Gross Margin/Square 
This is the forecast gross margin divided by the Square (footprint) value for the 
planogram. 

Forecast Gross Margin/Cubic 
This is the forecast gross margin divided by the Cubic (volume) value for the planogram. 

Forecast Movement 
Forecast movement is the number of times the planogram will be replenished in a 
specific time period.  

Forecast Movement/Linear 
This is the forecast movement divided by the Linear figure for the planogram. 

Forecast Movement/Square 
This is the forecast movement divided by the Square (footprint) value for the planogram. 

Forecast Movement/Cubic 
This is the forecast movement divided by the Cubic (volume) value for the planogram. 
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Financial Data and Planogram Weighting 
The data from the Financial tab is used in the Financial Weighing dialog box accessed 
from the Merchandising menu in the Admin module. 

 
This option allows users to set up a system for calculating the relative performance of 
planograms from the imported or manually entered financial performance data. 

Overview of the UDA Tab 
The UDA Tab is used to add User Defined Attributes (UDA's) to the Planogram. 

 
UDA's are implementation specific and can be customized according to customer 
requirements.  
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Configuring the Fields for the UDAs 
The fields for the UDAs are configured in the Admin Module. Select the User Defined 
Attributes option from the Merchandising Menu. 

 
This will bring up the User Defined Attribute dialogue box. 

 
This allows the fields for the UDAs to be added, edited or deleted. 

Adding, Editing or Deleting UDA Information 
The UDA fields themselves are configured in the Admin Module. The title used for each 
UDA field is shown in the Property column. This information cannot be edited in the 
Planogram Design dialog box.  
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The information in the Value field can be added, edited or deleted by the user. Data can 
be one of the following types: 
 

Type  Description 

Text A text field, for example a name 

Whole 
Number 

An integer, such as 1, 2 or 3 

Decimal A number with values after the decimal 
point, for example 1.234 

Date A date - for example a review date 

Boolean A Yes/No field. This appears as a 
checkbox. 

Currency Currency: a financial value. 
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Planogram Design – Saving Planograms 

Saving Planograms as New Designs and New Revisions 
Once a planogram has been designed, that design can be updated at a later date. 
Changing the Revision Number of a planogram is straightforward.  

 
The Planogram Revision (1) can be seen at the top right of the dialogue box. 
To change the revision, click on the Save As button (2). This will bring up the Save As 
dialogue. 
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Select the Save as New Revision radio button and enter the Revision Number. Click on 
OK to save the new revision.  

Overview of Planogram Versions 
Planogram designs can be updated. For example, a more up to date design of packaging 
could become available and the planogram updated accordingly.  
The updated planogram is known as a new version.  
When a planogram is revised in such a manner, the older version of the planogram has 
its status changed to 'superseded',   

Overview of Planogram Import 
As an alternative to creating planograms within Merchandiser, Macro Space 
Management users have the option of importing existing planograms from third party 
software.  
This requires a customized import routine - planograms being imported into the central 
Macro Space Management database where they become available for placement into 
store plans.  
Contact Oracle's Technical Support Team for further information.  

 Merchandiser – KPI's and Time Dependent Data 

Overview of Time Dependent Data 
Macro Space Management data can come from two main sources: the program itself and 
data imported from external software.  
This data is stored in the central Macro Space Management database.  
The data can then be analyzed in two ways: using Reporting Tools and using KPI’s (Key 
Performance Indicators). 

 
Key Performance Indicators present data visually in the form of color coded objects 
within the Virtual Reality store. This enables an overview of performance to be seen at a 
glance.  
Reporting Tools present data in the form of ordered lists. This enables data to be 
analyzed in detail.  
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Note: Macro Space Management has an internal reporting 
tool called Report Studio. Alternatively, reporting tools from 
Oracle can be used - an example is BI Publisher. 

The two methods are complementary; enabling the user to see information in two 
different ways.  
As data changes with time, Macro Space Management allows data to be analyzed for 
specific periods of time. Such information is known as Time Dependent Data.  
It is possible to review Time Dependent Data for a specific day, week, month, quarter or 
year. It is also possible to review the data for seasons or any other specified criteria. 

Data Import 
Data can be imported from external programs using Macro Space Management’s Data 
Import module.  

 
This data is then stored in tables within Macro Space Management’s central database.  
Such data might include sales values, product volumes, etc. 
Imported data can then be analyzed using Report Studio or KPI’s, (Key Performance 
Indicators). 

Setting Effective Dates in Store Manager 
The Effective Date for a drawing within in Store Manager can be manually set by 
selecting the required drawing by highlighting it. Right clicking will bring up a menu of 
options. 
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Selecting Properties will bring up the Properties dialogue box. 

 
Publish and effective dates can then be set by clicking on the down arrows by the Publish 
and Effective Date drop down menus. This will cause a Standard Date control to be 
displayed.  
This can be used to set the Publish and Effectives data for the drawing. 



Merchandiser – KPI's and Time Dependent Data 

628 Store Planning User Guide 

Note: Publish and Effective dates can only be set when a 
drawing has Authorized status. 

Status and Effective Dates 

Status 
Each store within a retail organization is subdivided into floors. Each floor in turn can 
have a number of revisions, and each revision can contain a number of drawings.  
Only one drawing at a time can be current (active) for a store. The current position of a 
drawing is indicated by its Status. Although these there will be some variation from 
customer to customer, statuses tend to follow the same general sequence. 

 
� Proposed drawings are tentative layouts for stores. 
� Authorized drawings are layouts that have been accepted for future 

implementation. 
� Current drawings are the layouts that are presently in use. 
� Historical drawings are drawings of layouts that have been superseded.  

A specific store may only have one current drawing (the layout presently in use) and one 
authorized drawing (the layout due to come into use) at any one time. 
Drawings can be viewed with any status, but the amount of information available for 
KPI’s and reports may vary depending on the status of the drawing.  
For example drawings with Proposed status may not have sales data associated with 
them, while drawings with Current status probably will.  

Publish and Effective Dates 
When a drawing reaches Authorized status it may have Publish and Effective dates 
assigned to it.  
The Publish Date is the date at which an authorized drawing is sent to the affected stores 
so that they may begin preparations for implementing it.  
The Effective Date is the date at which the drawing becomes the active version of the 
layout within the affected stores.  

Note: Publish and Effective dates can only be set when a 
drawing has Authorized status. 

Effect of Effective Date on Status 
When an Authorized drawing is given an Effective date, this indicates the date at which 
it is to come into use.  
At the date at which the drawing becomes Effective, its status is changed from 
Authorized to Current. Simultaneously, the drawing it replaces has its status changed 
from Current to Historical. 
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Overview of using KPI's 
KPI’s can be produced using data from on the store associated with the current drawing, 
or from a user specified store.  
Macro Space Management enables the user to select both the date and time period for the 
data to be displayed. This enables users to monitor performance with specified time 
periods.  
KPI’s can be selected from the Object Browser by clicking on the KPI tab.  

 
Clicking on a particular KPI will then bring up the Key Performance Indicator Dialogue 
Box. 

 



Merchandiser – KPI's and Time Dependent Data 

630 Store Planning User Guide 

This lets the user specify the Details, Stores involved and Date Ranges required. 
It also lets the user specify which ViewPort(s) to use. 
When these have been selected, the pertinent KPI will be displayed. 

Selecting Stores and Date Ranges 

Selecting Stores 
Stores for which KPI’s can be displayed can be selected using the Stores Tab in the Key 
Performance Indicator dialogue box.  

 
If the Current Store check box is selected, then KPI’s will be displayed for the store 
associated with the currently active drawing.  
If the Current Store check box is un-ticked, then the store may be selected from the list of 
all available stores. These may be sorted by Store Code or Store Name by clicking on the 
column header.  

Selecting Dates 
Date Ranges for which KPI’s can be displayed can be selected using the Date Tab in the 
Key Performance Indicator dialogue box. 
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Radio buttons enable the user to specify whether the date on which the KPI should be 
based is the Effective Date (the date on which the drawing became current), the Current 
Date (today’s date), or a user specified date.  
Dates can be set using the Date Control Display that will appear as soon as the Date drop 
down list is activated.  

 
The Date range can also be selected from the drop down list that appears when Data 
Type is activated.  

 
This will specify the time period relative to the selected date. 
All date ranges are after the selected date.  
For example, selecting a current date of 11/10/06 and a date range of a Month will select 
all data for October 2006. 

KPI's and ViewPorts 
Each KPI can be associated with one or more viewports.  
This is specified in the Details Tab of the Key Performance Indicator dialogue box when 
the KPI is first opened. 
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In the above example, the KPI has been selected to show in ViewPort 1. 

KPI's and using Multiple Viewports 
It is possible to use ViewPorts to display a single KPI reporting on data over different 
date ranges. It is also possible to use ViewPorts to display performance data from 
different stores sharing the same layout. 
Each instance of the KPI can be set to show in a different ViewPort window, allowing the 
Macro Space Management user to see compare how performance changes over time or 
how performance varies from store to store.  
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In the above example the Weekly Sales KPI has been set to show in four different 
ViewPorts, each showing a different week’s data.  

Renaming KPI’s 
Each instance of similar KPI’s open in multiple ViewPorts has to be renamed. This is 
because each KPI must have a unique name. If duplicate names occur, Macro Space 
Management will put a warning at the bottom of the Key Performance Indicator dialogue 
box.  

 
In the example below the SubClass Forecast Sales (Fixture) KPI has been renamed to each 
instance has a unique name. 

 

Selecting stores 
Stores can be selected from the list on the Stores Tab of the Key Performance Indicator 
dialogue box.  
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Date Ranges 
Start dates and Date Ranges can be set from the Date Tab of the Key Performance 
Indicator dialogue box.  
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